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Preface
The Hansa Financials and HansaWorld ranges contain a number of powerful
accounting, CRM and ERP systems for the Windows, Macintosh, Linux,
PocketPC 2002 and AIX environments.

Hansa Financials and HansaWorld are practically identical, and they are
designed to make administration and accounting as easy and fast as possible.
The main differences between the two programs are discussed in the
appropriate sections of these manuals.

The programs are similar in operation regardless of platform. In the specific
areas where there are significant differences, these are described and
illustrated in full. In all other cases illustrations are taken from the Windows
version.

Text in square brackets - [Save], [Cancel] - refers to buttons on screen.



How these manuals are organised
Volume 1: Introduction

Introduction Installing Hansa, the basic ideas
Work Area Basic elements of Hansa: modules, registers, windows, menus,

functions, buttons
Accounting Principles

About Hansa’s place in your business, integration between
ledgers, objects

Starting Work Entering opening balances
Customers Customers, customer categories and reports
Items Products and services, pricing
System Module Settings and parameters. System-wide usage

Volume 2: Accounting Package

Volume 2a Sales Ledger Invoices, receipts, debtors
Purchase Ledger Purchase invoices, payments and creditors

Volume 2b Nominal Ledger The basic accounting module. Transactions and budgets
Currency Multi-currency in all modules

Volume 3: Logistics Package
Sales Orders Orders and deliveries. Invoices from orders
Purchase Orders Purchase orders, goods receipts and purchase pricing
Stock Deliveries, goods receipts and stock movements

Volume 4: General Modules
Assets Asset accounting, depreciation, revaluation
Cash Book Inward and outward cash transactions, receipts and payments
Consolidation Multi-company reporting, subsidiaries and daughter companies
Expenses Payments to and from employees
Quotations Sending quotations, call backs, reports

Volume 5: Specialised Modules
Contracts Periodic invoicing, contract renewals, contracts from invoices
Job Costing Project management, time recording, budgets and quotations
Production Multi-level assemblies from components
Service Orders Management of service stock, invoicing of repairs, warranties

Volume 6: Personal Registers
CRM Contact and time management. Activities, the task manager and

the calendar: registering and reviewing appointments in daily
or monthly diary or calendar format. Contact Persons.
Customer letters and mailshots. Target time.

Mail Internal mail, external mail (email), conferences, chat.



Hansa Financials and HansaWorld

4

Contents
Preface .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .II

Chapter 1: Introduction and Installation .........................18

Structure of Hansa ..... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Work Flow ...............................................................................20

Multi-year Database .................................................................22

Preparing for Installation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Efficient Management......................................................... 23
Planning and Setting up...................................................... 24

Installation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
System Requirements ..............................................................26

All Platforms..................................................................... 26
Windows.......................................................................... 27
Macintosh ........................................................................ 27
Linux .............................................................................. 28

Installation ...............................................................................28
Single-user ...................................................................... 28
Multi-user......................................................................... 29
Linux and Macintosh OS X Server Installation ......................... 30

After Installation .......................................................................32

Starting Hansa ..... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Companies and Databases.......................................................35

Loading an Existing Database and Company .............................36
Single-user ...................................................................... 36
Multi-user......................................................................... 36

Creating a New Database - Single-user .....................................37
Importing from a Back-up .................................................... 37
The Work Area ................................................................. 38
Creating a New Company ................................................... 39
Settings........................................................................... 41
Modules, Users and Companies ........................................... 45
Changing and Adding Companies......................................... 46
The Database Key............................................................. 48
If the “DBDef.txt” file is missing............................................. 49
Setting up a Basic Accounts System ..................................... 51



Contents

5

Creating a New Database - Multi-user....................................... 52
Server with Graphical Interface (Windows and Macintosh OS 9) ..52
Server with no Graphical Interface (Linux and Macintosh OS X)...53
Setting up the Server module ...............................................54
The Program Mode Register ................................................56
Logging on from a Client......................................................58

Setting up an FTP Server ......................................................... 59

Shutting Down......................................................................... 62
Single-user .......................................................................62
Multi-user .........................................................................63

Backing Up ..... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Automatic Timed Back-ups ..................................................68
Backing Up Using Specialist Back-up Software ........................70

Restoring from a Back-up......................................................... 72

Upgrading from Previous Versions of Hansa.............................. 75

Chapter 2: Work Area .................................................. 78

The Master Control Panel .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
HansaWorld.com ..................................................................... 83

Personal Desktop .................................................................... 83

Passwords .............................................................................. 83

Windows..... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Browse Window....................................................................... 84

Record Window ....................................................................... 88
Button Bar ........................................................................89
Paste Special ....................................................................91
Drag and Drop...................................................................94
Attachments......................................................................95

Report Window........................................................................ 95
Printouts ..........................................................................97
Searching in Reports ..........................................................97
Recalculating reports ..........................................................97
Drill-down .........................................................................98

List Window........................................................................... 100

Specification Window............................................................. 100

File Dialogue Window ............................................................ 101



Hansa Financials and HansaWorld

6

Menus and Sub-menus..... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .103
The Menu Bar........................................................................103

File Menu ..............................................................................103
Company........................................................................104
Master Control .................................................................104
Exports ..........................................................................104
Imports...........................................................................105
Maintenance ...................................................................105
Reports ..........................................................................106
Documents .....................................................................110
Settings..........................................................................112
Page Setup .....................................................................113
Print...............................................................................114
Print Queue.....................................................................114
Quit ...............................................................................115

Edit Menu..............................................................................115
Undo .............................................................................115
Cut ................................................................................115
Copy..............................................................................116
Paste .............................................................................116
Clear..............................................................................116
Select All ........................................................................116
Select Row .....................................................................116

Record Menu.........................................................................117
Next ..............................................................................117
Previous .........................................................................118
OK ................................................................................118
Cancel ...........................................................................118
New...............................................................................118
Duplicate ........................................................................118
Delete ............................................................................119
Invalidate........................................................................119
Attachments ....................................................................121
Send to Desktop ..............................................................121
History ...........................................................................121

The Registers ........................................................................124

Modules Menu .......................................................................125

Operations Menu ...................................................................125

Window Menu........................................................................126

About Hansa..........................................................................126



Contents

7

Working with Records.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Current Record...................................................................... 128

New Record .......................................................................... 128

Duplicate Record ................................................................... 128

Delete Record ....................................................................... 129

Working with Companies.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
Shared Registers................................................................... 133

Attachments and Personal Desktop ..... . . . . . . . . . . . . . . . . . . . . . 135
Attachments .......................................................................... 135

Attaching Files to Records ................................................. 136
Reading Files .................................................................. 136
Attaching Notes or Comments to Records ............................. 137
Reading and Changing Notes ............................................. 137
Printing Notes ................................................................. 137
Changing the Names of Attachments ................................... 138
Attaching Records to Other Records .................................... 138
Viewing Attached Records ................................................. 139
Removing Attachments ..................................................... 139
Attaching Records to Mails................................................. 139
Copying Attachments from one Record to Another .................. 140
Organising Attachments: Archives ....................................... 140

Personal Desktop .................................................................. 143
Records in your Personal Desktop....................................... 145
Settings, Reports, Documents and Maintenance functions in your
Personal Desktop............................................................. 146
Registers in your Personal Desktop ..................................... 146
Notes and Comments in your Personal Desktop ..................... 147
Changing the Names of Items in your Personal Desktop .......... 148
Removing Items from your Personal Desktop......................... 148
Organising Items from your Personal Desktop: Archives .......... 148

Keyboard Shortcuts .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152

Chapter 3: Accounting Principles................................ 154

Internal and External Documents.... . . . . . . . . . . . . . . . . . . . . . . . . . . 154

Transaction Records .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
Transactions in Hansa............................................................ 155

Sales Invoices ................................................................. 156
Receipts......................................................................... 160
Purchase Invoices............................................................ 162
Payments ....................................................................... 166
Expenses ....................................................................... 167



Hansa Financials and HansaWorld

8

Credits and Loans ............................................................167
Stock .............................................................................167

Chart of Accounts .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .179
Objects..................................................................................180

Objects in Hansa..............................................................183
Examples .......................................................................185
Object Types ...................................................................186
Hierarchical Objects..........................................................188

Who needs to know about your business .... . . . . . . . . . . . . . . .191
Practical use of accounting information....................................191

Getting capital........................................................................191

Tax returns ............................................................................191

VAT declaration .....................................................................191

The End of a Financial Year .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .193

Chapter 4: Starting Work with Hansa ........................... 202
Entering Data and Opening Balances......................................202

Settings..........................................................................202
Persons and Mailboxes .....................................................202
Entering the First Customer ................................................206
Entering the First Supplier ..................................................208
Entering the First Item .......................................................209
Entering Opening Balances ................................................209
Opening Balances in the Nominal Ledger ..............................210
Opening Balances in the Sales Ledger .................................214
Opening Balances in the Purchase Ledger ............................223
Opening Balances in the Stock Module .................................223
Importing Opening Balances...............................................224
Printing Reports ...............................................................224

Chapter 5: Customers ................................................ 228

Settings .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .228
Customer Categories..............................................................228

User Defined Fields................................................................232
Card 1............................................................................233
Card 2............................................................................236

The Customer Register.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .238
Entering a Customer ..............................................................238

Header...........................................................................239
Contact Card ...................................................................240
Delivery Card...................................................................243



Contents

9

Terms Card..................................................................... 245
Pricing Card.................................................................... 249
Company Card ................................................................ 252
Web Card....................................................................... 254
User Defined Card ........................................................... 255

Editing a Customer ................................................................ 255

Deleting a Customer .............................................................. 256

Operations Menu ................................................................... 256
Customer Status .............................................................. 257
Change Password............................................................ 257
New Contact ................................................................... 258
Create Activity ................................................................. 259
Create Random Password Mail........................................... 260

Documents.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 262
Introduction ........................................................................... 262

Customer Labels ................................................................... 263

Reports .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267
Introduction ........................................................................... 267

Customer List ........................................................................ 267

Customer Statistics................................................................ 272

Customer Sales Statistics....................................................... 274

Customer Status.................................................................... 275

Chapter 6: Items and Pricing ...................................... 278

The Item Group Register .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 278
Entering Item Groups............................................................. 278

Header .......................................................................... 279
A/C Card ........................................................................ 279
Cost Card....................................................................... 283
Credit A/C Card ............................................................... 285
Texts Card...................................................................... 286

Deleting an Item Group .......................................................... 286

The Item Register.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 287
Entering an Item .................................................................... 287

Header .......................................................................... 288
Pricing Card.................................................................... 289
Stock Card ..................................................................... 294
Costs Card ..................................................................... 300
Recipe Card.................................................................... 302



Hansa Financials and HansaWorld

10

A/C Card ........................................................................305
Texts Card ......................................................................307

Editing an Item.......................................................................308

Deleting an Item.....................................................................309

Operations Menu ...................................................................309
Item Status Report............................................................309
Item Status .....................................................................310
Item History.....................................................................312
Create Purchase Item .......................................................312

Item Settings.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .313

Item Formulae .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .316
Item Formulae when Prices include VAT..................................320

Default Items..... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .323

Item Classifications .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .326
Item Classifications and the Item ‘Paste Special’ List................328

Item Classifications and the Web Shop....................................334

Controlling Price Changes ..... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .336
The Base Price Changes Setting.............................................336

Header...........................................................................337
Card 1............................................................................337
Card 2............................................................................338

Using Access Groups to Control Price Changes.......................338
Prices in Sales Transactions...............................................340

Changing Prices of Items in Batches .......................................342

Price Lists .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .344
Introduction............................................................................344

The Base Price ......................................................................344

Structure of Price Lists ...........................................................344

Price Formulae ......................................................................346

Price Lists..............................................................................347

The Price Register .................................................................351
The Quantity Dependent Prices Setting.................................351
The ‘Calculate Price Lists’ function.......................................352
Entering Price Records Manually .........................................354

Deleting a Price List ...............................................................355

Examples ..............................................................................356



Contents

11

Prices in Currency............................................................ 356
Creating Price Lists .......................................................... 359
Creating a Price List in another Currency .............................. 361
Dated Price Lists.............................................................. 362

Quantity Discounts................................................................. 365
Quantity Dependent Discounts............................................ 366
Discount Matrices............................................................. 367

Reports .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 371
Introduction ........................................................................... 371

Item Group List...................................................................... 372

Item List ................................................................................ 372

Item Statistics........................................................................ 374

Item Sales Statistics............................................................... 377

Item Turnover History............................................................. 379

Item/Quantity Statistics........................................................... 380

Customer/Item Statistics......................................................... 381

Price List ............................................................................... 383

Discount Matrices List ............................................................ 385

Varieties .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 387
Introduction ........................................................................... 387

Defining Varieties................................................................... 387
Item Variety Groups.......................................................... 389
Item Varieties .................................................................. 390
Variety Masks ................................................................. 391

Item Numbers of Items with Varieties ...................................... 395
Using Items with Varieties in Transactions............................. 397
Using ‘Paste Special’ with Items with Varieties ....................... 398

Varieties and Reports............................................................. 402
Varieties Enquiry.............................................................. 402
Varieties in Stock ............................................................. 403
Stock List ....................................................................... 408

Varieties and the ‘Item Status’ Window.................................... 410

Chapter 7: The System Module ................................... 414

Settings.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 414
Access Groups ...................................................................... 415

Logging In ...................................................................... 420
System Administrator........................................................ 421



Hansa Financials and HansaWorld

12

Block Accounts ................................................................422

Active Users ..........................................................................423

Auto Actions ..........................................................................423

Base Currency.......................................................................424

Base Currency Rates .............................................................424

Company Info ........................................................................424
Reg Card........................................................................425
Fonts Card......................................................................426

Conversions - Master, Conversions - Accounts ........................428

Conversions - Master, Conversions - Activity Types .................430

Conversions - Master, Conversions - Currency Codes..............433

Conversions - Master, Conversions - Customers......................433

Conversions - Master, Conversions - Customer Classifications .434

Conversions - Master, Conversions - Items..............................434

Countries...............................................................................435

Currency Round Off ...............................................................435

Date and Numeric Format.......................................................436
Dates and Export Files ......................................................437

Display Groups ......................................................................438

Enabler..................................................................................439

Fiscal Years...........................................................................440

General Options.....................................................................440

Languages.............................................................................441

Local Machine........................................................................442

Locking..................................................................................442

Number Series Defaults..........................................................446

Password Security .................................................................447

Printers..................................................................................448
Defining when Printers are to be used ..................................451
Setting up a Print Server ....................................................452
Setting up a Fax Server .....................................................456

Reporting Periods ..................................................................463

Round Off..............................................................................463

Sales Groups.........................................................................465

Styles....................................................................................469



Contents

13

Sub-ledger Control Accounts .................................................. 471

System Usage....................................................................... 472

Values in Text........................................................................ 473
Card 1 ........................................................................... 473
Card 2 ........................................................................... 474
Including Amounts in Words in Documents............................ 476

VAT Number Masks............................................................... 478

Weeks .................................................................................. 480

The Company Register.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 481
Entering Companies .............................................................. 481

Working with Companies........................................................ 482

The Admin Client ................................................................... 483

The Person Register .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 484
Header .......................................................................... 485
Access Card ................................................................... 486
Job Card ........................................................................ 488
Ser Nos Card .................................................................. 488
Bonus Card .................................................................... 489

Operations Menu ................................................................... 491
Open Mailbox.................................................................. 491
Change Password............................................................ 491
To Do List....................................................................... 492
Calendar ........................................................................ 492
Create Mailbox ................................................................ 492

The Account Register .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 493
Showing all Accounts on screen ............................................. 494

Searching for an Account ....................................................... 494

Inspecting or Changing an Account......................................... 495
Header .......................................................................... 495
Misc Card....................................................................... 495
Texts Card...................................................................... 498

Entering an Account............................................................... 498

Deleting Accounts.................................................................. 499

Printing the Chart of Accounts ................................................ 499

The Object Register.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 500
Defining, Inspecting, Changing and Deleting Objects ............... 502

Using Objects - an example.................................................... 503



Hansa Financials and HansaWorld

14

Multiple Objects .....................................................................503

The Currency Register .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .504

The Exchange Rate Register.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .504

The Form Register.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .505
Editing Objects.......................................................................506

Text Objects....................................................................506
Lines and Frames.............................................................507
Fields.............................................................................507
Pictures..........................................................................508

Operations Menu ...................................................................509
Properties .......................................................................509
PC Printer.......................................................................510
Copies ...........................................................................510
Send to Back...................................................................510
View All, First Only, Middle Only, Last Only, Single Page Only...510

Single- and Multi-Page Forms.................................................511

Printing Forms .......................................................................513

Related Items ........................................................................514

The Activity Register .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .514

Maintenance ..... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .515
Introduction............................................................................515

Create N/L Transactions.........................................................515

Delete Old Transactions .........................................................516

Send and Receive E-Mail .......................................................517

Update Fax Numbers .............................................................517

Documents .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .518

Reports .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .519
Introduction............................................................................519

Activities, Persons..................................................................520

Company Info ........................................................................520

Exchange Rates.....................................................................520

Person List ............................................................................520

Record Checking ...................................................................520

System Documentation...........................................................521

Transaction Checking.............................................................521



Contents

15

User Activities........................................................................ 521

Imports.... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 522
Automatic.............................................................................. 522

Automatic, manual file search................................................. 523

Exports .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 526
Introduction ........................................................................... 526

Company Text Backup, Database Text Backup ....................... 527
Restoring from a Back-up .................................................. 530

Client Text Backup................................................................. 534
Restoring from a Client Text Back-up ................................... 535

System Data.......................................................................... 535

Base Registers ...................................................................... 536

Item Base Registers............................................................... 538

Transaction Registers ............................................................ 539

Transaction Registers (Period) ............................................... 539

Raw Data .............................................................................. 540

Run Timed Backup ................................................................ 541

Settings................................................................................. 541

Index ....................................................................... 544





Hansa Financials
HansaWorld

Introduction
and Installation



Hansa Financials and HansaWorld

18

Chapter 1: Introduction and Installation
Hansa Financials and HansaWorld are integrated accounting, CRM and ERP
tools for working with Sales Order Processing, Stock Control and the Sales,
Purchase and Nominal Ledgers, and for keeping track of contacts with
Customers, organising mailshots and for planning activities of all kinds.

Hansa Financials and HansaWorld (the generic term “Hansa” is used
throughout these manuals) are modular systems. The number of modules
available to a user varies with the installation. The minimum configuration
(the Accounting package) comprises the System module and the Nominal,
Sales and Purchase Ledgers with Multi-Currency capability. To this, the
Logistics package adds the Sales Order, Purchase Order and Stock modules.
Further modules can be added as required. Multi-user installations have a
Server module added.

When the CRM module is present, the program can be used to record the
different tasks and events in the business day, such as customer contacts for
sales, service support, consultancy appointments etc. In Hansa, each task and
event is saved as a separate record in the Activity register. Activities can be
viewed, reviewed, changed and added to using the Calendar and the Task
Manager. They can be used as a planning and monitoring tool for a sales
force, or as a tool to log telephone calls to a customer service centre, and in
many other ways.

Hansa contains full internal mail, email and conferencing facilities. These
features, together with the External Gateway and web, FTP and fax servers,
mean that users can be online from anywhere at anytime. This means that
employees can always be in touch with each other.

In this introductory chapter, we will cover the steps you need to follow to get
started with Hansa. Topics covered include installation (both single- and
multi-user) and the creation of a new database. Subsequent chapters cover
Hansa’s working environment, its structure and the way data is handled, and
beginning work. The remaining chapters in this volume describe the
Customer and Item registers which are used throughout the system and the
System module, where preferences and look-up information are stored.
Subsequent volumes cover the individual modules in detail, enabling you to
become familiar with the more advanced functions of the program.
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Structure of Hansa
A Hansa system consists of two or more modules which interact with each
other in several ways. Each module uses a number of registers, or files, in
which all information of a particular type is stored. For example, all
information about Customers is stored in a Customer register, all information
about Suppliers is stored in a Supplier register and so on. The smallest system
(the Accounting package) consists of four modules with the following
registers—

Hansa’s Database Structure

Nominal Ledger

Sales Ledger Purchase Ledger

System

The integration between modules is quite straightforward in this small
system. Apart from the Account and Object registers, there are no common
registers in this case: information can be entered to each one from only one of
the modules. Nevertheless, the different modules need to be able to access the
information stored in registers in other modules. For example, the Sales,
Purchase and Nominal Ledgers can all access the members of personnel,
stored in the Person register in the System module.

In addition to the registers, there are several smaller files known as ‘Settings’
in each module. The difference between a setting and a register lies in the
frequency and nature of use. The information with which you will be working
daily, such as Customers, Suppliers, Sales Orders and Invoices, tends to be
stored in registers, while information stored in settings tends to be used in
‘look-up’ tables or used to determine the manner in which a particular
function operates.

Larger Hansa systems have a more complex structure. The Customer and
Item registers, for example, are used in several modules - Quotations, Sales
Orders, Sales Ledger, Stock, Contracts and Job Costing.
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Work Flow

The administration of a company is always associated with a certain flow of
tasks and work. In a typical trading company, items are purchased from a
group of suppliers, goods are received and put into stock, sales orders are
processed, stock levels are checked, goods are shipped and invoices issued,
and payments are made and received. All transactions are logged and
recorded, and financial events are recorded in the accounting subsystem.

A modern financial system like Hansa is designed to automate as many
administrative tasks as possible. If information is entered in one part of the
system, there should be no need to enter it again elsewhere. Information
should be recorded for re-use, and it should be available throughout the
system.

The Administrative Workflow in a Business

Operative Flow (of Goods)

N/L

P/L S/L

PURCHASE SALES

SUPPLIER RECEIVING STOCK SHIPPING CUSTOMER

Goods Rec

Stock

Delivery

Order

Del Note

Quotation

Receipt

N/L TransN/L Trans

Payment

Invoice

Purch Ord

CRM

Invoice

The above illustration shows a simplified description of the interaction of
functions and information (messages) in a traditional trading business. The
basic physical flow is shown at the bottom, with “operative” functions
handling the goods as they are received, stocked and shipped. The rectangles
above the operative flow are “administrative” functions that handle the flow
of information in the business. The smaller rectangles are messages
containing information that is passed around in the business. The dashed
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frame is the boundary of the business: although Suppliers and Customers are
on the outside, there is an continuous exchange of information with them.

One of the tasks of the administration is to keep the organisation’s
“memory”. This is done with the help of files and registers, where
information about business events is kept. The following picture shows the
same structure as above, but the messages have been removed and are
replaced by the registers kept by the business.

SALES
ORDERS

Customers

Items

Quotations

Orders

STOCK
Goods Receipts

Deliveries

Stocks

PURCH
ORDERS

Suppliers

Items

Purchases

P/L
Invoices

Payments
P/L

S/L
Invoices

Receipts
S/L

N/L
Accounts

Balances

Transactions

SUPPLIER RECEIPT STOCK DELIVERY CUSTOMER

Basic Registers in a Trading Business

Operative Flow (of Goods)

Hansa’s modular design provides a number of standardised tasks for each
functional area in a business. The design is very flexible, so that many
different types of business can use the software. In Hansa it is always
possible to access information immediately from another module. If for
example the person involved with Purchase Invoices needs some information
about a Sales Invoice, then it is immediately available to them without any
need to leave the system (subject to the person having the necessary access
rights).

Hansa is an integrated accounting system. The different parts of the system
interact with each other. The Sales Ledger is for example integrated with the
Nominal Ledger so that as soon as an Invoice has been approved, all ledgers
in the company’s accounts are automatically updated. This interaction is
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immediate, and covers the entire accounting system. All registers, ledgers and
reports are updated for all users.

In many cases, this integration means that you, the user, will not notice the
actual creation of Nominal Ledger Transactions from the Sales and Purchase
Ledgers. These Transactions constitute about 80% of the Nominal Ledger
transactions in a manual system - you simply can forget them, together with
all the hassle of reconciling the ledgers with each other. Hansa does all this
automatically. The picture below illustrates the integration process.

Hansa
Integration

Invoice

N/L Transactions 
are generated 
automatically

Nominal Ledger

N/L Transactions 
entered manually

Transactions

Receipt

Purchase Invoice

Payment

Multi-year Database

Hansa uses a multi-year database. This means that Transactions, Invoices etc.
from several years are stored in the same database. Closing balances for all
accounts at the end of one financial year are automatically converted into
opening balances for the beginning of the next. The multi-year database thus
simplifies your end-of-year procedures.

Hansa’s database is continuous. Transactions are stored continuously, with no
periods fixed in advance. It is possible to extract reports for completely
arbitrary periods. When a certain period is finally reconciled it can be closed
for further entries. However, you can have as many periods open as you wish.

Each set of transactions has its own Number Series. There is no limit to the
number of series, which can be set up in each module using the ‘Settings’
function.
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Preparing for Installation
Hansa is designed with a modern graphical user interface - for Windows and
for Macintosh. It uses many different “windows” on the screen, one for each
task. The basic idea is to create a working environment that as closely as
possible relates to the way you handle papers, files and documents on your
desk.

Accounting tasks normally require that you work with several documents at
the same time. This fact is reflected in the design of Hansa, and documents
and reports are handled in a slightly different manner to what you may be
used to in word processors or spreadsheet programs. Hansa therefore contains
a number of features that you may not be familiar with.

If this is the first program you will be using in a Windows or Macintosh
environment, you should first of all take the time to learn as much as possible
about the computer and how to use it. And you must of course be sure that
the correct version of the computer’s operating system is installed. Talk to
your computer dealer or consultant if you are uncertain.

In the ‘Accounting Principles’ chapter later in this manual you can read more
about the basic accounting tasks in a business. Please ensure you read it if
this is your first attempt with computerised accounting.

Even if you are an experienced computer user, you should read this
Introduction, because Hansa contains a large number of features designed to
facilitate your work and to make it faster. If you are the ‘I-never-read-
manuals’ type of person, you will of course be able to use Hansa anyway - it
is very simple. But there are some not so obvious shortcuts that can save you
a lot of time. They are all in the manual.

Efficient Management

Hansa is easy to use. By following the instructions in the installation section
of this manual, you can set up your order and invoicing system in a very short
time. You will quickly be able to get the benefits from efficient order
processing and a well-functioning system for your Sales Ledger and debtors.

The basic idea with automatic administration is to make the computer do
most of the routine work. In the beginning it may seem a lot of work to enter
all the necessary information about Items and Customers, but that is really all
the preparation you have to do. It is not necessary to use all the many features
of Hansa. Remember, however, that the more basic information you can enter
into the various files and registers, the more the program will be able to assist
you in your work.
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Planning and Setting up

If this is the first time that you will be using a computerised accounting
system to manage your order processing, stock, and your sales, purchase and
nominal ledgers, or if you are changing from another system, why not take a
good look at the overall operations? Maybe you can do things in your present
operation more efficiently.

A good idea is to sit down with pen and paper for a while, and go through
your Items (products and services you buy and sell), Item Groups, Customer
Categories, Accounts, Payment Modes and Terms, etc. If some of the
concepts of Hansa are new to you, it is always a good idea to think first.

The setting up of a Hansa system in your business requires some planning
and forethought. You will have to make a number of decisions about number
series for Customers, Items, statistical classifications, invoice procedures and
so on. Hansa allows a great deal of flexibility, and you can create almost any
work environment you want. But remember that you are in charge. If you
find that the standard Chart of Accounts is not suitable for your business,
only you can make the decision to use another chart. Hansa allows almost
anything.

If you will be using Hansa as a multi-user system, its installation, as is the
case for any advanced multi-user system, will mean a great change in the
day-to-day operations of the business. Before you install, you should
therefore consider very carefully how you want the business to work, now
and in the future.

• What tasks are to be performed, and just how do you want them done?

• Who should enter e.g. Orders, Invoices, Payments, and how?

• What business documentation is needed, and how should you identify
and file the documents?

• What reports do you want, and how do you want Orders, stocks, sales
etc. to be reflected in your accounts?

Hansa gives you great flexibility, but it is important that you know what you
want beforehand. We strongly advise against installing a multi-user
installation without the assistance of a qualified Hansa consultant. Please
contact your Hansa representative for advice and training.

Most people think that the beginning of the year is the only time when you
should change the accounting procedures in a business. Quite to the contrary,
it is better to change systems during the year. You can then select a calm
period of the year, enter all data from the beginning of the year and check the
outcome against reports produced from the previous system.
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Remember that once the installation process has been completed, Hansa does
require some maintenance. At the very least, you should establish a regular
routine for backing up. A financial system is very different from a word
processor, which handles individual documents. Hansa works - like all
financial systems - with a database, in which all your data about customers,
invoices, nominal ledger etc. is stored in a single file. If you lose that file, you
have lost not just a single document, but all your accounting and customer
information.



Hansa Financials and HansaWorld

26

Installation
The installation of a Hansa financial system is technically simple. If you are
used to computers and have some experience of installing software, you will
find the installation of Hansa very straightforward.

Hansa can be used in many environments: Windows 98/2000/NT/CE,
Macintosh OS 9 and OS X, Linux, IBM iSeries (AS/400), pSeries, xSeries
and zSeries, and AIX. In this section, we describe the system requirements
and installation procedures for Windows 98/2000/NT, Macintosh OS 9/OS X
and Linux. Please contact your local Hansa representative for details about
the other environments.

System Requirements

All Platforms

Hansa requires  at least 15 Mb of free hard disk space at the time of
installation, but more will be required as the database grows with regular use.

In multi-user systems, you must reserve at least one computer in the network
as your Hansa server (more than one if you will be using the parallel server
feature). All servers should be dedicated (i.e. they should not be used for any
other purpose such as print spooling or running separate applications). Hansa
communicates using TCP/IP: this must be installed on all servers and clients.
Hansa is suitable for use on mixed networks (e.g. networks with Linux,
Macintosh and Windows clients), provided all machines have TCP/IP
installed.

If you will be connecting to your Hansa server using GSM devices (e.g.
mobile phone) or a dial-up modem connection, the minimum recommended
modem speed on the server is 64 kbps. If there will be more than 10 users, or
if the Attachments feature will be used to attach files to records or mails, at
least 128 kbps is preferable. The server should have a fixed line connection
and a static IP address. The Attachments feature is described in Chapter 2 of
this manual.

10 Mb/s Ethernet Cards are sufficient for the clients and for the server in
small networks. In large networks with more simultaneous connections, a 100
Mb/s card is recommended for the server.

Hansa does not require Windows or Macintosh file sharing to be switched on.
In fact, since the Hansa server can also act as an FTP (File Transfer Protocol)
server, a more secure FTP connection can be used for file transfer.
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Instructions for setting up an FTP server can be found towards the end of this
chapter.

Any employee can work with Hansa simultaneously in a local area network
or a wide area network. As Hansa supports firewall technology independent
of the type of internet connection (ADSL, ISDN or dial-up modem), it is
recommended that firewall software be installed on the server machine.

Concerning security, it is important to mention that the data flow between the
Hansa server and its clients is encrypted. Back-up files created using Hansa’s
built-in feature are also encrypted. Every user will use a unique user name
and password to log in.

Windows

Hardware

For a single-user installation, you will need a Windows computer with a hard
disk drive and a printer. The minimum processor is a 450 MHz Pentium II
(600 MHz PIII or P4 recommended). The minimum memory requirement is
128 Mb (up to 192 Mb recommended). These specifications also apply to the
client machines in a multi-user system, where memory requirements are more
dependent on the version of Windows than on Hansa. Hansa has a minimal
hard disk requirement on the clients (usually under 15 Mb). The server
should be selected with the transaction load of the installation in mind. The
minimum server is a 600 MHz Pentium III (1.6 GHz Pentium 4
recommended) with at least 256 Mb memory.

Software

Hansa single-user needs Windows 98/2000/XP. In client/server installations,
Windows NT or XP are the recommended operating systems for the server,
and Windows 2000 or XP are recommended for the clients. Hansa can be
installed in file-sharing networks (Novell) but the Hansa installation will not
use any of the file-sharing facilities. TCP/IP and Winsock2 (WS2_32.DLL)
must be installed on the server and all clients.

Macintosh

Hardware

In a single-user system, you will need a Macintosh with a hard disk drive, a
printer and  at least 64 Mb (OS 9) or 128 Mb (OS X) of internal memory. The
minimum recommended machine is an iMac or a Macintosh G3 (G4 if you
are using OS X). These specifications also apply to the client machines in a
multi-user system. The minimum server is a Macintosh G4 with at least 128
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Mb of memory (256 Mb is recommended). Hard disk speed is more
important than processor speed. iMacs should not be used as servers.

Software

Hansa requires Macintosh System 9.1 (or later). Users of OS X should use
10.1 or later. Macintosh servers should use OS X. Multi-user versions of
Hansa use TCP/IP and Open Transport: these must be installed on the server
and on all clients.

Linux

Hardware

Please refer to the Windows or Macintosh sections above for details of
hardware requirements.

Software

Recommended distributions are Red Hat 7.1, SuSE 7.0, Slackware 7.2 or
similar/later. The X Window System should be installed in single-user
installations and on client machines. The Linux server version of Hansa does
not have a graphical interface: it can be used with any distribution that has
Linux Kernel 2.4 or later and GNU C Library 2.2 or later.

Installation

Single-user

1. The latest version of Hansa is always available from the Downloads area
of our website, www.hansaworld.com. Download the latest version of
Hansa that is correct for your platform and operating system. In most
cases, the downloaded file will be a single self-expanding archive, and
therefore installation will be the same for all platforms.

2. Create a new folder on your hard disk, and move the file that you have
downloaded into this folder.
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3. Make sure you have at least 15 Mb available for the Hansa application,
the associated files and for the data file which will be created the first
time you launch Hansa. Then, double-click the file to expand it.

4. In some operating systems (e.g. Windows), you will now be asked where
you would like the Hansa application and associated files to be saved.

Specify where you would like the application to be saved, using the
[Browse] button if necessary to locate the correct folder Click [OK].

In other operating systems (e.g. Macintosh OS 9 and OS X), the Hansa
application and associated files will be saved in the folder containing the
self-expanding archive.

5. A thermometer bar will show you how the installation is progressing.

Multi-user

For a multi-user installation you need to proceed as follows—

1. Create a network including all the computers and other equipment you
are going to use. Use the Windows, Macintosh or Linux System
installation tools to install and configure TCP/IP on each machine.
Ensure all Windows machines have Winsock 2 (WS2_32.DLL) installed
and that all Macintoshes have Open Transport installed.

2. Select one computer as the server computer.

3. If your server is a Linux or Macintosh OS X machine, the Hansa server
application will not have a graphical interface. Proceed as described in
the next section. Otherwise, install Hansa on the server computer, as
described in the single-user section above.

4. Install Hansa on each of the client machines, again as described above.
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Linux and Macintosh OS X Server Installation

The Hansa server applications for Linux and Macintosh OS X can only be
run with the machine in “Terminal” mode. However, you can install them
either using the usual graphical interface or using the “Terminal” mode.

To install the Hansa server application on a Linux or Macintosh OS X
machine using the graphical interface, follow the instructions in the ‘Single-
user’ section above.

Otherwise, to install the Hansa server application using the “Terminal” mode,
follow these steps—

1. Download the latest version of Hansa that is correct for your platform
and operating system. Create a new folder on your hard disk, and move
the file that you have downloaded into this folder.

2. Put the machine into “Terminal” mode.

On a Macintosh OS X machine, double-click the Terminal application
that will usually be found in the Utilities folder in the Applications
folder—

Alternatively, use the Terminal icon in the Dock—
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On a Linux machine, use the Terminal icon in the Dock or Panel. The
appearance of these icons will vary depending on your interface: shown
below are typical icons for KDE and GNOME—

3. Type the following, noting that the Terminal is case-sensitive—

cd Hansa/ changes to the directory where you
have placed the installer file, in
this case the “Hansa” directory at
the root level

tar -xvzf HansaFinancialsServ40.tar.gz

where
HansaFinancialsServ40.tar.gz is
the name of the installer file that
you have downloaded

When you press the Return key, the installer will create a new directory in
your Hansa directory. This new directory will be named HansaFinancialsServ
(Linux) or HansaFinancialsOSXServ (Macintosh OS X). This will contain
the application and the necessary auxiliary files.
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After Installation

The Hansa directory or folder contains a number of files—

 

Shown is the Windows 98 folder: its appearance on your computer and the
number of files and folders may differ slightly according to the type of
machine you are using, its operating system and certain other settings. In the
illustration, for example, all file extensions are shown. Some or all of the
following files should be present—

1. The Hansa application, consisting of the program file “Hansa.exe” or
“Hansa32” (Windows), “Hansa /PPC” (Macintosh OS9) or Hansa OSX
(Macintosh OS X). In some circumstances, this file may be named
“Server32”.

2. The “Hob” folder, containing language and other files. This must be
present in the same folder or directory as the Hansa application. In some
installations, there may be a “Hal” folder as well, used for the same
purpose.

3. The file “DBDef.txt”, which is used by Hansa to import some basic
settings data whenever a new database is created. This file must be
present in the same directory as the program when a new database is
created.
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4. The file “Default.txt”, which is used by Hansa to import some basic
settings data whenever a new Company is created. This file must be
present in the same directory as the program when a new Company is
created. Companies and databases are described in the next section of
this chapter.

5. The files “UKStd.TXT”, which contains sample set-up data,
“UKAccs1.TXT”, which contains a sample Chart of Accounts, and
UKForms.TXT, which contains templates for Invoices and other forms.
If you wish to use these, follow the instructions in the section entitled
‘Creating a New Company’ later in this chapter first to create a new
database and then import these settings. The name and precise make-up
of these files will vary according to the country of use. In some
installations, these files will be placed in a folder named “Setup”.

6. A back-up of an example database for training purposes
(“DemoData2003.TXT”). It includes the Chart of Accounts and other
settings that are also in the files described in the previous paragraph. To
use the example database, follow the instructions in the section entitled
‘Restoring from a Back-up’ later in this chapter covering the creation of
a new database and the importing of a back-up file. In some installations,
this file will be placed in a folder named “Setup”.

7. An “Attach” folder, which must be present if you want to attach files to
records. Such Attachments are fully described in the next chapter,
‘Hansa’s Work Area’. In multi-user installations, this folder should be on
the server machine.

8. A “Backup” folder to be used for storing daily back-up files.

9. Two extra folders, “PS” and “Scripts”, will be present in Linux
installations.

The following folders should be present if you wish to use certain features,
but otherwise need not be present—

1. The “Halcust” folder contains bespoke (HAL) files (e.g. customised
reports). This should be on the server and on all clients likely to use the
bespoke files.

2. In multi-user installations, the “Shared” folder should be on the server
machine if you are using the FTP server facility. This will be used by
default to store the files that are to be made available to the FTP clients.
You can specify that a different folder is to be used for this purpose
when you configure your FTP server: this is described later in this
chapter.
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3. The “Tmp” folder should be present if you will be using the HansaMail
facility to send and receive external mail (i.e. to communicate with
standard email programs outside your Hansa network). The Hansa
External Gateway uses it to store mail attachments downloaded from the
POP3 server before they are transferred to the “Attach” folder and
attachments that are to be uploaded to the SMTP server. You should
delete the contents of the “Tmp” folder periodically.

4. The “Web” folder contains language and other files required if you wish
to use Hansa’s Web Shop. This folder should be on the server machine.

5. The “Webcust” folder is used to store images used in the Web Shop (e.g.
images of the Items that you sell). This folder should be on the server
machine.
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Starting Hansa

Companies and Databases

The key components of a Hansa system are the application and the database.
The application, or program, has the following symbol in the directory
window (Windows) or in the Finder (Macintosh)—

The database is the file used by Hansa to store its data. In many cases, that
data will pertain to a single company, but where there are separate
departments or subsidiary companies that keep separate accounts, their data
can also be stored in a single database. Each department or subsidiary will be
set up in the Hansa database, where they are termed ‘Companies’. If you set
up more than one Company in Hansa, each will be completely separate: there
will be no common information, although it is possible to copy from one to
another using the export and import functions or by dragging and dropping.
Separate account balances will be maintained, and each Company within a
database can be backed up separately or together.

Note that you should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.

The database is shown with the document symbol—

The database must have the name
“Hansa.HDB” and be present in the
same folder or directory as the Hansa
application. If the database is moved
or renamed, the next time Hansa is
loaded a new database will be created.

!
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Loading an Existing Database and Company

Single-user

Start Hansa just like any other Windows or Macintosh application, by
double-clicking the program icon. Hansa will load the database named
“Hansa.HDB”. If this is not present in the folder or directory, a new database
will be created automatically.

The ‘Select Company’ window opens, where you should select a Company to
work with.

Double-click the appropriate Company in the list, or highlight it and press the
Enter key on your keyboard. The database is now ready to use.

If you have only one Company in your database, you may find that having to
select it every time you start Hansa is unnecessary. For instructions about
bypassing the ‘Select Company’ window, please refer to the section entitled
‘The Program Mode Register’ later in this chapter.

Multi-user

In a multi-user installation, launch Hansa on the server first. If your server
has a graphical interface, follow the procedure described in the previous
section: choose any Company when the ‘Select Company’ window appears.
Users will then be able to log on to work with any of the Companies stored
within that database.

Select ‘Server’ from the Modules menu. The ‘Server Status’ screen appears.
This can be used to monitor network activity.

The server can now be left alone.
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Servers with no Graphical Interface

If your server is a Linux or Macintosh OS X machine, you must first put it
into “Terminal” mode before you can launch the Hansa server application.
Instructions can be found in the ‘Linux and Macintosh OS X Server
Installation’ section earlier in this chapter.

When the Terminal window opens, and assuming you have retained the
default directory structure, type—

cd Hansa/HansaFinancialsServ/ (Linux server), or
cd Hansa/HansaFinancialsOSXServ/ (Macintosh OSX server)

./hansa & starts the Hansa server application.
The & is optional: it allows you to
run the program in the background
and to close the Terminal window

Creating a New Database - Single-user

In the event that you need to create a new database, simply ensure there is no
database file with the name “Hansa.HDB” in the same folder as the Hansa
application when launching. A new database will be created automatically.

The “DBDef.txt” and “Default.txt” text files must be present in the same
folder as the application when a new database is created. Hansa will use these
files to set some initial preferences in the new database.

The installation will not be correct if
the “DBDef.txt” file is missing.

Importing from a Back-up

Hansa will now open a window listing back-up files which can be imported.
Hansa looks in the folder or directory containing the application for folders
named “Backup” and “Setup”. Any files in these folders in the correct format
are listed in this window.

Note that if the list of back-up files does not appear at this point, this will be
because your example of the “DBDef.txt” file has not instructed Hansa to
create a new Company and so you should do this yourself. In this case, turn
now to the next section but one, ‘Creating a New Company’ and follow its
instructions. Then return here to continue with the set-up sequence.

!
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Proceed down one of the following routes, depending on your
circumstances—

1. If you are launching Hansa for the first time, you will not have any back-
up files to be imported. If you do not wish to import the example
database or the sample Chart of Accounts, close the window using the
close box and refer to the next section, ‘The Work Area’.

2. If you are launching Hansa for the first time and wish to import the
example database or the sample Chart of Accounts, double-click the file
to be imported, or highlight it and press the Enter key. If you choose to
import the example database, Hansa will quit when it has finished
importing the file. Restart Hansa and log in as SJ with no password.

3. If you are creating a new Hansa database which is to be based on your
existing data (perhaps you are restoring from a back-up because your
previous database has become damaged or because you are upgrading to
a new version), double-click the back-up file to be imported, or highlight
it and press the Enter key. For full details of this process, please refer to
the ‘Restoring from a Back-up’ section at the end of this chapter.

The Work Area

Whether or not a back-up file was imported, the Hansa work area will now
appear. This will be the basis for all your work in Hansa and is fully
described in the next chapter, ‘Hansa’s Work Area’. It is illustrated below to
enable you to identify the various parts of the screen mentioned in the
following sections.
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Creating a New Company

If the list of back-up files did not appear as expected and as described above,
this will be because your example of the “DBDef.txt” file did not instruct
Hansa to create a new Company automatically. So, you should do this
yourself, as described here. When you have done this, turn back to
‘Importing from a Back-up’ and continue with the set-up sequence from
there.

When creating a new database, the first task is to enter a new Company. If the
“DBDef.txt” file did not instruct Hansa to do this automatically, Hansa will
open the ‘Companies: Inspect’ window so that you can carry out this task.
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Click in the Code field in the first blank row and enter information as
described below. Use the Tab or Return key to move from field to field.

The following fields are present in this window—

Code Enter a unique code. This can be a numeric code greater
than 0 or an alpha code of up to five characters.

Name Enter a name by which this company or department will
be identified in the ‘Select Company’ window
(illustrated at the end of this section). When you log in to
Hansa, this window allows you to choose the Company
you want to work with.

Short If you have more than one Company in your database it
is possible to switch between Companies in a work
session, leaving windows from each Company open.
This Short Code appears as part of every window title to
indicate the Company to which the information in the
window belongs.

TCP/IP This field is described in the next section, ‘Creating a
New Database - Multi-user’. It need not be considered in
single-user systems.

Port This field is described in the next section, ‘Creating a
New Database - Multi-user’. It need not be considered in
single-user systems.

Flip B

Encryption Key This field becomes visible if you click the button marked
“B” on the right-hand side of the ‘Companies: Inspect’
window. Again, this field is used in multi-user systems
and need not be considered in single-user systems.
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You can only enter one Company now: if you need more than one, you will
be able to add them later in the set-up process (described in the ‘Modules,
Users and Companies’ and ‘Adding New Companies’ sections below).

The “Default.txt” text file must be present in the same folder as the Hansa
application when a new Company is created. Hansa will use this file to
import some basic settings to the new Company. When the entry is complete
and you have made certain that the “Default.txt” file is in the right place,
click the [Save] button in the top right-hand corner of the Company screen.

You should now inform Hansa that you wish to use the Company you have
just created. The ‘Select Company’ list window will appear automatically—

Select the single Company to work with and press the Enter key.

Settings

Each module contains a number of settings which can be used to control how
that module operates. They are accessed using the ‘Settings’ item on the File
menu or the [Settings] button in the Master Control panel. Before you start
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working with each module, you should consider its settings, since its
functions depend on the settings being correct.

Many settings take the form of options or preferences. Others, such as
Company Info, that will be considered next, require information or a number
of records to be entered.

Changing the Company Name

The System module is where settings used throughout the Hansa system are
determined. You will now use it to enter company name, address and other
information to be used in reports and documents such as Invoices. Select
‘System’ from the Modules menu.

Select ‘Settings’ from the File menu or click the [Settings] button in the
Master Control panel to bring up the ‘Settings’ list window—
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In the list, select ‘Company Info’ by double-clicking. The ‘Company Info:
Inspect’ window appears.

Enter the name, address and other data as shown in the example illustration.

The Bank Customer ID is an ID number used for automatic (modem)
communication with certain credit institutions in some countries.

Click the [E-Mail] button towards the top centre of the window to see the
other fields in this setting.

The Edit and Report Font fields allow you to select different fonts for use on
screen and in reports respectively. If nothing is entered in these fields,
Hansa’s default fonts will be used. These fonts are selected for maximum
readability, and should only be changed if you have good reasons to do so. In
non-English versions of Hansa, these fields are used to select fonts with
special character sets.
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VAT Law and Character Set are used to ensure the behaviour of Hansa
conforms to certain local conventions of the country in which it is being used.
Depending on your location, you should enter one of the following values in
these fields—

Byelorussia 46
Denmark 7
Estonia 27
Finland 13
France 1
Germany 2
Hungary 26
Iceland 15
Ireland (Republic of) 35
Italy 3
Latvia 28
Lithuania 24
Netherlands 4
Norway 9
Poland 25
Portugal 8
Russia 32
Spain 6
Sweden 5
Ukraine 45
United Kingdom 0 (zero)
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Details of the other fields can be found in the ‘System Module’ chapter
elsewhere in this manual. When you have completed the window, click the
[Save] button in top right-hand corner to save the changes and close the
window.

Modules, Users and Companies

The next task is to ensure that you have been granted access to the
appropriate modules and that the correct numbers of users and Companies
have been registered. If you no longer have the ‘Settings’ list on screen,
select ‘Settings’ from the File menu or click the [Settings] button in the
Master Control panel once again. Select ‘System Usage’ by double-clicking.
The ‘System Usage: Inspect’ window appears—

If you need more than one Company, enter the correct number in the
Companies field. Ensure that the numbers of Users, Level 1 Users and Level
2 Users are correct (and in any case is at least 1).

The number of Companies should only be changed if your business is one
where there are separate departments or subsidiary companies that keep
separate accounts. These can be set up as separate accounting entities in
Hansa. Each department or subsidiary is termed a ‘Company’. If you set up
more than one Company in Hansa, each will be completely separate: usually,
there will be no common information, although it is possible to copy from
one to another using the export and import functions or by dragging and
dropping. Separate account balances will be maintained, and each Company
within a database can be backed up separately or together.
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Note that you should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.

In the remaining sections of the window, select the modules that you require
by clicking the check box next to each one so that a tick appears. Click the
five numbered buttons to see more modules. Finally, click [Save]. The
Modules menu will now contain the modules selected.  These tasks should be
completed before applying for a database key.

Changing and Adding Companies

If you want to change the company identifier that appears in the title bar of
each window, and/or you need more than one Company, you can do this now.
Click [Companies], the first button in the ‘Registers’ section of the Master
Control panel—

The ‘Companies: Inspect’ window is opened—

The Company Name in the second column will appear in the ‘Select
Company’ window, where you will choose the Company you want to work
with when you log in to Hansa. The Short Code is the identifier that appears
in the title bar of each window. If either of these are not suitable, change
them now.

To create more Companies, click in the Code field in the first blank row and
enter information as described in the section above entitled ‘Creating a New
Company’. Remember, this should only be done for parts of your business
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which are completely separate accounting entities to the first Company
entered.

If you are creating a new Company, the “Default.txt” text file must be present
in the same folder as the Hansa application. Hansa will use this file to import
some basic settings to the new Company.

It is advisable to enter as many Companies as you need now, so that you only
need apply for a database key once. You will be able to enter all set up
information such as a Chart of Accounts to one Company and then to export
those settings to the other Companies (or to transfer them by dragging and
dropping). Remember that each Company will maintain completely separate
accounts, so there is no need to create separate Companies for departments
that are part of the same accounting whole.

When the entry is complete, click the [Save] button in the top right-hand
corner of the Company screen.

For security reasons, Hansa will shut down after any changes or additions
have been made in the Company register. Restart the program to continue
working.

For each Company added, you should now repeat the process described
above in the ‘Changing the Company Name’ and ‘Modules, Users and
Companies’ sections, entering the correct company name and address, and
ensuring that access has been granted to the correct modules. To change
Companies, select ‘Companies’ from the File menu and choose another
Company in the list that appears. This work should be completed before
applying for a database key.
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The Database Key

The next stage is to inform Hansa that you have a full licence for its use.

A Hansa licence normally gives you the right to use the program for a single
database. Each database will normally require its own database key provided
to you on application by your local Hansa distributor. When Hansa is first
purchased, this key is absent but Hansa will be fully operational for 30 days
after installation, allowing time for the set-up work described in the previous
sections. After 30 days, if the key has not been applied for, Hansa will change
to demonstration mode: it will remain fully functional, but printing will be
disabled. The key can be applied for at any time (before or after the 30 day
point), but before doing so you should ensure you have entered all required
Companies in the Company register, named them all in the Company Info
setting, and given yourself access to the required modules and entered the
number of users in the System Usage setting (all as described above).

On closing the System Usage window, Hansa calculates a Control String
based on the modules selected and the number of users and Companies
entered. This will be visible if the System Usage window is reopened and
will be copied by Hansa to a second setting, the Enabler setting, where it is
used to calculate a Control Code, an eight-digit number.

At this point, where a Control String and Control Code are known to Hansa,
the database will enter its demonstration mode 30 days from installation. To
gain full use of the program, a database key needs to be acquired and entered.
To do this, follow this procedure—

1. Use the Modules menu to ensure you are in the System module and
select ‘Settings’ from the File menu. In the list, double-click ‘Enabler’.
The ‘Enabler: Inspect’ window appears.
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2. Enter the expiry date of your Hansa contract in the Key is Valid Until
field. Click the [Save] button in the Button Bar to save and close the
Enabler.

3. Contact your local Hansa representative during normal working hours
and quote the Control String, Control Code and contract expiry date.
You may be asked to produce a Company Info report: this is described in
the ‘System Module’ chapter later in this manual. You will then be given
a key.

4. Enter the key and click [Save] to save the Enabler. This will inform
Hansa that you have a full licence for its use.

If, in the System Usage setting, the modules checked are changed or the
number of users is altered, Hansa will go into demonstration mode. Full use
of Hansa can be regained by reverting the System Usage setting to its original
state.

If a new Company is added to the database, the Valid Until date is changed in
the Enabler setting or the Company Name is changed in the Company Info
setting of any existing Company, this will also cause Hansa to go into
demonstration mode. In this case, however, full use of Hansa can only be
regained by applying for a new key.

A record of your database key should be kept in a safe place: you will need to
enter it again if you ever create a new database by restoring from a back-up
file.

Set up your Companies and define
the System Usage and Company Info
settings for each before applying for a
database key.

If the “DBDef.txt” file is missing

If you attempt to create a new database as described above in the section
entitled ‘Creating a New Database’ but without a “DBDef.txt” file present in
the same folder or directory as the Hansa application, that database will be
created successfully. However, the process will deviate from the path
outlined in two respects—

1. The list of possible back-up files which can be imported will not be
shown.

2. You will only have access to the System module.

!
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You can either decide to start again or to proceed with the empty database.
The former route is recommended as little time will have been lost. Follow
these steps—

1. Close Hansa using the ‘Quit’ command on the File menu.

2. Delete the “Hansa.HDB” file.

3. Locate the “DBDef.txt” file and move it to the folder or directory
containing the Hansa application. Also, ensure that the ‘Default.txt’ file
is present.

4. Launch Hansa again and follow the procedure described in the ‘Creating
a New Database’ section.

If you decide to proceed with the empty database, follow these steps—

1. Ensure the “Default.txt” file is present in the same folder or directory as
the Hansa application and enter a single Company to the ‘Companies:
Update’ window. This window is described in the section entitled
‘Creating a New Company’ above. Click the [Save] button to save.

2. On closing this window, the ‘Select Company’ window will open.
Double-click the Company that you wish to work with.

3. The System module will be the only module available. The next step
should be to remedy this. Select ‘System’ from the Modules menu and
‘Imports’ from the File menu. Double-click ‘Automatic, manual file
search’ in the subsequent list. Locate the “DBDef.txt” file and import it.
You will now have access to all modules.

4. Return to the ‘Creating a New Database’ section above and resume the
sequence at the ‘Settings’ sub-heading.
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Setting up a Basic Accounts System

Hansa is supplied with a basic accounts template which you can use as a
basis for your own system if necessary. It includes VAT Codes, Fiscal Years,
a Chart of Accounts, report definitions and so on.

If you did not import this template when creating your database (as described
in the ‘Creating a New Database’ section above), you can do so at any time.
To import this template, ensure you are in the System module using the
Modules menu and select ‘Imports’ from the File menu. The ‘Imports’
window is shown—

Double-click ‘Automatic’, or click once and press the Enter key. Hansa opens
a window listing importable files in the “Backup” and “Setup” folders, which
are in the same folder as the Hansa application. Locate “UKAccs1.TXT” and
click [Open] or [Select] (depending on the operating system).

The file will be imported. A message window informs you about the progress
of the import.

When the import is finished, repeat the process, selecting “UKForms.TXT”
and then “UKStd.TXT” to import template forms and other settings. Then,
close the ‘Imports’ list window using the close box.

Your Hansa database is now ready to be used. You are free to change any
aspect of the model Chart of Accounts, but note that some of the default
settings in Hansa presume that the model chart is being used in an
unmodified form. If you alter the chart, you must also alter these defaults
wherever they occur. For example, if you change the Account Code of the
VAT Outputs Payable Account, remember to alter all the VAT Code records
accordingly as well.



Hansa Financials and HansaWorld

52

If you do not wish to use the template supplied…

You are also free to implement your own accounting set-up. If you choose to
do this, please first refer to the chapter entitled ‘Hansa and your Business’
where some basic accounting principles are outlined. Then, referring to the
appropriate chapters in this manual, you will need to set up VAT Codes in the
Nominal Ledger (covered in Volume 2b) before creating your Chart of
Accounts and defining Fiscal Years in the System module (at the end of
Volume 1). Referring to the chapters describing the Sales and Purchase
Ledgers, ensure the correct Accounts have been defined for use by various
functions using the Account Usage S/L and Account Usage P/L settings. The
Item Group register and Payment Modes setting should also be checked.
Finally, referring to the ‘Reports’ section of the ‘Nominal Ledger’ chapter in
Volume 2b, define the Balance Sheet, the Key Financial Ratios Report, the
Profit & Loss Report and the VAT Report.

   Importing your own Chart of Accounts   

If you are changing to Hansa from another computerised accounts program,
you may be able to import the accounts set-up from that program. This will
have three advantages: the import procedure is relatively fast (compared to
entering the accounts manually), the possibility of data entry errors is reduced
and you will be able to use a Chart of Accounts with which you are already
familiar.

If you wish to follow this procedure, please follow the import instructions
described above in the section ‘Setting up a Basic Accounts System’ to
import your text file. For details of the composition of the text file, please
refer to your Hansa representative.

Entering Data and Opening Balances

Your Hansa database is now ready for the entry of data and of opening
balances. Please refer to the chapter entitled ‘Starting Work’ for full details of
how to proceed. Before you do so, however, it is recommended that you read
the following sections of this chapter. ‘Hansa’s Work Area’ will enable you
to familiarise yourself with Hansa’s tools, windows and method of working,
while ‘Hansa and your Business’ describes some of the accounting concepts
used by Hansa.

Creating a New Database - Multi-user

Server with Graphical Interface (Windows and Macintosh OS 9)

To create a new, multi-user, database, essentially the same steps as those
described above need be followed. Working on the server, simply ensure that
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there is no database file with the name “Hansa.HDB” in the same folder as
the Hansa application, and launch the application by double-clicking.
However, make sure that the “DBDef.txt” and “Default.txt” files are present.
A new database is created.

As in a single-user system, create your first Company as described in the
section entitled ‘Creating a New Company’ earlier in this chapter. Make sure
that the “Default.txt” file is present. Again, at this stage you do not need to
consider the TCP/IP and Port fields.

All communications between clients and the server are encrypted using a
built-in Encryption Key. If you would like an Encryption Key of your own to
be used, click the button marked “B” on the right-hand side of the
‘Companies: Inspect’ window and enter your key in the Encryption Key
field. You should enter the same key on the server and on the clients.

When the entry is complete, click the [Save] button. Again, as with the
single-user system, the next stage is to inform Hansa which Company you
wish to use. The ‘Companies’ list will appear: highlight the single Company
and press the Enter key.

Server with no Graphical Interface (Linux and Macintosh OS X)

To create a new database on a server that does not have a graphical interface,
first ensure that there is no database file with the name “Hansa.HDB” in the
same folder as the Hansa application, and that the “DBDef.txt” and
“Default.txt” files are present. Then, put the server into “Terminal” mode as
described in the ‘Linux and Macintosh OS X Server Installation’ section
earlier in this chapter.

When the Terminal window opens, and assuming you have retained the
default directory structure, type—

cd Hansa/HansaFinancialsServ/ (Linux server), or
cd Hansa/HansaFinancialsOSXServ/ (Macintosh OSX server)

./hansa backup/TBXXXXXX.txt & Starts the Hansa server application
and imports the back-up or
e x a m p l e  d a t a  f i l e
TBXXXXXX.txt. In this example,
this file is in the “backup” folder
inside the folder containing the
Hansa server application.

The progress of the import will be shown in the Terminal window. When it
has finished, Hansa will quit. Restart it by typing—

./hansa &
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If you do not want a back-up or example data file to be imported to the new
database, you need to ensure a Server Port (see below) will be open in the
new database so that clients will be able to log in. You can do this using one
of two methods—

1. Before starting the Hansa application, ensure the “DBDef.txt” contains
an instruction to set the Server Port to the required value. The
“DBDef.txt” file supplied with Hansa will set the Server Port to 1200. If
you are using this method, you may need to start Hansa, quit and restart
to activate the port, thus enabling users to log on.

2. By typing the following command in to the Terminal—

./hansa --port 1200 &

This starts the Hansa server application and sets the Server Port to 1200,
for a single work session only. If you want to set it to 1200 permanently,
do so from a client using the Program Mode register as described below
(or use method 1 above).

Since the server does not have a graphical interface, you will need to
configure the new database from a client. Refer to the next section but one
(entitled ‘Logging on from a Client’) and follow its instructions to log in to
the server from a single client. Use the Port number that you specified in the
final command above. Working on that client machine, first go to the System
module and create a record in the Access Groups setting explicitly granting
full access to the Technics module. Then, create a record in the Person record
for yourself, assigning it to the Access Group you have just created. Access
Groups and Persons are described in full in the ‘System Module’ chapter later
in this chapter. Then, quit Hansa and restart. You should now follow the
instructions in the section immediately below (‘Setting up the Server
module’) to configure the new database.

Setting up the Server module

The database key requires that you make all purchased modules available on
the server machine, and that you register the number of users there. Go to the
Modules menu and select ‘System’. Next, use the ‘Settings’ function on the
File menu to bring up the ‘Settings’ list window. Select ‘System Usage’ by
double-clicking (or by clicking once and pressing the Enter key). The
‘System Usage: Inspect’ window appears.

On card 1 of this setting, select the Server module by clicking the check box
so that a tick appears. Click the check boxes for the other modules you have
purchased. Ensure that the numbers of Users, Level 1 Users, Level 2 Users,
Mailboxes, Conferences and Companies are all correct. Click the [Save]
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button in the Button Bar to save and close. Mailboxes and Conferences are
described in Volume 6 of these manuals.

You should now enter your company’s name, address and other details using
the Company Info setting. This task is fully described in the section entitled
‘Changing the Company Name’ earlier in this chapter. If you need to create
additional Companies, this should be done now, following the instructions in
the ‘Adding New Companies’ section above. The Company Info and System
Usage settings should be checked for each Company before the next stage:
the application for a database key. Full details of this step can be found in the
section entitled ‘The Database Key’ above. It is only necessary to enter the
database key to the server: the key will be copied to the client machines
automatically.

Once you have finished this process, it doesn't matter which Company you
end up in: all will be available to any client machines logging in.

Set up your Companies and define
the System Usage and Company Info
settings for each before applying for a
database key.

If the server does not have a graphical interface, you will have carried out the
work described in this section from a client machine. If you need to create
additional Companies, you should change to “Admin Client” mode. To do
this, choose ‘Company’ from the File menu, ‘Open Company Register’ from
the Operations menu and then ‘Admin Client’, again from the Operations
menu. If you are not in “Admin Client” mode, the new Companies will be
saved on your machine and not on the server. As described in the ‘Adding
New Companies’ section, the server will shut down after any changes or
additions have been made in the Company register. So you will need to close
the client, restart the server and then restart the client after adding Companies
on the server.

!
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The Program Mode Register

The next stage is to make this database available to the network. Select
‘Technics’ from the Modules menu and click the [Prog Mode] button in the
bottom left-hand corner of the Master Control panel (or select ‘Program
Mode’ from the Registers menu).

The fields on this window should be completed as follows—

Header

Program Name If you are using Hansa under Windows, you can specify
the name of the window in which Hansa appears and of
the application’s button in the Taskbar (Windows
95/98/2000). Enter that name here.

Server Card

Server Port This field is for TCP/IP communication with Hansa
clients. Enter an arbitrary four-digit code to identify this
database. If you have more than one server machine
running Hansa, or more than one copy of Hansa running
different databases on the same machine (not
recommended), each must feature a unique Server Port
number.

If you change the Server Port or put one in for the first
time, you must quit Hansa and restart for the change to
take effect.
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Default Company If you would like a particular Company to be used by
default when you launch Hansa, specify that Company
here. The next time Hansa is used, the Company
specified here will be opened automatically and the
‘Select Company’ window will not appear.

This field can be used in single-user systems to ensure a
particular Company is always used. This is the only field
that can be used in this register in a single-user system.

Server at Startup Switch this check box on if you would like the Server
module to be selected by default when you launch
Hansa.

Usually, it will not be necessary to use this check box.
When the time comes to shut down the server, two
options are available on the File menu. If you choose
‘Quit’, Hansa will automatically go into server mode the
next time it is used, even if the Server at Startup is not
checked. If you choose ‘Quit, Remove Autoserver’, it
will not, allowing you to work on the server machine
itself.

Other Cards

The remaining fields in this register are only used in the specialised situations
when setting up the Web Shop, FTP server and Print and Fax servers and
when establishing an open TCP/IP link with Hansa. They can be left blank
when setting up a data server.

For details about setting up an FTP server, please refer to the section entitled
‘Setting up an FTP Server’ below. For details about setting up Print and Fax
servers, please refer to the section describing the Printers setting in the
‘System Module’ chapter later in this manual. For details about setting up a
Web Shop and about establishing an open TCP/IP link with Hansa, please
refer to your local Hansa representatives.

Once the ‘Server’ card of this register is complete, click the [Save] button in
the Button Bar to save. If you have entered a Server Port number for the first
time (or changed the one that was already there), quit Hansa and restart to
allow the change to take effect.

Complete the Program Mode screen
before applying for a database key.!
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The final task is to select ‘Server’ from the Modules menu. The ‘Server
Status’ screen appears. This can be used to monitor network activity.

The server can now be left alone.

Logging on from a Client

On each client, a new database should now be created. Its sole task will be to
enable you to log on to the server: little information will be saved on the
client machines. Again, essentially the same steps as those described above
need be followed. Ensure that there is no database file with the name
“Hansa.HDB” in the same folder as the Hansa application, and launch the
application by double-clicking. However, make sure that the “DBDef.txt”
and “Default.txt” files are present. A new database with the name
“Hansa.HDB” will be created.

Once again, the first task is to ensure the correct Companies have been
entered. To do this use the Company register as described in the section
entitled ‘Creating a New Company’ earlier in this chapter. Make sure that the
“Default.txt” file is present if you need to create new Companies. All that it is
necessary to do here is to enter once again the Companies that you have
previously entered to the database on the server. This will enable you to log
in to them.

In the Code field (the left-hand field of the grid), enter the same Code(s) that
you entered on the server. The TCP/IP and Port fields now become relevant.
In the TCP/IP field, enter the IP address of the server machine. This can be
obtained from the TCP/IP control software on the server and is used to enable
the client copy of Hansa to locate the correct server on the network. In the
Port field, enter the value that you entered to the Server Port field on the
Program Mode screen on the server. This is used to enable the client Hansa to
locate the correct copy of Hansa on the server.  If the server does not have a
graphical interface, use the Port Number that you typed as part of the
command to start the server application.

If you entered an Encryption Key to the Company on the server, you should
enter the same one to all Companies on the client that will be used to log on
to that server. Click the button marked “B” on the right-hand side of the
‘Companies: Inspect’ window to do this.

When you have entered all relevant Companies, click [Save].

The ‘Companies’ list will now appear allowing you to inform Hansa which
Company you wish to use. Double-click the appropriate Company in the list,
or highlight it and press the Enter key. If the result is that Hansa displays an
error message “User Limit on Server reached” and you are certain this is not
the case, the probable cause is that the Company Code of the chosen
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Company (in the first column of the Company register) does not match that
of any of the Companies that were entered on the server.

In typical multi-user installations, the next task will be to enter details of each
member of your staff that will be using Hansa. You might wish to limit each
person to areas of Hansa relevant to their job and to give each one a
password, to prevent unauthorised access. To do this, you will be using the
Person register in the System module: please refer to the ‘System Module’
chapter at the end of this volume for full details.

Once this task has been completed, please refer back to the section entitled
‘Setting up a Basic Accounts System’ for details covering the setting up of a
basic accounts system. It is recommended that this set-up work is carried out
either from a single client machine or from the server itself. Until it has been
completed, no other users should be allowed to log on.

Setting up an FTP Server

The File Transfer Protocol (FTP) is a means of transferring files between two
connected computers. One computer is configured as an FTP server and the
other connects to it as a client. Working from the client machine, files can be
copied to the server (“uploaded”) and copied from the server
(“downloaded”). In large installations, it can be convenient to have an FTP
server running permanently. It can be used as a central store of important
files such as marketing materials, document templates and so on.

Hansa can be configured to act as your FTP server software. Once this has
been done, members of staff (known as “Persons” in Hansa) can log in using
proprietary FTP client software such as Fetch or Transmit. If required,
Customers can log in as well.

If you are already using a Hansa multi-user system, the copy of Hansa that is
acting as your data server can also act as your FTP server. This means that
your data server computer will also be your FTP server computer. However,
if FTP usage is likely to be heavy, a separate machine can be used. In this
case it will have a separate database, so you will need to enter once again
those Persons and Customers that are to have FTP access.

To set up a Hansa FTP server on a dedicated machine, follow the steps below
in full. If you have already set up your Hansa data server following the
instructions earlier in this chapter and would like it to act as an FTP server as
well, work on that machine and follow the steps below starting with step 2.

1. Create a new database on the machine that is to act as your dedicated
FTP server following the instructions in the section entitled ‘Creating a
New Database - Multi-user’ above. Only one Company is necessary.
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2. In the System Usage setting in the System module, ensure that the box
marked “Server” has been selected (i.e. it contains a tick). Then, go to
card 5 (click the tab marked “5”) and do the same for the box marked
“FTP Server”. Click the [Save] button in the Button Bar to save and
close. This may result in you needing to apply for a new database key.

3. Select ‘Technics’ from the Modules menu and click the [Prog Mode]
button in the bottom left-hand corner of the Master Control panel (or
select ‘Program Mode’ from the Registers menu).

In the case of a dedicated FTP server, only the fields on the ‘FTP’ card
need be completed, as illustrated and described below. If the FTP server
is a data server as well, the fields on the ‘Server’ card should also be
completed, as described earlier in this chapter.

FTP Port Enter an arbitrary code here to represent the server
socket that will be used for FTP communications. This
must be different to the Server and Web Ports above.
When logging on, Customers and Persons will add this
to the IP address for your server machine (usually in the
format IP address:Port number).

Note that the most commonly used FTP Port number is
21, and some FTP client applications may have
difficulty establishing a connection if a different number
is used.
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If you change the FTP Port, you must quit Hansa and
restart for the change to take effect.

Max FTP Users Enter here the maximum number of Customers and
Persons that you anticipate will be logged on to your
Hansa FTP server at any one time.

FTP Shared Directory

Specify here the name of the folder that is to be made
available as the root directory to everyone logging on to
your Hansa FTP server. This folder will contain the files
that will be copied to and from the server by FTP users.
Any folders inside this folder will also be available to
FTP users.

In the following example showing the correct syntax for
Windows and Macintosh users, the shared folder is
called “Shared” and it is situated inside the “FTP” folder
on the hard disk. The \ character is used as a separator
between folder names under Windows while : is used on
the Mac.

Windows c:\FTP\shared

Mac hard disk:FTP:shared

If the “Shared” folder is inside the folder containing the
Hansa server application, there is no need to specify the
full path name.

An entry must be made to this field otherwise FTP users
will not be able to log on. Take care not to make any
mistakes when typing the folder path (and make sure
that the folder you specify exists), otherwise you might
make more files available to FTP users than you intend.

Allow Anonymous FTP Users

Check this box if you would like FTP users to be able to
log on to your FTP server without specifying a user
name or a password.

If this box is not checked, you will be able to restrict
access to your FTP server using the Allow FTP Access
box for each Person and Customer. Only Persons and
Customers whose Allow FTP Access box has been
checked will be able to log on. Persons (i.e. members of
staff with their own record in the Person register) will
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use their initials as their Login ID and will use their
normal Hansa password. Customers will use their
Customer Number as their Login ID. They can be
allocated a password using the ‘Change Password’
function on the Operations menu of the ‘Customers:
Browse’ window. They will use the same password for
FTP and Web Shop access. Customers are fully
described in the ‘Customers’ chapter of this manual,
while Persons are described in the ‘System Module’
chapter.

4. Once the ‘FTP’ card of the Program Mode register is complete, click the
[Save] button in the Button Bar to save. If you have entered an FTP Port
number for the first time (or changed the one that was already there), quit
Hansa and restart to allow the change to take effect.

5. If your FTP server is separate to your data server, you will now need to
enter once again those Persons and Customers that are to have FTP
access.

6. The final task is to select ‘Server’ from the Modules menu. The ‘Server
Status’ screen appears. The FTP server can now be left alone, and FTP
clients will be able to log on.

7. If you will be allowing users to access your FTP server through a modem
connection, don’t forget to make any necessary adjustments to your
firewall.

Shutting Down

Remember to make a back-up before shutting Hansa down. Back-ups are
described in the next section.

Single-user

To shut Hansa down, select ‘Quit’ from the File menu. Macintosh OS X users
can find the ‘Quit’ command on the Hansa OS X menu. The keyboard
shortcut Alt-F4 (Windows and Linux) or z-Q (Macintosh OS 9 and OS X)
can be used. All open windows will be closed, and you will be asked if you
want to keep any changes that have not yet been changed.
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Multi-user

Hansa clients can be shut down in the same way as Hansa single-user: by
selecting ‘Quit’ from the File or Hansa OS X menu.

Two methods are available by which the server can be shut down, if it has a
graphical interface—

1. If ‘Quit’ on the File menu is used, the server will automatically enter
server mode the next time it is started up.

2. If ‘Quit, remove autoserver’ on the File menu is used, the server will not
go into enter server mode the next time it is started up. This option
should be used if you want to do some work on the server.

If the server does not have a graphical interface and if the Terminal window
is still open, press the Ctrl-C key combination. If the Terminal window is not
open, open a new Terminal window and (assuming you have retained the
default directory structure) type the following—

cd Hansa/HansaFinancialsServ/ (Linux server), or
cd Hansa/HansaFinancialsOSXServ/ (Macintosh OSX server)

cat hansa.pid This displays the process ID for
H a n s a  s e r v e r  ( e . g .
2296[hansa:~/HansaOSX]
hansa% )

kill 2296 (where 2296 is the process ID)

If you need to close the server down and there are some clients logged in, you
can send a warning message. To do this, you should be working on a client
and you should have logged in as a Person that has access to the Technics
module (this is described in the section describing the Access Groups setting
in the ‘System Module’ chapter later in this Volume). Follow these steps—

1. Select ‘Technics’ from the Modules menu.

2. Click the [Maintenance] button in the Master Control panel or select
‘Maintenance’ from the File menu.
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3. When the ‘Maintenance’ list window appears, double-click ‘System
Message’. The following window appears—

Complete the window as follows—

Message Type in the message that you want all users to read.

From Type in the author of the message: this will also be
shown to all users. Your name (i.e. the name of the
current user) will appear here by default.

Time until Shutdown

Specify here the number of minutes that you want to
wait until the server shuts down. This should be
sufficient time to allow the other users to save their work
and quit Hansa.

If this field contains a value, the server will be shut
down automatically after the specified period of time. If
this field does not contain a value, the server will not
shut down. This means this function can also be used to
send a message to all users at any time.

Shutdown will Remove Autoserver

If the Time until Shutdown field above contains a value,
the server will be shut down automatically after the
specified period of time. Check this box if you want the
server to be shut down in the same way as if the ‘Quit,
remove autoserver’ option had been used. Do not check
this box if you want it to be shut down in the same way
as if the ‘Quit’ option had been used.
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Disallow Login Check this box if you want to prevent new users logging
in during the Time until Shutdown.

4. Click the [Run] button in the Button Bar. The Message will be shown to
all users.

5. Close your own Hansa client.

6. The server will shut down automatically after the specified time.
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Backing Up
When the day’s work with Hansa is done, we advise you to make a back-up.
It is a good idea to save a copy of the file and store it in a safe place. It might
seem unnecessary to make a back-up every day, but the short time this takes
is a good investment for the day something goes wrong with the hard disk.

To back up your data is particularly important when, as in the case of a Hansa
database, the financial information of your company is involved. If you
should lose all your data, you will find yourself in a very awkward situation,
missing all invoices, receipts, reports etc. Make sure you make a back-up
each time you have been working with your accounts. Name your copies
systematically with dates so that you can easily restore the database, should
an accident occur.

If you get a virus on your computer, you must first try to establish the date
when your computer was infected. In this case you must restore your data
from a back-up created before the infection date. Otherwise you run the
obvious risk of re-infecting the computer again.

Hansa’s method of back-up is fast and economical. The data is saved as a
back-up file that takes up a minimal amount of space, and the back-up files
are independent of the program versions. Of course, it is also possible to copy
the database file as it appears on your hard disk, but this is not so economical
in terms of disk space, and a subsequent restoration may not be successful if
the version of your Hansa application has changed since the back-up was
made.

Use Hansa’s built-in back-up feature
to guarantee a successful restoration.

To create a back-up, follow these steps—

1. Select ‘System’ from the Modules menu.

2. Choose ‘Exports’ on the File menu or click the [Exports] button in the
Master Control panel. The Exports window is shown—

!



Chapter 1: Introduction and Installation - Backing Up

67

3. Select ‘Company Text Back-up’ (if you wish to back up the data in the
database relating to the single Company currently selected) or ‘Database
Text Back-up’ (if you wish to back up the whole database) from the
‘Exports’ window and click [Run].

Usually the ‘Database Text Back-up’ option should be used, as this is the
only choice that backs up the entire database. You must use it regularly
for your safety and peace of mind. Some registers and settings (e.g. the
System Usage setting, Mailboxes and Conferences) are stored at
database level, not Company level. These will not be exported by the
‘Company Text Back-up’ option, even if your database only contains a
single Company. The ‘Company Text Back-up’ option is intended for
use in the situation where you need to move all the information relating
to a specific Company from one database to another.

In a multi-user system, the ‘Database Text Back-up’ option cannot be
used on a client machine. It can only be used on the server machine,
when no other user is logged in. First, select ‘Quit, Remove Autoserver’
from the File menu and restart Hansa. Then, choose the System module
using the Modules menu. If it is not convenient to work from the server,
use the automatic timed back-up feature described below.

If the server does not have a graphical interface, you can use the
automatic timed back-up feature, or you can create a back-up file by
typing into the Terminal—

./hansa --backup

This will launch the Hansa server application, which will then create a
back-up file and then quit.
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4. The ‘Specify Text Backup’ window appears. This offers you 40
characters with which to describe the back-up file that you are about to
create. If it becomes necessary to restore from a back-up, this description
will be shown in the list of importable files to help you select the correct
one.

Enter an appropriate description and click [Run].

5. If you have chosen to back up the whole database and you have more
than one Company, you will now be asked to log in to any that you have
not yet used in this work session. For reasons of security, if you are not
able to log in to all Companies, the back-up procedure will be halted.

6. Hansa opens a dialogue where you can name and place the export file.
Enter the name of the file in the filename area and locate it in the
appropriate directory in the usual way. The name of the back-up should
include the date the back-up was made, but remember that you can use a
maximum of eight characters if you are using Windows NT version 3.
Then, click [Save].

It is recommended that the back-up file be stored in a folder or directory
named “Backup” which should be in the same folder or directory as the
Hansa application. All back-up files in this folder will be shown in a list
of importable files if it becomes necessary to restore from a back-up.

A message window informs you about the progress of the export.

When the export is finished, you are brought back to the ‘Exports’ list. Close
it using the close box.

Under no circumstances should you
edit or change a back-up file with
another program.

Automatic Timed Back-ups

The importance of establishing a regular routine for backing up cannot be
emphasised enough. Because Hansa works - like all financial systems - with a
single file database in which all your data about customers, invoices, nominal

!
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ledger etc. is stored, if you lose that file, you have lost not just a single
document, but all your accounting and customer information.

To make this task easier, Hansa contains a timed back-up feature whereby a
database back-up file can be created automatically every day. To specify
when the back-up files are to be created, and where they are to be stored,
follow the steps outlined below. In multi-user systems, these steps should be
carried out on the server machine only.

1. Select ‘Technics’ from the Modules menu. In multi-user systems, this
can be done on the server machine, when no other user is logged in. To
gain access to the Modules menu, select ‘Quit, Remove Autoserver’
from the File menu and restart Hansa.

If it is inconvenient to work on the server (e.g. it does not have a
graphical interface, or it is in another building), you can work from a
client machine. Log in as a Person that has access to the Technics
module (this is described in the section describing the Access Groups
setting in the ‘System Module’ chapter later in this Volume).

If ‘Technics’ is not available on the Modules menu in a single-user
system, this will probably be because you have not granted yourself
access to the Server module in the System Usage setting.

2. Choose ‘Settings’ from the File menu. Double-click ‘Timed Operations’.
The following window appears—
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3. Set the Operation Time (the time when the backup is to take place) to the
appropriate time, when it is likely that no-one will be using Hansa. The
24-hour clock should be used, and a colon (:) used as the separator
between the hour and the minute. The back-up file will be created at the
specified time, even if there are still users logged in to Hansa. However,
such users will find the speed of operation to be much reduced while the
back-up is being carried out. It is therefore highly recommended that a
time is specified that is outside working hours, to minimise such
inconvenience.

4. Specify the Database Backup Path, which determines where on your
hard disk the back-up files are to be saved. If this field is left blank, the
back-up files will be saved in the folder containing the Hansa
application.

The following example shows the correct syntax for Windows and
Macintosh users. The back-up files will be saved in a folder called
“Backup” inside the “Hansa” folder on the hard disk. The \ character is
used as a separator between folder names under Windows while : is used
on the Mac. Note that the separator appears as the final character in the
path.

Windows c:\hansa\backup\

Mac hard disk:hansa:backup:

Note that if a mistake is made (for example, there is a syntax error or a
non-existent folder is specified) there is a risk that the back-up file will
not be created.

5. Click the [Save] button in the Button Bar to save the back-up
specifications.

Once the timed back-up feature has been set up as described above, a new
back-up file will be created automatically every day at the same time. It will
be given the name “TBYYMMDD.TXT” where “YYMMDD” represents the
current date. The file will contain a back-up comment stating that it was
created by timed back-up and showing the date and time this occurred.

Backing Up Using Specialist Back-up Software

As described above, we strongly recommend that Hansa’s built-in back-up
facilities are used as the main part of your back-up strategy. They are more
economical in terms of disk space and are more reliable in that the success of
a restoration is guaranteed even if the version of your Hansa application has
changed.
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However, some users may prefer to rely on specialist back-up software such
as Retrospect to produce back-up tapes that can be stored off-site. Such
software can sometimes fail to create a back-up file if the files being backed
up are still in use. For example, a user may have gone home having forgotten
to log off (or having left their machine producing a report) and this may
cause the back-up to fail.

To cater for this eventuality, Hansa can be instructed to alter the state of the
database so that, as far as the back-up software is concerned, it appears not to
be in use. To do this, follow these steps—

1. Select ‘Technics’ from the Modules menu and then choose ‘Settings’
from the File menu.

2. Double-click ‘Timed Operations’. The following window appears—

 

3. Set the Database Closing Time to a few minutes before the moment the
back-up software is scheduled to start work. The 24-hour clock should be
used, and a colon (:) used as the separator between the hour and the
minute.

4. Set the Database Opening Time to a few minutes after the moment the
back-up software is scheduled to finish work.

5. If you have specified an Operation Time as well, this should not be
between the Database Opening and Closing Times. The database is
dormant during this period, so the Operation Time will have no effect.
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6. Click the [Save] button in the Button Bar to save the changes.

Once these steps have been followed, in the case of the user who has gone
home having not logged off, they will return the next morning to find their
machine still logged in to Hansa. Despite this, the back-up should have been
carried out successfully.

Restoring from a Back-up

To restore from a back-up, you must first create a new database. Then import
the back-up file using the ‘Imports’ function on the File menu in the System
module.

The replacement of a safety back-up is a non-destructive process, i.e. the
back-up file is not affected by the reading process. This means that you can
use the same back-up file more than once.

For reasons of speed, it is recommended that the process of restoring from a
back-up be carried out on the server machine in multi-user systems. If this is
not possible, a single client machine should be used. If you have separate
back-up files for different Companies, they should be imported individually.
Attempting to import them simultaneously using different client machines
could result in data being lost.

Restoring from a back-up is done in the following way—

1. Move the old database (named “Hansa.HDB”) to another
folder/directory, to avoid mixing things up. Rename it so that you know
what it contains.

2. Delete the database file “Hansa.HDB” from the folder or directory with
your Hansa application. Double-clicking the Hansa application now will
force it to create a new database, as described earlier in this chapter.

It is important to restore to a new,
empty database, to avoid mixing the
restored data with the old, damaged
database.

    The “DBDef.txt” and “Default.txt” files should always be present in the
  same directory/folder as the      Hansa application    .   They contain some
important data used when setting up the new database and creating new
Companies. If this file is missing, your Hansa application may not work
the way you expect it to do!

!
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3. As part of the process of creating a new database, a list of back-up files
is shown. To be included in this list, a back-up file must be stored in the
“Backup” or “Setup” folder or directory, which should be in the same
folder or directory as the Hansa application.

In the list, the filename of each back-up file is shown together with the
date it was saved and any description added when it was created (see
step 4 in the previous section).

4. Highlight the file you want to import (the back-up to which you wish to
revert) and press the Enter key (or double-click on the name of the file).
The back-up data will be imported. A message window informs you
about the progress of the import. For reasons of security, Hansa will
close when the import finishes if the back-up file contains at least one
record in the Person register. Restart the program and type your database
key in to the Enabler setting: you will then be ready to continue working.

Note that there are certain circumstances in which Hansa will show files in
the list of available back-up files, but not be able to import them successfully.
This will occur on both Macintosh and Windows machines if the filename
does not comply with the DOS naming convention (i.e. it has a maximum of
eight characters followed by a three character extension). If the name of your
back-up file does not comply with this convention (or it is not shown in the
list of available files because it is not stored in the “Backup” or “Setup”
folder or directory), continue with these steps—

5. If it is still open, close the list of available import files using the close
box.
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6. In the System module, choose ‘Imports’ from the File menu. The
‘Imports’ window is shown—

7. Select ‘Automatic, manual file search’ and press the Enter key (or
double-click on ‘Automatic, manual file search’).

In most operating systems, Hansa opens a standard dialogue box with a
list of the files in the current folder of the current volume. To find the
back-up file, scroll through the list or select another folder or volume in
the normal way.
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In some operating systems (e.g. Macintosh OS X), Hansa uses its own
file dialogue window—

When the file dialogue window is first opened, the main part of the
window shows the contents of the folder containing your Hansa
application. Folder names are shown in angled brackets <>. Double-click
a folder name to see its contents. Double-click the first item in the list (..)
to go up one level. Click the [Desktop] button to go to your desktop, and
the [Backup] button to enter the Backup folder that is inside the folder
containing your Hansa application. This has been done in the illustration
above.

8. Once you have found the file you want to import (the back-up to which
you wish to revert), highlight it and click [Open] or [Select] (depending
on the operating system), or double-click on the name of the file.

A message window informs you about the progress of the import.

When the import has finished, Hansa will close, for reasons of security if the
back-up file contains at least one record in the Person register. Restart the
program and type your database key in to the Enabler setting: you will then
be ready to continue working.

Upgrading from Previous Versions of Hansa

The latest version of Hansa is always available from Hansa’s website,
www.hansaworld.com, from where upgrades should be obtained. If you are
online, clicking the [Hansaworld.com] button in the Master Control panel
will take you to this site.
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Inevitably, new versions will incorporate significant structural changes.
Because of this, it cannot be guaranteed that they will be able to open
databases created by previous versions unless the export and import functions
are used.

To upgrade, follow these steps—

1. Before installing the new version, create a database back-up as usual and
as described above using the old application.

2. Download the new version of Hansa and install it in a new folder or
directory.

3. Ensure that the new folder or directory contains the “DBDef.txt” and
“Default.txt” files, but not a “Hansa.HDB” file. Ensure it also contains a
folder or directory named “Backup” which in turn contains the back-up
file created in step 1, and that this file is named according to the DOS
naming convention.

4. Copy the following folders and their contents from the old Hansa folder
to the new one: “Attach”; “Halcust”; “Shared”; “Tmp”; “Web”; and
“Webcust”. You may not have all of these folders in your installation: if
so, copy the ones that you do have and don’t worry about those that are
missing. Do NOT copy the “Hob” folder.

5. Launch the new Hansa application. A new database is created.

6. Import the back-up created by the previous version of Hansa using the
procedure described in the previous section, ‘Restoring from a Back-up’.

For reasons of speed, it is recommended that backing up, restoring and
upgrading are carried out on the server machine in multi-user systems. If
this is not possible, a single client machine should be used. If you have
separate back-up files for different Companies, they should be imported
individually. Attempting to import them simultaneously using different
client machines could result in data being lost.

7. In multi-user systems, the new Hansa application should now be
installed on all client machines. Repeat steps 2, 3, 4 and 5 above on each
machine. If you have any Client Text Backup files, these should be
imported to the new databases on the relevant machines as per step 6
above.   
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Chapter 2: Work Area
When a database has been opened or created, Hansa’s desktop will appear,
with the Master Control panel in the centre of the screen. The icons in this
panel are used as shortcuts to different parts of the program.

Most operations in Hansa can be executed in three different ways—

• Selecting an option from a menu

• Clicking a button in the Master Control panel

• With a keyboard command

Use the method you feel most comfortable with. In the beginning you may
find it easiest to select from menus or from the Master Control panel, but
when you get more used to the program, you will find the keyboard
commands faster to work with.

Personal
Desktop

Registers

Menu Commands

Menu Bar

Master
Control
Panel

HansaWorld.com
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The Master Control Panel
Hansa’s work area contains a single movable, tool palette, the Master Control
panel, located by default in the centre of the screen. This contains the
Personal Desktop and four rows of buttons. The buttons in the first two rows
(entitled ‘Personal’ and ‘Company’ mostly control functions that cannot be
operated in any other way. Those in the third row (entitled ‘Routines’)
duplicate some of the functions on the File menu, while those in the fourth
row (entitled ‘Registers’) duplicate the commands on the Registers menu.
The registers shown both here and on the Registers menu vary with the
selected module. Since the Master Control panel is always visible to the user,
it is often simpler to use the buttons it contains than to select functions from
the menus.

The Master Control panel can be brought to the front at any time using the
‘Master Control’ item on the File menu. Windows and Linux users can use
the keyboard shortcut Ctrl-M, while Macintosh users can use z-M. To close
the Master Control panel, click the close box or use the keyboard shortcuts
Ctrl-F4/z-W.
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The panel contains four rows of buttons—

Personal These buttons allow you to communicate with other
users of your Hansa system and to organise your diary.
This provides a means of recording appointments and
other tasks. Some of these buttons have a keyboard
shortcut, as shown below, which you can use when the
Master Control panel is the active (front) window.

Full details of these features can be found in Volume 6
of these manuals.

[Calendar] Click this button to open the Calendar: a graphic
representation of your completed Activities and
those of other users.

[Mailbox] Windows/Linux keyboard shortcut: Ctrl-Shift-M
Macintosh keyboard shortcut: z-Shift-M

If you are using Hansa’s Mail facilities, click this
button to open your Mailbox. From here, you can
send mail to other users in your Hansa system and
read mail that has been sent to you. Your Mailbox
is also used to send and receive external mail (i.e.
to communicate with people outside your Hansa
system who use standard email programs).

[Tasks] This button allows you to organise your diary,
providing a means of recording appointments and
other tasks.

[Login] Click this button to sign in to Hansa as a different
user.

Company These buttons provide more tools to help you
communicate with other users of your Hansa system.
Some of these buttons have a keyboard shortcut, as
shown below, which you can use when the Master
Control panel is the active (front) window.

[Select Module] Windows/Linux keyboard shortcut: Alt-M
Macintosh keyboard shortcut: z-0

Click this button if you need to work in a
different module or area of the program (e.g.
when you want to change from the Nominal
Ledger to the Sales Ledger). Each time you
change module, the Register buttons in the lower
part of the Master Control panel will be changed
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to show the Registers in the new module. You
can also change modules using the Modules
menu.

[Resources] Click this button to use Hansa’s Resource
Planning module.

[Conferences] If you are using Hansa’s Mail facilities,
Conferences are addresses to which mail can be
sent from where it can be read by all users
(subject to access restrictions). Click this button
to open a window showing the available
Conferences. These are described in Volume 6 of
these manuals.

[Chat] Click this button to produce a list of users
currently logged in to your Hansa system. Only
those users that have Mailboxes will be listed.
Click on a user’s initials to chat with that person.

Routines These buttons are equivalent to some of the commands
on the File menu. In each case, clicking the button
produces a list of options from which the required one
can be selected by double-clicking. These options will
vary depending on the current module. Each of these
buttons has a keyboard shortcut, as shown below, which
you can use when the Master Control panel is the active
(front) window.

[Reports] Windows/Linux keyboard shortcut: Ctrl-R
Macintosh keyboard shortcut: z-R

Click this button to produce reports. You can
define some of the reports and choose where they
are to be printed (e.g. to screen, to a particular
printer or to a text file). General details about
producing reports can be found in the ‘Report
Window’, ‘File Menu’ and ‘Reports’ sections
later in this chapter, while the reports themselves
are described in detail in the chapters covering
the individual modules.

[Documents] Windows/Linux keyboard shortcut: Ctrl-D
Macintosh keyboard shortcut: z-D

Use this button when you want to print
documents intended for external use (e.g.
Invoices or Purchase Orders). Details about



Hansa Financials and HansaWorld

82

printing documents can be found in the ‘File
Menu’ section later in this chapter, while the
documents themselves are described individually
in the appropriate chapter.

[Exports] Windows/Linux keyboard shortcut: Ctrl-E
Macintosh keyboard shortcut: z-E

This is the button you use when you need to back
up your Hansa database and to export data from
Hansa. Exports are described individually in the
appropriate chapter, and details about backing up
can be found in the previous chapter.

[Settings] Windows/Linux keyboard shortcut: Ctrl-S
Macintosh keyboard shortcut: z-S

Settings are used to set operating preferences
within Hansa, to tailor its operations to your
requirements. The settings available vary with the
different modules. Before you start working with
each module, you should consider its settings,
since its functions depend on the settings being
correct. Many settings take the form of options or
preferences. Others require information or a
number of records to be entered. Click the button
to open the ‘Settings’ list window where you will
find an alphabetical list of the settings that are
available in the current module. Double-click an
item in this list to add to or change a particular
setting. Settings are described individually in the
appropriate chapter.

Registers These buttons vary according to the current module: one
is provided for each register in that module. Separate
registers are used for the different types of information
stored in and used by the module. Click on a register
button to open the browse window for the register. This
window lists all the records contained in the register.
Each register is explained in separate sections
throughout these manuals.
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HansaWorld.com

In the top right-hand corner of the Master Control panel there is a
[HansaWorld.com] button—

Click this button to connect to the web and go to Hansa’s website
(www.hansaworld.com). The latest versions of Hansa Financials and
HansaWorld are always available for downloading from this site.

Personal Desktop

The area on the right of the Master Control panel is known as the “Personal
Desktop”. If you have certain records, registers, reports or Maintenance
functions that you use all the time, you can move them to your Personal
Desktop for easy access. You can open a record or register or run a report or
Maintenance function from your Master Control panel at any time, without
first having to find them in their proper place in Hansa. The Personal Desktop
is therefore similar to a list of Bookmarks in a browser.

Please refer to the section later in this chapter entitled “Attachments and
Personal Desktop” for full details.

Passwords

You can set or change your password from the Master Control panel,
providing that a record for you already exists in the Person register (the
Person register is described in the ‘System Module’ chapter later in this
manual). Select ‘Change Password’ from the Operations menu. Enter the old
password if there is one and then type in the new one twice to ensure that it is
correct. Press Shift-Enter to close the window and save: use the close box if
you do not want to save changes. The password is case-sensitive.
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Windows
Hansa allows you to work with several windows on the screen at the same
time. The window that is currently in use is known as the ‘active window’.
That is the uppermost window, where the title bar is not dimmed.

In the Windows version you can “Iconise” a window, i.e. shrink it to an icon
on the screen, using the  button in its top right hand corner. The window
can be re-opened by clicking the button again.

You can move the active window by dragging the title bar, and change its
size by dragging the size box in the bottom right-hand corner. Close the
window with the close box. On the Macintosh, clicking the close box of a
window while holding down the Alt key will close all windows. In addition,
you can save attributes such as size, sort order and position for a particular
window using the Window menu.

Hansa allows you to have up to 100
windows open at the same time. It is
however a good habit to close a
window when it is no longer needed.
Too many open windows may become
confusing.

There are six types of window.

Browse Window

Browse windows are used to display lists of records. Clicking a register
button in the Master Control panel will open a browse window listing every
record stored in that register. In a browse window, you can search for a
certain record and select a specific record for processing. You can have
several different browse windows open at any time.

For example, if you click the [Transactions] button in the Master Control
panel while working in the Nominal Ledger module (or select ‘Transactions’
from the Registers menu), the window that opens is a browse window,
entitled ‘Transactions: Browse’. This window lists all the Transactions in the
register.

!
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You can scroll through the list using the scroll bar on the right. You can
scroll down or up a screen at a time by selecting ‘Next’ or ‘Previous’
respectively from the Record menu.  

You can change the sort order of the list. Click the heading of the column you
want to sort by, and the list will re-sort immediately. The heading of the
column will be coloured blue to show the selected sort order. If you click on
the heading a second time, the sort order will be reversed.

At the top of each browse window there is an area known as the Button Bar.
This contains a set of buttons—

Operations This drop-down menu appears in certain browse
windows only. Highlight one or more records in the list
(hold down the Shift key while clicking) and then
choose a function from this menu. The function will be
applied to all highlighted records. The contents of the
Operations menu will vary depending on the browse
window. Full details of each function can be found in the
chapters covering each module elsewhere in this manual.

This drop-down menu contains the same functions as the
Operations menu in the main menu bar.

[New] Windows/Linux keyboard shortcut: Ctrl-N
Macintosh keyboard shortcut: z-N

Click this button to open a new blank record for data
entry.
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[Duplicate] Windows/Linux keyboard shortcut: Ctrl-K
Macintosh keyboard shortcut: z-Y

If you need to create a new record that is a copy of one
that already exists, first find the earlier record in the list
and highlight it by clicking once. Then, click this button.
A new record is opened, a duplicate of that highlighted.
In many cases, the new record will contain the current
date, not the date of the copied record.

[Search] Use the Search field and button (on the right of the
Button Bar) to find a particular record in the list. First,
sort the list by the column that you want to use for the
search. In the illustration above, for example, the list is
sorted by No. allowing you to search for a Transaction
with a certain Number. Then, type a letter, word,
number, or date in the Search field (there is no need to
click in the field before typing). Then press Enter or
click [Search]. Hansa will search the column by which
the list is sorted for a match. The first row beginning
with an exact match (or, if there is no exact match, with
the nearest match) will be highlighted. If you are not
certain of the exact spelling, use the * character as a
wildcard. For example, in the illustration shown above,
if you want to find Transactions relating to Mutual of
New York but do not know their Customer Number
(013), sort the list by the Text column, type “*Mutual”
in the Search field and press the Enter key. If the first
record found is not the one you want, press the Shift-
Enter key combination to search again.

If you want to view or modify an existing record, first find it using the Search
facility described above. Then, open it by double-clicking its line in the list,
or by selecting the line and pressing the Enter key.

It is not possible to delete a record
directly from the browse window. The
record must first be opened.!
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Some browse windows have three extra buttons in the centre of their Button
Bars—

You can use these buttons if the Limited Access module is present, as
follows—

Lists all records in the register.

Lists records belonging to members of the same Sales
Group as the current user (i.e. records whose Sales
Group is the same as that of the current user).

Lists records belonging to the current user (i.e. records
whose Person field contains the initials of the current
user).

You can use the Person register to prevent a user from seeing every record in
the register by restricting their view to their own records or to those of their
Sales Group. This feature and Sales Groups are both described in the ‘System
Module’ chapter later in this manual.
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Record Window

Record windows are used to enter, view and edit individual records. The
heading may read ‘New’, ‘Inspect’, ‘Update’ or ‘Deleting’, depending on the
circumstance. All data entry to Hansa is made in windows of this type.

A record window is opened when you open a specific record from a browse
window by double-clicking, and when you create a new record. Below is the
window that is opened when you double-click a row in the ‘Invoices:
Browse’ window.

The record window is where you enter or edit information. Note that certain
fields will only accept numbers or uppercase letters, while others cannot be
changed at all. In some cases, all characters will be converted to uppercase
automatically.

Use the Return, Tab or arrow keys to move from field to field. The Return
key moves the cursor to the next editable field, while the arrow keys move to
the next field, whether it can be changed or not. You can also use the mouse
to click directly in a field to enter or change its data. When you click in a
field, its contents will be highlighted, and the contents will be replaced as
soon as you start typing. If you click twice in the same field, the insertion
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point will be placed at the point where you click, allowing you to enter or
delete characters at that point.

Some record windows, such as that in the illustration, are divided into two
sections: the top half shows details of the parent record (in this case, an
Invoice) and the lower half contains the individual items (or rows) that are
listed on that Invoice.

Sometimes a record window contains more information than can be shown on
screen at once. If this is the case, there will be a series of tabs (marked
‘Terms’, ‘Items’, ‘Currency’, etc in the example of the Invoice illustrated
above) which can be clicked to show further pages of data about the parent
record. There may also be a series of flips (marked ‘A’, ‘B’, ‘C’, etc) which
can be clicked to show more information for the rows.

Button Bar

At the top of each record window there is an area known as the Button Bar.
This contains a set of buttons—

 Windows/Linux keyboard shortcuts: PgUp and PgDn
Macintosh keyboard shortcuts: z-- and z-+

These are the [Previous Record] (on the left) and [Next
Record] buttons. Use them to go from record to record.
Once you have opened a record from a list in a browse
window, click the [Next Record] button to move to the
next record in that list. At the same time everything you
may have changed in the record you are leaving will be
saved. If you want to cancel the changes, close the
record window with the close box or press the [Cancel]
button on the right of the Button Bar. Similarly, clicking
the [Previous Record] button will open the previous
record in the list.   

These buttons have the same effect as selecting
‘Previous’ and ‘Next’ from the Record menu.
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Operations In several record windows, such as those for Invoices
and Orders, there is an Operations drop-down menu
available. This contains different functions depending on
the window. For the Invoice record, the following menu
items are available—

‘Item Status’ shows the stock position for the Item in the
current row on the Invoice. ‘Create Cash In’ allows you
to receive cash payment against the current invoice, and
‘Invoice Status’ opens a window with a summary of the
status of the invoice; payments etc.

Full details of each function can be found in the chapters
covering each module elsewhere in this manual.

This drop-down menu contains the same functions as the
Operations menu in the main menu bar.

Windows/Linux keyboard shortcut: Ctrl-P
Macintosh keyboard shortcut: z-P

Click this Printer icon to print the current record. The
Printer icon will only appear in the Button Bar when the
record window contains something that can be printed
directly, e.g. an Invoice or Purchase Order. The ‘Print’
command on the File menu has the same function.

When you start a printout, it will print directly on your
selected printer. Normally, no printer dialogue is shown.
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 Windows/Linux keyboard shortcut: Ctrl-Shift-P
Macintosh keyboard shortcut: z-Shift-P

Clicking the Preview icon will cause the current record
to be printed to screen in a new window. This will allow
you to see what it will look like when you print it on a
printer by clicking the Printer icon immediately to the
left.

[New] Windows/Linux keyboard shortcut: Ctrl-N
Macintosh keyboard shortcut: z-N

Click this button to save the current record and to close
it. A new blank record is then opened for data entry.

[Duplicate] Windows/Linux keyboard shortcut: Ctrl-K
Macintosh keyboard shortcut: z-Y

Click this button to save the current record and to create
a copy of it. The original record is closed and the new
copy is opened. In many cases, the new record will
contain the current date, not the date of the copied
record.

[Cancel] Macintosh keyboard shortcut: z-B

If the current record has not been saved before, click this
button to cancel the data entry process and to close the
record window. The record is not saved. If the current
record has been saved before, click this button to discard
all changes made since it was last saved. In this case, the
record window is not closed.

[Save] Windows/Linux keyboard shortcut: Shift-Enter
Macintosh keyboard shortcut: Shift-Enter

This button saves all changes to the current record but
does not close it.

Paste Special

When you enter information in Hansa, you frequently need to refer to another
register or setting. For example, when entering an Invoice, the Customer
Number is used to bring information in from the Customer register (e.g. the
name and address of the Customer), while the Payment Terms field brings
information in from the Payment Terms setting. Using the ‘Paste Special’
command, you can find out the information you require from a selection list
quickly and easily. Pressing Ctrl-Return or Ctrl-Enter in a field activates the
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‘Paste Special’ feature. Macintosh users can press z-Return or z-Enter, and
PocketPC users can tap in the field with the stylus. The following example
shows pasting a Customer Number into an Invoice—

With the cursor placed in the Customer field, press the Ctrl-Enter (Windows
and Linux) or z-Enter (Macintosh) key combination. A new window will
open, showing the contents of the register or setting from which you can
select a record (in this case, the Customer register). This window is similar to
a browse window in its behaviour, so you can sort the list by any of the
columns by clicking the column heading and use the Search field to find the
record you are looking for (using the * wildcard if necessary).

Select the Customer you want by double-clicking or by highlighting and
pressing Enter. The Customer Number and other details are transferred to the
Invoice screen.

You can make the ‘Paste Special’ feature more powerful by saving the sort
order of the ‘Paste Special’ list. For example, whenever you need to choose a
Customer, you will probably know its Name but not its Number. The first
time you use the ‘Paste Special’ feature to choose a Customer, sort the list by
Name and then select ‘Save Normal Position’ (Windows and Linux)/‘Save
Position’ (Macintosh) from the Window menu. From now on, the list will be
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sorted by Name when it opens. Now you can type the first few characters of
the Customer Name in a Customer field and then press Ctrl-Enter or z-Enter.
When the ‘Paste Special’ list opens, the highlighted Customer will be the first
one to match what was typed. If this is the correct one, all you need do is
press the Enter key and carry on typing without interruption. In the example
shown below, we typed “OSLO” into the Customer Number field of an
Invoice and then pressed Ctrl-Enter. The ‘Paste Special’ list opens, with the
first Customer whose name begins with “OSLO” highlighted—

If the record you are looking for does not exist and so is not shown in the
‘Paste Special’ list, you can often enter it on the fly. In the ‘Paste Special’
window, press Ctrl-N or z-N. A new Customer screen (in this example) is
shown. Enter the new Customer, click [Save] and the new record is saved. At
the same time, the Customer Number is entered in the Invoice.

If you are entering an Invoice and realise that your information about the
Customer is out of date (they might have changed their address or telephone
number, for example), highlight the Customer in the ‘Paste Special’ window
and press F2 (Windows and Linux) or z-Shift-V (Macintosh). The Customer
record is opened, allowing you to make the necessary changes. You can also
do this if the Customer Number has already been entered to the Invoice. With
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the cursor in the Customer Number field, press F2 or z-Shift-V. This feature
is available from most fields with a ‘Paste Special’ link.

The availability to individual users of the F2/z-Shift-V feature and of the
ability to create records on the fly can be controlled using the Access Groups
setting in the System module (described later in this manual).

‘Paste Special’ can also be used when you are in a date or time field. Simply
press Ctrl-Enter or z-Enter and the current date or time is entered straight
away.

Drag and Drop

You can also link information in different registers or settings by dragging
and dropping. Information can be dragged from the browse window of one
register into the record window of another. For example, a Customer Number
can be dragged from the ‘Customers: Browse’ window into an Invoice. With
both the ‘Customers: Browse’ and ‘Invoice: New’ windows open, find the
correct Customer in the list, click on the Customer Number and drag it to the
Customer Number field of the Invoice. Items and information from settings
such as Payment Terms can be added to Invoices, Orders and other
transactions in the same manner. In the case of Items, you can select a range
of Items by clicking while holding down the Shift key, and then drag them to
the Item field in the first empty Invoice row.

In certain circumstances, it is also possible to create records by dragging and
dropping. For example, an Order can be dragged from the ‘Orders: Browse’
window to the ‘Deliveries: Browse’ window to create a Delivery for all the
Items on the Order. Once that Delivery has been approved, the Order can
then be dragged from the ‘Orders: Browse’ window to the ‘Invoices: Browse’
window to create an Invoice for all delivered Items.

If you have several Companies, information can be transferred from one
Company to another by dragging and dropping between browse windows.
For example, when a new Company is created, you can drag all the Accounts
from the ‘Accounts: Browse’ window of an existing Company to that of the
new Company. This makes it easy to transfer basic information to the new
Company. If you transfer approved accounting transactions of any kind using
this method, they will appear as unapproved transactions in the new
Company. An approved transaction is one from the Sales Ledger, Purchase
Ledger or Stock module that has been posted to the Nominal Ledger.
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Attachments

All record windows contain an [Attachments] button, which can take one of
two forms—

This button allows you to connect files, notes or other records to any record
in Hansa. These connected objects are known as “Attachments”. Please refer
to the section later in this chapter entitled ‘Working with Records’ for full
details.

Report Window

Report windows are used to display the reports you print to the screen. Below
we show an example of a report from the Nominal Ledger module. You can
scroll up and down in the window, and search for information in the report.

Below the Button Bar there is a report header, which shows the name of the
report and the selection on which it is based. This is important information,
since all reports can be produced using different selections.

Below this is the report itself, always shown to its full width in its own
window. You can change the window’s height and width, which may lead to
the report not fitting in the window. You can therefore scroll the window up
and down with the scroll bar to the right. If the window is too narrow, the
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report is compressed sideways, which may make it hard to read. By
increasing the width of the window the report can be made to expand.

Since each report is shown in its own window, several reports can be put on
the screen at the same time, totally independently. This gives Hansa an
unmatched reporting power. You can for example show two versions of the
Balance Sheet simultaneously, in two different windows. In one you might
show the result without simulated transactions and in the other with
simulations. Hansa can easily give you information that can only be obtained
after some complicated manoeuvring in other accounting systems.

There is no limit to the number of reports that can be shown simultaneously
on the screen, and reports from the different modules may be mixed freely.
Since Hansa's windows are completely independent, report windows can be
mixed with data entry windows and lists from different parts of the system.

In the following picture we show an example where four reports from the
Nominal Ledger and Sales Ledger are shown at the same time.
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Printouts

All reports are printed by clicking the Printer icon in the Button Bar of the
window containing the report. The page format is set in advance for each
report so that the report will fit in a portrait or landscape page.

Searching in Reports

Another useful function built in to all Hansa's reports when printed to screen
is the option to search for a text string in a report. The search string may
contain any combination of letters and digits occurring in the report.

In this example you might want to search for the Nominal Ledger
Transaction resulting from Invoice 913. Enter “913” into the Search field on
the right of the Button Bar and press the Enter key. Hansa will search for the
first text string in the report that matches the search word, scroll the report to
the position where the text was found, and highlight the text. Press the Enter
key again to find the next match.

Recalculating reports

All reports are shown in their own windows. You can leave a report on the
screen and go to other windows to do various additions and alterations. If
such alterations affect the contents of the report, there is a simple shortcut for
updating the report. With the report window active again - activate it by
clicking in it - the Operations menu is available in the menu bar. Select the
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‘Recalculate’ command (or use the Ctrl-Shift-R/z-Shift-R keyboard
shortcut) to produce an updated version of the report, using the same
specifications. If you want to produce an updated version of the report using
different specifications, select ‘Reopen Report Specification’ from the
Operations menu.

Drill-down

Hansa has a unique drill-down feature in some reports when they are printed
to screen. For example, when you have a Profit & Loss statement on the
screen, you can click on any of the Account Numbers in the report. Subject to
you having the necessary access rights, the Nominal Ledger report for the
same selection and period is then opened in a separate window, showing all
the Transactions that constitute the total amount on the Profit & Loss
statement. If you further click on one of the Transaction numbers in the
Nominal Ledger report, the Transaction record will open, showing all the
details recorded for the event. The following picture shows the result of the
above example.
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Text with the drill-down feature is shown underlined in a screen report.
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List Window

The list window is used whenever it is necessary to choose from a list of
options, usually after accessing the ‘Settings’, ‘Maintenance’, ‘Reports’ and
‘Documents’ functions. Double-click your choice in the list, or click it once
with the mouse and then press the Enter key.

You can use the scroll bar to find the item that you want, or you can type the
first letter of its name. For example, referring to the example illustrated
below and assuming ‘Customer List’ is the item you want, press the letter
“C” on your keyboard three times. After the first press, the highlight will
move down to the first item beginning with C, ‘Credit Notes, Updating
Stock’. As you press “C” on your keyboard again, the highlight will move
down until ‘Customer List’ is highlighted. You can now press the Enter key
to activate the report.

When the list window shows a list of documents, it will be accompanied by
an Operations menu allowing you to assign a Form to each document (the
Form contains the design that will be printed). This is described later in this
chapter.

The following example shows the list window from where you can choose a
report in the Sales Ledger module.

Specification Window

Specification windows allow you to specify the contents of a report or
document, or how a Maintenance function is to operate. A specification
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window will usually appear after you have selected an option in a list
window. Once you have entered the report criteria or specified how the
Maintenance function is to behave, click [Run]. The example below shows
the specification window for the Transaction Journal report.

File Dialogue Window

Hansa uses the standard Windows or Macintosh file dialogue window when it
requires you to select a file for import, or to give a file name to an export file.
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In some operating systems (e.g. Macintosh OS X), Hansa uses its own file
dialogue window—

When the file dialogue window is first opened, the main part of the window
shows the contents of the folder containing your Hansa application. Folder
names are shown in angled brackets <>. Double-click a folder name to see its
contents. Double-click the first item in the list (..) to go up one level. Click
the [Desktop] button to go to your desktop, and the [Backup] button to enter
the Backup folder that is inside the folder containing your Hansa application.
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Menus and Sub-menus

The Menu Bar

Select menus by pulling them down with the mouse in the normal way.
Where appropriate, keyboard shortcuts are shown to the right of the menu
items. Some commands are also available as icons in the Button Bar and
Master Control panel.

Not all menu items are available at all times. Disabled items are grey or
dimmed.

File Menu

The File menu contains commands for the handling of files, documents and
printouts. Instead of selecting an item from the menu, you can in some cases
click on the corresponding icon in the Master Control panel. The commands
on the File menu also all have a keyboard shortcut, shown to the right of each
command in the menu, e.g. Ctrl-P (Windows and Linux) or z-P (Macintosh)
for ‘Print’. These shortcuts are shown in the illustrations above: the
Macintosh version is on the left, the Windows version on the right.
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Company

This command opens a list for selecting a Company to work with. The
Companies listed in the window will have been entered using the Companies
register in the System module.

Double-click a Company in the list, or click once and press the Enter key.

If you need to add a new Company to the list, select ‘Open Company
Register’ from the Operations menu while the list is open. Refer to the
‘Adding New Companies’ section in the previous chapter for full details, but
remember that adding a new Company will mean that you will have to apply
for a new Enabler key. For more information about using a multi-Company
database, refer to the ‘Working with Companies’ section later in this chapter.

Master Control

This function brings the Master Control panel to the front. This will be
necessary if you wish to use Hansa’s Mail functions as the Master Control
panel provides the only means of accessing these.

Exports

Use this command to copy information from Hansa into a text file on your
hard disk. This data is then available for use in other programs, such as word
processors, spreadsheets, database programs etc. Selecting the command is
equivalent to pressing the [Exports] button in the Master Control panel.

When you select this command, the ‘Exports’ list window is opened, where
you can choose the information to be exported by double-clicking. The
options available in the ‘Exports’ list window vary according to the active
module.
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One reason to use the ‘Exports’ function is to back up your Hansa database.
For full details of how to do this, please refer to the ‘Safety Back-up’ section
in the ‘Introduction and Installation’ chapter. For security reasons, the
‘Company Text Backup’ and ‘Database Text Backup’ exports do not produce
text files as mentioned above but encrypted files that can only be read by
another copy of Hansa.

Note that all Hansa reports can also be printed to disk as text files. This, in
combination with the ‘Exports’ function, makes it very easy to retrieve
information from Hansa for use with other applications.

Imports

This command imports a text file, previously saved in the proper format, into
the Company you are working with. Only data that is new will be added
during the import process, and there is no danger that you will get duplicate
data of any kind into your database.

When you select this command, the ‘Imports’ list window is opened, where
you can specify what is to be imported. As with the ‘Exports’ list, the options
available in the Imports list window vary according to the active module.

The function can import information from another Hansa database or from a
text file created by another computer program. In the latter instance, you
should ensure the text file is correctly formatted (contains the information in
the correct order) before importing. This format information is available from
your local Hansa representative.

You should use the ‘Imports’ function to restore your Hansa database from a
back-up and to import your information into a new version of Hansa. For full
details of how to do this, please refer to the ‘Restoring from a Back-up’
section in the ‘Introduction and Installation’ chapter of this manual.

Maintenance

You can use the ‘Maintenance’ option on the File menu to carry out certain
updating tasks, such as creating Purchase Orders from Sales Orders or
recalculating Price Lists. When you select the function, a list window will
appear, from where you can choose the required option by double-clicking.
The options available vary according to the active module. See the chapters
covering each module for details of the specific functions.
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Reports

Hansa can print reports or documents. Reports are used mostly in relation to
your internal accounting and management.

Reporting in Hansa is non-destructive, i.e. you can make and print a report as
many times as you wish. Some accounting programs are designed in such a
way as to allow journal printing only directly in connection with the data
entry. Hansa does not have this limitation.

When you select ‘Reports’ from the File menu or from the Master Control
panel, a window is opened, containing a list of all available reports. The
contents of this window vary with the selected module: the illustration below
shows the reports in the Nominal Ledger module—
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Choose a report by highlighting an item in the list in the Reports window. If
you need to set the page size , number of copies and other printer options for
the report, choose ‘Page Setup’ from the File menu. These settings will be
used whenever the particular report is printed until you choose ‘Page Setup’
once again. Windows users can also use this function to choose the printer on
which the report is to be printed.

Once you have done this, double-click the report name in the list. A
specification window will open, where you can choose the information that
you want to be shown in the report. For example, when producing a Balance
Sheet, you can use its specification window (illustrated below) to choose the
period that is to be covered by the report.

While the specification window is open, you can choose the destination of the
printout by selecting one of the Media options at the bottom of the window.
The available options are Screen, Printer, Hansa’s internal Print Queue (see
below), File and Clipboard. If you print to screen (the default setting), the
report will be shown in a new window. You can subsequently send the report
to a printer by clicking the Printer icon in the Button Bar of this window or
by selecting ‘Print’ from the File menu.

If you are sending the report to a printer and you want a print dialogue to
appear, check the Printer Dialog box (last of the Media options). You might
do this if you want to print several copies of a report.
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Once you have entered the reporting criteria and have chosen a print
destination, click [Run] to produce the report.

Updating Reports

While a report is on screen, it may be that you change some of the
information it contains. If so, there is no need to close and recreate the report.
Simply select ‘Recalculate’ from the Operations menu (or use the Ctrl-Shift-
R/z-Shift-R keyboard shortcut) to update the report. If you want to change
the report criteria before recreating the report (e.g. you want to change the
report period), choose ‘Reopen Report Specification’ instead.

Defining Reports

For some reports in the Nominal Ledger module, you can redefine the
contents and layout of the report. To do this, use the Report Settings setting
in the Nominal Ledger. Full details can be found in the ‘Nominal Ledger’
chapter in Volume 2b of this manual.

Export to other applications

It is very easy to export the contents of any report to another application
program, e.g. Excel or Word. The specification window for each report
contains a set of Media options, one option of which is ‘File’. If you select
this option, the report will be saved as  a tab-separated text file on your hard
disk. This can be used directly in Excel, for further calculations etc.
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The following example shows a Customer Statistics report opened in Excel—
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Documents

Documents are more formal printouts, usually printed using forms, such as
invoices or delivery notes. They are often directed to third parties. Hansa
offers several documents in each module. Documents cannot be printed to
file. The documents available vary with the selected module: the illustration
below shows those in the Sales Ledger module—

Defining Documents

You must assign a Form to each document before you print it for the first
time. The Form is the design or layout of the document. You can have a
single Form for each document, or you may have several  versions of a
particular type of document, to be used on different occasions. To assign a
Form or Forms to a document, use the ‘Define Document’ function on the
Operations menu.

The example described below imagines you to have two different invoice
layouts, one for English language customers, and one for French customers.
You can design these invoice layouts, named, for example, INVENG and
INVFRE, using the Form register in the System module. Full details of this
design process can be found in the ‘System Module’ chapter of this manual.
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This is how you specify when each Form is to be used, using the Invoice as
an example.

1. Select the Sales Ledger module using the Modules menu.

2. Click the [Documents] button in the Master Control panel. The
‘Documents’ list window is opened showing a list of available
documents. Highlight ‘Invoices’.

3. Select ‘Define Document’ from the Operations menu. Specify INVENG
as the Form on the first row and INVFRE as the Form on the second
row—

For each row you can specify a language, a user group, a sequence
number series, a form name and a printer.

Seq This column is used if you want to print two (or more)
different documents from a single command. For
example, you might want to print a Delivery Note and an
Invoice immediately when an Invoice is approved. In
this case, you would enter the Delivery Note with Seq.
no. 1 on the first row of the grid, and the Invoice with
Seq. no 2 on the second row.

Lang Enter a Language code for the document. Each
Customer and/or Invoice can be assigned a Language
code, which will control the selection of a document.
You can use ‘Paste Special’ (Ctrl-Enter or z-Enter) to
select from a list of Languages as set up in the System
module. In this way, you can instruct Hansa to print, for
example, an English Invoice for all Customers and a
French Invoice for those customers who have been
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assigned the Language code for French. The ‘Paste
Special’ feature is described earlier in this chapter.

In some cases, you can also enter a Delivery Mode here,
permitting different layouts to be used depending on the
Delivery Mode. This feature can only be used where the
record to be printed contains a Delivery Mode field (e.g.
it can be used with Invoices but not with Activities or
Mails).

Us Gr You can assign a particular Form to one user group.
When a member of the group prints the document, the
system will automatically select the Form assigned to the
group. Use ‘Paste Special’ to select from a list of Access
Groups as set up in the System module.

Ser No A particular Form can be assigned to a number series, so
that Invoices with numbers from that series will be
printed using the assigned Form.

Form Enter the Form Code of the relevant Form in this field.
This field is case sensitive: only upper case characters
should be used. Use ‘Paste Special’ to select from a list
of Forms as set up in the System module.

Printer Enter a printer code to send the printout to extra printers
defined in the System module (use ‘Paste Special’ to
obtain a selection list).

4. Click [Save] to save the Invoice definitions. When printing Invoices
from now on, the correct Form will be selected automatically according
to the Language of the Customer, without further user intervention.

This process can be repeated for almost all documents as required.

Settings

This command opens the ‘Settings’ list window where you will find an
alphabetical list of the settings that are available. Settings are used to tailor
certain aspects of the program’s operation to your requirements, and to
supply information to be used throughout the program.

The contents of the ‘Settings’ list window vary according to the module
selected. The illustration below shows the different settings in the System (on
the left) and Nominal Ledger modules.
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Choose an entry in the list by double-clicking it, or by selecting it and
pressing the Enter key. Settings are described in detail in the chapters
covering the individual modules.

Page Setup

This function is available when the active (top) window on the screen
contains a list of reports or documents.

When a report or document is printed, one copy is usually produced, using a
standard page size. If you need to print more than one copy, or to use a non-
standard page size or magnification, highlight the desired report or document
in the list and then select ‘Page Setup’ from the File menu to make these
changes. Once this has been done, double-click the item in the list to carry on
with the printing process.

The number of copies, page size and/or magnification can be set individually
in this way for each document or report. These settings will remain in place
until ‘Page Setup’ is chosen once again.

Windows users can also use this function to choose the printer on which the
report or document is to be printed.
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Print

This function is available when the active (top) window on the screen
contains—

• something that can be printed directly (a screen report, a transaction in
the transaction window) or

• the contents of the Print Queue.

When you select ‘Print’, the transaction or the report is printed directly to the
selected printer, normally without the Print dialogue box being shown.

This menu item duplicates the functions of the Printer icon in the Button Bar
of the active window.

Print Queue

You can choose to put your documents or reports in a waiting list so that they
can be printed later, perhaps to reduce the load on the network, or to ensure
that the printer contains the right paper. In the example below three reports
have been put in the queue for later printing.

To place a Report or Document in the Print Queue, select ‘Reports’ or
‘Documents’ on the File menu or click the appropriate button in the Master
Control panel. Double-click the required option in the list. After entering the
report criteria, select ‘Print Queue’ from the Media options at the bottom of
the specification window before clicking [Run].

To print the items in the queue, bring up the Print Queue list by selecting
‘Print Queue’ from the File menu. Then select ‘Print’, also from the File
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menu. All the items in the list will be printed in the order in which they are
shown.

To remove an item from the list, mark it with the mouse and select ‘Clear’
from the Edit menu.

Quitting Hansa will cause the queue to be emptied.

Quit

Quits Hansa. Remember to take a safety back-up of your work before you
quit!

Macintosh OS X users can find the ‘Quit’ command on the Hansa OS X
menu.

Edit Menu

The commands in this menu are usually used when you are working with the
contents of individual fields. If you wish to copy or delete entire records, you
should instead use the commands in the Record menu, or the [New] or
[Duplicate] buttons in the Button Bar. If the active window contains nothing
editable, the commands will be dimmed. For each command in the Edit menu
there is a keyboard shortcut, e.g. Ctrl-Z (Windows and Linux) or z-Z
(Macintosh) for ‘Undo’. These shortcuts are shown in the illustrations above:
the Macintosh version is on the left, the Windows version on the right.

Undo

Select ‘Undo’ to undo your last action.

There are a few actions in Hansa that cannot be undone, e.g. deleting a record
with the ‘Delete’ command on the Record menu. Anything removed using
the ‘Clear’ command in the Edit menu also cannot be undone.

Cut

‘Cut’ removes the data you have selected (highlighted) and puts a copy in the
Clipboard. The Clipboard is a special part of the computer's memory, used to
store a single piece of data temporarily. This data can then be inserted
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(Pasted) into another place, once or several times, until you ‘Cut’ or ‘Copy’
something else. That will replace the old contents in the Clipboard.

In certain fields, e.g. the Account Number fields in a Transaction that has
already been saved, you may not remove the data, and thus not use ‘Cut’. If
you want to make a copy of the field’s contents, use the ‘Copy’ command
instead.

Copy

Use ‘Copy’ to copy text or numbers from one field to another without
removing the data from the original field. The copy is put in the Clipboard.
Then you can ‘Paste’ the copy in as many other locations as required. The
copy remains in the Clipboard until you ‘Cut’ or ‘Copy’ something else.

Note that ‘Copy’ (and ‘Cut’) can only be used to copy text from a single field
at a time. If you want to copy a whole record in a file, use the ‘Duplicate’
command in the Record menu (or the [Duplicate] button in the Button Bar).

Paste

With this command you can insert text or a value that has been cut or copied
to the Clipboard. The clipping is inserted at the insertion mark. If you select
several characters in the destination field, ‘Paste’ will replace the selected
text with the contents of the Clipboard.

Clear

‘Clear’ removes the characters you have selected (highlighted) without
copying them to the Clipboard.

The ‘Clear’ command removes text or values within a single field. If you
wish to remove an entire record, use the ‘Delete’ command on the Record
menu.

Select All

Use this command to select the whole contents of a field. You can use it
when you are editing a field and want to replace the whole contents with new
data.

Select Row

This command is used in screens which contain rows of information, divided
into separate columns (or ‘fields’), for example the Invoice and Transaction
screens. It allows you to select a whole row. When you choose ‘Select Row’,
the row in which the cursor is placed is selected. Clicking the number
identifier of the row (on the left) has the same effect.
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Record Menu

The Record menu contains the necessary commands to open, enter, change
and delete the records in the different registers.

Almost all these commands can also be executed using the buttons in the
Button Bar. In addition, there are keyboard shortcuts available for most of
them. Commands that cannot be used at a certain point are dimmed in the
menu.

The Record menu commands cannot
be undone with ‘Undo’.

Next

• When you work in a record window, showing an individual record in a
register, ‘Next’ will take you forward to the next record in that register.

It will also save all changes you have made in the record you have just
left.

In this situation, the ‘Next’ command has the same effect as clicking the
[Next Record] button in the Button Bar.

• When you work in a browse window, ‘Next’ will move forward to the
next group (page) of records.

• When you work with a Report, ‘Next’ will scroll to the next page of the
report.

!
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Previous

The command works in the same way as ‘Next’, but moves backwards
instead of forwards. As with ‘Next’, when working in a record window,
‘Previous’ saves all changes you have made in the record you are leaving.

In record windows, the ‘Previous’ command has the same effect as clicking
the [Previous Record] button in the Button Bar.

OK

This command is equivalent to pressing the [Save] and [Run] buttons in the
Button Bar (depending on context). When used in a record window, it closes
the record on screen and saves all changes. When used in a browse window,
it opens the selected (highlighted) record for editing. When used in a
specification window, it prints the report or document or activates the
Maintenance function.

Cancel

Closes the record on screen without saving any changes. It is equivalent to
the [Cancel] button in the Button Bar.

Windows of all types can also be closed using the close box or Ctrl-F4
(Windows and Linux) or z-W (Macintosh). When using these methods, you
will be asked if you wish to save changes.

New

Use this command when you need to create a new record. It can only be used
after you have opened a register using the one of the buttons in the bottom
row of the Master Control panel or a function on the Registers menu.

This function opens a blank window into which you can enter the new record.
On clicking [Save], the record will be saved into the register concerned. On
clicking [New] again, the record will be saved and a new blank window
opened, enabling you to enter another new record in the same register. On
clicking [Cancel], the record will be closed but not saved.

Duplicate

This function creates a new record by duplicating an existing one. The
duplicate is opened in a window marked ‘New’. In many cases, dates in the
new record will be changed to show the current date.

You can duplicate a record either from a record window, showing the record
to be duplicated, or from the browse window, in which you have highlighted
the record to be duplicated by clicking with the mouse.
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Delete

Use this command to delete, i.e. remove, an existing record. The record must
be of a type that can be removed - records such as Invoices and Nominal
Ledger Transactions cannot be removed once completed. You must open a
record in the record window to be able to delete it. The only exception to this
rule is that Mails must be deleted from the browse window.

When a record is deleted, the next record in the register is displayed.

Remember that you cannot undo the
deletion of a record.

Invalidate

You can use this function when an Invoice or Purchase Invoice is open in a
record window, when it is necessary to remove an Invoice from the Sales
Ledger or a Purchase Invoice from the Purchase Ledger. Any associated
Nominal Ledger Transaction will be removed from the Nominal Ledger as
well. As illustrated overleaf, an invalidated Invoice is easily distinguished
because all fields have red lines drawn through them. You can invalidate
Activities, Expenses and Personnel Payments in the same way.

In the case of Sales Invoices, the function is designed for use in situations
where Invoice Numbers are pre-determined (perhaps through being printed
on Invoice stationery) and where it is not desirable to raise a Credit Note. It is
not recommended for use where the cancelling of an Invoice has implications
for the stock system. In these circumstances, you should issue a Credit Note,
and receive the goods back into stock using the Goods Receipt or Returned
Goods registers. These issues are fully described in the ‘Sales Ledger’
chapter in Volume 2a of these manuals.

!
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In the case of Activities, once an Activity has been marked as Done and
saved, the To Do and Private boxes, the Start and End Dates and Times and
the Calendar options cannot be changed. If you realise that a Done Activity
contains a mistake, open it and select ‘Invalidate’ from the Record menu. Red
lines will be drawn through all the fields, and the Activity will be removed
from the Calendar, Task Manager and all reports. Then click the [Duplicate]
button in the Button Bar to create a new Activity without the mistake.
Activities, the Calendar and the Task Manager are described in Volume 6 of
these manuals.

The invalidation of an Invoice or
Activity cannot be reversed.!



Chapter 2: Work Area - Menus - Record Menu

121

Attachments

This menu command allows you to connect files, notes or other records to
any record in Hansa. These connected objects are known as “Attachments”.
Please refer to the section later in this chapter entitled ‘Attachments and
Personal Desktop’ for full details.

A record must be open in a record window and must have been saved at least
once before you can attach objects to it.

Send to Desktop

Use this function if you would like the current record (the one currently open
in a record window) to appear in your Personal Desktop (on the right-hand
side of your Master Control panel). This will allow you to open the record at
any time without having to change module and without having to find it in a
browse window. Please refer to the section later in this chapter entitled
‘Attachments and Personal Desktop’ for full details.

History

This function allows you to view the change history of a particular record.

To use this function, you must first instruct Hansa to store the change
histories of records. To do this, follow these steps—

1. Select ‘Technics’ from the Modules menu. In multi-user systems, this
can be done on the server machine or on a client. In both cases, no other
user should be logged in. To gain access to the Modules menu, select
‘Quit, Remove Autoserver’ from the File menu and restart Hansa.

If ‘Technics’ is not available on the Modules menu, this will probably be
because you have not granted yourself access to the Server module in the
System Usage setting (single-user) or in the Access Groups setting
(multi-user).

2. Choose ‘Settings’ from the File menu. In the ‘Settings’ list, double-click
‘Logging Control’.
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3. The ‘Logging Control: Inspect’ window opens—

Use the grid to tell Hansa the registers for which you wish to keep a
history of the changes made to each record. No history will be kept for
registers not listed in the grid. Note that maintaining record histories will
cause the size of the database to grow quickly.

4. In the Register column, use ‘Paste Special’ (described later in this
chapter) to select the register for which a history is to be kept.

5. In the Type column, use ‘Paste Special’ to select an option, as follows—

No Logging No change history will be kept.

Log User and Time

Whenever a record in the register is created or modified,
the history will show the date and time this happened
and the initials of the Person responsible.

Keep Original Record

Again, the history will show the date and time each
record was created or modified and the initials of the
Person responsible. In addition, every modification of
each record will be recorded.

6. Click the [Save] button in the Button Bar to save the Logging Control
setting.

7. Quit and restart Hansa.

Once this has been done, to view the change history of a record, first open
that record in a record window. Then, select ‘History’ from the Record menu.
A list of the dates and times of modifications to the record appears: this can
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be printed by clicking the Printer icon. If you are using the ‘Keep Original
Record’ option, click a date in the report to open the version of the record as
it was on that date, before the modification. For example, if a record was
created on May 1st and modified on May 2nd, 3rd and 4th, click on May 3rd
in the report to see the record as it was immediately before the May 3rd
modification.
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The Registers

Hansa consists of a number of modules, each with a number of Registers or
Files, in which your data is stored. Each module has a different set of
registers, accessible through the Registers menu. The following illustration
shows the registers available in each module. The exact contents and the use
of each register is explained in the chapters of this manual covering the
individual modules.

To work with a register (for example, if you need to enter a new Sales Order),
first go into the appropriate module using the Modules menu and then click
the relevant register button in the Master Control panel or select from the
Registers menu. A browse window will open, listing all the existing records
in the register (in this example, all Sales Orders). Then, click [New] in the
Button Bar and a blank record window will appear in which you can enter a
new record.

Registers in Hansa’s Modules

System

Nominal 
Ledger

Purchase 
Ledger

Purchase 
Orders

Sales 
Ledger

Sales 
Orders

Stock
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Modules Menu

The Modules menu and the Modules window are used to select the part of
Hansa you wish to work with. To change the module you are working in, use
the Modules menu or the keyboard shortcut Alt-M (Windows and Linux) or
z-0 (Macintosh). With the resulting list on the screen, you may select the
module you want by entering its first letter on the keyboard, such as N for the
Nominal Ledger, then press Enter.

Operations Menu

The Operations menu appears with certain screens only. Its contents will vary
depending on the screen shown and are specific to that screen. Full details
can be found in the chapters covering each module elsewhere in this manual.
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Window Menu

Use this menu to manage your windows, including closing them and
arranging them on screen. ‘Save Normal Position’ (Windows and
Linux)/‘Save Position’ (Macintosh) and ‘Restore Normal Position’ (Windows
and Linux)/‘Restore Position’ (Macintosh) allow you to save a particular
setting for an individual window. ‘Save Normal Position’ will save the
position and size of the window and, in browse and ‘Paste Special’ windows,
the sort order, while ‘Restore Normal Position’ will return the setting of the
window to standard.

Although the ‘Close All’ function is not available to Macintosh users,
clicking the close box of a window while holding down the Alt key will have
the same effect.

In multi-user systems, each user can use the ‘Save Normal Position’/‘Save
Position’ functions to save their own window positions, sizes and sort orders.
This information is stored on the client machine, so it will not be included in
the normal daily back-up file made from the server. To back up this
information, use the ‘Client Text Backup’ option: please refer to the ‘System
Module’ chapter later in this manual for full details.

About Hansa

This command on the ? menu (Windows and Linux), the Apple menu
(Macintosh OS 9) and the Hansa OS X menu (Macintosh OS X) shows the
copyright information for Hansa. The version of the program and information
about the owner of the program license are also shown here. You return to the
program by clicking [OK].
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If you need to contact your local Hansa representative with a technical query,
you should first find out the precise version number from this window.

This window also shows the size of your Hansa database and the amount of
disk space available on the hard disk on which it is stored. In multi-user
systems, these figures refer to the server.



Hansa Financials and HansaWorld

128

Working with Records

Current Record

When you wish to work with a particular record, you can open its record
window using one of the following methods. All methods give the same
result.

• Double-click the record in a browse window.

• Select the record in a Browse Window and press Enter.

With the record opened in a record window, you can edit all fields in the
usual way. Some fields may be locked due to relations to other functions in
the program. If this is the case, Hansa will tell you.

New Record

You can create a new record from a browse window or a record window. To
create a new record do one of the following—

• Click [New] on the Button Bar.

• Select ‘New’ from the Record menu.

A blank record is opened in a record window.

Duplicate Record

You may copy a record from a browse window or a record window. Select
the record you want to copy and -

• Click [Duplicate] in the Button Bar, or

• Select ‘Duplicate’ from the Record menu.

A new record is created. Relevant data from the original record is transferred,
and you only need to enter some of the fields. In many cases, date fields will
not be copied, but instead will be given new values.
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Delete Record

1. Open the record window for the record you want to delete.

2. Select ‘Delete’ in the Record menu.

You cannot delete a record that is used by other transactions, such as an
Account.

You cannot undo the deletion of a
record.

In most cases, it is not possible to delete a record directly from a browse
window. The record must first be opened. The exception is a Mail, which can
only be deleted from the browse window.

You can prevent a particular user or group of users from deleting records
using Access Groups. For full details about Access Groups, please refer to
the ‘System Module’ chapter later in this manual.

!



Hansa Financials and HansaWorld

130

Working with Companies
A Hansa database can contain more than one Company. This feature can be
useful if your business is one where there are separate departments or
subsidiary companies that keep separate accounts. These can be set up as
separate accounting entities in Hansa. Each department or subsidiary is
termed a ‘Company’.

Note that you should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.

Companies are stored in the Company register in the System module. New
Companies can be added at any time: this process is described in the ‘Adding
New Companies’ section in the previous chapter. If you have more than one
Company in your Company register, it is recommended that you specify a
Short Code for each one—
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Each time you log in to Hansa, you will be asked to choose a Company to
work with—

The names in this list are taken from the Name field in the Company register.

Once you have logged in, the Short Code of the Company (“H” in the
example illustrated) will be included in the title of every window—
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If you need to change Companies, there is no need to quit Hansa and restart.
Instead, you can select ‘Company’ from the File menu and select the new
Company. Once you have done this, the Short Code in the window title
identifies the Company to which the information in each window belongs—

In this illustration, the ‘Transactions: Browse’ window lists Transactions
belonging to Company H, while the ‘Simulations: Browse’ window lists
Simulations belonging to Company S. Only one Master Control panel can be
open at any time, so the Short Code in its title (“S” in the example) is always
that of the current Company. This is the Company whose information will be
shown in any new windows that you open, and the Company in which any
new records that you create will be saved. If you want to return to work in
Company H, use the ‘Company’ function on the File menu once again.

Usually, each Company will be completely separate: there will be no
common information. If you want to copy information from one Company to
another, you can do so using one of two methods—

1. by dragging and dropping. For example, to copy a Customer record from
one Company to another, open the ‘Customers: Browse’ window in the
first Company, change to the second Company using the ‘Company’
function on the File menu, and open the ‘Customers: Browse’ window in
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that Company as well. Then click on the relevant Customer record and
drag it from one browse window to the other. This method is suitable for
copying individual records.

2. using the export and import functions in the System module. This
method is suitable for transferring the entire contents of a register or
setting from one Company to another.

Shared Registers

You can choose to make the information in certain registers available to
every Company in your database. Such registers are termed “Shared
Registers”. For example, you may choose to make the Customer register a
Shared Register so that you use the same Customer list in all your
Companies. This will mean that all Customers will be available to all
Companies. You will not be able to isolate a particular single Customer so
that it can only be used by a particular single Company. Nor will you be able
to make the same Customer list available to four of your Companies and have
a completely separate Customer list in a fifth Company.

To set up a Shared Register, follow these steps—

1. Working in any Company, enter the Technics module by selecting
‘Technics’ from the Modules menu. To be able to do this, you should
have logged in as a Person that has access to the Technics module: this is
described in the section describing the Access Groups setting in the
‘System Module’ chapter later in this Volume.

2. Open the ‘Settings’ list by clicking the [Settings] button in the Master
Control panel or by selecting ‘Settings’ from the File menu.

3. Double-click ‘Shared Registers’ in the list. The following window
opens—
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4. List the registers that you want to be shared. Use the ‘Paste Special’
feature (Ctrl-Enter/z-Enter) to ensure each register is spelt correctly (an
incorrect spelling will mean that the register will not be shared). Click
the [Save] button to save and close the window, or click the close box if
you don’t want to save changes.

In the example illustrated above, the information in the Customer, Supplier,
Account and Object registers will be made available to all Companies in the
database. When a new Customer is entered in Company H, for example, it
will immediately be made available for use in Company S.

If any of these registers in any Company contained any records before they
were shared, these records will no longer be available. For example, you will
no longer be able to use any Customers already in Company S. If you want to
carry on using these Customers, you should export them before sharing the
register and then import them after sharing the register. To export them, use
the ‘Base Registers’ Export function in the System module. To import them,
use the ‘Automatic’ or ‘Automatic, manual file search’ Import functions, also
in the System module. If you have Customers in several Companies and want
to carry on using them all, you should export them from each Company in
turn, creating several export files. On import, if a Customer Number has been
used more than once, it will end up being used for the Customer in the last
file imported. For example, Customer Number 001 refers to Customer Name
A in Company 1 and to Customer Name AA in Company 2. Having shared
the Customer register and assuming you import the Customers from
Company 1 followed by those from Company 2, Customer Number 001 will
now refer to Customer Name AA.

Sharing the Account register only means that the static information in the
Account register (e.g. Account Number and Name, Account Type and so on)
will be shared. It does not mean that there will be a single balance for each
Account made up from the Transactions in all Companies. Separate account
balances will be maintained for each Account in each Company. If you want
there to be a single balance for each Account made up from the Transactions
in all Companies, use the Consolidation module (see Volume 4 of these
manuals).

It is possible to remove a register from the Shared Registers setting, but this
is not recommended. Depending on the register in question, you may cause
your database to be corrupted. If you do follow this course of action, you will
no longer be able to use any records entered since you first shared the
register, but you will regain access to any records that were previously in
each Company.
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Attachments and Personal Desktop

Attachments

You can connect files, notes or other records to any record in Hansa. These
connected objects are known as “Attachments”.

All record windows contain an [Attachments] button—

If a record has an Attachment, the button has a different icon—

Click this button to work with Attachments (or select ‘Attachments’ from the
Record menu). A list of objects currently attached to the record is opened—

This list has its own Operations menu, which contains the functions
necessary to attach, view and remove Attachments—
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In the case of records whose unique identifying codes are not generated
automatically (e.g. the Item Number of Items), you must save the record at
least once before you can add any Attachments.

Attaching Files to Records

To attach a file to a record, open the record in question and click the
[Attachments] button. Select ‘Attach File’ from the Operations menu. An
‘Open File’ dialogue box will open, allowing you to locate the file to be
attached. Find the file and click [Open]. The file will be attached to the
record. Its filename will appear in the list of Attachments with the prefix
“File:”. You can attach as many files as you like to a single record.

The ‘Attach File’ function attaches a file to a record by copying the file into a
folder called “Attach” that is in the same folder as your Hansa application. In
multi-user systems, the “Attach” folder should be on the server. This means
that you will still be able to download and read the attached file, even after
the original has been deleted. If you want to attach a large file to a record,
make sure (using the disk space indicator in the ‘About Hansa’ window) that
the hard disk containing your Hansa application has sufficient space. As the
file is uploaded to the server, a progress indicator appears so that you can
monitor its progress.

The “Attach” folder must be present
in the folder containing your Hansa
application if you want to attach files
to records. Do not rename any of the
files in the “Attach” folder.

Reading Files

A file that has been attached to a record can be read in one of two ways.
Whichever method is used, a ‘Save File’ dialogue box is opened, asking you
where the file is to be saved.

1. By double-clicking on the file in the list of Attachments. When the file
has been saved to your hard disk, your default browser will be opened so
that the file can be opened using the appropriate helper application (not
Macintosh).

2. By clicking on the file in the list of Attachments and selecting
‘Download File’ from the Operations menu. The file is saved to your
hard disk, but no attempt is made to open it using a helper application.

!
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Attaching Notes or Comments to Records

You can attach notes or comments to records. To do this, open the record in
question and click the [Attachments] button. Select ‘New Note’ from the
Operations menu. A window will open, where you can type in your comment.

Click [Save] to save. The note will appear in the list of Attachments with the
prefix “Note:”. If you want to identify the note with a name, refer to the
section below entitled ‘Changing the Names of Attachments’. You can attach
as many notes as you like to a single record.

Reading and Changing Notes

A note or comment that has been attached to a record can be read in one of
two ways—

1. By clicking on the note in the list of Attachments and selecting ‘OK’
from the Record menu; and

2. By double-clicking on the note in the list of Attachments.

Whichever method is used, the note is opened in its own window where it can
be read or edited.

Printing Notes

A note or comment that has been attached to a record can be printed when the
record is printed. For example, a note that has been attached to an Invoice can
be printed on the Invoice document. If more than one note has been attached
to a record, only the first note will be printed.

If you want notes and comments to be printed in this way, you should include
the “Note” field in each of your Form designs. Form design in fully described
in the ‘System Module’ chapter later in this manual.
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Changing the Names of Attachments

When a file is attached to a record, its file name will be shown in the list of
attachments. When a note is attached to a record, it is not immediately given
its own name in the list.

If you want to rename a file or note, highlight it in the list of Attachments and
select ‘Edit Link Comment’ from the Operations menu. A window opens
where you can type in a new name.

Click [Save] to save and close the window, or [Cancel] if you don't want to
save changes. You may have to close and re-open the list of Attachments for
the change to take effect.

Attaching Records to Other Records

You can attach records to other records by dragging and dropping from the
browse window of one register onto the [Attachments] button of another. For
example, to attach a Customer record to an Invoice, open the Invoice in a
record window and then open the ‘Customers: Browse’ window. Find the
correct Customer in the list, click on the Customer Number and drag it to the
[Attachments] button of the Invoice. The Customer record will then appear in
the Invoice’s list of attachments. Alternatively, if the Customer record is
already open, you can drag its [Attachments] button onto that of the Invoice.

Later, when viewing the Customer record in the example above, you might
wish to see which other records it has been attached to. Open the list of
Attachments and select ‘Show To Links’ from the Operations menu. The
records the Customer has been attached to will be listed below a dotted line.
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Viewing Attached Records

A record that has been attached to another record can be read in one of three
ways—

1. By clicking on the record in the list of Attachments and selecting ‘Open
Record’ from the Operations menu;

2. By clicking on the record in the list of Attachments and selecting ‘OK’
from the Record menu (or pressing the Enter key); and

3. By double-clicking on the record in the list of Attachments.

Whichever method is used, the linked record is opened in its own window
where it can be read or edited in the usual manner.

Removing Attachments

To remove an attachment of any kind from a record, highlight it in the list of
Attachments and select ‘Clear’ from the Edit menu.

Attaching Records to Mails

Records can be attached to Mails in one of two ways—

1. Where the Mail already exists, the record can be dragged from its browse
window to the [Attachments] button of the Mail, as described in the
‘Attaching Records to Other Records’ section above.

2. Where the Mail does not exist, open the record and click its
[Attachments] button. Select ‘New Mail’ from the Operations menu. A
new Mail is opened. Complete the Mail in the usual way and save. The
new Mail will be attached to the record automatically, and the recipient
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of the Mail will be able to open the record using the ‘Show To Links’
Operations menu function.

Remember that Mails themselves are records. Therefore Mails can be
attached to other Mails or to other records. Every feature described in this
section applies to Mails as much as to other records.

Mails are fully described in Volume 6 of these manuals.

Copying Attachments from one Record to Another

You can copy an Attachment of any kind from one record to another as
follows—

1. Open the record with the Attachment (the ‘source’ record) and click its
[Attachments] button.

2. Open the record that is to receive the Attachment (the ‘destination’
record).

3. Drag the Attachment from the list of Attachments to the [Attachments]
button of the ‘destination’ record (or to its list of Attachments).

4. Hold down the Shift key while dragging if you do not want to remove
the Attachment from the ‘source’ record.

Organising Attachments: Archives

When a record has many Attachments, you can organise them into Archives.
An Archive is a folder that can contain Attachments of all kinds, including
other Archives.

1. Open the list of Attachments.

2. Select ‘New Archive’ from the Operations menu. A new Archive will
appear at the top of the list of Attachments, named “Archive: New”.
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3. Move the Attachments into the Archive by dragging and dropping onto
“Archive: New”.

4. If you want to work with an Attachment that is in an Archive, double-
click the Archive. A new window is opened, listing the Attachments that
are in the Archive. This window has the same properties, features and
functions as the main list of Attachments, so you can work with it in the
manner described in the preceding sections.
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5. If you want to rename the Archive, first open it as described in step 4
above and then select ‘Rename Archive’ from the Operations menu.

Enter the new Name of the Archive and click [Save]. The new name will
replace the text “New,” both in the title bar of the Archive and in the
main list of Attachments—

6. You can remove an Attachment from an Archive in one of two ways. If
you want the Attachment to remain attached to the record, drag it to the
main list of Attachments or to another Archive. To remove the
Attachment altogether, click on it and select ‘Clear’ from the Edit menu.

7. To remove an Archive, click on it in the main list of Attachments and
select ‘Clear’ from the Edit menu. You can only remove empty
Archives. To empty an Archive, you must remove its contents item by
item as described in step 6 above.
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Personal Desktop

As well as being able to connect files, notes or records to any record in Hansa
(as described above), you can also attach them to your Master Control panel.
They will be listed in the area on the right of the Master Control panel,
known as the “Personal Desktop”. You can also list important reports,
documents, Maintenance functions, settings and registers in the Personal
Desktop. You can therefore configure your Personal Desktop so that it gives
you immediate access to the areas of Hansa that are most important to you
(i.e. removing the need to change modules, find records in browse windows
and find reports in list windows). The Personal Desktop is therefore similar to
a list of Bookmarks in a browser.

If you want to use the Personal Desktop, you must first set up a Mailbox for
yourself. This process is described in the ‘Mail’ chapter in Volume 6 of these
manuals. In a multi-user system, each user that will be using the Personal
Desktop should have their own Mailbox.

You must have a Mailbox if you want
to use the Personal Desktop.!
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Once you have a Mailbox, your name will be shown in the title bar of the
Master Control panel, and the contents of your Personal Desktop will be
listed in the area on the right—

Company identifier and
name of current user

Two Archives: used to ensure there is a
managable number of objects in the Personal

Desktop. Double-click to view contents

Double-click to
open individual

Invoice

Double-click to
open Invoice

register

Links to two reports, one
Maintenance function and one

document. Double-click to activate

The contents of your Personal Desktop cannot be viewed by another user. So.
if someone else logs in to Hansa on your machine using the [Login] button in
the Master Control panel, your Personal Desktop will disappear, to be
replaced with theirs.
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Records in your Personal Desktop

You can place records in your Personal Desktop using the following
methods—

1. By dragging the record from its browse window and dropping it on the
Personal Desktop. For example, to place a Customer record in the
Personal Desktop, open the ‘Customers: Browse’ window and find the
correct Customer in the list. Click on the Customer Number and drag it
to the Personal Desktop.

2. By opening the record and dragging its [Attachments] button onto the
Personal Desktop.

3. By opening the record and selecting ‘Send to Desktop’ from the Record
menu. The record should have been saved at least once before you use
this function (i.e. the title of the window should be ‘Inspect’ or ‘Update’,
not ‘New’).

Records are shown in the Personal Desktop with the name of the register
followed by the record identifier. In the illustration above, the final item
(“Invoice: 2016”) is an example (2016 is the Invoice Number).

The illustration also shows that the Personal Desktop can contain records
from different Companies. In the illustration, the current Company is
Company H (shown in the title bar of the Master Control panel, next to the
name of the current user). “H” is short for Holding Company in the example
database. The penultimate item in the Personal Desktop in the illustration
(“S: Invoice: 5015”) is an Invoice that belongs to Company S (a Subsidiary
Company). Any record that does not belong to the current Company will be
shown in the Personal Desktop with its Company Short Code before the
name of the register. So, in this example, if the current user were to quit
Hansa and restart, selecting Company S, then Invoice 2016 would appear in
the Personal Desktop as “H: Invoice: 2016” and Invoice 5015 would appear
simply as “Invoice: 5015”.

A record in the Personal Desktop can be opened in one of three ways—

1. By clicking on the record in the Personal Desktop and selecting ‘Open
Record’ from the Operations menu;

2. By clicking on the record in the Personal Desktop and selecting ‘OK’
from the Record menu (or pressing the Enter key); and

3. By double-clicking on the record in the Personal Desktop.

Whichever method is used, the record is opened in its own window where it
can be read or edited in the usual manner. If you choose to open a record that
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is not in the current Company, you will be asked to log in to the relevant
Company before the record is opened.

Settings, Reports, Documents and Maintenance functions in your
Personal Desktop

To place a setting, report, document or Maintenance function in your
Personal Desktop, simply open the appropriate list window and then drag an
item from the list to the Personal Desktop. This method can also be used for
import and export functions.

For example, to place the Open Inv Customer Statement in your Personal
Desktop (as shown in the example illustration above), first use the Modules
menu to enter the Sales Ledger and then select ‘Reports’ from the File menu
(or click [Reports] in the Master Control panel). Click on ‘Open Inv
Customer Statement’ in the list and drag this text to your Personal Desktop.

To work with a setting, report, document or Maintenance function, use one of
these methods—

1. Click on the item in the Personal Desktop and select ‘Open Record’ from
the Operations menu;

2. Click on the item in the Personal Desktop and select ‘OK’ from the
Record menu (or press the Enter key); and

3. Double-click on the item in the Personal Desktop.

Registers in your Personal Desktop

To place a register in your Personal Desktop, simply drag it from the Master
Control panel to the Personal Desktop. For example, to place the Invoice
register in your Personal Desktop (as shown in the example illustration
above), first use the Modules menu to enter the Sales Ledger. Click on the
[Invoices] button in the Master Control panel and drag it to your Personal
Desktop.

To work with a register, use one of these methods—

1. Click on the item in the Personal Desktop and select ‘Open Record’ from
the Operations menu;

2. Click on the item in the Personal Desktop and select ‘OK’ from the
Record menu (or press the Enter key); and

3. Double-click on the item in the Personal Desktop.

Whichever method is used, the normal browse window for the register in
question will be opened. If, as in the example illustrated above, the database
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contains more than one Company, the browse window will list the records in
the register in the current Company.

Notes and Comments in your Personal Desktop

You can place notes or comments in your Personal Desktop. To do this, bring
the Master Control panel to the front and select ‘New Note’ from the
Operations menu. A window will open, where you can type in your comment.

Click [Save] to save. The note will appear in your Personal Desktop with the
prefix “Note:”. If you want to identify the note with a name, refer to the
section below entitled ‘Changing the Names of Items in your Personal
Desktop’. You can place as many notes as you like in your Personal Desktop.

A note or comment that has been placed in the Personal Desktop can be read
in one of two ways—

1. By clicking on the note in the Personal Desktop and selecting ‘OK’ from
the Record menu; and

2. By double-clicking on the note in the Personal Desktop.

Whichever method is used, the note is opened in its own window where it can
be read or edited.



Hansa Financials and HansaWorld

148

Changing the Names of Items in your Personal Desktop

When a file is placed in your Personal Desktop, its file name will be shown in
the list of attachments. When a note is placed in your Personal Desktop, it is
not immediately given its own name in the list.

If you want to rename a file or note, highlight it in your Personal Desktop and
select ‘Edit Link Comment’ from the Operations menu. A window opens
where you can type in a new name.

Click [Save] to save and close the window, or [Cancel] if you don't want to
save changes.

Removing Items from your Personal Desktop

To remove an item of any kind from your Personal Desktop, highlight it and
select ‘Clear’ from the Edit menu.

Organising Items from your Personal Desktop: Archives

When you have many items in your Personal Desktop, you can organise them
into Archives. An Archive is a folder that can contain Attachments of all
kinds, including other Archives.

1. Bring the Master Control Panel to the front by clicking on it, by using
the Ctrl-M/z-M keyboard shortcut or by selecting ‘Master Control’
from the File menu.

2. Select ‘New Archive’ from the Operations menu. A new Archive will
appear at towards the top of the Personal Desktop, named “Archive:
New”.
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3. Move the relevant items into the Archive by dragging and dropping onto
“Archive: New”.

4. If you want to work with an item that is in an Archive, double-click the
Archive. A new window is opened, listing the items that are in the
Archive. This window has the same properties, features and functions as
a list of Attachments, so you can work with it in the manner described in
the ‘Attachments’ section above.
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5. If you want to rename the Archive, first open it as described in step 4
above and then select ‘Rename Archive’ from the Operations menu.

Enter the new Name of the Archive and click [Save]. The new name will
replace the text “New,” both in the title bar of the Archive and in the
Personal Desktop—
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6. You can remove an item from an Archive in one of two ways. First, you
can drag it to the Personal Desktop or to another Archive. Otherwise, to
remove the item altogether, click on it and select ‘Clear’ from the Edit
menu.

7. To remove an Archive, click on it in the Personal Desktop and select
‘Clear’ from the Edit menu. You can only remove empty Archives. To
empty an Archive, you must remove its contents item by item as
described in step 6 above.
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Keyboard Shortcuts
Menu Function Windows/Linux Macintosh

File Menu Company Ctrl-O z-O
Master Control Ctrl-M z-M
Exports Ctrl-E z-E
Imports Ctrl-Shift-I z-Shift-I
Reports Ctrl-R z-R
Documents Ctrl-D z-D
Settings Ctrl-S z-S
Print (Printer Icon) Ctrl-P z-P
Print Queue z-T
Quit Ctrl-Q z-Q

Edit Menu Undo Ctrl-Z z-Z
Cut Ctrl-X z-X
Copy Ctrl-C z-C
Paste Ctrl-V z-V
Select All z-A
Select Row z-H

Record Menu Next ([4] button) PgDn z-+
Prev ([3] button) PgUp z--
OK ([Save], [Run] buttons) Shift-Enter Shift-Enter
Cancel ([Cancel] button) z-B
New ([New] button) Ctrl-N z-N
Duplicate ([Duplicate] button) Ctrl-K z-Y
Delete z-Shift-D
Attachments z-Shift-A

Registers Menu Ctrl-1 to 8 z-1 to 8

Window Menu Save Normal Position z-Shift-S
Restore Normal Position z-Shift-T

Browse Window Sort Column Ctrl-Shift- z-Alt-
-highlighted letter

Record Window OK check box on/off Ctrl-Shift-O z-Alt-O
Paste Special Ctrl-Return z-Return

Other Modify Linked Record F2 z-Shift-V
Close Window Ctrl-F4 z-W
Close All Windows Use Window menu Alt-Close Box
Change Window Ctrl-Tab z-Shift-N
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Chapter 3: Accounting Principles
Managing your own business is often a rewarding undertaking, but with it
come a number of obligations. One is the requirement to keep your accounts
up to a certain standard. The legal requirements differ with the type of
business and the country of operation, but regardless of these there can be
great advantages in having your books in order. In this chapter some of the
basic concepts used in accounting, and their integration into Hansa, are
described.

Internal and External Documents
There are two basic types of documents produced by an accounting system:
external and internal documents. External documents, such as invoices,
payment vouchers, VAT reports and tax returns, are produced because
someone outside the business needs them. These are termed ‘Documents’ in
Hansa. Internal documents are used inside your company to make decisions
about different things. Examples are price information, sales statistics, credit
limits, payment forecasts etc. These are termed ‘Reports’ in Hansa.

Accounting material should be handled with care. You need the information
it provides to control and to develop your business, and you are also required
by law to keep it up to date and archived in a certain way.

Both the reports handed in to authorities, banks etc. and those you make for
your own use are based on a basic series of transactions. The records of these
basic transactions (sales invoices, cash ledger vouchers, purchase invoices,
bank statements, personnel records and loans) are found among the
documents of any business.
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Transaction Records
A transaction record is the proof of a transaction, e.g. a receipt for something
you have bought, or a bank statement showing that an invoice has been paid
by one of your customers. Every event in the business that involves its
finances should be supported by a transaction record.

All financial events should be recorded in date order as they occur. When
each event is recorded in the accounts, a transaction is created. The
transaction classifies the event according to certain accounting rules,
allowing the production of reports and the later recollection of the event.
Transactions are recorded in a daily journal and each is distinguished by a
unique sequence number. Their supporting documents (the hard copies of the
transactions) are kept in a file, marked with the same sequence numbers (and
with the date on which the transaction occurred). The transaction should also
contain a code, or account, classifying its nature. This is where your Chart of
Accounts comes in as a tool for the systematic recording of financial events.

Transactions in Hansa

Hansa features a high level of integration between  the different modules and
the Nominal Ledger, where all transactions are recorded.

Whenever a transaction is processed in Hansa’s Sales or Purchase Ledger, an
equivalent Nominal Ledger Transaction is normally created automatically.
For example, when an Invoice is approved and sent to a Customer, a Nominal
Ledger Transaction is created automatically to post amounts to the Sales,
Debtor and VAT Accounts. Simultaneously, the Sales Ledger and all reports
are updated. Similarly, when a payment is received, the Sales Ledger is
updated, and a Nominal Ledger Transaction updates the Debtor Account and
the Bank or Cash Account as appropriate. In general terms, a record that
causes a Nominal Ledger Transaction to be created (e.g. an Invoice or Stock
Movement) is usually referred to as a “sub system record” or “sub system
transaction” in Hansa and in these manuals.
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Hansa
Integration

Nominal Ledger

Sales Ledger Purchase Ledger

Stock

Through a large number of settings and parameters, the user can set up the
accounting environment so that the correct Sales Accounts, cost centres, Cost
Accounts etc. are updated when necessary. The level of automation available
is extensive, but Hansa also allows full manual control over the accounting
environment. By default, when Hansa is installed, full integration is made
available, but this can be partially or wholly switched off as required.

Below are described some of the more common sub system transactions.

Sales Invoices

Invoices are demands for payment sent to Customers. They are created
(‘raised’) in the Sales Ledger, which is also used to keep a record of how
much is owed to your business by whom. The raising of an Invoice causes a
Nominal Ledger Transaction to be created which debits the Debtor Account
(which keeps a tally of how much your company is owed), credits a Sales
Account (it is normal practice to maintain more than one Sales Account to
keep a record of the sales of different types of product) and, in most cases,
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credits a VAT Account. Once Invoices have been raised in the Sales Ledger,
the creation of the Nominal Ledger Transaction is handled automatically in
Hansa. Below is shown a typical such Transaction.

Hansa has a number of methods whereby the Accounts used in this
Transaction can be chosen to reflect the accounting needs of different
situations. The Debtor Account can be set according to the Customer or
Customer Category, different Sales Accounts can be used for the various
Item Groups or individual Items, and the VAT Account can be controlled
through the VAT Code. In addition, Hansa can post to the Stock and Cost
Accounts. The number of options is great, and they are described in detail in
this section.

Each individual Invoice, when approved, determines how the consequent
Nominal Ledger Transaction is to be structured. The Accounts used are
chosen as follows—

Sales Account

The Sales Accounts in the Nominal Ledger are used to record the levels of
sales of different types of Items. To determine which Account is to be used,
clicking flip B when entering Invoices reveals that a Sales Account can be
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specified for each row (in the column marked ‘A/C’). Different Invoice rows
can have different Sales Accounts.

When adding rows to an Invoice, Hansa places a default Sales Account in the
A/C field. This default can be overwritten by the user. It is chosen as
follows—

1. When an Item Code is entered, if there is a Price List shown on the
‘Delivery’ card of the Invoice and there is a record in the Price register
for that Item/Price List combination, Hansa takes the Sales Account from
there. If this Sales Account is blank, or there is no appropriate record in
the Price register—

2. Hansa uses the Sales Account for the relevant Item (taken from the Item
register). If this is blank—

3. Hansa uses the Sales Account from the Item Group specified for the
Item. If this is blank, or if no Item Group has been specified for the Item,
or if no Item Code has been entered to the Invoice row—

4. Hansa uses the Sales Account entered in the Account Usage S/L setting
for the zone to which the Customer belongs. There are three zones
(Domestic, EU and Export), and each can have a different Sales
Account.

If the selected Account is missing from the Chart of Accounts, Hansa will
display the error message: “Sales Account missing, check Account Usage
S/L”.

VAT Account

When entering Invoices, a VAT Code can be specified for each row. This
code refers to a specific VAT Code record, which controls which VAT
Account will be used by the subsequent Nominal Ledger Transaction (and
also the rate at which VAT will be charged). VAT Code records are set up
using the VAT Codes setting in the Nominal Ledger.

When entering Invoice rows, the VAT Code field (marked ‘V-Cd’, visible on
flip B) may not be left blank. Hansa places a default in the field, chosen as
follows—

1. The VAT Code is taken from the Customer register. Usually, you should
only specify a VAT Code for an individual Customer if for some reason
your usual VAT accounting method does not apply to them. If this is
blank—

2. When an Item Code is entered, Hansa uses the VAT Code entered for the
relevant Item in the Item register. If this is blank—
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3. Hansa uses the VAT Code from the Item Group specified for the Item. If
this is blank, or if no Item Group has been specified for the Item, or if no
Item Code has been entered to the Invoice row—

4. Hansa uses the VAT Code entered in the Account Usage S/L setting for
the zone to which the Customer belongs.

If the selected VAT Code is missing from the VAT Codes setting, Hansa will
display the error message: “Code not registered”.

Debtor Control Account

When generating a Nominal Ledger Transaction from an Invoice, the Debtor
Account used is not determined from the Invoice itself (unlike the Sales and
VAT Accounts described above). Instead, it is determined as follows—

1. A Debtor Account can be specified for the Customer Category to which
the Customer belongs. If this is blank, or if no Customer Category has
been specified—

2. Hansa uses the Debtor (or, if the Invoice is a cash Invoice, the Cash)
Account entered in the Account Usage S/L setting.

3. If the Customer is marked as an “On Account” Customer and the Invoice
has been allocated to an “On Account” Receipt, the On Account A/C
entered in the Customer Category or the Account Usage S/L setting (in
order of priority) will be used.

If the Account reference used refers to a non-existent Account, Hansa will
display the error message: “Debtor Account missing, check Account Usage
S/L”.

Stock Account and Cost Account

When goods are sold from stock, Hansa can generate Nominal Ledger
postings for the cost of goods, and for the stock outtake (‘Cost Accounting’).
This can be determined to occur when Invoices are approved or when
Delivery Notes are approved.

For cost accounting transactions to take place, the Items concerned must be
stocked Items. If cost accounting transactions are set to be created when
Invoices are approved, this will mean that, in addition to posting to the Sales,
VAT and Debtor Accounts, Nominal Ledger Transactions generated from
Invoices will debit the specified Cost Account and credit the specified Stock
Account. Further settings controlling the operation of cost accounting are
discussed in the ‘Stock Module’ chapter in Volume 3 of this manual.
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The Cost of Goods Account debited by such transactions is determined as
follows—

1. If the Use Item Groups for Cost Accounts option is off, the Cost Account
for the Item is used. This option is to be found in the Cost Accounting
setting in the Stock module. If it is in use, the Cost Account specified on
the ‘A/C’ card of the Item Group to which the Item belongs is used.

2. In all other circumstances (e.g. the Cost Account for the Item or Item
Group is blank), the Stock Cost Account specified on card 5 of the
Account Usage S/L setting is used.

The Stock Account credited by such transactions is determined as follows—

1. The Stock Account specified for the stock Location is used. If this is
blank, or if no stock Location is specified—

2. If the Use Item Groups for Cost Accounts option is on, the Stock
Account specified on the ‘A/C’ card of the Item Group record is used.

3. In all other circumstances, the Stock Account specified on card 5 of the
Account Usage S/L setting is used.

Various models are available by which the value of the cost accounting
transaction can be calculated (for example, cost price, FIFO price, weighted
average cost price). A different cost model can be used for each Item Group,
or a single default cost model can be used. Full details can be found in the
section describing the Cost Model setting in the ‘Sales Ledger’ chapter in
Volume 2.

If any of the Account Numbers refers to a non-existent Account, Hansa, in
attempting to generate the Nominal Ledger Transaction,  will display the error
message: “Transaction could not be generated. Check settings”.

Round-off Account

If Hansa’s option for rounding the Invoice amount to the nearest monetary
unit (Euro, Pound etc.) is used, a Round-off Account must be entered in the
Account Usage S/L setting. To switch this option on, use the Round Off and
Currency Round Off settings in the System module.

Receipts

When a Customer makes a payment against an Invoice, the transaction is
known as a Receipt. In the Nominal Ledger, the raising of a Receipt credits
the Debtor Account and debits the Bank or Cash Account. As with Invoices,
Receipts are usually entered in the Sales Ledger, where they are allocated
against the appropriate Invoice(s), and the consequences in the Nominal
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Ledger are handled automatically. Normally, a Receipt will generate a
Nominal Ledger Transaction like this—

In generating Nominal Ledger Transactions from Receipts, the Accounts
used are selected as follows.

Debtor Control Account

The Debtor Control Account for the Invoice being paid will be transferred to
the Receipt. For details of how this is calculated, please refer to the ‘Debtor
Control Account’ section under ‘Sales Invoices’ above.

If the Receipt is not allocated against a specific Invoice (i.e. it is an ‘On
Account’ Receipt) , the On Account A/C entered in the Customer Category or
the Account Usage S/L setting (in order of priority) will be credited.

Bank or Cash Account

The Cash or Bank Account posting will be determined from the Payment
Modes setting, available in the Sales and Purchase Ledgers. This is used to
store different payment methods, such as cheque, cash, credit card. Each
payment method can be attached to a different Account, perhaps reflecting
the usage of different bank accounts for each type of payment.
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If a payment is received in a foreign currency, the Rate Loss, Rate Gain and
Rate Round Off Accounts will be used. Cash discounts will be booked to the
relevant Cash Discount Accounts, and write-offs from the Sales Ledger will
use the Write Offs Account. All these accounts are specified in the Account
Usage S/L setting.

If any of the Account Numbers refers to a non-existent Account, Hansa, in
attempting to generate the Nominal Ledger Transaction,  will display the error
message: “Transaction could not be generated. Check settings”.

Purchase Invoices

A Purchase Invoice is a demand for your company to make a payment. It will
usually be recorded in the Purchase Ledger, which is used to monitor these
invoices and to record payments against them. The Purchase Ledger allows
you to find out how much money you owe to your creditors, and you can use
it to make a forecast of future payments.

Most transactions in the Purchase Ledger mirror similar transactions in the
Sales Ledger. Therefore, as with a Sales Invoice, a Nominal Ledger
Transaction created from a Purchase Invoice will normally affect three
Accounts: the Creditor Account will be credited, a Purchase Account will be
debited and, in most cases, the VAT Account will also be debited. Defaults
for the Accounts affected are taken from the Account Usage P/L setting, and
they are selected according to the priority rules described below.
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Purchase Account

The Purchase Accounts in the Nominal Ledger are used to record the levels
of purchases of different types of Items. To determine which Account is to be
used, when entering Purchase Invoices, a Purchase Account should be typed
in to each row (in the column marked ‘A/C’). Different rows can have
different Purchase Accounts.

When adding rows to a Purchase Invoice, Hansa can in some instances offer
a default Purchase Account in the A/C field, taken from the Cost Account
specified on the ‘Accounts’ card of the Supplier record. You might specify
such a default for Suppliers of services (such as electricity or telephone
services), whose Purchase Invoices are always posted to the same Account.

When Purchase Invoices are created from Purchase Orders, the Purchase
Account for each row will depend on the set of Purchase Order Item Transfer
Control options in the Purchase Invoice Settings setting in the Purchase
Ledger. These options operate in the following manner—

Consolidate Items to Supplier Cost Account

The ordered Items are grouped together on a single row
on the Invoice indicating that they are to be posted to the
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same Cost Account (taken from the Cost Account on the
‘Accounts’ card of the Supplier record). If the Items on
the Purchase Order have different VAT Codes, there will
be a separate row on the Invoice for each VAT Code.

Consolidate by Items and Project

The Purchase Invoice will feature a separate row for
each received Item/Project combination on the Purchase
Order. The Cost Accounts will be the Purchase Control
Account for the Item Groups to which the Items belong
(if the Use Item Groups for Cost Accounts option in the
Cost Accounting setting in the Stock module is in use) or
that on card 5 of the Account Usage S/L setting.

Transfer Each Row Separately

Each ordered Item will have its own row on the Invoice.
The Cost Accounts will be the Cost Account on flip B of
the Purchase Order, the Purchase Control Account for
the Item Groups to which the Items belong (if the Use
Item Groups for Cost Accounts option in the Cost
Accounting setting in the Stock module is in use) or that
on card 5 of the Account Usage S/L setting.

VAT Account

When entering Purchase Invoices, a VAT Code must be specified for each
row. This code refers to a specific VAT Code record, which controls which
VAT Account will be used by the subsequent Nominal Ledger Transaction
(and also the rate at which VAT will be charged). VAT Code records are set
up using the VAT Codes setting in the Nominal Ledger.

When entering Purchase Invoice rows, the VAT Code field (marked ‘V-Cd’)
may not be left blank. The default is placed in this field as follows—

1. Hansa uses the VAT Code specified in the Supplier register. If this is
blank—

2. Hansa uses the VAT Code specified for the Account. If this is blank—

3. The VAT Code specified in the Account Usage P/L setting is used.

Although VAT Codes can be specified for both Suppliers and Accounts (as
described in points 1 and 2 above), it is important you do not mix these
methods of setting default VAT Accounts.

If the selected VAT Code is missing  from the VAT Codes setting, Hansa will
display the error message: “Code not registered”.
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Creditor Control Account

When generating a Nominal Ledger Transaction from a Purchase Invoice, the
Creditor Account is determined as follows—

1. Hansa uses the Purchase Ledger Control Account specified in the
Supplier record. If this is blank—

2. A Creditor Account can be specified for the Supplier Category to which
the Supplier belongs. If this is blank, or if no Supplier Category has been
specified—

3. Hansa will use the default Creditor (or, if the Invoice is a cash Invoice,
the Cash) Account entered in the Account Usage P/L setting.

4. If the Supplier is marked as an “On Account” Supplier and the Invoice
has been allocated to an “On Account” Payment, the On Account A/C
for the Supplier, the Supplier Category or that entered on card 2 of the
Account Usage P/L setting (in order of priority) will be used.

5. If the Prel. Book check box on the Purchase Invoice is switched on, a
preliminary creditors account will be used, taken from the Account
Usage P/L setting. When the Purchase Invoice is finally approved, this
preliminary transaction will be replaced with a final transaction, using
the correct Creditor Account determined as above.

Note: the Creditor Account selected following steps 1-3 above is displayed
on the ‘Other’ card of the Purchase Invoice, where it can be replaced with an
ad hoc Account if necessary.

If any of the selected Accounts is missing from the Chart of Accounts, Hansa
will display the error message: “Creditor Account missing. Check Account
Usage P/L” or, if step 5 above applies, “Preliminary Account not found,
check Account Usage P/L”.
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Payments

A Payment is the Purchase Ledger equivalent of a Receipt: it is the
transaction which occurs when you pay a supplier’s Purchase Invoice. In the
Nominal Ledger, the raising of a Payment debits the Creditor Account and
credits the Bank or Cash Account. Payments are usually entered in the
Purchase Ledger, where they are allocated against the appropriate Invoice(s),
and the consequences in the Nominal Ledger are handled automatically.
Normally, a Payment will generate a Nominal Ledger Transaction like this—

In generating Nominal Ledger Transactions from Payments, the Accounts
used are selected as follows.

Creditor Control Account

The Creditor Control Account for the Purchase Invoice being paid will be
transferred to the Payment. For details of how this is calculated, please refer
to the ‘Creditor Control Account’ section under ‘Purchase Invoices’ above.

If the Payment is not made against a specific Purchase Invoice (i.e. it is an
‘On Account’ Payment), the On Account A/C entered in the Supplier
Category or the Account Usage P/L setting (in order of priority) will be
debited.
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Bank or Cash Account

The Bank or Cash Account posting will be determined from the Payment
Modes setting, available in both the Sales and Purchase Ledgers. This is used
to store different payment methods, such as cheque, cash, credit card. Each
payment method can be attached to a different Account, perhaps reflecting
the use of different bank accounts.

If a payment is received in a foreign currency, the Rate Loss, Rate Gain and
Rate Round Off Accounts will be used. Cash discounts will be booked to the
relevant Cash Discount Accounts. All these accounts are specified in the
Account Usage P/L setting.

If any of the Account Numbers refers to a non-existent Account, Hansa, in
attempting to generate the Nominal Ledger Transaction,  will display the error
message: “Transaction could not be generated. Check settings”.

Expenses

The Expenses module functions as a creditors/debtors ledger for employees.
Advances and settlements are recorded for each individual, and Hansa
generates transactions for each event. To use the Expenses ledger, each
Person must be assigned an account in the Nominal Ledger. Normally, one
Account will be used for all employees, the individuals being separated with
the help of Objects (see below). Its Account Number is entered on the
‘Bonus’ card of each Person record. Expenses are booked in exactly the same
manner as in the Purchase Ledger, and advances or settlements are recorded
in a similar manner to Payments.

Credits and Loans

Most companies have one or more loans, and you must keep records of the
management of the loans, i.e. interest payments, instalments etc.

Stock

In every business where stocks are kept, there are by necessity differences
between recorded stocks, physical stocks and stock values, for the simple
reasons that things break or disappear or that mistakes are made in shipping,
recording etc. In Hansa, stock values are kept both in the Stock module and
as Account balances in the Nominal Ledger. To have absolute agreement
between FIFO stock levels and Nominal Ledger Stock Account balances is
very difficult, and every business must decide for itself how important it is to
minimise differences. There is a price to be paid for precision. The smaller
the tolerance for errors, the greater the control apparatus will be, and the
greater the cost. There is a trade-off of control costs against precision that
every company must decide for itself.
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The Stock module contains separate registers for Goods Received, Deliveries,
Stock Movements (internal stock transfers between Locations) and Stock
Depreciations. Whenever you enter and approve a new record in any of these
registers, the physical stock levels of the Items involved and the stock
valuation in the Nominal Ledger are both updated automatically. In the
second case, each stock record causes a Nominal Ledger Transaction to be
generated, thus updating the stock valuation in the Nominal Ledger. Stock
levels and valuations can also be updated automatically from Invoices.

Hansa’s Stock module basically uses the FIFO (‘First In First Out’)  principle
for stock calculations. Illustrated below is an example Goods Receipt,
recording the arrival of three units of Item 10118 into stock at a price of 4.00
each—
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This is the Nominal Ledger Transaction generated by the Goods Receipt,
which updates the stock valuation in the Nominal Ledger with the value of
the goods received into stock—

When goods are received, the Stock Account is debited with the cost of
goods, and a Creditor Suspense Account (usually given the term “Purchase
Control Account” in these manuals) is credited until the Purchase Invoice
arrives. The Stock Account used is that specified in the Locations setting in
the Stock module or, if that is blank, the Stock Account specified on card 5 of
the Account Usage S/L setting.
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Depending on local accounting conventions, purchase costs, VAT, freight
and customs costs can be added to the stock value in the Goods Receipt
record, or left out until the Purchase Invoice arrives. If they are added at the
time of receipt into stock, their values will be added to the Stock Account,
and credited against the Freight and Customs Cost Accounts specified on
card 5 of the Account Usage S/L setting—

The FIFO value of each Item is the value entered in the relevant Goods
Receipt, and you can decide which valuation method (e.g. FIFO, Cost Price,
Weighted Average) you want to use. After receiving two more shipments of
Item 10118 into stock, the Stock List report illustrated below provides a stock
valuation using the individual FIFO values from the relevant Goods
Receipts—
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When goods are sold, stock balances are reduced and the Stock Account is
credited. Normally Hansa will use the FIFO value for crediting stock and for
debiting a Cost of Goods Account.

In the following example, we will sell and ship all 26 units of Item 10118. In
the Delivery record that records this shipment, the total FIFO value of these
26 units is placed automatically in the Row FIFO field on flip C—
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This total FIFO value will be the figure credited to the Stock Account and
debited to the Cost of Goods Account in the Nominal Ledger Transaction
created when the Delivery is approved—
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The Item History report in the Stock module shows that this total FIFO value
is calculated using the average FIFO value per unit of the Items sold—

In this case, because we sold our entire stock, there is no difference between
the stock value and the Stock Account value.

In the following example, we have received into stock twenty units of Item
10119 using two separate Goods Receipt records. The first Goods Receipt
shows that ten units were purchased at a price of 8.00 per unit, and the second
shows that ten were purchased at a price of 9.00 per unit—
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We will deliver 12 units of Item 10119. In the Delivery record, their total
FIFO value is shown on flip C to be 98.00 (i.e. 8.1667 per unit)—
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Again, this total FIFO value will be the figure credited to the Stock Account
and debited to the Cost of Goods Account in the Nominal Ledger Transaction
created when the Delivery is approved—

The price per unit in the Delivery and consequent Nominal Ledger
Transaction in this example is calculated on a strict FIFO basis. This dictates
that the units shipped were all ten of those purchased at the earlier price (8.00
per unit) and two of those purchased at the later price (9.00), as follows—

   (10 x 8) + (2 x 9)    = 8.1667
12
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This is shown when the Item History report is recalculated after the Delivery
has been made—

The Stock List now values the remaining eight units at 9.00 each, the
purchase price per unit in the second Goods Receipt record—

In Hansa, Deliveries are always created from Orders. Included in each Order
record (in the bottom left-hand corner) is a Gross Profit figure. This is
calculated using the standard Cost Prices of the Items on the Order, not their
FIFO values. In this example, the standard Cost Price per unit of Item 10119
is 10.00—
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This Cost Price is also used in the GP, Orders report in the Sales Orders
module—
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You can have the standard Cost Price of each Item updated to be the last
actual purchase price (the one used in the most recent Goods Receipt record).
This can be done using two methods—

1. The Stock module contains an ‘Update Item Cost Price’ Maintenance
function. This is not an automatic function: it is your decision whether
and when to use it. Each time you run this function, it will transfer the
last purchase price to the Cost Price field of each Item record.

2. If you would like the Cost Price of an Item to be updated automatically
with the latest purchase price each time a Goods Receipt is entered and
approved, use one of the Update Cost Price At Purchase options in each
Item record (‘Costs’ card).

In the example above, the Gross Profit of the Order would have been reduced
by 12 if the Cost Price of Item 10119 had been updated using either method
before the Order record was created.
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Chart of Accounts
Accounts are the Nominal Ledger headings by which you classify all
financial transactions: each Nominal Ledger Transaction described above
posts to two or more Accounts. In fact each Nominal Ledger Transaction can
be defined by which Accounts these are. The organisation of these Accounts
is known as a ‘Chart of Accounts’: a systematic list of how assets, liabilities,
income and expenses are to be classified and thus the basis for your
accounting reports. The logic used in the classification determines the
usefulness of your reports, and the drawing up of a satisfactory Chart of
Accounts requires careful consideration.

In designing a Chart of Accounts, it is usual practice to group Accounts
together according to type. For example, all Sales Accounts should have
similar codes, different Bank Accounts should have similar codes and so on.
This will ensure that they appear together in reports. Room should be left so
that new Accounts, the need for which is currently unforeseen, can be
inserted in the right place. If your business develops into new products, for
example, you should be able to create Sales Accounts for those new products
with similar codes to the existing Sales Accounts.

In traditional accounting systems, the Chart is divided into account classes,
following a decimal classification. Two or three classes are reserved for
Balance Sheet Accounts, one class is normally reserved for internal
accounting and year-end operations, and the remaining five or six classes are
used for revenue and cost classification.

Typical Charts of Accounts, including that supplied as a template with Hansa,
follow the model illustrated below. The Accounts are usually divided into
two groups, named after the report in which they appear.

Profit & Loss This report shows the trading profit or loss of your
business, usually at the end of a month or year.

Balance Sheet This report shows the assets, liabilities and capital of
your business at the moment of printing.
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Balance Sheet

Profit & Loss (P & L)

Account
Type

Account
Number
Range

Description

Income100-199Sales

Expense200-299Cost of Sales

Gross Profit = Sales - Cost of Sales

Expense300-599Overheads

Net Profit = Gross Profit - Overheads

Asset600-699Fixed Assets

Asset700-799Current Assets

Liability800-899Current Liabilities

Liability900-949Long Term Liabilities

Net Current Assets = Current Assets  - Current Liabilities

Total Net Assets = Fixed Assets  + Net Current Assets - Long Term Liabilties

Hansa

Sample Structure of Chart of Accounts

Equity950-999Equity

IncomeNet Profit
from P & L

Profit/Loss Year To Date

Total Net Assets = Equity + Profit/Loss Year To Date

Your Chart of Accounts should be
drawn up in consultation with your
accountant or financial adviser.

Objects

In traditional cost accounting, the classification of expenditure and the
allocation of different expenses to departments, products, regions etc. is a
well known problem area. In essence, there is a need to present management

!
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reports in several different views or dimensions. Normally, there are three
basic dimensions used in the accounting of any business—

• The KIND of income or expense - material, labour, transport, telephone
etc.

• The COST CENTRE, i.e. the department or organisational unit that
carries the responsibility for incurring the expense or realising the
revenue.

• The COST BEARER, normally the output, product or service produced.

In some businesses, there is a requirement to add further dimensions that are
not subdivisions of the above, such as geographical areas.

Conceptually, the accounting situation can be described as a three-
dimensional table—

Products

Unit B

   

  

 

 
 

 

  -

    

Revenue
Sales 100
less Discounts -10
Net Sales 90

Costs
Material -12
Labour -13

GP 65

Sales & Distribution -18
Marketing -8

GP2 49

 
 

   

 
 

Unit C Unit D TotalUnit A

Cost Centres

Cars

Trucks

Buses

Other

Total

Revenue

Sales 100
less Discounts -10
Net Sales 90

Costs
Material -12
Labour -13

GP 65

Sales & Distribution -18
Marketing -8

GP2 49

Revenue

Sales 100
less Discounts -10
Net Sales 90

Costs
Material -12
Labour -13

GP 65

Sales & Distribution -18
Marketing -8

GP2 49

Revenue

Sales 100
less Discounts -10
Net Sales 90

Costs
Material -12
Labour -13

GP 65

Sales & Distribution -18
Marketing -8

GP2 49

Revenue

Sales 100
less Discounts -10
Net Sales 90

Costs
Material -12
Labour -13

GP 65

Sales & Distribution -18
Marketing -8

GP2 49

Revenue

Sales 100
less Discounts -10
Net Sales 90

Costs
Material -12
Labour -13

GP 65

Sales & Distribution -18
Marketing -8

GP2 49

Revenue

Sales 100
less Discounts -10
Net Sales 90

Costs
Material -12
Labour -13

GP 65

Sales & Distribution -18
Marketing -8

GP2 49

Revenue

Sales 100
less Discounts -10
Net Sales 90

Costs
Material -12
Labour -13

GP 65

Sales & Distribution -18
Marketing -8

GP2 49

In traditional accounting systems, the classification is done with the help of
the Chart of Accounts. The Chart is divided into account classes, following a
decimal classification. Two or three classes are reserved for Balance Sheet
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Accounts, one class is normally reserved for internal accounting and year-end
operations, and the remaining five or six classes are used for revenue and cost
classification.

A Chart of Accounts is a    list    of Accounts. By definition it is one-dimensional.
Through various means, the Accounts are divided into sub-classes down one
or more levels, and the result is a hierarchical tree structure of classifications.

Revenues

Sales Rev.

Unit A

Unit B

Vehicles

Cars

Trucks
Other Rev.

Sales of Assets

Capital Rev.

Costs

Manuf. Costs

Unit A

Unit B

Car Costs

Material

Labour
Sales Costs

Unit A

Unit B
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A result of the hierarchical tree structure classification is inevitably that cost
type, profit centre and cost bearer classifications are scattered all over the
Chart of Accounts. This makes the description of reports complicated and
cumbersome, since data will have to be picked up individually from many
different Accounts, in order to produce different types of “Functional” result
reports.

To simplify the structure many accounting systems subdivide the “account
string” into different parts, each indicating cost type, department, project,
product etc. This is only a half-way solution. The only logically viable
solution to truly multi-dimensional accounting is to use an “Object”
classification in each accounting transaction. With this method, the Chart of
Accounts contains account specifications for the   kind   of revenue,
expenditure, asset, liability or equity. Each accounting transaction consists of
an Account Number, an amount, a date, and one or more Object
classifications. In the example above, a wages payment for trucks in Unit C
would contain the following information—

Number 970001

Date 010198

Account 5102 Wages

Text “Any written description”

Amount Debit 15420.25

Objects Unit C, Trucks

With this classification, it will be simple to show all transactions entered for a
separate product, unit and cost type, or to show a profit and loss statement for
a particular section of the business.

In the following section we will show how Hansa deals with this task.

Objects in Hansa

Hansa supports the use of Objects, to allow your accounts to be classified and
reported in several different categories or dimensions. Up to 30 Objects can
be assigned to a row in a transaction: the Object field can contain up to 60
characters. When entering Objects, each Object Code is separated by a
comma. It is recommended that Object Codes with at least two characters are
used, placing a more usual limit of 20 Objects on each transaction row.

You can assign default Objects to Customers, Items, Suppliers, individual
Invoices and Nominal Ledger entries. When an Object is assigned to a
Customer, for example, Hansa will automatically assign that Object to all
Nominal Ledger Transactions generated by Invoices made out to that
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Customer. This gives you excellent possibilities to report for example sales
per Object. In general, Objects are tools to improve the internal cost
accounting capabilities in your business. You can use Objects in
Autotransactions to create automatic cost distributions to products or profit
centres for certain cost types.

Objects may be used as selection criteria in many reports. For example, if you
have several profit centres in your business, and use Objects to separate
income and expenditure for each of these, you may produce separate profit
and loss statements for each profit centre. You can also print a Nominal
Ledger report that is restricted to a particular Object. The report will then
only show the transactions for each Account that have been classified with
the selected Object.

All objects in Hansa can span several years. This is a consequence of Hansa’s
continuous database, where the end of year is simply a user-defined reporting
interval. The Object balances are thus automatically transferred from one
fiscal year to the next. This gives you the ability to keep track of the budget
and results of an Object (e.g. a building project) for several years.

An Object can also be closed, to prevent further postings to it. Working in the
Object register (in the Nominal Ledger or the System module), switch on the
Closed check box to close it. If you want to open the Object again later, you
simply click in the box again to remove the check.

It is a good idea to experiment with the Objects, Object Types and the various
reports.
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Examples

The following Nominal Ledger Transaction shows the result of a Sales
Invoice, where the Customer belongs to the “Unit A” Object and the Items
belong to the “Cars” and “Trucks” Objects respectively. Each Item and
Customer have thus been assigned an Object reflecting their position in the
table illustrated at the beginning of this section.

The two Profit & Loss reports illustrated overleaf show the Income Statement
for two of the journal postings: those with the Object combinations “Unit A
& Cars ” and “Unit A & Trucks”, respectively. Some cost transactions have
been added to make the example more complete.
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With a careful use of Object and Account definitions, Hansa allows you to
allocate revenues and expenses in a logical way, in order to reveal the
profitability pattern in the business. Most of the assigning of Objects is done
automatically. Objects assigned to Customers, Suppliers and Items are
automatically transferred to the Nominal Ledger Transactions.

Object Types

Objects that belong to the same type, e.g. departments or products, can be
grouped together as Object Types. Several reports in Hansa can be produced
for an Object Type.

In our example we have created the Object Types “PRODS” and “UNITS”
(using the Object Types setting in the Nominal Ledger).
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The following Objects are defined for the three Object Types—

All invoiced sales are recorded with an Object of the “LAND” Object Type
(representing their country of origin). Here, we produce a Profit and Loss
report for the “LAND” Object Type—

Similarly, ordering a report for an individual Account (the Nominal Ledger
Report) and for one Object Type will list only Transactions for that Object
Type. The Balance Sheet for the “LAND” Object Type will summarise the
accounts receivable per country.
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Hierarchical Objects

In order to simplify the assigning of Objects, hierarchical Objects can be
used. It is possible to define a new Object that consists of a string or sequence
of Objects as in the following example—

When you enter a Nominal Ledger Transaction using the “STRA” Object, it
will be replaced by the string of Objects in the Hier. Objects field. In the
example below, the “STRA” Object has just been entered.
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As soon as you press the Tab key, the string of Objects from the definition
will replace the Object typed—

This expansion of the hierarchical Object does not take place on screen when
assigning Objects to a particular Invoice, Customer or Item, but it does take
place when a Nominal Ledger Transaction is generated using that Invoice,
Customer or Item. Therefore, whenever you look at the Invoice, you will see
“STRA” in the example above, but when you look at the consequent Nominal
Ledger Transaction you will see the full Object string. Note that the
hierarchical “STRA” Object is listed in the Object string, a useful feature that
allows you to work with several levels in your analysis.

Hierarchical Objects can be nested. i.e. one hierarchical definition can
contain another—
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When the “STRB” Object is used, it will expand to the combined contents of
“STRA” and “STRB”—
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Who needs to know about your business
There are several parties who have an interest in your accounts: you, other
owners, creditors and banks, employees and not least the tax authorities.
Your auditor’s job is to certify your accounts on behalf of all the interested
parties. He or she will check your books to certify that they give a “true and
fair” representation of the state of affairs.

Sometimes it feels as if all this apparatus of reports and accounts is just too
much trouble. Used in the right way, however, a good accounting system
improves the control of the business. There are, indeed, more examples of
companies that have failed because of bad accounting than of too good…

Practical use of accounting information

Accounting information is useful in many situations. You can use it as a
foundation for your budgeting, when you want to find out if a certain deal is
profitable or not or to monitor the performance of a department, a market
segment etc.

Getting capital

From time to time you need to persuade banks or other financiers that your
business is solid and profitable, e.g. when you need to borrow money for an
investment. A good accounting system allows you to find the information
they require quickly, and to make a credible presentation.

Tax returns

Your accounts provide all the information needed to produce the different
types of tax returns.

VAT declaration

All VAT registered companies must produce a number of periodical reports,
of which the VAT return is the most important. If you are above the threshold
amount for trade within EU, there are some other reports that need to be
made.
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The VAT return comes from your accounts. It follows a prescribed format,
and your accounts should reflect the VAT requirements, to make it easy to
produce the report.
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The End of a Financial Year
At the end of the financial year, the books are closed and a new year is
started. The final accounts are produced, the auditors will produce their
report, and management will produce their report to the owners’ annual
meeting. After approval, in the case of limited companies, the annual report is
filed with the registrar of companies.

To end a financial year and start a new one in Hansa, follow these steps—

1. If you are registered for VAT, the first step should be to print a VAT
Report for the final quarter of the year (and separately for earlier quarters
if this has not already been done).

2. For each quarter, you should then enter a Transaction in the Transaction
register transferring the VAT amount payable/receivable into the VAT
Payments Account (835 in the Chart of Accounts supplied with Hansa).
This Transaction would debit the VAT Outputs Payable Account (830)
and credit the VAT Inputs Receivable Account (831), with a balancing
posting to the VAT Payments Account. This Transaction must be entered
within the quarter to which it belongs, preferably as the last Transaction
of the period.
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The amount payable/receivable can then be transferred to your bank
account with a further Transaction when payment is made/received.

3. Print out the following Nominal Ledger reports, using the whole year as
the report period in each case. These will provide both a hard copy
record of the year’s business and the basis for the end-of-year work
which will now be carried out by your auditors.

Nominal Ledger The Nominal Ledger report is an important part of the
final accounts of a business. It is a list of every
Transaction, classified by Account and listed in the order
in which they were entered.

Transaction Journal

The Transaction Journal is a list of every Transaction, in
Transaction Number order.

Profit & Loss The Profit and Loss report summarises the income and
expenditure (and therefore the operating profit or loss) of
the business during the fiscal year. The result shown on
the Profit & Loss report should agree with (‘balance’)
the result on the Balance Sheet.
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Balance Sheet The Balance Sheet shows the financial status - at a
particular point in time - of the company showing
Assets, Liabilities and Equity capital.

System Documentation

The System Documentation report describes the
accounting system being used. This includes
descriptions of the Chart of Accounts, accounting rules
etc. This allows an outsider to understand how you have
arrived at the final accounts.

4. Ensure your Chart of Accounts (i.e. Account register) includes an
Account for Profit & Loss Year To Date. It should be defined as shown
in the illustration—

5. The Account defined in step 4 above should not appear in the Definitions
for your Profit & Loss or Trial Balance reports, but should be part of the
profit calculation in the Balance Sheet. In the sample Chart of Accounts
supplied with Hansa, this is line 100 of the Balance Sheet Definition. To
check this, first select ‘Settings’ from the File menu and double-click
‘Report Settings’ in the subsequent list. Then, highlight ‘Balance Sheet’
in the list on the left-hand side of the ‘Report Settings’ window and click
the [Definition] button.
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The following window opens—

Double-click on line 100, and ensure it is defined as shown—

Finally, take care that the Account is not included in the Equity
calculation (line 90 in the sample Balance Sheet Definition).
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6. Once your auditors have concluded their work and any consequent
Transactions have been entered, refer to step 3 above and print out the
reports again, as final records of the year just ended. These will be the
basis for the end-of-year accounts presented to the owners or directors.
The Net Profit in the Profit & Loss Report should be the same as the
Profit/Loss this YTD shown in the Balance Sheet. Make a note of this
figure.

7. You should now bring this profit/loss figure forward to the next year. Do
this by entering a new record to the Transaction register dated the last
day of the year just ended. If a profit has been made, this Transaction
should credit the Profit & Loss Brought Forward Account and debit the
Year to Date Account created in step 4 above with the value noted in
step 6. If a loss has been made, the debits and credits should be reversed.

8. Save the Transaction and print the Balance Sheet and Trial Balance to
screen. You should now find that the YTD Profit figure on the Balance
Sheet is zero, and the Balance Sheet should balance. Finally, check that
your Trial Balance report for the last year still balances.
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Some work should now be done to ensure you are ready for the new year.
Follow these steps—

9. Using the Fiscal Years setting in the System module, register the new
financial year on the first blank line. Do not insert the new year at the top
of the list because Fiscal Years have to be listed in chronological order.
Do not remove past Fiscal Years. Click [Save] to save.

10. You should now define the periods that you will commonly use when
producing reports. This is done using the Reporting Periods setting,
again in the System module. In this case, the new periods should be
inserted at the top of the list because the first period in the list is offered
as a default whenever you produce a report. To insert a new period at the
top of the list, click on row number 1 and press the Return key. Enter the
Reporting Periods that you need and click [Save] to save.
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11. If you are using Number Series that are date dependent, you should
update them to take account of the new year. This is particularly
important for Number Series that will be used when generating records
remotely (e.g. Deliveries and Invoices from Sales Orders). There are
many Number Series settings in various modules in Hansa: be sure to
change every one that you have used.

Don't forget to make sure that any defaults set in the Number Series
Defaults setting in the System module and in records in the Person
register (‘Ser Nos’ card) refer to Number Series in the new year.

Further details of each of these steps can be seen in the sections describing
the respective functions in the ‘System Module’ and ‘Nominal Ledger’
chapters elsewhere in these manuals.
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Chapter 4: Starting Work with Hansa

Entering Data and Opening Balances

If you have been following this manual in sequence, you should by now have
created a new database into which you have entered information about your
company, the current Fiscal Year, a set of VAT Codes and a Chart of
Accounts. If this is not the case, please turn back to the ‘Starting Hansa’
section of the ‘Introduction and Installation’ chapter before proceeding.

Settings

As you start using each module for the first time, it is a good idea to check
the different settings in that module. Some settings have default values that
you should be aware of and may wish to change, and some represent a special
functionality that you might be able to use.

Remember, most settings are
imported automatically when a new
database is created. If you alter the
Chart of Accounts, you will probably
have to change any settings that use
Account Codes as well.

Persons and Mailboxes

One of your first tasks in creating a new database should be to enter details of
each member of your staff in Hansa. You will do this using the Person
register in the System module. One reason for doing this is to protect your
data: the Person register allows you to assign a password to each user. It's a
good idea to do this even in a single-user system: protecting your database
with a password might prove to be a wise precaution if your computer is
stolen. In multi-user systems, you can also use the Person register together
with the Access Groups setting (also in the System module) to restrict the
access to Hansa each member of staff has to the modules and function that
are relevant to their job.

It is not necessary to restrict this process to members of staff that will be
using Hansa. For example, someone that will not use Hansa should still be
recorded in the Person register if you want their work to be included in your
time recording reports.

!
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Before entering Persons, you may wish to define Access Groups: these are
described in the ‘System Module’ chapter elsewhere in this Volume.

To enter details of your personnel to the Person register, follow these steps—

1. Select the System module from the Modules menu. If this module is not
available on the Modules menu, please refer to the ‘Modules’ section of
the ‘Introduction and Installation’ chapter.

2. Open the Person register by clicking the [Person] button in the Master
Control panel. If you are using a new database, a blank browse window
will appear. Otherwise, it will list all Persons previously entered.

3. Click the [New] button in the Button Bar at the top of the browse
window.

Use the ‘Person: New’ window shown below to enter information about
a member of staff. For full details about each field on the screen, please
refer to the ‘System Module’ chapter later in this manual.

When entering a Person’s initials in the Signature field, not that where
there is more than one Company in the database, records in the Person
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register are specific to the Company in which they were entered.
However, when you come to create them as described below, their
Mailboxes will be open to all Companies in the database. This allows
mail to be sent between Persons in different Companies. One implication
of this is that all Persons across all Companies should have different
Signatures (initials). If there are two or more Persons in different
Companies with the same Signature, they will not be able to have their
own Mailbox.

4. Click the tabs (named ‘Access’, ‘Job’, ‘Ser Nos’, etc) to enter more
information about the member of staff.

5. Click the [Save] button in the top right-hand corner of the window. The
record is saved in the Person register.

6. The window title changes to ‘Person: Inspect’, giving you a chance to
check you have not made any mistakes in entering the record.

7. Close the record by clicking the close box or using the Ctrl-F4 (Windows
and Linux) or z-W (Macintosh) keyboard shortcut.

8. If you have a number of personnel to enter, click [New] instead of [Save]
at step (5) above (or use the Ctrl-N/z-N keyboard shortcut). The Person
record is saved and closed, and a blank window is opened, allowing you
to enter another record straight away.

9. When you close the last Person record at step 7 above, you will be
returned to the ‘Persons: Browse’ window, which now lists the members
of staff that you have just registered. Click on each one in turn and
allocate a password by selecting ‘Change Password’ from the Operations
menu.

You should now create a Mailbox for each Person. Mailboxes allow members
of staff to send and receive mail, and to use the Personal Desktop.

In contrast to the Person register, you should only create Mailboxes for
members of staff that will be using Hansa. This is because the Hansa user
licence is issued on the basis of the number of Named Users (i.e. the number
of Mailboxes).

Before creating Mailboxes, you should first make sure that you have recorded
the correct number of Mailboxes in the System Usage setting in the System
module. This is described in the ‘Introduction and Installation’ chapter
elsewhere in this Volume.
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To create a Mailbox, follow these steps—

1. Select the Technics module from the Modules menu. If this module is
not available on the Modules menu, please refer to the ‘Modules’ section
of the ‘Introduction and Installation’ chapter.

2. Click the [Settings] button in the Master Control panel (or select
‘Settings’ from the File menu). In the resulting list, double-click
‘Mailboxes’. If you are using a new database, a blank ‘Conferences’
window will appear. Otherwise, it will show the Mailboxes that already
exist—

3. Click the [New] button in the Button Bar at the top of the window.

Use the ‘Mailbox/Conference: New’ window shown overleaf to create a
Mailbox. For full details about each field on the screen, please refer to
the ‘Mail’ chapter in Volume 6 of these manuals.
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4. Click the [Save] button in the top right-hand corner of the window. The
record is saved in the Mailboxes setting, the window is closed, and you
are returned to the ‘Conferences’ window. This now shows the Mailbox
that you have just created.

5. Repeat steps 3 and 4 to create all the Mailboxes that you need.

Entering the First Customer

Hansa keeps all information about Customers in a Customer register, with
one record for each Customer.

Before entering Customers, you should first make sure all relevant Payment
Terms (used to calculate Due Dates and settlement discounts in Invoices)
have been entered in the Payment Terms setting. This is described in the
‘Sales Ledger’ chapter in Volume 2a of these manuals. You may also wish to
define Customer Categories (used to group together Customers of a similar
type): these are described in the ‘Customers’ chapter elsewhere in this
Volume.

To enter your first Customer, follow these steps—

1. Select the Sales Ledger or Sales Orders module from the Modules menu.
The same Customer register is available in both modules. If neither
module is available on the Modules menu, please refer to the ‘Modules’
section of the ‘Introduction and Installation’ chapter.

2. Open the Customer register by clicking the [Customers] button in the
Master Control panel. If you are using a new database, a blank browse
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window will appear. Otherwise, it will list all Customers previously
entered.

3. Click the [New] button in the Button Bar at the top of the browse
window.

Use the ‘Customer: New’ window shown below to enter information
about the Customer. For full details about each field on the screen, please
refer to the ‘Customers’ chapter later in this manual.

4. Click the tabs (named ‘Contact’, ‘Delivery’, ‘Terms’, etc) to enter more
information about the Customer.

5. Click the [Save] button in the top right-hand corner of the window. The
Customer is saved in the Customer register.

6. The window title changes to ‘Customer: Inspect’, giving you a chance to
check you have not made any mistakes in entering the record.

7. Close the record by clicking the close box or using the Ctrl-F4 (Windows
and Linux) or z-W (Macintosh) keyboard shortcut.
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8. If you have a number of Customers to enter, click [New] instead of
[Save] at step (5) above (or use the Ctrl-N/z-N keyboard shortcut). The
Customer is saved and closed, and a blank window is opened, allowing
you to enter another Customer straight away.

It is a good idea to repeat the above process for a few Customers in order to
familiarise yourself both with the data entry process and with the Customer
entry screen. However, if you are changing to Hansa from another computer
program, it is likely that you will want to import your Customers from a text
file created by your old system. If you wish to do this, please follow the
import instructions described in the section ‘Setting up a Basic Accounts
System’ in the ‘Introduction and Installation’ chapter to import your text file.
This procedure, although described there as being used to import a Chart of
Accounts, is in fact an all-encompassing import function which will bring in
whatever is in the selected text file and save it in the appropriate place in
Hansa. For details of the composition of the text file (field order, etc), please
refer to your Hansa representative.

Entering the First Supplier

Hansa keeps all information about Suppliers in a Supplier register, with one
record for each Supplier.

Before entering Suppliers, you should first make sure all relevant Payment
Terms (used to calculate Due Dates and settlement discounts in Invoices)
have been entered in the Payment Terms setting. This is described in the
‘Sales Ledger’ chapter in Volume 2a of these manuals. You may also wish to
define Supplier Categories (used to group together Suppliers of a similar
type): these are described in the ‘Purchase Ledger’ chapter also in Volume 2a
of these manuals.

Select the Purchase Ledger or Purchase Orders module from the Modules
menu. The same Supplier register is available in both modules. If neither
module is available on the Modules menu, please refer to the ‘Modules’
section of the ‘Introduction and Installation’ chapter. Open the Supplier
register by clicking the [Suppliers] button in the Master Control panel. If you
are using a new database, a blank browse window will appear. Otherwise, it
will list all Suppliers previously entered. Then, follow the same basic process
described above, under ‘Entering the First Customer’.

For full details about each field in the ‘Supplier: New’ window, please refer
to the ‘Purchase Ledger’ chapter in Volume 2a of these manuals.

If you wish to import Suppliers from your old accounts system, please follow
the import instructions described in the section ‘Setting up a Basic Accounts
System’ of Chapter 1, ‘Introduction and Installation’, to import a text file
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created by that system. For details of the composition of this text file, please
refer to your Hansa representative.

Entering the First Item

Hansa keeps all information about Items and prices in an Item register, with
one record for each Item. The Item register contains basic data about all
products and services sold by your business.

Before entering Items, you may wish to define Item Groups (used to group
together Items of a similar type): these are described in the ‘Items and
Pricing’ chapter elsewhere in this Volume.

To enter your first Item, select the Sales Ledger or Sales Orders module from
the Modules menu. Using the Item register, follow the same basic process
described above, under ‘Entering the First Customer’.

For full details about each field in the ‘Item: New’ window, please refer to
the ‘Items and Pricing’ chapter later in this manual.

If you wish to import Items from your old accounts system, please follow the
import instructions described in the section ‘Setting up a Basic Accounts
System’ of the ‘Introduction and Installation’ chapter to import a text file
created by that system. For details of the composition of this text file, please
refer to your Hansa representative.

Entering Opening Balances

Unless you are starting a new business and intend to use Hansa to administer
your accounts from the first day, you will need to enter some opening
balances. If you are starting to use Hansa at the beginning of the fiscal year,
these opening balances will take the form of the closing balances for each
Account for the end of the previous year. If you are starting to use Hansa in
the middle of the fiscal year, there will be two components to opening
balance figures: the closing balances for each Account for the end of the
previous year and Account balances for the current year to date.

To carry out this task, you should equip yourself with as much information as
you can in the form of transaction data and reports produced by the old
system, in order to make this task as easy as possible.

We recommend that you change during a current financial year. You should
enter Account balances for the previous year and then enter individually all
current year transactions registered so far. This will a) make you familiar
with Hansa, and b) automatically give you a check of the old transactions.

You should already have specified the current and, if appropriate, previous
financial years using the Fiscal Years setting and entered the Chart of
Accounts and VAT Codes you wish to use. Normally you will be able to use
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the Charts of Accounts included in the program. If this is not suitable, you
can import your own chart from a text file or enter it manually. For more
instructions about this process, please refer to the section entitled ‘Setting up
a Basic Accounts System’ in the ‘Introduction and Installation’ chapter.

If appropriate, you should also enter the Currencies used in your business and
Exchange Rates. Full details about this process can be found in the ‘Multi-
Currency’ chapter in Volume 2b of these manuals.

Once you have entered your Fiscal Year, Chart of Accounts, VAT Codes and
Currencies it’s a good idea to enter all the opening balances at once. Ideally,
this process should be completed before you start to enter new Transactions
but it is possible to change the opening balances at any time during the
financial year.

When entering opening balances, the level of detail is up to you. Factors
influencing this decision may be the number of Transactions, the time
available to enter these Transactions, whether they can be imported
(otherwise, they will have to be entered manually) and the level of detail
required in your reports. It might be that you enter or import all Transactions
individually (in the form of Invoices, Receipts, Purchase Invoices, Payments
and Nominal Ledger Transactions) or it might be that you enter a single
opening balance for each Account. Full details covering the necessary data
entry processes follow in the next sections.

Once you have entered your opening balances in their chosen form, print the
reports you usually use and compare them with the reports from your old
system. These reports should include the Trial Balance, Profit & Loss and
Balance Sheet from the Nominal Ledger, and Debtors and Creditors reports
from the Sales and Purchase Ledgers respectively.

Opening Balances in the Nominal Ledger

In the Nominal Ledger, the task of entering opening balances has two stages.
First, it is recommended that you enter balances for each Account as they
stood at the end of the previous fiscal year. This is done using the Balances
Brought Forward register. This information should be available on the Trial
Balance report obtained from your old system. Then, if appropriate,
Transactions for the current year to date should be entered, using the
Transaction register.

Once all Balances and Transactions have been entered, print out a Trial
Balance and compare it with that obtained from your old system. Any
discrepancies should be investigated immediately: any delay will make this
more difficult.
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The following section assumes that a Chart of Accounts and a set of VAT
Codes have already been defined. To enter Account balances as they stood at
the end of the previous financial year to the Nominal Ledger, follow these
steps—

1. Select the Nominal Ledger module from the Modules menu.

2. Click the [B/FW Balances] button in the Master Control panel or select
‘BW Balances’ from the Registers menu.

3. Click [New] on the Button Bar.

4. Enter the information as shown in the following illustration. Full details
of the fields are to be found in the chapter covering the Nominal Ledger
in Volume 2b of this manual. It is recommended that you choose a
Transaction Date that is at the end of the previous fiscal year and that is,
in any case, prior to the date when you will be starting work with Hansa.

Use the Base 1 Debit and Credit fields for values in your home Currency.
If you are using the Dual-Base currency conversion system you should
already have defined which Currencies are to be used as Base Currencies
1 and 2. This system will be useful for companies that have offices in
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two countries that need to report in both Currencies, for companies
operating in countries where there is a second Currency (usually the US
Dollar or Euro) in common use in addition to the national one, and for
companies in the Euro zone who retain their old national Currency for
comparison purposes. If your country is a member of the European
Monetary Union, the Euro should be defined as Base Currency 1. To
record values in a second Currency, use the Base 2 Debit and Credit
fields on flip B. To record values in a foreign Currency, use the fields on
flip C. All values should be entered manually: no Currency conversion
will take place because users will have many different methods of
converting opening balance figures.

5. The Brought Forward Balances screen does not have an OK check box,
so Account Balances are updated as soon as the record is saved.
Therefore, before clicking [Save], make sure that no mistakes have been
made. One check is that the Debit and Credit totals are the same. If a
mistake is discovered at a later date, you will be able to correct the
record without difficulty.

6. Finish with [New] (or use the Ctrl-N/z-N keyboard shortcut) if you
wish to enter more Balances.

7. If you are using Objects, you should enter a separate record to the
Brought Forward Balances register for each Object and one for the total.
For example, if you have a Cash Account with a balance of 100.00 that is
divided between two departments so that 49.00 belongs to Department 1
and 51.00 to Department 2, enter three Brought Forward Balance records
as follows—

1st record, Cash Account, no Objects, total figure (100.00)
2nd record, Cash Account, Object for Dept 1, figure for Dept 1 (49.00)
3rd record, Cash Account, Object for Dept 2, figure for Dept 2 (51.00)

8. Finish with [Save] when you have entered the last Balance, and close the
window by clicking the close box.
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If you are starting to use Hansa in the middle of a financial year, you should
now enter the Transactions for the current year so far. These should be
entered from the original documentation, not copied from Transaction
Journal reports produced from your old system. This will ensure that you do
not enter any Transactions that relate to the Sales or Purchase Ledger. These
will be entered later. Follow these steps—

1. Using the Modules menu, ensure you are in the Nominal Ledger.

2. Click the [Transactions] button in the Master Control panel or select
‘Transactions’ from the Registers menu.

3. Click [New] on the Button Bar.

4. Enter the information as shown in the following illustration. Full details
of the fields are to be found in the chapter covering the Nominal Ledger
in Volume 2b of this manual. Ensure you use the same Transaction Date
that was used when entering the Transaction to your previous system.

The Base 1 Debit and Credit fields should be used for values in your
home Currency. Please refer to the ‘Multi-Currency’ chapter in Volume
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2b of these manuals for details about using foreign Currencies in
Nominal Ledger Transactions.

5. The Transaction screen does not have an OK check box, so Account
Balances are updated as soon as the Transaction is saved. Therefore,
before clicking [Save], make sure that no mistakes have been made. One
check is that the Debit and Credit totals are the same.

6. Finish with [New] (or use the Ctrl-N/z-N keyboard shortcut) if you
wish to enter more Transactions.

You can use another feature when you need to enter several Transactions
quickly in one sitting and don’t want to interrupt your typing by reaching
for the mouse. Enter the debits in a Transaction first and then, with the
cursor in the Base 1 Credit field in the final credit row, press the Return
or Enter key twice. The first pressing causes Hansa to enter the correct
credit amount to balance the entry for you. The second saves, closes and
commits the Transaction to the Nominal Ledger and opens a new, empty,
Transaction.

7. Finish with [Save] when you have entered the last Transaction, and close
the window by clicking the close box.

Opening Balances in the Sales Ledger

It is worth repeating that there can be two components to opening balance
figures in the Sales Ledger: the final Customer balances from the previous
fiscal year and, if you will be starting to use Hansa in the middle of a fiscal
year, Customer balances for the current year to date.

In considering Customer balances from the previous year, it is only necessary
to take account of those which are open (i.e. unpaid). These can be entered in
one of two ways—

• as a single outstanding balance for each Customer; or

• as separate outstanding Invoices per Customer.

In considering Customer balances for the current year to date, the following
options are available—

• the minimum is to enter a balance for each Customer as a single figure
(in fact, you will need to enter an Invoice total and a Receipt total,
representing totals for the current fiscal year to date, enabling you to
reconcile your bank account and to keep your Aged Debtor report
accurate);
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• the opposite extreme is to enter all Invoices raised so far in the current
fiscal year, and all Receipts;

• a compromise route to reduce the amount of work required is to enter
monthly Invoice and Receipt balances for each Customer;

• a final option, available if you are changing to Hansa from an older
computerised system, is to import the current year’s Invoices and
Receipts from a text file. Please refer to your local Hansa representative
if you would like to consider this option.

In deciding which procedure to use, one factor to consider is credit control. If
you need to produce statements that show details of previous Invoices, it will
not be enough to simply enter a total balance for each Customer. Instead, you
will need to enter individual Invoices and Receipts. If, however, you do not
issue statements or it is acceptable for a single opening balance figure to
appear on your statements, entering a single opening balance figure per
Customer will be sufficient. If you do not issue Invoices or you do not give
credit, it may not be necessary to enter any opening balances at all in the
Sales Ledger.

If you need to enter opening balances in the Sales Ledger, you should first
ensure that all Customers have been entered using the process described in
the section entitled ‘Entering the First Customer’ above. If you are entering
individual Invoices, you should also ensure that all Items have been entered.
You may be able to import this information from text files. Finally, if you are
entering Receipts in any form (i.e. individual Receipts, or monthly or year-to-
date Receipts) make sure all relevant Payment Modes have been entered, so
that the Receipt amounts can be posted to the correct Bank or Cash Account.
Payment Modes are described below.

Nominal Ledger Settings

Sales Ledger opening balances are entered in the form of Invoices and
Receipts. However, in the case of balances brought forward from the
previous fiscal year, they are Invoices and Receipts that should not be posted
to the Nominal Ledger if you have already entered previous-year Nominal
Ledger opening balances to the Balances Brought Forward register as
described in the previous section. The Nominal Ledger opening balances
include balances for the Accounts affected by Invoices and thus to post to
those Accounts from opening balance Invoices is to post the same amounts
twice. Therefore, before Sales Ledger opening balances can be entered, a
setting in the Nominal Ledger needs to be considered to ensure that they will
not be posted.
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Using the Modules menu, ensure that you are in the Nominal Ledger. Click
[Settings] in the Master Control panel or select ‘Settings’ from the File menu.
In the subsequent list, double-click ‘Sub Systems’. The following window
appears—

Specify by clicking the check boxes which transactions (‘Sub Systems’) are
to cause the automatic creation of Nominal Ledger Transactions. In the
illustration, for example, each Invoice with a Transaction Date later than
1/4/2003 will cause a Nominal Ledger Transaction to be created. If the
Transaction Date is earlier than 1/4/2003, a Nominal Ledger Transaction will
not be created.

It is recommended that for each Sub System you enter the first day of your
fiscal year. When entering previous-year opening balances, a Transaction
Date prior to that date should be used. This will ensure that Nominal Ledger
Transactions are created when expected and that they are not created for
opening balances. If it takes longer than expected to enter opening balances,
you can continue doing so (using early Transaction Dates) and start to issue
new Invoices without needing to worry about the consequences in the
Nominal Ledger.

If you are starting to use Hansa in the middle of a financial year, you should
already have entered the Nominal Ledger Transactions for the current year so
far, as described in the ‘Opening Balances in the Nominal Ledger’ section
above. If, as was recommended, these were entered from the original
documentation, not copied from Transaction Journal reports produced from
your old system, you will not have any current year Transactions that relate
to the Sales or Purchase Ledger. These will now be created automatically
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from the Invoices and Receipts (and Purchase Invoices and Payments) that
you are about to enter, providing that their Transaction Dates are later than
the Sub System Date (the first day of your fiscal year). If you did enter
current year Transactions relating to the Sales or Purchase Ledger as part of
the previous exercise, you will not want them created again when you enter
Invoices and Receipts. In this case, make the Sub System Date later (a few
days before the date you start using Hansa to originate transactions). This
means you will be able to enter Invoices for the current year to date and to
issue new Invoices simultaneously without needing to worry about the
consequences in the Nominal Ledger.

If you are not certain whether you have entered current year Transactions
relating to the Sales or Purchase Ledger, produce a Trial Balance report for
the current year and check the balances for your Sales, Purchase, Debtor and
Creditor Accounts. If these are zero, you have not entered these Transactions.
If they are the same as those on the Trial Balance produced from your old
system, you have entered these Transactions already. Please refer to the last
section of this chapter, ‘Printing Reports’, for instructions about printing a
Trial Balance report.

Once the Sub Systems setting is to your satisfaction, save and close the
window by clicking [Save] in the Button Bar.

Note that if you have entered
previous-year opening balances in the
Nominal Ledger, you should not post
any Sales, Purchase or Stock opening
balances to your Nominal Ledger. To
do so will duplicate the work you have
already done and will immediately
render your accounts inaccurate.

!
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Sales Ledger Settings

Before entering the first opening balance, there is a single setting in the Sales
Ledger that needs to be considered if you will be entering Receipts for the
fiscal year to date.

Use the Modules menu to enter the Sales Ledger and select ‘Settings’ from
the File menu. In the subsequent list window, double-click on ‘Payment
Modes’.

Payment Modes represent the different methods by which your Invoices will
be paid by your Customers and by which you will pay your Suppliers.
Typical examples are cash, cheque, direct debit and credit card. If necessary,
Hansa allows each Payment Mode to debit a different Account and to be paid
into a different bank account.

If you have used the accounts template supplied with Hansa, you will find
that the basic Payment Modes have already been entered. If you have
modified the Chart of Accounts supplied, or you have created your own,
ensure that the Account Code shown in the second column now refers to the
correct Account (remember, you can use ‘Paste Special’ if necessary).

To create a new Payment Mode, simply click in the first blank row and enter
a unique Code. Then enter the other details as appropriate, referring to the
‘Sales Ledger’ chapter in Volume 2a of this manual if necessary. Click flips
B-D to complete the entry. Click [Save] when you have finished. Then, close
the ‘Settings’ list using the close box.

Opening Balances

The process described below applies to the entering of opening balances both
from the previous fiscal year and for the current year to date.

You are now ready to enter the first Invoice. If you are entering a single
opening balance figure per Customer, either for the previous fiscal year or for
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the current year to date, you will need to do this by entering it in an Invoice.
If so, omit step 7 in the following procedure. Do this—

1. If you are not already in the Sales Ledger module, move into it using the
Modules menu.

2. Click the [Invoices] button in the Master Control panel to open the
Invoice register.

3. Click [New] in the Button Bar.

4. In the ‘Invoice: New’ window three fields are already filled in: the
Invoice Number (except in multi-user systems) and the Invoice and
Transaction Dates (which show the current date taken from the system
clock). Depending on the Base Currency setting in the System module,
the Currency field may also contain a default (your home Currency). If
you are entering a single opening balance figure for each Customer, you
might like to use a separate numbering sequence for opening balances
(use the Number Series - Invoices setting in the Sales Ledger to set up
numbering sequences). If you are entering individual Invoices, you will
need to use the Invoice Number and Date of the original Invoice. In
multi-user systems, an Invoice Number will be allocated when the
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Invoice is saved: when entering individual Invoices for the current year
to date, it is recommended that these Invoices be entered in number order
from a single client computer to ensure each Invoice retains the number
with which it was originally issued.

5. Place the insertion point in the Customer field and select ‘Paste Special’
from the Edit menu or use the shortcut (Ctrl-Return - Windows/Linux or
z-Return - Macintosh). The ‘Paste Customer’ window appears, showing
a list of the Customers recorded in the Customer register. Select a
Customer by clicking on its row and press the Return key twice. The first
pressing causes the Customer Number to be transferred to the field in the
Invoice, and the second will move information about the Customer
(Name, Address etc.) to the Invoice.

6. Use the Return key to move the insertion point to the Date field. In the
case of Customer balances from the end of the previous fiscal year,
ensure that this is set to a date that is earlier than the cut-off date you
specified in the Sub Systems setting.

7. If you are entering individual Invoices, move the insertion point to the
Item field and press Ctrl-Return or z-Return again. Select the correct
Item from the list and press Return twice. The insertion point is moved to
the Qty field. Enter the number of items ordered, and press Return.
Check that the Unit Price is correct and repeat for each item on the
Invoice.

8. If you are entering single opening balances, move the insertion point to
the Qty field and enter a quantity of 1. Press Return and enter the text
“Opening Balance” in the Description field. Enter an amount (excluding
VAT) in the Unit Price field.

9. Until you are familiar with the Invoice screen, it is a good idea to check
that every field is correct. Clicking the named tabs marked ‘Currency’,
‘Delivery’, ‘Identifiers’, etc causes different information about the
Invoice to be shown, while the tabs marked A-E display further
information about the Invoice items. Pay particular attention to the Sales
Account and VAT Code fields on flip B. These defaults are taken from
the Item record or, if not specified there, from the Account Usage S/L
setting. It will be the latter in the case of single opening balances as then
you are not referring to the Item register.

10. At the bottom of the Invoice the total is shown, together with the VAT
amount and the total payable amount.

11. Click [Save] to save the Invoice.
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The window title changes to ‘Invoice: Inspect’. You can now correct any
mistakes before you click the OK check box in the bottom left-hand
corner. With the OK box checked, clicking the [Save] button once again
approves the Invoice and commits it to your Sales Ledger. After this you
may not change the individual fields.

12. Finish with [New] if you wish to enter another Invoice. Or, if you are
entering all Invoices for the current fiscal year, click [Duplicate]. This
will create a new Invoice which will be a copy of the one just saved. This
will save you having to enter Customer details, etc, again if they are the
same.

13. Finish with [Save] when you have entered the last Invoice, and close the
window by clicking the close box.

Entering Receipts

As with entering Invoices, you can get much help with entering your Receipts
from Hansa’s built-in short-cuts. Perhaps the most useful tool is the ‘Paste
Special’ command. ‘Paste Special’ can be used whenever you enter data in a
field that refers to a register or setting in Hansa.

There is no need to enter any Receipts from the previous fiscal year, because
only outstanding Invoices from that year have been entered. These steps
should only be followed for Receipts from the current year to date, and thus
are only applicable if you are starting to use Hansa in the middle of a fiscal
year.

1. Open the ‘Receipts: Browse’ window by clicking the [Receipts] button
in the Sales Ledger.

2. Click [New] or use the keyboard shortcut Ctrl-N (Windows and Linux)
or z-N (Macintosh).

3. The ‘Receipt: New’ window is shown. You can use a single window to
enter all your Receipts from the earlier part of the year, even if they are
in different Currencies and Payment Modes.
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4. Enter the data in the top of the window. Select a Payment Mode using
‘Paste Special’ to open the list of Payment Modes you created earlier.
Make sure the Transaction Date is correct.

5. For each Receipt, enter the Invoice Number in the first column (or use
‘Paste Special’ to choose from the unpaid Invoices) and press the Return
key.

6. If you have an Invoice that is part-paid, alter the Received Value field to
show the amount paid.

7. If any receipt uses a different Payment Mode to that specified in the top
of the window, move to flip C to enter a Payment Mode to be used for
that row only. Again, use ‘Paste Special’ to ensure the correct one is
selected.

8. When all receipts are entered you should check what you have entered. If
you find any errors you can change them as needed. When you are
satisfied, click the OK check box in the lower left-hand corner.

9. When you click [New] or [Save], the Receipt is approved and after this
may not deleted or changed.
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Opening Balances in the Purchase Ledger

When entering opening balances in the Purchase Ledger, the same basic
decisions and procedures described in the Sales Ledger section above should
be followed, using the Purchase Invoice and Payment registers in the
Purchase Ledger. Before entering opening balances, use the Sub Systems
setting in the Nominal Ledger to make sure that your previous year Purchase
Ledger opening balances will not be posted to the Nominal Ledger, as
described in the Sales Ledger section above.

Opening Balances in the Stock Module

When entering opening balances in the Stock module, the precise procedure
to be followed will be determined by the nature of your business and the
Items that are sold. Again, as in the Sales Ledger, the accuracy of the opening
balances increases with the level of detail entered, but the time required by
the task increases as well.

You should decide whether to—

• enter each example of each Item in stock at the moment of implementing
Hansa. You may prefer this option if the cost price of each Item is often
subject to fluctuation, and you must use it for Items that carry serial
numbers;

• enter a single line for each Item together with a quantity and an average
purchase price; or

• use a combination of the two methods.

Before entering opening balances in the Stock module, you should first
ensure that all Items have been entered using the process described in the
‘Entering the First Item’ section above. Ensure that, for each Item whose
stock levels are to be maintained, the Stocked Item option on the ‘Pricing’
card is selected. Depending on your old system, you may be able to import
Item data from text files.

You should also use the Sub Systems setting in the Nominal Ledger to make
sure that your Stock Control opening balances will not be posted to the
Nominal Ledger, as described in the Sales Ledger section above.

When entering opening balances in the Stock module, the same basic
procedures described in the Sales Ledger section above should be followed,
using the Goods Receipt register.
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Importing Opening Balances

If you are changing to Hansa from another computer program, it is likely that
you will want to import opening balances for all three ledgers from text files
created by your old system. If you wish to do this, please follow the import
instructions described in the section ‘Setting up a Basic Accounts System’ in
the ‘Introduction and Installation’ chapter to import your text file. This
procedure, although described there as one used to import a Chart of
Accounts, is in fact an all-encompassing import function which will bring in
whatever is in the selected text file and save it in the appropriate place in
Hansa. For details of the composition of the text files, please refer to your
Hansa representative. Ensure that they contain opening balances as they were
at the beginning of the fiscal year and all subsequent transactions as
described in the previous sections.

Printing Reports

Hansa can produce many different reports. A detailed description of these
will be found in the chapters describing each module. You should, however,
always print a Transaction Journal for the Transactions entered during one
work session. The same goes for the Invoice Journal in the Sales Ledger.

Having completed the process of entering your opening balances, you should
now print a Trial Balance and compare it with a Trial Balance produced from
your old system.

To print a Trial Balance, follow these steps—

1. Ensure you are in the Nominal Ledger module using the Modules menu
and click the [Reports] button in the Master Control panel.

2. The window illustrated below is opened.
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3. Scroll to the bottom of the list and choose ‘Trial Balance’ by double-
clicking. The ‘Specify Trial Balance’ window appears.

4. In the ‘Specify Trial Balance’ window, enter the range of transactions
you wish to print. To report on your opening balances, you should enter
a period from the beginning of the current fiscal year to the current date.
The start and end dates of this period should be separated by a colon (:),
as shown in the illustration. All other fields can be left blank, ensuring
that all Accounts, Currencies etc will be included in the report.
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5. Use the Media options at the bottom of the window to choose a print
destination (for example, ‘Printer’ or ‘Screen’), and click the [Run]
button to produce the report.

6. If you printed to screen and now wish to print on a printer, simply click
the Printer icon in the Button Bar of the report window.
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Chapter 5: Customers
Information about your Customers is stored in the Customer register, which
is available from the Sales Orders and Sales Ledger modules, and from the
Contract, Quotations, CRM and Service Orders modules if installed.

Customers of a similar type can be grouped together using Customer
Categories. All Customers of the same Category can be given the same
default Price List, Discount Matrix and Debtor Account, saving you the work
of having to specify these for all Customers individually. Defining and
assigning Customer Categories also makes modification easier: if it is
necessary to assign a different Discount Matrix, for example, only one
change need be made (to the Customer Category), rather than many (to each
of the Customers).

If information is specified both for a Customer Category and for a Customer
that belongs to that Category, that entered for the Customer will take
precedence.

This chapter first describes the defining of Customer Categories. This is
followed by a detailed description of the Customer register and of Customer-
related reports.

Settings

Customer Categories

Customer Categories are defined using the setting in the Sales Ledger. Use
the Modules menu to enter the Sales Ledger and then select ‘Settings’ from
the File menu or click [Settings] in the Master Control panel. Double-click
‘Customer Categories’ in the resulting list. Then click [New] to open a new
record, or double-click an existing record to modify it.
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Code Specify a unique code, by which the Customer Category
may be identified from the Customer screen and
elsewhere in Hansa.

Description Enter text describing the Customer Category here.

Price List Paste Special Price List register, Pricing
module

Used as default in Customers, Quotations, Orders,
Invoices

The Price List entered here determines the prices used in
Orders and Invoices for all Customers belonging to this
Category. Price Lists are described in the next chapter,
‘Items and Pricing’.

Discount Matrix Paste Special Discount Matrix register,
Pricing module

Used as default in Customers, Quotations, Orders,
Invoices

A Discount Matrix code entered here determines the
discount structure for all Customers in this Category.
Discount Matrices are described in the next chapter,
‘Items and Pricing’.
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Debtors Account Paste Special Account register, Nominal
Ledger/System module

Specify here the Debtor Account that you wish to be
debited by the Nominal Ledger Transactions created
when Invoices are raised for Customers of this Category.

Note that a Debtor Account can only be specified at the
Customer Category level, not at the individual Customer
level. If no Debtor Account is specified for a Category,
the Debtor Account specified in the Account Usage S/L
setting in the Sales Ledger will be used.

If you have Sub-ledger Checking switched on, any
Account entered here must first be defined as a Debtor
Control Account. Sub-ledger Checking is switched on
using the check box on card 1 of the Account Usage S/L
setting, and Control Accounts are defined using the Sub-
ledger Control Accounts setting in the System module.

Bad Debtors Account

Paste Special Account register, Nominal
Ledger/System module

You can use the ‘Transfer to Bad Debtors’ Maintenance
function to transfer the outstanding balances of overdue
Invoices from the Debtor Account specified above to a
Bad Debtor Account. Specify here the Account that you
wish to be used as the Bad Debtor Account for Invoices
made out to Customers belonging to this Category.

As with the Debtor Account above, a Bad Debtor
Account can only be specified at the Customer Category
level, not at the individual Customer level. If no Bad
Debtor Account is specified for a Category, the Bad
Debtor Account specified in the Account Usage S/L
setting in the Sales Ledger will be used.

On Account A/C Paste Special Account register, Nominal
Ledger/System module

This Account is used when you allow Customers to buy
on account (i.e. to allow them to pay before you have
invoiced them). To allow this, you must check the On
Account check box for each individual Customer
affected (on the ‘Terms’ card of the Customer screen).
When a Prepayment or On Account Receipt is received
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from a Customer belonging to this Category, it will be
credited to this Account. Subsequently, when the Invoice
is issued and allocated to that Receipt, the same Account
is debited in place of the default Debtor Account. Please
refer to the ‘On Account Receipts and Prepayments’
section in the ‘Sales Ledger’ chapter in Volume 2a of
these manuals for full details of this process.

An On Account A/C can only be specified at the
Customer Category level, not at the individual Customer
level. If no On Account A/C is specified for a Category,
the On Account A/C specified on card 2 of the Account
Usage S/L setting in the Sales Ledger will be used.

Down Payment Percentage

When creating Down Payment Invoices from Sales
Orders for Customers belonging to this Category, enter
here the percentage of the Order total that is to be the
value of the Down Payment Invoice. This value will be
rounded up or down to the nearest whole number.

If this field is blank or the Customer does not belong to a
Category, the percentage will be taken from the Down
Payments setting in the Sales Orders module.

Wherever the percentage is taken from, it can be applied
to the Order total including or excluding VAT. This is
set in the Down Payments setting.

Web Order Class Paste Special Order Classes setting, Sales
Orders module

Specify here the Order Class that you wish to be used in
all Orders placed over the web (i.e. using Hansa’s Web
Shop) by Customers of this Category. All such Orders
will be given this Class automatically.

A Web Order Class can only be specified at the
Customer Category level, not at an individual Customer
level. It is therefore recommended that all Web Shop
Customers be placed in a Customer Category if you
want to distinguish and analyse their Orders using the
Order Class field.

Conventional Orders (i.e. those entered directly to the
Order register and those created from Quotations) will
not use this Order Class.
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Main Classification

Paste Special Item Classifications setting,
Stock module

If you are using Hansa’s Web Shop, you may wish to
offer different Items to different Customers. This is done
by dividing the Items into sets known as
“Classifications” and then specifying a Classification for
each Customer or Customer Category. Customers will
see only those Items in the relevant Classification when
they log on to your Web Shop site.

Classifications are defined using a setting in the Stock
module, described in the ‘Items and Pricing’ chapter
elsewhere in this manual. Items can belong to more than
one Classification.

If a Classification has been specified at the individual
Customer level, this will override one that has been
specified at the Category level.

If no Classification has been specified for a Customer or
Customer Category, the Classification with the Code
“MAIN” will be used. If there is no “MAIN” Display
Group, or if a non-existent Classification has been
specified for the Customer or Category, no Items will
listed when the Customer logs on.

User Defined Fields

The Customer record is capable of storing a sufficient quantity of information
to cater for most requirements. However, in some circumstances, it might be
necessary to store additional information for which no fields have been
provided. The User Defined Fields setting in the CRM module allows you to
add your own fields to each Customer record for this purpose. The new fields
will be visible on the ‘User Defined’ card of each Customer record.

Use the Modules menu to enter the CRM module and then select ‘Settings’
from the File menu or click [Settings] in the Master Control panel. Double-
click ‘User Defined Fields’ in the resulting list. The ‘User Defined Field
Labels: Inspect’ window opens. Make changes as required and then click the
[Save] button in the Button Bar to save changes and close the window. Click
the close box if you do not want to save changes.
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Card 1

When the ‘User Defined Field Labels: Inspect’ window is empty as shown in
the illustration above, the ‘User Defined’ card of each Customer record will
be empty as well—
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Use card 1 of the ‘User Defined Field Labels: Inspect’ window to give names
to the new fields that you want to be shown on the ‘User Defined’ card of
each Customer record. You can add up to five text fields (fields that can
contain letters and numbers), three value fields (fields that can hold numbers
only) and three date fields. In this example, we have added two text fields,
two value fields and one date field—
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This is how they appear in the Customer record—
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Card 2

Use card 2 of the ‘User Defined Field Labels: Inspect’ to name the address
fields in each Customer record. When card 2 of the ‘User Defined Field
Labels: Inspect’ window is empty, the address fields on the ‘Contact’ and
‘Delivery’ cards of each Customer record are unnamed—

Use card 2 of the ‘User Defined Field Labels: Inspect’ to name these address
fields so that all users know what to type into each one. Here is an example,
reflecting the usual address format used in the UK—



Chapter 5: Customers - Settings - User Defined Fields

237

The ‘Contact’ card of each Customer record will now look like this—
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The Customer Register
The Customer register is where you store information about your Customers
and assign Customer Categories and Payment Terms. It is accessible from the
Sales Orders and Sales Ledger modules, and from the Contract, Quotations,
CRM and Service Orders modules if installed. Use the Modules menu to
enter one of these modules and select ‘Customers’ from the Registers menu,
or click the [Customers] button in the Master Control panel.

The ‘Customers: Browse’ window is opened, showing all Customers already
entered.

Entering a Customer

To enter a new Customer, click [New] in the Button Bar or use the Ctrl-N
(Windows and Linux) or z-N (Macintosh) keyboard shortcut. Alternatively,
highlight a Customer similar to the one you want to enter and click
[Duplicate] on the Button Bar.

The ‘Customer: New’ window is shown, empty if you clicked [New] or
containing a duplicate of the highlighted Customer.

Since the amount of information stored about each Customer will not fit in a
single window, the Customer screen has been divided into seven cards. At the
top of each is the header. This contains the Customer Number, Short Code,
Customer Category, Name and Department. There are seven named buttons
(‘tabs’) in the header.
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By clicking the tabs you can navigate between cards. The header is always
visible, as a reminder of the Customer you are working with.

Below, the Customer screen is described field by field. The entry of
Customer information often requires reference using ‘Paste Special’ to
settings entered in the Sales Ledger or other modules. Where use of ‘Paste
Special’ is appropriate, this is indicated in the text together with the module
in which the setting is to be found. Apart from Customer Categories
(described above), please refer to the chapter in this manual describing the
appropriate module for full details of a particular setting.

Header

No. Enter the unique code you are assigning to this
Customer. The field holds up to 20 letters and/or
numbers. Hansa offers a default based on the Customer
Number of the previous Customer entered. Once the
record has been saved, the Customer Number may not be
changed. It is the means by which this Customer will be
identified elsewhere in Hansa.

Short This field can be used as an alternative means of
identifying this Customer - information entered here
appears in the Short column in the ‘Customers: Browse’
window. Firms of a similar nature could be given the
same Short Code so that they would be grouped together
in the ‘Customers: Browse’ window when sorted by the
Code column. The field holds up to ten letters and/or
numbers.

Category Paste Special Customer Categories setting,
Sales Ledger

Used as default in Quotations, Orders, Invoices

Enter the Customer Category to which this Customer
belongs. Customer Categories enable you to classify
similar Customers together. All Customers of the same
Category can use the same default Price List, Discount
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Matrix and Debtor Account, saving you the work of
having to specify these for each Customer individually.

Name Enter the Name of the Customer.

Department The Department Name can be recorded here. This might
be necessary if you are dealing with several Departments
of the same Customer.

Alternatively, if your company has several departments,
that responsible for this Customer can be recorded here.
The Customer List report can be sorted into Department
order.

Contact Card

Inv. Address Used as default in Invoices

Enter here the address to which Invoices and statements
are to be sent.

If you want to give a name to each of the individual
address lines, use card 2 of the User Defined Fields
setting in the CRM module (described earlier in this
chapter). This can be useful if, for example, you want to
indicate that the town is always to be typed into the third
line of the address.

Sort Key This field can be used in countries where a post code, zip
code or other area code appears on a separate line in an
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address. Note that, if the field is used for this purpose, it
will need to appear on the standard Forms (Invoice,
Delivery Note, etc). Therefore, the models supplied with
Hansa will need to be modified accordingly using the
Form register in the System module.

You can also use this field to organise your Customers
into zones to provide a guide for delivery drivers. The
Sort Key is copied to the Sorting field of the Sales Order
record. The Sorted Order List report in the Sales Order
module is a list in Sort Key order of Orders with a
particular Planned Delivery Date.

Objects Paste Special Object register, Nominal
Ledger/System module

Used as default in Quotations, Orders, Invoices,
N/L Transactions

Up to 20 Objects can be assigned to each Customer,
separated by commas. They will be used as defaults in
all Orders, Invoices and other transactions involving this
Customer. You might define separate Objects to
represent different departments, cost centres or product
types. This provides a flexible method of analysis that
can be used in Nominal Ledger reports.

Creation Date This field automatically records when this Customer was
added to your Hansa database. It cannot be changed by
the user.

The Customer List report (described later in this chapter)
can be used to list Customers that were added or
changed after a certain date.

Last Changed This field is updated automatically by Hansa whenever
any modification is made to the Customer record on
screen.

Telephone, Fax, Mobile

Enter the Customer’s main telephone, mobile and fax
numbers here. If you have the CRM module, extensions,
direct line and mobile numbers and e-mail addresses for
each contact can be recorded there.

If you are using the Hansa Fax Server, the fax number
will be used when faxing documents to this Customer.
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The ‘Update Fax Numbers’ Maintenance function in the
System module can be used to remove spaces and dashes
from all Customers’ Fax Numbers. This will be
necessary if you will be sending faxes through the fax
server, in which case fax numbers should not contain
non-numeric characters.

Email If the Customer has an email address, enter it here.

Web Site If the Customer has a website, enter its address (URL)
here.

Primary Contact Paste Special Contact Person register, CRM
module

Used as default in Quotations, Orders, Invoices

The name of your main contact person can be entered
here: it will be transferred as a default entry whenever
this Customer is used in a transaction. If the CRM
module is installed, the ‘Paste Special’ selection list will
only show contact names for the Customer in question
(identified by Customer Number). If you need to add
more contact names, use the ‘New Contact’ function on
the Operations menu.

Classification Paste Special Customer Classifications
setting, CRM module

This field provides a further means of grouping
Customers of a similar type together. It can be used as a
reporting and mailing criterion in the CRM module and
in the Sales Ledger. It is possible to allocate more than
one Classification to each Customer, separated by
commas.

The ‘Add Class to Customer’ Maintenance function in
the CRM module can be used to assign Classifications to
Customers based on the Items they have bought or not
bought.
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Delivery Card

Del. Address Used as a default in Deliveries

Specify the Customer’s usual delivery address here.

If the Customer has several Delivery Addresses, they
can be recorded in the Delivery Addresses setting in the
Sales Orders module. The appropriate one can be
selected in Quotations, Orders, Invoices and Deliveries
as necessary.

If you want to give a name to each of the individual
address lines, use card 2 of the User Defined Fields
setting in the CRM module (described earlier in this
chapter). This can be useful if, for example, you want to
indicate that the town is always to be typed into the third
line of the address.

Order Comment Text entered here will appear as a default in the
Comment fields of Orders and Invoices for this
Customer.

Freight No In some countries each Customer can be allocated a
specific Freight Number which will be quoted on all
Deliveries. Freight Numbers can be included on delivery
documents if necessary.
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Del. Terms Paste Special Delivery Terms setting, Sales
Orders module

Used as default in Orders, Deliveries

Specify the Delivery Terms for this Customer here. You
will tend to use this field for international Customers:
examples might be Cost, Insurance, Freight or Free On
Board.

For each Delivery Term record you can specify
translations in different Languages: the Language for the
Customer will determine the text to be printed on any
Delivery Notes.

Del. Mode Paste Special Delivery Modes setting, Sales
Orders module

Used as default in Orders, Deliveries

Enter the mode of shipping most commonly used for this
Customer. Examples might be Post or Courier, or might
specify the name of one of the couriers that you use.

For each Delivery Mode record you can specify an
appropriate description in different Languages: the
Language for the Customer will therefore determine the
text to be printed on any Delivery Notes produced.

You can also set up different versions of documents such
as Invoices and Delivery Notes for each Delivery Mode,
perhaps incorporating appropriate payment instructions.
To do this, enter the Delivery Mode in the Language
field when defining documents. Document definition is
described in the ‘Work Area’ chapter earlier in this
manual.

Bank Account Enter the Customer’s main bank account number here.

Account Operator Paste Special Banks setting, Purchase Ledger

Enter the name of the Customer’s bank or building
society here.

Delivery Date Based On

When issuing Deliveries from Orders entered in this
Customer’s name, the Delivery Date can default to the
current date or to the Planned Delivery Date entered in
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the Order. Specify here which option is to be used for
this Customer.

If the Planned Delivery Date option is chosen, the
current date will be used if the Planned Delivery Date in
the Order is blank. The Planned Delivery Date field must
use the Date format, set in the Planned Delivery setting
in the Sales Orders module.

Terms Card

Pay. Terms Paste Special Payment Terms setting,
Sales/Purchase Ledger

Used as default in Invoices

In addition simply to ensuring the correct Payment
Terms appear on Invoices (in the Language of the
Customer if necessary), entering Payment Terms records
using the setting available in both the Sales and Purchase
Ledger modules can enable a system of early settlement
discounts to be established.

Specifying Payment Terms for each Customer and
therefore for each Invoice provides the basis for the
debt-chasing reports provided in Hansa.

In the Baltic States, there are circumstances where
Invoices should follow the same number sequence as
that used by Receipts and Cash In records. For this to
happen, define the number sequences using the left-hand
From and To fields on flip C of the Payment Modes
setting and check the Common Number Series box in the
Cash Book Settings setting in the Cash Book module.
Then, enter a Payment Mode to this field for cash
Customers. When one such Customer is entered to an
Invoice, the Invoice Number will change to one in the
correct sequence. When the Invoice is approved, it is
treated as paid and no posting to a Debtor Account is
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made. Instead, a debit posting is made to the Account of
the Payment Mode (i.e. a bank or cash Account).

Credit Limit Specify the Credit Limit for the Customer here. The
Credit Limit setting in the Sales Ledger can be used to
warn against or prevent the entering of Orders or
Invoices for Customers who have exceeded their Credit
Limit.

Their Supp. Code

Enter the Supplier Number allocated to your firm by this
Customer. It can be printed on Sales documents.

Invoice To Paste Special Customer register

If the Customer will not be paying your Invoices
themselves but may, for example, be purchasing through
a leasing company, enter the Customer Number of that
company here (that company must also be in the
Customer register).

When Invoices for this Customer are created from
Orders, they will be made out to the company specified
here.

ANA Code Record the unique number assigned by the Article
Numbering Association to this Customer here. This will
most usually be necessary if the Customer is an EDI
Customer (set using the check box on the ‘Terms’ card).
In the UK, companies with an ANA Code can create
their own bar codes.

Interest Rate When creating Interest Invoices for this Customer, enter
here the annual rate of interest to be used in calculating
interest charges.

If this field is blank, the percentage will be taken from
the Interest setting in the Sales Ledger. Wherever the
percentage is taken from, the Sales Account and VAT
Code are specified using the Interest setting: that setting
can also be used to determine any fee to be levied for the
raising of Interest Invoices.

Interest Invoices are raised using the ‘Create Interest
Invoices’ Maintenance function in the Sales Ledger, and
will only be raised for Customers whose Interest box has
been checked (‘Terms’ card).
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Closed Check this box if the Customer is no longer to be used
(Customer records cannot be deleted if Orders or
Invoices have been raised in their name). Closed
Customers will appear in the ‘Customers: Browse’
window but not in the Customers ‘Paste Special’ list.
You will not be able to enter Orders or Invoices for
closed Customers. A closed Customer can be re-opened
at any time.

On Hold Check this box if the Customer is on hold. You can raise
Invoices for Customers that are on hold, but you will not
be able to approve them (commit them to the Sales and
Nominal Ledgers). You will be able to enter Orders for
such Customers, but you won't be able to create
Deliveries (ship any goods to them).

Some Maintenance functions (e.g. ‘Create Contract
Invoices’ in the Contracts module and ‘Create Deliveries
from Orders’) will not create new records for Customers
that are on hold.

Reminders Check this box if the Customer is to receive reminders.
Please refer to the description of the Reminder document
in the ‘Documents’ section of the ‘Sales Ledger’ chapter
in Volume 2a for full details of this feature.

If this box is on for a Customer, you can ensure
reminders are not sent for particular Invoices by
checking the No Reminder box on the ‘Delivery’ card of
the Invoice screen.

Interest Check this box if the Customer is to be sent interest
Invoices for late payments. Please refer to the
‘Maintenance’ section of the ‘Sales Ledger’ chapter in
Volume 2a for full details of this feature.

If this box is on for a Customer, you can ensure interest
is not charged on particular Invoices by checking the No
Interest box on the ‘Delivery’ card of the Invoice screen.

On Account Check this box if you want to be able to register
Prepayments and On Account Receipts from this
Customer (i.e. you want to allow them to pay before you
have invoiced them). Full details can be found in the
‘Receipts’ section of the ‘Sales Ledger’ chapter in
Volume 2a.
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Before Prepayments and On Account Receipts can be
entered, an On Account A/C must be specified on card 2
of the Account Usage S/L setting. Alternatively, such an
Account can be specified for the Customer Category.
This Account will be credited with the value of these
Receipts.

Allow Login If you are using the Hansa Web Shop facility and wish
to allow this Customer to place Orders over the web,
check this box. They will use their Customer Number as
a Login ID, and you can allocate them a password using
the ‘Change Password’ function on the Operations menu
of the ‘Customers: Browse’ window.

Allow FTP Access If you are using the Hansa FTP facility and wish to
allow this Customer access to your FTP server, check
this box. They will use their Customer Number as a
Login ID, and you can allocate them a password using
the ‘Change Password’ function on the Operations menu
of the ‘Customers: Browse’ window.

EGO Customer This check box is designed for use in Denmark, where
for certain Customers Invoices are not printed out but
are sent electronically to a third party such as the Post
Office for processing. Check this box for all such
Customers. Please refer to your local Hansa
representative for full details.

EDI Customer The EDI (Electronic Data Interchange) module can be
used to receive Orders and issue Invoices electronically
in particular formats. If you have this module and this is
a Customer that uses this system, check this box. EDI
Invoices can only be raised for Customers with this box
checked. Please refer to your local representative for full
details.

Mailing Use these options to specify whether letters are to be
sent to the Customer. Letters are produced using the
Customer Letter register in the CRM module: please
refer to Volume 6 of these manuals for full details.

Allow Letters Printed letters and emails will be sent to the
Customer in all circumstances.

No Letters Printed letters and emails will not be sent to the
Customer in any circumstances.
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No mass mailing Printed letters will be sent to the Customer in all
circumstances, and single emails will be sent to
the Customer, but the Customer will not be
included in mass emailing campaigns. A mass
emailing campaign is one generated from a
Customer Letter whose Customer field is empty.

Pricing Card

Default Items Paste Special Default Items setting, Sales
Ledger

The Default Items setting allows you to define sets of
Items that are always to appear on Invoices for certain
Customers: specify here a particular Default Item record
(i.e. a particular set of Items) for this Customer. The
Items will be added as soon as the Customer is specified
in the Invoice. They will also be added to Invoices
created from Orders (although they will not appear in the
Orders themselves or in Deliveries) and to those created
in batches using the ‘Group Invoicing’ Maintenance
function in the Sales Orders module. They will not
appear in Interest Invoices.

Price List Paste Special Price List register, Pricing
module

Used as default in Quotations, Orders, Invoices

If you wish to assign a particular Price List to a
Customer, you can do so here. It will determine the
prices used in Orders and Invoices for this Customer.

Note that it is also possible to allocate Price Lists to
Customer Categories. This makes it easy to allocate or
change the Price List of a group or Customers in a single
step. Any Price List specified here will override that of
the Customer Category (if any) to which the Customer
belongs.
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Please refer to the ‘Price List’ section in the ‘Items and
Pricing’ chapter for full details of how to use Price Lists.
If you need to use dated Price Lists, please refer also to
the section below describing the Price Based On options.

Discount Matrix Paste Special Discount Matrix register,
Pricing module

Used as default in Quotations, Orders, Invoices

If you wish to assign a particular Discount Matrix to an
individual Customer you can do so here. Discount
Matrices allow you to set up a quantity discount
structure and are fully described in the next chapter,
‘Items and Pricing’. When receiving Orders from this
Customer, the Discount Matrix entered here will
determine the default percentage discount for each Item,
depending on quantity ordered.

Note that it is also possible to allocate Discount Matrices
to Customer Categories. This makes it easy to allocate or
change the Discount Matrix of a group of Customers in a
single step. Any Discount Matrix specified here will
override that of the Customer Category (if any) to which
the Customer belongs.

Salesman Paste Special Person register, System module

Used as default in Quotations, Orders, Invoices

Enter the initials of the salesman responsible for this
Customer’s account. By default, Orders and Invoices for
this Customer will be attributed to the salesman entered
here.

This field is also used by the Limited Access module:
please refer to the description of the Sales Group field
(below) for details.

Sales Group Paste Special Sales Groups setting, System
module

Default taken from Salesman

The Sales Group is brought in from the Person record
after you have entered a Salesman. If the Limited Access
module is present, this field can be used to prevent a user
from seeing all Customers in the ‘Customers: Browse’
and Customer ‘Paste Special’ windows by restricting
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their view to their own Customers or to those of their
Sales Group.

Please refer to the section describing the Person register
in the ‘System Module’ chapter later in this Volume for
full details of the Limited Access module.

Price Based On When entering Orders, if you are using dated Price Lists
the choice of Price List can depend on the Order Date,
the Planned Delivery Date or the Despatch Date. Specify
here which option is to be used for this Customer.

If the Planned Delivery Date option is chosen, the
standard Price List will be used if the Planned Delivery
Date in the Order is blank or in the wrong format. The
Planned Delivery Date field must use the Date format,
set in the Planned Delivery setting in the Sales Orders
module. If the Despatch Date option is chosen, the
standard Price List will be used if the Despatch Date in
the Order is blank. The standard Price List is that entered
to the Customer record above or the Customer Category.

When entering Invoices directly to the Invoice register,
Price List selection will always depend on the Invoice
Date. Similarly, when entering Quotations, Price List
selection will always depend on the Quotation Date.

Dated Price Lists are described in the ‘Items and
Pricing’ chapter later in this Volume.

Currency Paste Special Currency register, System
module

Used as default in Quotations, Orders, Invoices,
N/L Transactions

Specify here the Currency to be used for invoicing this
Customer. When entering Orders or Invoices, all prices
of Items will be converted from the home Currency to
that specified here using the latest Exchange Rate.

Hansa will prevent the entry of Orders, Invoices,
Quotations and Receipts in the name of this Customer
using Currencies other than that specified here. If you
need to be able to use more than one Currency with a
particular Customer, leave this field blank.
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Once a Currency has been entered in this field and the
Customer has been used in a transaction of any kind, this
Currency should not be changed.

Company Card

Comment This field can be used to record any additional
information about the Customer. Comments entered here
will be shown on Sales Ledger reports featuring this
Customer.

Warning Text entered here will be used to alert users whenever an
Order or Invoice is entered for this Customer.

Reg. No. 1 If the Customer is a limited company, enter their
Company Registration Number here.

Reg. No. 2 Paste Special Registration Defaults setting,
Sales Ledger

This field is used in Finland, where companies have two
registration numbers.

Elsewhere, the ‘Paste Special’ link to the Registration
Defaults setting can be used to bring in a default VAT
Code and Language.

Country Paste Special Countries setting, System
module

Specify a code for the Country in which the Customer is
located. Once this has been specified, entering a VAT
Number below will cause Hansa to check it is in the
correct format for the Country. VAT Number formats
are defined in the VAT Number Masks setting in the
System module.
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Language Paste Special Languages setting, System
module

It is possible to set up different versions of documents
such as Invoices and Delivery Notes for Customers with
different Languages: the Language code specified here
will be used as a default in determining which document
is used (it can be overridden for individual Orders). In
addition, some of the information shown on the
documents, such as Item Names, Payment Terms and
Delivery Modes, can be made to appear in the
appropriate translation.

VAT Code Paste Special VAT Codes setting, Nominal
Ledger

The VAT Code entered here refers to a VAT Code
record entered using the VAT Codes setting in the
Nominal Ledger. It determines the rate at which VAT
will be charged to this Customer and the VAT Account
to be credited.

When creating Orders or Invoices for this Customer, in
determining which VAT Code is to be used, that entered
here will take precedence over those specified for the
Item and the Item Group and that on card 3 of the
Account Usage S/L setting in the Sales Ledger. Usually,
you should only specify a VAT Code for an individual
Customer if for some reason your usual VAT accounting
method does not apply to them.

Zone Used as default in Orders, Invoices, Nominal
Ledger Transactions

Select a Zone for this Customer. This will be used in
Orders and Invoices to control VAT calculation and
accounting and the choice of Sales Account. Separate
default VAT Codes and Sales Accounts can be assigned
to each Zone on card 3 of the Account Usage S/L setting
in the Sales Ledger.

For Customers in the “Within EU” Zone, it is important
that their VAT Number is recorded (see below). When
Invoices are raised for such Customers, VAT will not be
charged, irrespective of the VAT Code used on card 3 of
the Account Usage S/L setting.
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VAT Reg No It is important that the Customer’s VAT Number is
recorded here if they are in the “Within EU” Zone as this
information is required for EU VAT reporting purposes.

A check is made when the record is saved that the VAT
Number has not been used for any other Customer. If
this check fails, you can find the other Customer by
searching for the VAT Number in the Customer List
report (Detailed version).

Hansa contains a feature whereby it will check that the
VAT Number entered here is in the correct format for
the Customer’s Country. The correct format should be
defined in the VAT Number Masks setting in the System
module. If the Country is blank, the Country from the
Company Info setting will be used. If that is blank, no
validation check will be made.

Because of this feature, be sure to enter the Customer’s
Country above before their VAT Number.

Web Card

Main Classification

Paste Special Item Classifications setting,
Stock module

If you are using Hansa’s Web Shop, you may wish to
offer different Items to different Customers. This is done
by dividing the Items into sets known as
“Classifications” and then specifying a Classification for
each Customer. Customers will see only those Items in
the relevant Classification when they log on to your Web
Shop site.

Classifications are defined using a setting in the Stock
module, described in the ‘Items and Pricing’ chapter
elsewhere in this manual. Items can belong to more than
one Classification.
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If a Classification has been specified at the individual
Customer level, it will override one that has been
specified at the Customer Category level.

If no Classification has been specified for a Customer or
Customer Category, the Classification with the Code
“MAIN” will be used. If there is no “MAIN”
Classification, or if a non-existent Classification has
been specified for the Customer, no Items will listed
when the Customer logs on.

Display on the Web

Paste Special Display on the Web setting,
Web Shop module

Web Shop Customers are usually shown the prices of
your Items, but not the current stock levels of those
Items. If you want to change either or both of these
defaults for a particular Customer, enter an appropriate
record in the Display On The Web setting in the Web
Shop module, and then enter the Code of that record in
this field.

Freight Code Paste Special Web Freight setting, Web Shop
module

If you are using Hansa’s Web Shop, you may wish to
define various methods by which freight charges will be
calculated on Orders placed over the web (e.g. for local,
national and international delivery). These calculation
methods are defined in the Web Freight setting in the
Web Shop module: specify here which method is to be
used for this Customer.

User Defined Card

Please refer to the description of the User Defined Fields setting earlier in this
chapter for details of this card.

Editing a Customer

The Customer register must be kept up to date, so it will need editing from
time to time.

In the ‘Customers: Browse’ window which appears when the Customer
register is opened, the Customers are initially shown in Customer Number
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order. You can change the sort order by clicking on one of the headings. The
underlined heading shows the current sort order.

To search for a specific Customer, enter the text to be found in the Search
field in the top right-hand corner of the window and press Return. The text
should be such that it would appear in the current sort column: to search by
Company Name, for example, sort by Company Name before entering a
Company Name (or its initial letters) to the Search field.

To modify a Customer’s record, double-click on the line in the browse
window. That record will be opened in a window entitled ‘Customer:
Inspect’. The fields in this window are the same as those in the ‘Customer:
New’ window: please refer to the previous section for a detailed description
of each field.

Edit the fields as necessary. Move from field to field with the Return key, or
with the arrow keys. Click [Save] when you have finished, to save changes.

Deleting a Customer

Select and open the Customer record in the same way as for editing. Select
‘Delete’ from the Record menu. The Customer is deleted. Note that once
Orders or Invoices have been entered in a Customer’s name, that Customer
can no longer be deleted.

You cannot undo the deletion of a
Customer record.

Operations Menu

The Operations menus for Customers are shown above. On the left is that for
the ‘Customers: Browse’ window: highlight a Customer in the list before
selecting the function. You can also apply the function to a group of
Customers: highlight the first Customer in the group and then click on the last
while holding down the Shift key. Then select the function. On the right is
that for the ‘Customer: New’ and ‘Customer: Inspect’ windows.

!
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Customer Status

The ‘Customer Status’ function provides a short cut to the Customer Status
report, otherwise only available in a less detailed form in the Sales Ledger.

In its basic form, this report shows address and turnover information and lists
all Contact Persons for the Customer currently on screen or for those
Customers highlighted in the browse window. However, if required, more
information can be shown in the report, such as lists of recent Activities,
Invoices, Contract Quotations, Contracts, Quotations and Orders, and
monthly sales figures for the past year. Use the Customer Status Report
setting in the CRM module to control how much of this additional
information will be shown to different users, each of whom can be given a
different report definition. Much of this additional information will not be
shown if the report is produced from the Sales Ledger.

The Customer Status report has Hansa’s Drill-down feature. Many records
such as Contact Persons, Quotations and Invoices can be opened by clicking
in the appropriate places (i.e. on Contact Person names and on Quotation and
Invoice Numbers). Text with the drill-down feature is shown underlined in
the report.

Change Password

If you are using the Hansa Web Shop facility and have Customers who will
be placing Orders over the web, you should use this function to give them
passwords. Such Customers should also have the Allow Login box on the
‘Terms’ card of their Customer records checked. They will use their
Customer Number as a Login ID.

To set a password for a Customer, highlight their name in the ‘Customers:
Browse’ window and select ‘Change Password’ from the Operations menu.
The following window is opened—

Enter the old password if there is one and then type in the new one twice to
ensure that it is correct. Passwords are case-sensitive. Press the Shift-Enter
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key combination to close the window and save: use the close box if you do
not want to save changes.

If you want to set rules for passwords (e.g. to impose a minimum number of
characters, or to require at least one alpha or numeric character), use the
Password Security setting in the System module.

New Contact

This function can be used to create records in the Contact Person register in
the CRM module, allowing you to add to the list of contact names for this
Customer.

When you select the function, the following screen appears, where you can
create a new Contact Person record—

The new record is opened in a window entitled ‘Contact Person: New’. This
means that it has not yet been saved. The Customer Number and Name are
brought in automatically. After adding the person’s name and making other
changes as necessary, save the record in the Contact Person register by
clicking the [Save] button in the Button Bar and close it using the close box.
Alternatively, if you no longer require the record, click [Cancel]. In either
case, you will be returned to the Customer window.
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The Customer does not have to be saved before creating a Contact Person.

Please refer to Volume 6 of these manuals for full details of the ‘Contact
Person: New’ window.

Create Activity

This function can be used to create records in the Activity register in the
System module. This can be useful if it is necessary, for example, to schedule
a call to a new Customer.

When you select the function, the following screen appears, where you can
create a new Activity—

The new record is opened in a window entitled ‘Activity: Inspect’. This
means that it has already been saved and is being opened for checking. The
Customer Number, Name and Phone Number are brought in automatically to
the fields on the ‘Customer’ card. No default Activity Type will be offered,
while the Task Type will be To Do, and the Symbol will be Other. The Start
Date of the Activity will be the current date, and the Person will be the
current user.

After amendment if necessary, save the record in the Activity register by
clicking the [Save] button in the Button Bar and close it using the close box.
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Alternatively, if you no longer require the Activity, remove it using the
‘Delete’ function on the Record menu. In either case, you will be returned to
the Customer window.

The Customer and the Activity will be connected to each other through the
Attachments facility. This allows you to open the Customer quickly and
easily when reviewing the Activity, or to open the Activity from the
Customer. When viewing the Activity or Customer, click the button with the
paper clip image to open a list of attachments. Then double-click an item in
this list to open it.

The Customer does not have to be saved before creating an Activity.

Please refer to Volume 6 of these manuals for full details of the ‘Activity:
Inspect’ window.

Create Random Password Mail

If you are using the Hansa Web Shop facility and have Customers who will
be placing Orders over the web, you can use this function to generate
passwords for them. Such Customers should also have the Allow Login box
on the ‘Terms’ card of their Customer records checked. They will use their
Customer Number as a Login ID.

To set a password for a Customer, double-click their name in the ‘Customers:
Browse’ window and, when the ‘Customer: Inspect’ window opens, select
‘Create Random Password Mail’ from the Operations menu. The window
shown on the next page appears, where you can create a new Mail.
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The new record is opened in a window entitled ‘Mail: Inspect’. This means
that it has already been saved and is being opened for checking. The current
user will be the default sender of the Mail. The To field will contain the email
address of the Customer. The Subject field will contain the random password.
After you have written a message and when you are then ready to send the
Mail, check the Sent box. Finally, save the Mail by clicking the [Save] button
in the Button Bar. If you are using the Lock and Send E-Mails Automatically
option in the Mail Settings setting in the Technics module and the Mail
contains an external email address (i.e. one with the @ sign), it will now be
sent automatically. If you are not using this option, select ‘Send E-mail’ from
the Operations menu after the Mail has been saved. Finally, close the Mail
using the close box. You will be returned to the Customer window.

If the function does not create a Mail, the probable causes are—

1. The current user does not have a Mailbox.

2. The Customer does not have an email address.

3. The Customer has not been saved.
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Documents

Introduction

Customer documents can be printed from the Sales Ledger. Use the Modules
menu to ensure you are in the Sales Ledger and then select ‘Documents’ from
the File menu or click [Documents] in the Master Control panel. Then,
double-click the appropriate item in the list. A specification window will then
appear, where you can decide the Customers for which documents are to be
printed. Click [Run] to print the documents.

Where specified below, it is often possible to report on a selection range,
such as a range of Customers. To do this, enter the lowest and highest values
of the range, separated by a colon. For example, to report on Customers 001
to 010, enter “001:010” in the Customer field. Depending on the field, the
sort used might be alpha or numeric. In the case of an alpha sort, a range of
1:2 would also include 100, 10109, etc.

To determine which Form is printed, follow this procedure (when Hansa is
supplied, a sample Form will be printed)—

1. Design a Form (or change the sample Form supplied to reflect your own
requirements) using the Form register in the System module. This
process is fully described in the chapter later in this manual describing
the System module. The sample Form supplied has the Form Code
“CUST_LABEL”.

2. Change to the Sales Ledger module and open the ‘Documents’ window
using the ‘Documents’ item on the File menu or by clicking the
[Documents] button in the Master Control panel.

3. Highlight the item in the list and select ‘Define Document’ from the
Operations menu. The subsequent window is used to assign a Form (or
more than one Form) to the document and is fully described in the
‘Documents’ section of the ‘Work Area’ chapter earlier in this manual.
In this instance, enter “CUST_LABEL” in the Form field of the first line.

4. The ‘Define Document’ function only needs to be used once. After this
has been done, Form selection will be automatic.
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Customer Labels

This document prints name and address labels to Customers. The Invoice
Address from the ‘Contact’ card of the Customer screen is used.

Customer Paste Special Customer register

Range Reporting Alpha

Enter the Customer Number or range of Numbers for
which you want the labels printed.

Category Paste Special Customer Categories setting,
Sales Ledger

Select a Customer Category. Labels will be printed for
all Customers in that Category.

Classification Paste Special Customer Classifications
setting, CRM module

Select a Customer Classification. Labels will be printed
for all Customers in that Classification. If you enter a
number of Classifications separated by commas, labels
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will only be printed for those Customers featuring all the
Classifications listed.

Sort Key Enter a Sort Key. Labels will be printed for all
Customers with that Sort Key.

Start with Label No.

If you will be printing to a sheet of labels, some of
which have already been used, specify here where on the
sheet you wish to begin printing.

Country Paste Special Countries setting, System
module

To print labels for Customers in a particular Country,
enter that Country here.

Vertical Margin If you want the labels to be printed with a non-standard
vertical margin (vertical spacing between the labels),
specify the margin that you want to be used here. The
standard margins (which will be used if you leave this
field empty) are—

Label Format Vertical Margin

2 x 8 103
3 x 8 103
1 x 1 1
2 x 4 206

Labels for Contact Persons

If you have the CRM module and wish to print labels for
all Contact Persons for the Customers in the selection (or
for Contact Persons selected using the two options
below), switch on this check box.

Include Closed Customers

Usually, labels will not be printed for Closed Customers
(Customers whose Closed box on the ‘Terms’ card is
checked). If you want to include such Customers in your
label printing run, check this box.

Job Description Paste Special Job Descriptions setting, CRM
module

If you have the CRM module and wish to print labels for
Contact Persons with a particular Job Description, enter
that Job Description here.



Chapter 5: Customers - Documents - Customer Labels

265

Class. of Cont. Pers.

Paste Special Customer Classifications
setting, CRM module

Select a Customer Classification. Labels will be printed
for all Contact Persons with that Classification.

Sorting The labels can be sorted by Customer Number,
Customer Name or Sort Key.

Function Choose which of the four standard label formats you
would like to use.

Illustrated below is a sample CUST_LABEL record from the Form register in
the System module. Note that each field should only be drawn once: the label
printing function will print the fields the appropriate number of times on each
page.

Fields are added to the Form design in the usual way (click the [Field] button
and draw a rectangle where you want the field to appear). When the Field
dialogue box opens, specify the Fieldname. The one departure from the usual
procedure is that the Format of each field must be set to 1—
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Setting the Format to 1 ensures the labels will be aligned properly.

If you want static text to be printed on your labels (i.e. text that identifies the
information on the labels, such as “Customer Name”), follow these steps—

1. Click the [Field] button and draw a rectangle where you want the static
text to appear. The Field dialogue box opens.

2. Leave the Fieldname blank and enter the static text in the Field
Argument field.

3. Click [OK] to save.

4. Do not use the [Text] button for this purpose: any text entered this way
will be printed for the first label only.
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Reports

Introduction

Customer reports are located in the Sales Ledger. Use the Modules menu to
ensure you are in the Sales Ledger and then select ‘Reports’ from the File
menu or click [Reports] in the Master Control panel. Then, double-click the
appropriate item in the list. A specification window will then appear, where
you can decide what is to be included in the report. Leave all the fields in this
window blank if the report is to cover all the Customers in the database. If it
is necessary to restrict the coverage of the report, use the fields as described
individually for each report.

Where specified below, it is often possible to report on a selection range,
such as a range of Customers, or a range of Items. To do this, enter the lowest
and highest values of the range, separated by a colon. For example, to report
on Customers 001 to 010, enter “001:010” in the Customer field. Depending
on the field, the sort used might be alpha or numeric. In the case of an alpha
sort, a range of 1:2 would also include 100, 10109, etc.

Using the options at the bottom of the specification window, determine the
print destination of the report (the default is to print to screen). You can
initially print to screen and subsequently send the report to a printer using the
Printer icon.

Once you have entered the reporting criteria and have chosen a print
destination, click [Run].

Customer List

This is a simple listing of all the Customers in the Customer register. It can
be produced from the ‘Reports’ list in the Sales Ledger or the CRM module.
It can also be produced for an individual Customer by clicking the Printer
icon when that Customer is open in a record window. In this case, it will be
printed as if the Include all Contact Persons box is on.

The Customer List report has Hansa’s Drill-down feature. Click on any
Customer Number in the report to open that Customer record.
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Leave all the fields blank if the report is to cover all the Customers in the
Customer register. If it is necessary to restrict the coverage of the report, use
the fields as described below.

Customer Paste Special Customer register

Range Reporting Alpha

Use this field to limit the report to a single Customer, or
range of Customers.

Category Paste Special Customer Categories setting,
Sales Ledger

To restrict the report to Customers of a single Category,
enter a Category Code here.

Salesman Paste Special Person register, System module

To restrict the report to Customers of a single Salesman,
enter a Salesman’s initials here.
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Sales Group Paste Special Sales Groups setting, System
module

To restrict the report to Customers with a particular
Sales Group (shown on the ‘Pricing’ card of the
Customer screen), enter that Sales Group here.

Language Paste Special Languages setting, System
module

To restrict the report to Customers with a particular
Language, enter a Language Code here.

Payment Terms Paste Special Payment Terms setting,
Sales/Purchase Ledger

Use this field to restrict the report to Customers with the
same Payment Terms.

Classification Paste Special Customer Classifications
setting, CRM module

Enter a Classification Code in this field if you want to
list Customers with a certain Classification. If the field is
empty, all Customers, with and without Classification,
are included. If you enter a number of Classifications
separated by commas, only those Customers featuring all
the Classifications listed will be shown. If you enter a
number of Classifications separated by plus signs (+), all
Customers featuring at least one of the Classifications
listed will be shown. If you enter a Classification
preceded by an exclamation mark (!), all Customers
featuring any Classification except the one listed will be
shown.

For example—

1,2 Lists Customers with Classifications 1 and 2
(including Customers with Classifications 1, 2
and 3).

1+2 Lists Customers with Classifications 1 or 2.

!2 Lists all Customers except those with
Classification 2.

1,!2 Lists Customers with Classification 1 but
excludes those with Classification 2 (i.e.
Customers with Classifications 1 and 2 are not
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shown). Note the comma before the exclamation
mark in this example.

!1,!2 Lists all Customers except those with
Classification 1 or 2 or both. Again, note the
comma.

Classification Types

Paste Special Classification Types setting,
CRM module

Enter a Classification Type in this field if you want to
list Customers with a Classification belonging to that
Type. If the field is empty, all Customers, with and
without Classification, are included. If you enter a
number of Classification Types separated by commas,
Customers featuring a Classification belonging to any of
those Types will be shown.

Object Paste Special Object register, System module

To restrict the report to Customers with a particular
Object, enter the Object’s Code here.

Country Paste Special Countries setting, System
module

To restrict the report to Customers in a particular
Country, enter the Country Code here.

New or updated since

Paste Special Current Date

This field refers to the Last Changed field on the
‘Contact’ card of the Customer record and can be used to
display recently entered or changed Customers.

Sort Key Enter a Sort Key. All Customers with that Sort Key will
be listed in the report.

Short Enter a Short Code. All Customers with that Short Code
will be listed in the report.

Include all Contact Persons

This option will list all Contacts for each Customer, as
recorded in the Contact Person register in the CRM
module.
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Sorting These radio buttons control the sort order of the report.
The default is to print the report in Customer Number
order, but you can also print in Name, Category, Sort
Key, Department or Telephone Number order.

Function These radio buttons control the level of detail shown in
the report.

Detailed This, the default option, prints a comprehensive
report that includes virtually all the information
stored in each Customer record.

Phone This choice produces a simple list showing the
Customer Number, Name, Telephone Number,
and Contact Person.

Fax This option is the same as the previous one, with
the exception that Fax Numbers are printed
instead of Telephone Numbers.

E-Mail This is also the same as the Phone option, with
the exception that Email Addresses are printed
instead of Telephone Numbers.

Include Use these options to specify whether Closed Customers
(Customers whose Closed box on the ‘Terms’ card is
checked) are to be included in the report.

Not Closed Closed Customers are not listed in the report.

Closed Both open and Closed Customers are listed in the
report.

Closed Only Closed Customers only are listed in the report.
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Customer Statistics

This report displays trading statistics for each Customer, including turnover,
margin and gross profit.

Leave all the fields blank if the report is to cover all the Customers in the
Customer register. If it is necessary to restrict the coverage of the report, use
the fields as described below.

Customer Paste Special Customer register

Range Reporting Alpha

Use this field to limit the report to a single Customer, or
range of Customers.

Item Paste Special Item register

To limit the report to a single Item, enter an Item
Number here.

Categories Paste Special Customer Categories setting,
Sales Ledger

Range Reporting Alpha

To restrict the report to Customers of a single Category,
enter a Category Code here.
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Classification Paste Special Customer Classifications
setting, CRM module

Enter a Classification Code in this field if you want to
list Customers with a certain Classification. If the field is
empty, all Customers, with and without Classification,
are included. If you enter a number of Classifications
separated by commas, only those Customers featuring all
the Classifications listed will be shown.

Salesman (from Cust.)

Paste Special Person register, System module

To restrict the report to Customers of a single Salesman,
enter a Salesman’s initials here.

Sales Group (from Cust.)

Paste Special Sales Groups setting, System
module

To restrict the report to Customers with a particular
Sales Group (shown on the ‘Pricing’ card of the
Customer screen), enter that Sales Group here.

Period Paste Special Reporting Periods setting,
System module

Enter the start and end dates of the reporting period,
separated by a colon.

Min Turnover Enter a value to exclude customers with a lower turnover
during the period.

Min. GP Enter a value to exclude customers with lower gross
profit.

Object on Customer

Paste Special Object register, System module

To restrict the report to Customers with a particular
Object, enter the Object’s Code here.

Country on Customer

Paste Special Countries setting, System
module

To restrict the report to Customers in a particular
Country, enter the Country Code here.
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Sorting The report can be sorted by Customer Number or Name.

Customer Info Only

Usually, this report shows the turnover, margin and
gross profit for each Customer in the list, with totals at
the bottom. If this box is checked, only the totals are
shown. In the body of the report, telephone and fax
numbers are shown in place of the individual Customer
statistics.

Customer Sales Statistics

This report is a simple list of Customers, showing the turnover and gross
profit for each one. Unlike the Customer Statistics report described above,
however, it sorts the Customers by sales (turnover or gross profit), allowing
the most or least successful to be ascertained easily. The statistics are
compiled from approved Invoices only.

Period Paste Special Reporting Periods setting,
System module

Enter the start and end dates of the reporting period,
separated by a colon. The period should consist of a
number of whole months otherwise the report will not be
produced.
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Customers Paste Special Customer register

Range Reporting Alpha

Use this field to limit the report to a single Customer, or
range of Customers.

Customer Category

Paste Special Customer Categories setting,
Sales Ledger

To restrict the report to Customers of a single Category,
enter a Category Code here.

No. of Customers shown

Enter here the number of Customers to be shown in the
report. For example, to list the ten most or least
successful Customers, enter “10” here.

Function These options control the sort order of the report.

Highest Sales Choose this option to sort the report so that the
most successful Customers in terms of turnover
are at the top.

Lowest Sales Choose this option to sort the report so that the
least successful Customers in terms of turnover
are at the top. This will not include Customers
with no sales, unless the Include Customers with
no sales box (below) is also checked.

Highest Gross Profit

Choose this option to sort the report so that the
most successful Customers in terms of gross
profit are at the top.

Include Customers with no sales

Check this box if you want to include in the report
Customers that have not bought from you during the
report period.

Customer Status

This reports shows the paid and unpaid Invoices for each Customer in the
selection. The age of due Invoices is shown together with their Reminder
Levels as are Receipts and total turnover and amount due figures.
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The Customer Status report has Hansa’s Drill-down feature. Click on the
Invoice Number of any Invoice in the report to open that Invoice record.

Leave all the fields blank if the report is to cover all the Customers in the
Customer register. If it is necessary to restrict the coverage of the report, use
the fields as described below.

Customer Paste Special Customer register

Range Reporting Alpha

Use this field to limit the report to a single Customer, or
range of Customers.

Category Paste Special Customer Categories setting,
Sales Ledger

To restrict the report to Customers of a single Category,
enter a Category Code here.

Customers with Balance Only

Switch this option on to exclude Customers with no
unpaid Invoices. Customers with unpaid Invoices that
are not yet due for payment will not be excluded.

Function Use these options to limit the report to include only the
last five paid Invoices (the default), or to start the report
from a specific date.
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Chapter 6: Items and Pricing
The Item register is used to store information about the products and services
that you sell. It is accessible from the Sales Orders, Purchase Orders and
Sales Ledger modules, and from the Contracts, Production, Quotations,
Service Orders and Job Costing modules if installed.

Items of a similar type can be grouped together using Item Groups. All Items
of the same Group can be given the same default Sales and Cost Accounts,
Credit Account and VAT Codes, saving you the work of having to specify
these for all Items individually. Defining and assigning Item Groups also
makes modification easier: if it is necessary to assign a different Cost
Account, for example, only one change need be made (to the Item Group),
rather than many (to each of the Items).

If information is specified both for an Item Group and for an Item that
belongs to that Group, that entered for the Item will take precedence.

This chapter first describes the defining of Item Groups. This is followed by a
detailed description of the Item register and of Hansa’s pricing features. The
final section covers Item-related reports.

The Item Group Register
It can be practical to organise Items of similar kinds into Item Groups. This
option gives you more flexibility in reporting, and helps you to achieve an
efficient accounting of costs and stock values.

Entering Item Groups

Item Groups are defined using the register in the Sales Ledger. Use the
Modules menu to enter the Sales Ledger and then select ‘Item Groups’ from
the Registers menu or click [Item Groups] in the Master Control panel. Then
click [New] to open a new record, or double-click an existing record to
modify it.
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Header

No. Enter the code or number identifying this Item Group.
You can use any combination of letters and numbers.
There is a maximum of five characters.

Name Enter the name or description of the Item Group.

A/C Card

Sales Accounts Paste Special Account register, Nominal
Ledger/System module

Used as default in Invoices, N/L Transactions

One of the Sales Accounts specified in these three fields
will be credited whenever a member of this Group is
used on an Invoice, depending on the Zone of the
Customer (specified on the ‘Company’ card of the
Customer screen). If the Item has a Sales Account
specified for the appropriate Zone, or there is a record in
Price register for the appropriate Item/Price List
combination which has a Sales Account specified, those
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will take precedence over any entry here. If these fields
are blank, the Sales Account will be taken from the
Account Usage S/L setting in the Sales Ledger.

The Accounts specified here will usually be used in both
Invoices and Credit Notes. If you would like to use
different Accounts in Credit Notes, these should be
specified on the ‘Credit A/C’ card of this Item Group
record. You should also check the Use Credit Sales
Accounts box on card 1 of the Account Usage S/L
setting.

VAT Codes Paste Special VAT Codes setting, Nominal
Ledger

Used as default in Invoices, N/L Transactions

Enter a VAT Code for each Zone. Each will specify the
VAT Account to be credited whenever a member of this
Group is used on an Invoice and the rate at which VAT
will be charged. The Zone used will depend on that
specified for the Customer.

If the Customer or Item has a VAT Code specified, they
will take precedence over any entry here. If these fields
are left blank, the VAT Code will be taken from card 3
of the Account Usage S/L setting.

The VAT Codes specified here will usually be used in
both Invoices and Credit Notes. If you would like to use
different VAT Codes in Credit Notes, these should be
specified on the ‘Credit A/C’ card of this Item Group
record. You should also check the Use Credit Sales
Accounts box on card 1 of the Account Usage S/L
setting.

Cost A/C Paste Special Account register, Nominal
Ledger/System module

If you are maintaining stock valuations in the Nominal
Ledger, specify here the Account to be debited with the
calculated cost of goods when Items which are members
of this Item Group are sold (removed from stock). The
cost of goods is calculated using the Cost Model chosen
on the ‘Cost’ card. If blank, the Stock Cost Account on
card 5 of the Account Usage S/L setting will be debited.
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This Account will only be used as described above if the
Use Item Groups for Cost Accounts option in the Cost
Accounting setting in the Stock module is in use. If so, it
is recommended that all Stocked Items belong to Item
Groups and that all Item Groups have Cost, Purchase
Control and Stock Accounts specified.

Please refer to the ‘Cost Accounting’ section of the
‘Stock Module’ chapter in Volume 3 of these manuals
for full details of this feature.

As with all Accounts on this screen, make sure the
desired Account is defined in the Account register
(available in the Nominal Ledger and the System
module) to ensure that Nominal Ledger Transactions are
generated without difficulty: Hansa will not attempt to
post to non-existent Accounts.

Stock A/C Paste Special Account register, Nominal
Ledger/System module

If you are maintaining stock valuations in the Nominal
Ledger, specify here the Account to be credited with the
calculated cost of goods when Items which are members
of this Item Group are sold. The cost of goods is
calculated using the Cost Model chosen on the ‘Cost’
card. This Account will be used for Items which do not
have a Location specified, or if the Location has no
Stock Account. If this Account is blank, the Stock
Account on card 5 of the Account Usage S/L setting will
be credited.

Where no Location or a Location with no Stock Account
is specified, this Account will be debited when Items
which are members of this Item Group are received into
stock. Again, if this field is blank, the Stock Account
from the Account Usage S/L setting will be debited.

For both goods out and goods in transactions, this
Account will only be used as described above if the Use
Item Groups for Cost Accounts option in the Cost
Accounting setting in the Stock module is in use. If so, it
is recommended that all Stocked Items belong to Item
Groups and that all Item Groups have Cost, Purchase
Control and Stock Accounts specified.
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Purch. Control A/C

Paste Special Account register, Nominal
Ledger/System module

If you are maintaining stock valuations in the Nominal
Ledger, specify here the Account to be credited when
Items which are members of this Item Group are
received into stock. If this field is blank, the Purchase
Control Account on card 5 of the Account Usage S/L
setting will be credited.

This Account will only be used as described above if the
Use Item Groups for Cost Accounts option in the Cost
Accounting setting in the Stock module is in use. If so, it
is recommended that all Stocked Items belong to Item
Groups and that all Item Groups have Cost, Purchase
Control and Stock Accounts specified.When a Purchase
Invoice is created from a Purchase Order, the Cost
Accounts in the Invoice will depend on the Purchase
Order Item Transfer Control option chosen in the
Purchase Invoice Settings setting in the Purchase
Ledger. If Purchase Order Item Transfer Control is set to
Consolidate By Items And Project or to Transfer Each
Row Separately, the Cost Account for Items belonging
to this Item Group will be the Account specified here.
This will be the debit Account in the Nominal Ledger
Transaction that results from the Invoice. Again, if this
field is blank, the Purchase Control Account from the
Account Usage S/L setting will be used for this purpose.

Do Not Print Freight Labels for this Group

You can prevent the printing of Freight Labels for
certain Items. To do so, place these Items in an Item
Group whose Do Not Print Freight Labels for this Group
option is switched on. This is useful for Service Items
such as labour.

Please refer to the ‘Stock Module’ chapter in Volume 3
of these manuals for details about printing Freight
Labels.
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Cost Card

If you are maintaining stock valuations in the Nominal Ledger (‘cost
accounting’), this card is concerned with the selection of the Cost Model for
this Item Group. The Cost Model is the valuation method that will be used to
calculate the amount to be debited to the Cost Account and credited to the
Stock Account whenever an Item is sold. Both these Accounts are specified
on the ‘A/C’ card.

The Cost Model will be chosen as follows—

• in the case of cost accounting transactions created from Deliveries, it will
be the Cost Model, Delivery specified in the Cost Model setting in the
Sales Ledger;

• in the case of cost accounting transactions created from Invoices, it will
be the Cost Model specified here. If that Cost Model is “Default”, or the
Item Group does not have Cost and Stock Accounts on the ‘A/C’ card, or
an Item does not belong to an Item Group, then it will be the Cost
Model, Invoice specified in the Cost Model setting.

Cost accounting is fully described in the ‘Stock Module’ chapter in Volume 3
of these manuals.

Cost Model If you use cost accounting, select one of the alternatives
for calculating the cost amount.

Default This option will calculate the cost amount using
the default Cost Model, determined using the
Cost Model setting in the Sales Ledger.
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Cost Price Use the Cost Price of the Item (visible on the
‘Costs’ card of the Item screen). If this option is
chosen, it is recommended that one of the Update
Cost Price at Purchase options (also on the
‘Costs’ card of the Item) is chosen, to ensure the
Cost Price is always up-to-date.

% of Base Price Calculate the cost by applying a specified
percentage to the Base Price (i.e. the retail price)
of the Item. The percentage is specified in the
Cost in % of Base Price field, just above this Cost
Model selection area. This option can be used in
cases where a consistent gross margin is required.

Cost from Invoice Use the Cost Price of the appropriate row of the
Invoice.

FIFO Price A true FIFO cost is used based on the cost prices
recorded in Goods Receipts.

Weighted Average Use the Weighted Average Cost Price of the Item
(the average unit price of all previous purchases,
visible on the ‘Costs’ card of the Item screen).

None Select this option to ensure cost accounting
postings will not be made on the sale of Items of
the Item Group.

Cost in % of Base Price

Specify here the percentage to be applied if the % of
Base Price Cost Model is to be used.

If Cost Price, % of Base Price or
Weighted Average is selected, make
sure that the appropriate field
contains values for each Item.
Otherwise ,  cost  accounting
Transactions with a zero amount may
result.

!
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Type Use these options to indicate the type of Item that is
likely to belong to the Item Group. Once you have done
this and using the fields listed below, you can include
various subtotals in the design of your Invoice Form—

Total Goods

Total Transport Cost

Total for Packages Item

Subtotal without packages (=Total Goods + Total
Transport Cost)

total-discount without packages

These subtotals are calculated by referring to the Types
of the Item Groups to which the Items on the Invoice
belong. Items that do not belong to Item Groups are
included in the Total Goods figure.

Credit A/C Card

If you want to specify separate default Sales Accounts and VAT Codes for
use in Credit Notes, you can do so here. Be sure to check the Use Credit
Sales Accounts box on card 1 of the Account Usage S/L setting in the Sales
Ledger as well.

Please refer to the description of the ‘A/C’ card above for details of each
field.

If no credit Sales Account or VAT Code has been specified for an Item
Group, those on card 4 of the Account Usage S/L setting will be used. If any
of these fields is blank, the standard Account or VAT Code from card 3 of
the Account Usage S/L setting will be used instead.
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Texts Card

You can use this table to enter extended comments about the Item Group,
such as a detailed specification. This will be copied to Invoices whenever an
Item belonging to the Group is sold. To do this, enter the appropriate
Language and enter the text, taking up as many rows as necessary.

Please refer to the description of the ‘Texts’ card of the Item record below for
an illustrated example.

Deleting an Item Group

1. Ensure you are in the Sales Ledger using the Modules menu and select
‘Item Groups’ from the Registers menu or click [Item Groups] in the
Master Control panel.

2. Find the Item Group you want to remove, and open it by double-clicking.

3. Select ‘Delete’ from the Record menu.

The Item Group is permanently removed. The window shows the
preceding Item Group.

4. Close the window with the close box.

You cannot undo the deletion of an
Item Group.!
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The Item Register

Entering an Item

In the Item register you store information about the products and services that
you sell. If you also define Item Groups (described above) you can improve
the reporting capabilities of the program. The Item register is accessible from
the Sales Orders, Purchase Orders and Sales Ledger modules, and from the
Contracts, Production, Quotations, Service Orders and Job Costing modules
if installed.

Use the Modules menu to enter one of these modules and select ‘Items’ from
the Registers menu, or click the [Items] button in the Master Control panel.

The ‘Items: Browse’ window is opened, showing all Items already entered.

To enter a new Item, click [New] in the Button Bar or use the Ctrl-N
(Windows and Linux) or z-N (Macintosh) keyboard shortcut. Alternatively,
highlight an Item similar to the one you want to enter and click [Duplicate]
on the Button Bar.

The ‘Item: New’ window is shown, empty if you clicked [New] or containing
a duplicate of the highlighted Item.
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Since the amount of information stored about each Item will not fit on a
single screen, the Item window has been divided into six cards. At the top of
each is the header. This contains the Item Number, Item Group and
Description, and the Closed check box. There are six named buttons (‘tabs’)
in the header.

By clicking the tabs you can navigate between cards. The header is always
visible, as a reminder of the Item you are working with.

Header



Chapter 6: Items and Pricing - Registers - Items

289

No. Enter the unique identification code you are assigning to
this Item. This is the means by which you will identify
the Item when including it in Orders, Invoices etc. The
field holds up to 20 characters.

Group Paste Special Item Group register, Sales
Ledger

Enter the Item Group to which this Item belongs. Item
Groups enable you to classify similar Items together. All
Items of the same Group can use the same default Sales
and Cost Accounts, Credit Account, VAT Codes and
Cost Model, saving you the work of having to specify
these for all Items individually.

If you have entered a Default Item Group in the Item
Settings setting, it will be entered here automatically.

Description Enter the name or a short description of the Item.

Closed Check this box if the Item is no longer to be used (Item
records cannot be deleted if they have been used on
Orders or Invoices). Closed Items will appear in the
‘Items: Browse’ window but not in the Items ‘Paste
Special’ list. You will not be able to use a closed Item on
Orders or Invoices. A closed Item can be re-opened at
any time.

Pricing Card

Unit Paste Special Units setting, Sales Ledger

Specify here the quantity to which the Base Price
(below) refers. In the majority of cases, this will be a
single item, but otherwise it might be a pair or a dozen.
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The Units setting in the Sales Ledger module enables
language-specific text to be entered, which will then
appear, in translation if necessary, on Delivery Notes
and Invoices. You can also specify in the Unit record
whether one, two or all three of the dimension fields on
the ‘Stock’ card should contain values before the Item
can be saved, and specify a factor to link the Weight and
Volume fields.

If you need to be able to express the stock quantity of
this Item using more than one unit of measurement (for
example, metres and yards, gallons and litres or even
litres and kilograms), use this field in conjunction with
the Unit 2 and Unit Coefficient fields on the ‘Stock’
card.

In the case of Service Items (see below), you can enter a
Unit here (e.g. minutes or hours), or you can specify a
Default Service Unit in the Project Settings setting in the
Job Costing module. If you specify a Default Service
Unit, it will be used for all Service Items in all
transactions (e.g. Orders and Invoices), and it will
override any Unit specified for an individual Service
Item.

Base Price Used as default in Quotations, Orders, Invoices,
Price Calculations

Enter the normal sales price for the Item here. This price
should always be in your home Currency.

If you would like to prevent changes to this field, use the
Do not allow Base Price change option in the Item
Settings setting in the Sales Ledger.

The Base Price Changes setting in the Stock module can
be used to change the Base Price of many Items at a
single stroke. This can be used even if the Do not allow
Base Price change option in the Item Settings setting is
in use.

Base Price Change This field shows the date of the last change to the Base
Price for the Item and is updated automatically.
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Price Factor Used as default in Quotations, Orders, Purchase
Orders, Invoices

Use the Price Factor to define the Base Price of the Item
as being for a certain quantity; e.g. a price per box. If a
box contains 12 units and the Item is usually sold by the
box, enter “12” in this field to indicate that the Base
Price refers to a box of 12. On Orders and Invoices, the
price per unit is automatically calculated. On Purchase
Orders, the cost price per unit is automatically
calculated. Although related to the Unit field above, this
field will tend to be used for Items where the basic sales
unit can be broken (e.g. where an Item is usually sold as
a box of 12 but can occasionally be sold individually),
while the Unit field refers to unbreakable sales units.

Item Formula Paste Special Item Formula register, Pricing
module

When entering Quotations, Orders or Invoices, you can
use Items whose prices are calculated from the value of
the other Items sold. Examples might be freight or
freight insurance. The Item Formula register in the
Pricing module is used to define the formulae used in
these calculations. If this is such an Item, enter the Code
of the appropriate Item Formula here. Please refer to the
description of the Item Formula register later in this
chapter for full details.

Markup % This field is used in combination with the Job Costing
module. When a Purchase Invoice for this Item is
entered and associated with a Project, Hansa will charge
the Project with the Item cost plus this percentage.

The Markup % can also be used when calculating prices:
please refer to the section below describing the
‘Calculate Price Lists’ function for details.

Treat Item as Material on Project

Please refer to the ‘Job Costing’ chapter in Volume 5 of
these manuals for details of this check box.

Bonus % Enter a percentage here for use in the calculation of sales
bonuses for sales persons. Bonus calculations are shown
in the Bonus, Salesman report in the Sales Ledger. This
report has options allowing bonuses to be calculated
using percentages entered here, in the Person register
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(‘Bonus’ card), or in the Bonus setting in the Sales
Ledger. The Bonus, Salesman report and the Bonus
setting are described in the ‘Sales Ledger’ chapter in
Volume 2a of these manuals.

Objects Paste Special Object register, Nominal
Ledger/System module

Used as default in Quotations, Orders, Invoices,
N/L Transactions

Up to 20 Objects can be assigned to each Item, separated
by commas. They will be used as defaults in all Orders,
Invoices and other transactions involving this Item. You
might define separate Objects to represent different
departments, cost centres or product types. This provides
a flexible method of analysis that can be used in
Nominal Ledger reports.

Classification Paste Special Item Classifications setting,
Stock module

If you are using Hansa’s Web Shop, you may wish to
offer different Items to different Customers. This is done
by dividing the Items into sets known as
“Classifications” and then specifying a Classification for
each Customer. Customers will see only those Items in
the relevant Classification when they log on to your Web
Shop site.

Enter here the Classification to which this Item is to
belong. Items can belong to more than one
Classification: enter as many Classifications as
necessary, separated by commas.

Outside the Web Shop, Item Classifications can also be
used to change the Items ‘Paste Special’ list. Usually,
this is a simple list of Items from which the appropriate
one can be chosen. If you are using Item Classifications,
you can break the list up so that it only shows Items
belonging to a particular Classification.

Classifications are defined using a Setting in the Stock
module. This setting is described later in this chapter, in
the ‘Item Classifications’ section. This section describes
the use of Item Classifications in a Web Shop and in
‘Paste Special’ lists.
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Item Type The Item Type selected here determines how the Item
will be treated elsewhere in Hansa.

Plain Select this option if the Item is one for which
there is no requirement to maintain stock values.
This might be the case for items such as labour or
training, to be used if the Job Costing and Service
Orders modules are not present. Stock level
quantities are maintained for such Items, but they
are not subject to the Do Not Allow over Delivery
Setting in the Stock module (i.e. you will not be
prevented from creating negative stock).

Stocked Select this type for normal stocked Items, when
the stock module is installed. Hansa will keep
track of the stock values for these Items. When
creating Purchase Orders in batches using the
‘Create Purchase Orders’ function, only those
Items which are Stocked and which have
associated records in the Purchase Item register
will be included.

Structured Item An assembled Item is one which is constructed by
your company from components bought in for the
purpose.

Hansa supports two types of assembled Items:
those which are built the moment the Delivery is
made and those which are built in advance of
being delivered, until which moment they are
held in stock. If the Production module is not
installed, only the first of these is supported.

If the Item is one which will be built at the
moment of Delivery, it is termed a “Structured
Item” so should be entered as such. Hansa will
not keep track of the stock values for these Items.
An example is a Stereo System, which as an
entity is never kept in stock. Its components (e.g.
amplifier, CD player) are kept in stock. When a
Stereo System is delivered, appropriate quantities
of its components are automatically removed
from stock.

If the Item is one which will be built before the
moment of Delivery and kept in stock, it should
be entered as a Stocked Item. An example might
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be the CD Player. When the CD Player is built
using the Production register in the Production
module, its components (circuit boards,
laser/scanner unit and digital-analogue converter)
are removed from stock and it is added to stock.

In both cases, the assembled Item will have a
Recipe associated with it, which determines how
many of each component will be used in its
construction. This should be specified on the
‘Recipe’ card.

Service A Service Item is a special type of Item used in
the Job Costing and Service Orders modules. If
you are using either of these modules, any kind of
work charged by time such as labour, consultancy
and equipment repair should be entered as
Service Items.

When entering a new Item, the Item Type selected as a
default will be that chosen in the Item Settings setting in
the Sales Ledger.

Stock Card

Min. Level This is the minimum quantity of the Item that can be
held in stock.

The ‘Create Purchase Orders’ function in the Purchase
Orders module (on the Operations menu of the ‘Purchase
Orders: Browse’ window) will create Purchase Orders
with sufficient quantities to ensure that the stock balance
for this Item is made up to this minimum stock level,
taking into account quantities on Sales Orders that
cannot be delivered from stock (“stocking” Orders).
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This figure is also used in the Deficiency List and
Purchasing Suggestion reports, which produce purchase
proposals and can be used to preview the Purchase
Orders that will be created by the function described in
the previous paragraph.

If you would like to specify the minimum quantity of the
Item that can be held in stock in each Location, leave
this field empty and use the Minimum Stock Levels
setting in the Stock module.

Max. Level Record here the maximum quantity of the Item that can
be held in stock.

Serial No. Tracking

There are three different options controlling the Serial
Number Tracking for Items.

No Click here if the Item is not one that carries Serial
Numbers.

Unit No. Click here if each unit of the Item carries a
unique Serial Number. Each Item of this type
included on a Delivery must have an existing
Serial Number. Items of this type must be
recorded singly on Deliveries and Goods
Receipts, each with a unique Serial Number.

Batch No. Click here if the unique Serial Number is at batch
level. Each Item of this type included on a
Delivery must have an existing Serial Number:
Hansa will maintain a record of how many Items
from each batch have been shipped. When using
Items of this type on a Goods Receipt, it is not
necessary to record them singly, but a Serial
Number must be specified.

The Stock module contains a setting, Batch
Specifications, which can be used to record Best Before
dates for Items. To make full use of this feature,
perishable Items should be entered as requiring Serial
Numbers, at either Unit or Batch level. For full details of
this setting, please refer to the ‘Stock Module’ chapter in
Volume 3 of these manuals.
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Department Paste Special Departments setting, Assets
module

This field is used if the Item is one which will be stocked
or sold by a particular Department.

Shelf Code The Shelf Code recorded here will be printed on the
Stocktaking List report and on Picking Lists.

Default Source Paste Special Sources setting, Stock module

Used as default in Orders, Deliveries

This field can be used to record the origin of the Item
(e.g. the manufacturer, producer or importer). This can
be shown in Orders (flip F) and Deliveries (flip D).

Hazard Level Paste Special Hazard Levels setting, Sales
Orders module

If your business sells hazardous Items (e.g. chemicals),
the Hazard Levels setting in the Sales Orders module
can be used to display the relevant information on
Delivery Notes. Once you have defined your Hazard
Levels in this setting, you can assign the appropriate one
to each Item using this field. You can then ensure this
information is printed on Delivery Notes using the
“Hazard Level Code”, “Hazard Level Comment”,
“Hazard Level Weight” and “Hazard Level Volume”
fields.

Alcohol % If appropriate, the alcohol content of one unit of the Item
should be recorded here

Unit 2, Unit Coefficient

Paste Special Units setting, Sales Ledger

These fields are used if you need to produce a stock list
showing quantities in different units (for example,
metres and yards, gallons and litres or even litres and
kilograms).

To do this, first enter the alternative unit of measurement
in the Unit 2 field, using ‘Paste Special’ if necessary.
Then, use the Unit Coefficient field to show the
relationship between the Unit 2 and the Unit on the
‘Pricing’ card.
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Several reports in the Stock module offer the option to
include Quantity 2. This option will show the quantity
expressed using the Unit 2 unit of measurement. This
Quantity 2 figure can be calculated by multiplying or
dividing the standard quantity by the Unit Coefficient.
Make this choice using the Unit 2 Conversion
Calculation options in the Stock Settings setting in the
Stock module.

The value that you enter in the Unit Coefficient field will
therefore depend on which of the Unit 2 Conversion
Calculation options you are using. If you are using the
Multiply With Coefficient option, you should calculate
the Coefficient using the formula—

    Unit
Unit 2

For example, if the Unit is a single item and the Unit 2 is
a dozen, the Unit Coefficient will be 0.0833. If you have
144 in stock, the Quantity 2 will be 120 x 0.0833 = 10.

If you are using the Divide With Coefficient option, you
should calculate the Coefficient using the formula—

Unit x Unit 2

For example, if the Unit is a single item and the Unit 2 is
a dozen, the Unit Coefficient will be 12. If you have 120
in stock, the Quantity 2 will be 120/12 = 10.

The Unit Coefficient field supports up to five decimal
places.

Conversion 1, Conversion 2

These fields are used for Items which are sold in
different quantities. For example, a particular Item might
be sold in pairs, by the dozen and in boxes of 144. The
Unit field on the ‘Pricing’ card refers to the basic unit of
sale, since this is the unit to which the Base Price refers.
In this example, the basic unit is a pair. “72” will be
entered as the Conversion 1 (72 of the basic unit i.e. 72
pairs make 144) and “6” as the Conversion 2.

When designing the Invoice and Delivery Note forms
using the Form register in the System module, three
relevant fields can be shown. These are “Qty Conversion
1”, “Qty Conversion 2”, and “Qty Conversion 3”. Qty
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Conversion 1 refers to the Conversion 1 field, Qty
Conversion 2 refers to the Conversion 2 field, and Qty
Conversion 3 refers to the basic sale quantity.

If you receive an Order for 158 units of this Item (i.e.
158 pairs, the basic sale quantity), the three Qty
Conversion fields on the printed documentation will
appear as follows—

Qty Conv 1 Qty Conv 2 Qty Conv 3

2 2 2

2 boxes of 72 pairs + 2 boxes of 6 pairs + 2 pairs = 158
Units (pairs).

Width, Height, Depth

The dimensions of one unit should be recorded in these
fields. If all these fields contain values, the Volume
(below) will be calculated automatically.

If you would like to ensure that any one, two or all three
of these fields contain values, use the Size Entry Of
options and the Check Size Entry box in the appropriate
Unit record (in the setting in the Sales Ledger).

Width, Height and Depth fields can also be found in
Invoices (flip E), Orders (flip H) and Quotations (flip E).
These can be used for Items that are sold by area or
volume. For example, you sell cloth by the square metre.
Assign to the Item a Unit “M2” in which the Check Size
Entry box is marked and the Two Dimensions option is
selected. If the Item is sold by the square metre, the
Width, Height and Depth fields can be left blank. If the
Item is sold by some other measurement, enter
appropriate figures to the Width and Height fields. For
example, if the basic measurement is five metres by two,
enter 5 as the Width and 2 as the Height. In this case, the
Base Price will still be the figure for one square metre,
because that is the Unit. When the Item is sold, enter the
appropriate quantity to the Unit Qty field on flip E of the
Invoice. The Quantity on flip A will be calculated to
show the area in square metres and the pricing will be
adjusted accordingly. Alternatively, if an unusual size
has been sold, set the Unit Qty to 1 and enter the
appropriate dimensions to the Width and Height fields.
Since the Check Size Entry box in the Unit record has
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been marked, you will not be able to save the Invoice if
you enter figures in all three measurement fields, or in
one only. Hansa will display the error message: “Invalid
Size for the Item”.

Volume The volume of one unit should be recorded here. The
figure can be used to calculate quantity discounts: this
process is described later in this chapter.

If the Width, Height and Depth fields (above) contain
values, the Volume will be calculated automatically. If
the Item has been assigned a Unit and that Unit has a
Volume/Weight Factor, the Weight will be calculated
from the Volume automatically.

Density The density of the Item can be recorded here. If the Item
has been assigned a Unit and that Unit has a
Volume/Weight Factor, that Factor will be copied to this
field. Otherwise, the Density will be calculated from the
Weight and Volume automatically.

Weight The weight of one unit should be recorded here. The
figure can be used to calculate quantity discounts: this
process is described later in this chapter. If the Item has
been assigned a Unit and that Unit has a Volume/Weight
Factor, the Weight will be calculated from the Volume
automatically. Otherwise, it will be calculated from the
Weight and Density.

A freight charge can be added to an Invoice based on the
total weight of the Items on that Invoice: please refer to
the sections describing the Freight and Freight/Weight
Calculation settings in the ‘Sales Ledger’ chapter in
Volume 2a of these manuals for details of this feature.

Any unit of measurement can be used in the Weight
field, but take care to use the same one everywhere in
the system.
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Costs Card

Cost Price Used as default in Quotations, Orders, Invoices,
Purchase Items

The Cost Price of the Item should be recorded here, in
the home Currency. Since the figure will be used in
calculating the Gross Profit of Sales Orders, it is
important that it be determined by the same Unit and
Price Factor values as the Base Price on the ‘Pricing’
card. It is also used as a default when creating Purchase
Items (described in full in the ‘Purchase Orders’ chapter
in Volume 3) and can be used to set the Purchase Price
when using the ‘Create Purchase Orders’ Maintenance
function in the Sales Orders module. Depending on the
setting of the Update Cost Price at Purchase options (see
below), the figure can be updated automatically when
included on Goods Receipts.

Cost Price Change This field shows the date of the last change to the Cost
Price for the Item and is updated automatically.

Extra Cost Enter here any extra costs involved in the purchase of
this Item, such as fixed freight costs. The figure will be
included in the cost when calculating Gross Profit.

Weighted Average This figure records the average unit cost price of this
Item in the home Currency (including extra costs such as
freight and customs duties). It is updated automatically
from Goods Receipts whatever the setting of the Update
Cost Price at Purchase options (see below). The field can
also be recalculated using the ‘Update Item Cost Price’
Maintenance function in the Stock module.

Last Pur. Cost This figure records the last unit cost price (including
extra costs such as freight and customs duties) used
when purchasing this Item. It is updated automatically
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from approved Goods Receipts whatever the setting of
the Update Cost Price at Purchase options (see below).

Last Pur. Price This field is similar to the one above, but in this case the
figure does not include any extra costs such as freight
and customs duties.

Last Pur. Currency

This field records the last Currency used when
purchasing this Item. It is updated automatically.

Upd. Cost Price at Purchase

Hansa can update the Cost Price of an Item
automatically. If this feature is operating, the update will
occur whenever a Goods Receipt is approved, not when
a Purchase Order is raised. If the Item is one that is
constructed from components, the update will occur
whenever a Production record is marked as Finished.

The automatic updating of Cost Prices can be useful if
you are using cost accounting (maintaining stock values
in the Nominal Ledger) and your goods-out values are
based on Items’ Cost Prices. In this scenario, it is
advantageous if the Cost Prices are always kept up-to-
date. Cost Accounting is fully described in the ‘Stock
Module’ chapter in Volume 3 of these manuals.

Note that changes to the Cost Price made here will not
directly affect future Purchase Orders until the change is
transferred to the equivalent Purchase Item (see the
section describing the ‘Update Purchase Items’ function
in the ‘Purchase Orders’ chapter in Volume 3 for full
details).

These options are used to control this feature—

No Select this option if this feature is not to be used
for this Item.

Last Purch Cost Price

If this option is chosen, the Cost Price is changed
to the Cost Price of the Items on the last Stock
Receipt (i.e. the price including extra costs such
as carriage and customs duties). This option will
be used for Items whose prices do not often
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change, or where the long-term pattern is for
prices to fall or rise.

Weighted Average This option changes the Cost Price to the average
unit Cost Price of all previous Goods Receipts
and Returned Goods. This option will be useful
where prices fluctuate without a pattern, perhaps
due to changing exchange rates.

Where the Item has been used in Stock
Movements and Returned Goods, any Extra Cost
in those transactions will be taken into account
when changing the Cost Price.

When entering a new Item, the option selected as a
default will be that chosen in the Item Settings setting in
the Sales Ledger.

Recipe Card

Recipe Paste Special Recipes setting, Stock module

If the Item is a structured or assembled Item, specify
here the Recipe which describes how it is made up.
Recipes are defined using a register available in the
Stock and Production modules.

Show Components on Documents

If the Item is a Structured Item and you would like to
display its components in Quotations, Orders and
Invoices, switch this check box on. In this case, the Cost
Price on the ‘Costs’ card should be set to zero, so that
gross margin and profit calculations will use the cost
prices of the components. If you will be generating
outward cost accounting transactions from Invoices, it is
also recommended that you switch on the Use
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Components Cost Accounts option in the Cost
Accounting setting in the Stock module.

To determine whether components are to be listed on
Delivery Notes and Picking Lists, use the Structured
Items setting in the Stock module.

Invoice Recipe Paste Special Recipes setting, Stock module

This field is relevant for users in Sweden, where sales of
Items containing certain materials (e.g. metals) attract a
tax per unit sold. By specifying an Invoice Recipe for
such Items, the Recipe components will be listed on
Invoices (but not Orders or Deliveries).

Contract Item Paste Special Item register

If your business is one that sells both goods and the
service contracts to maintain them, it is likely that you
will have separate records in your Item register for each
Item and for the service contract for that Item. The Item
itself will be used in Orders and Invoices, while the
Contract Item will be used in the Contract register to
allow regular Invoices for the Contract to be issued. The
Base Price of this Item will be the charge for the
Contract period.

This field should be used to link the two Items. In the
record representing the Item itself, record here the Item
Number of the record representing the service contract
for that Item. Whenever the Item is used in an Invoice,
you can then use the ‘Create Contract’ function on the
Operations menu of the Invoice to generate a Contract
with the correct maintenance charge.

Rental Invoicing Paste Special Item register

If your business is one that rents Items to Customers,
you should have separate records in your Item register
for each Item and for the rental charge for that Item. The
Item itself will be used in the Stock module (when it is
purchased), in the Internal Stock module and in the
Assets module (where it will be depreciated), while the
Rental Item will provide the daily rental charge
whenever the Item is rented out.

This field should be used to link the two Items. In the
record representing the Item itself, record here the Item
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Number of the record representing the rental charge for
that Item.

Warranty Months Record here the length of the warranty period (if any)
covering the Item. This information will be used in the
Service Orders module to determine whether Items
purchased from your company are under warranty when
bought in for repair.

Alternative Code Use this field if you need to identify the Item by means
other than the Item Number. The Alternative Code is
shown in the ‘Items: Browse’ window, so it can be used
to search for a particular Item.

If you are using the EDI (Electronic Data Interchange)
module, you should record here the code allocated to the
Item by the Customer. When importing EDI Orders, this
will enable the import function to convert the
Customer’s Item Number contained in the import file to
your own. Please refer to your local representative for
full details.

Warning Text entered here will appear as a warning to alert users
whenever this Item is used.

Bar Code Record the Item’s Bar Code here.

Providing the Bar Code does not clash with your Item
Codes, you can enter it instead of the Item Code
whenever you need to refer to this Item (in Orders or
Invoices, for example).

If you need to ensure that each Item has a unique Bar
Code, switch on the Unique Bar Code option in the Item
Settings setting in the Sales Ledger.

If you need to ensure that each Bar Code contains at
least a certain number of characters, enter this number in
the Bar Code Length field in the Item Settings setting in
the Sales Ledger. Any Bar Codes with fewer than this
number of characters will be given the appropriate
number of leading zeroes. For example, if your Bar
Code Length is five, a Bar Code of “4256” will be
converted to “04256”. No warning will be issued for Bar
Codes containing more than the specified number of
characters.
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If you wish to enable entry to this field direct from a
barcode reader, please contact your local Hansa
representative.

Commodity/EAN Code

Paste Special Commodity Code register,
Customs module

Record the Item’s Commodity Code here. This is
required for Intrastat reporting in the event of trade with
another member of the EU. Commodity Codes are listed
in the Intrastat Classification Nomenclature document
available from www.uktradeinfo.com.

A/C Card

Sales Accounts Paste Special Account register, Nominal
Ledger/System module

When using this Item in Orders or Invoices, one of the
three Sales Accounts entered here is offered as a default,
depending on the Zone of the Customer. It will override
any Sales Accounts specified for the Item Group or in
the Account Usage S/L setting. If there is a record in the
Price register for the appropriate Item/Price List
combination which has a Sales Account specified, that
Sales Account will take precedence over the one entered
here.

The Accounts specified here will usually be used in both
Invoices and Credit Notes. If you would like to use
different Accounts in Credit Notes, these should be
specified on the ‘Credit A/C’ cards of your Item Group
records and on card 4 of the Account Usage S/L setting.
You should also check the Use Credit Sales Accounts
box on card 1 of the Account Usage S/L setting.
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VAT Codes Paste Special VAT Codes setting, Nominal
Ledger

When entering Orders or Invoices and including this
Item, one of the three VAT Codes entered here will be
offered as a default, depending on the Zone of the
Customer. It will override any VAT Code specified for
the Item Group or in the Account Usage S/L setting.
However, if the Customer has a VAT Code specified,
that will take precedence over any entry here.

This Code will determine the rate at which VAT will be
calculated for this Item when it is bought or sold and the
Accounts to be debited and credited respectively with
the VAT amount.

The VAT Codes specified here will usually be used in
both Invoices and Credit Notes. If you would like to use
different VAT Codes in Credit Notes, these should be
specified on the ‘Credit A/C’ cards of your Item Group
records and on card 4 of the Account Usage S/L setting.
You should also check the Use Credit Sales Accounts
box on card 1 of the Account Usage S/L setting.

Cost Account Paste Special Account register, Nominal
Ledger/System module

If you are maintaining stock valuations in the Nominal
Ledger, specify here the Account to be debited with the
calculated cost of goods when examples of this Item are
sold (removed from stock). The cost of goods is
calculated using the Cost Model chosen in the Cost
Model setting in the Sales Ledger. If blank, the Stock
Cost Account on card 5 of the Account Usage S/L
setting will be debited.

This Account will usually be used as described above if
the Use Item Groups for Cost Accounts option in the
Cost Accounting setting in the Stock module is not in
use.

Please refer to the ‘Cost Accounting’ section of the
‘Stock Module’ chapter in Volume 3 of these manuals
for full details of when this field is used.
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Texts Card

This table can be used to enter various translations of the name of the Item
(i.e. of the text entered into the Description field in the header). Specify a
Language in the first column using ‘Paste Special’ if necessary, and the
appropriate translation in the second column. When attaching the Item to
Quotations, Orders or Invoices, the Language of the Quotation, Order or
Invoice will determine which translation is used. There is no need to enter a
row for your home Language.

You can also use this table to enter extended comments about the Item, such
as a detailed specification, which will also appear on Quotations, Orders and
Invoices. To do this, again enter the appropriate Language (or leave the
Language column blank for comments in your home Language) and enter the
text, taking up as many rows as necessary. If you want to enter a translation
of the Item Name and a comment or specification in the same Language,
enter the translation first, as shown in the illustration.

An example Invoice made out to a Swedish Customer is illustrated overleaf.
The translation of the Item Name and an extra comment have been brought in
from the ‘Texts’ card of the Item illustrated above. A second comment has
been brought in from the ‘Texts’ card of the Item Group illustrated earlier in
this chapter.
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Editing an Item

To edit an Item, open the ‘Items: Browse’ window by clicking the [Items]
button in the Master Control panel or by selecting ‘Items’ on the Registers
menu.

The Items are initially shown in Item Number order. Change the sort order by
clicking on one of the column headings: the underlined heading shows the
current sort order.

To search for a specific Item, enter the text to be found in the Search field in
the top right-hand corner of the window and press Return. The text should be
such that it would appear in the current sort column: to search by Item
Description, for example, sort by Description before entering a Description
(or its initial letters) to the Search field.

To modify an Item’s record, double-click on the line in the browse window.
That record will be opened in a window entitled ‘Item: Inspect’. The fields in
this window are the same as those in the ‘Item: New’ window: please refer to
the previous section for a detailed description of each field.
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Edit the fields as necessary. Move from field to field with the Return key, or
with the arrow keys. Click [Save] when you have finished, to save changes.

Deleting an Item

Select and open the Item record in the same way as for editing. Select
‘Delete’ from the Record menu. The Item is deleted. Note that once an Item
has been included on an Order or Invoice, it can no longer be deleted.

You cannot undo the deletion of an
Item.

You can delete in bulk Items that you haven’t used. To do this, ensure you
are in the Sales Ledger and select ‘Maintenance’ from the File menu. In the
resulting list, double-click ‘Delete not used items’. This function is fully
described in the ‘Sales Ledger’ chapter in Volume 2a of these manuals.

Operations Menu

 

The Operations menus for Items are shown above. On the left is that for the
‘Items: Browse’ window: highlight an Item in the list before selecting the
function. On the right is that for the ‘Item: New’ and ‘Item: Inspect’
windows.

Item Status Report

The ‘Item Status Report’ function provides a quick report for the Item(s)
highlighted in the ‘Items: Browse’ window or that showing in the record
window, showing stock and order positions and prices in different price lists.
To apply the function to a group of Items, in the browse window highlight the
first Item of the group and then click on the last while holding down the Shift
key. Then select the function.

!
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The In Stock figure can be updated (i.e. reduced by the quantity delivered)
when Deliveries are created or when they are approved. This is controlled
using the Decrease Available on Deliveries options in the Stock Settings
setting in the Stock module. The Purchase Order figure includes both
approved and unapproved Purchase Orders. Goods Receipts will update the
In Stock and Purchase Order figures when they are approved.

Item Status

This function provides instant feedback for each Item concerning the quantity
in stock, the quantity on order, how many can be shipped and the current
gross profit.

The function is available from both the ‘Items: Browse’ and ‘Items: Inspect’
windows, as well as on the Operations menus for Sales Orders, Purchase
Orders, Invoices, Deliveries, Stock Depreciation records and Stock
Movements.

When you select this function, the ‘Item Status’ window is opened. This
window is different from other windows because it always “floats” on top of
other windows, even when those windows are active.
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When you open the ‘Item Status’ window from the ‘Item: Inspect’ window, it
displays information about the current Item. When you open it from the
‘Items: Browse’ window, it displays information about the Item highlighted
in the list. This information will change as you click on different Items in the
list.

When you open the ‘Item Status’ window from other windows, for example,
from an Invoice or Order, it displays information about the Item in the row
containing the cursor. As you move the insertion point to different rows, the
data in the ‘Item Status’ window is immediately updated. If you then select
‘Paste Special’ from the Item Number field of an Invoice or Order row and
highlight an Item in the ‘Paste Special’ window, the ‘Item Status’ window is
updated to show values for the Item highlighted.

The Stock, Stock 2 and Order figures can be updated (i.e. reduced by the
quantity delivered) when Deliveries are created or when they are approved.
This is controlled using the Decrease Available on Deliveries options in the
Stock Settings setting in the Stock module. The Shippable figure is reduced
by the quantity ordered as soon as a new Order is saved, so it assumes that
stock is immediately allocated to that Order. The Purchase Order figure
includes both approved and unapproved Purchase Orders. Goods Receipts
will update the Stock, Stock 2, Shippable and Purchase Order figures when
they are approved. The Stock 2 figure is the quantity in stock expressed using
a second unit of measurement: it will only be shown for Items that have a
Unit 2 and a Unit Coefficient specified on their ‘Stock’ cards.

If an Item has Varieties, click the [Var] button to produce a report showing
the quantity of each Variety in stock. Varieties are described later in this
chapter.

When used from the Invoice, Order and Quotation screens, the GP and GM
figures show the Gross Profit and Gross Margin (%) for the row containing
the cursor. The Disc. U. Pr. field will show the Unit Price after any Discount.
In other circumstances, these fields will be blank.

You can move the window and put it where you want on the screen. Use the
Window menu (Windows) or the z-Shift-S keystroke (Macintosh) to ensure
it is opened in that position the next time it is used.

You can choose to have the ‘Item Status’ window opened automatically
whenever you open a record window whose Operations menu features the
‘Item Status’ function. To do this, use the Show Item Status option in the
Item Settings setting in the Sales Ledger. The Item Settings setting is
described later in this chapter.
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Item History

The ‘Item History’ function provides a quick report listing all incoming and
outgoing stock movements for the Item(s) highlighted in the ‘Items: Browse’
window or that showing in the record window. To apply the function to a
group of Items, in the browse window highlight the first Item of the group
and then click on the last while holding down the Shift key. Then select the
function.

The report period is the first one entered in the Reporting Periods setting in
the System module.

The Item History report can also be produced from the Stock module.

Create Purchase Item

This function is active only if the Purchase Orders module is installed.

With this command, you can create a record in the Purchase Item register of
the Purchase Orders module. The created record will be based on the selected
Item, and will be shown in a record window, where additional information,
such as details of the usual Supplier, can be entered.

Read more about the Purchase Item register in the ‘Purchase Orders’ chapter
in Volume 3 of these manuals.
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Item Settings
This setting, available in the Sales Ledger, allows you to set various defaults
to be used when working with Items.

Use the Modules menu to ensure you are in the Sales Ledger and then select
‘Settings’ from the File menu or click the [Settings] button in the Master
Control panel. Double-click ‘Item Settings’ in the resulting list. The ‘Item
Settings: Inspect’ window opens—

Default Item Group

Paste Special Item Group register, Sales
Ledger

If an Item Group is entered here, it will be used as a
default when creating new Items.

Bar Code Length If you need to ensure that the Bar Code of each Item
contains at least a certain number of characters, enter
this number here. Any Bar Codes with fewer than this
number of characters will be given the appropriate
number of leading zeroes. For example, if your Bar
Code Length is five, a Bar Code of “4256” will be
converted to “04256”. No warning will be issued for Bar
Codes containing more than the specified number of
characters.

Unique Bar Code If the Bar Code field of each Item is required to hold a
unique value, switch this option on.
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Show Best Before Dates

Use this option if you would like Best Before dates to be
shown in the ‘Paste Special’ list opened from any Serial
Number field. Best Before Dates are fully described in
the section describing the Batch Specifications setting in
the ‘Stock Module’ chapter in Volume 3 of these
manuals.

Show Batch Status

You can use the Batch Status and Batch Quality Control
settings in the Stock module to control the selling of
Items with Best Before Dates. These settings allow you
to assign a Batch Status to each Serial Number which
will cause a warning to be issued when it is sold, or will
prevent sale altogether. Use this option if you would like
the latest Batch Status to be shown in the ‘Paste Special’
list opened from any Serial Number field. These two
settings are fully described in the in the ‘Stock Module’
chapter in Volume 3 of these manuals.

Show Item Status Use this option if you would like the ‘Item Status’
window to be opened automatically whenever you open
a record window whose Operations menu contains the
‘Item Status’ function.

Do not allow Base Price change

Check this box if you want to prevent changes being
made to the Base Price of each Item. This applies when
viewing Items individually: you will still be able to
make changes using the Base Price Changes setting in
the Stock module. In multi-user systems, you can restrict
the use of this setting using Access Groups, thus
allowing you to control who can change Base Prices.

Item Formula Please refer to the ‘Item Formulae’ section immediately
below for a description of this check box.

Enable Quantity Calculation

When entering Invoices, Orders, Quotations, Deliveries,
Goods Receipts and Productions, you can enter the
Width, Height and Depth bought or sold and have the
Quantity calculated automatically by multiplying those
dimensions together. This can be useful for Items sold
by area or volume.
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If you want to make use of this feature, you must first
check this Enable Quantity Calculation box. You should
then check the Calculate Quantity box in each Unit that
is to have the feature. Please refer to the description of
the Units setting in the ‘Sales Ledger’ chapter in Volume
2a of these manuals for full details and an example.

Default Item Type The Item Type selected here will be used as a default
when creating new Items.

Upd. Cost Price at Purchase

The option selected here will be used as a default when
creating new Items. Please refer to the description of the
‘Costs’ card of the Item record above for details of each
option.

To close the ‘Item Settings: Inspect’ window and save any changes, click the
[Save] button in the Button Bar. To close the window without saving
changes, click the close box.
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Item Formulae
When entering Quotations, Orders or Invoices, you can use Items whose
prices are calculated from the value of the other Items sold. Examples might
be freight or freight insurance. The Item Formula register in the Pricing
module is used to define the formulae used in these calculations.

To use this feature, enter an Item Formula as described below. Next, enter an
Item in the Item register, and assign to it the Code of this Formula using the
Item Formula field on the ‘Pricing’ card. Then, enter this Item on the last line
of a Quotation, Order or Invoice. The Unit Price of the Item will be
calculated by applying the Formula to the value of the other Items sold.

The Formula can be a simple one whereby a percentage is applied to the total
value of the other Items sold. Alternatively, a separate percentage can be
applied to Items belonging to each Item Group. Finally, the percentage can be
varied depending on the value of the other Items sold.

To work with Item Formulae, change to the Pricing module using the
Modules menu, and select ‘Item Formulae’ from the Registers menu (or click
the [Item Formulae] button in the Master Control panel). The ‘Item
Formulae: Browse’ window is displayed, showing all Item Formulae
previously entered. Double-click a Formula in the list to edit it, or add a new
record by clicking the [New] button in the Button Bar.

When you have finished working with the Item Formula, save it by clicking
the [Save] button in the Button Bar or by clicking the close box and choosing
to save changes. To close the record without saving changes, click the close
box.

For each record, enter a unique Code and a name and then use the grid to
define the Item Formula. This is perhaps best explained by a series of
examples.
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In this simple example, the Item Group, From and To fields are blank so the
price of this Freight Insurance will be 10% of the total value of the other
Items sold.

Once you have entered your Item Formulae, you can quote them in your Item
records. The Item shown below is Freight Insurance: we have left the Base
Price empty and entered the “FI” Item Formula in the Item Formula field—
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When this Freight Insurance Item is added as the final Item in a Quotation,
Order or Invoice, the Unit Price is calculated automatically—

The next example demonstrates that the result of the application of the
Formula is effectively the sum of the rows in the grid.
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The price of the Freight Insurance this time will be 10% of the total value of
any Group 1 Items sold, plus 12% of the value of any Group 2 Items sold.
Items belonging to any other Item Group will not affect the price of the
Freight Insurance.

Here, the price of the Freight Insurance will depend on the total value of the
Group 1 Items sold. If this value is less than 50.00, Freight Insurance will be
charged as in the previous example. If it is greater than 50.00, it will be
charged at 15% of the value of the Group 1 Items sold, plus 12% of the value
of the Group 2 Items sold. In either case, Items belonging to any other Item
Group will not affect the price of the Freight Insurance.
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This final example is similar to the previous one, except that when Items not
belonging to Item Groups 1 or 2 are sold, 11% of their value will be added to
the price of the Freight Insurance.

Item Formulae when Prices include VAT

Prices in Invoices, Orders and Quotations will include VAT in two
circumstances—

1. You have specified in the Account Usage S/L setting in the Sales Ledger
that Base Prices include VAT.

2. An individual Invoice, Order or Quotation uses a Price List that includes
VAT. Price Lists are described later in this chapter.

In the example Invoice illustrated below, an Item has been sold for 100.00
including VAT. The figure of 100.00 appears in all Price fields—

If an Item with an Item Formula is added to this Invoice, you can specify
whether the Item Formula calculation is to use the Price including VAT or
the Price excluding VAT. Make this choice using the Item Formula check
box in the Item Settings setting in the Sales Ledger.
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In this example, the value of the Freight Insurance will be 10% of the total
value of the other Items sold. If the Item Formula check box in the Item
Settings setting is off, the Item Formula calculation will use the Price
excluding VAT—

The value of the Freight Insurance is 8.51 (100 less VAT is 85.11. 10% of
85.11 is 8.51). The 8.51 figure itself includes VAT.
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If the Item Formula check box in the Item Settings setting is on, the Item
Formula calculation will use the Price including VAT—

In this case, the value of the Freight Insurance is 10.00 (10% of 100.00). The
10.00 figure itself includes VAT.

The Item Formula check box in the Item Settings setting is only used where
prices include VAT as described above: it has no effect in other
circumstances.
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Default Items
This setting in the Sales Ledger allows you to define sets of Items which will
then be added automatically to new Invoices on entry of a Customer Number.
They will also be added to Invoices created from Orders, although they will
not be shown in the Orders themselves. One set of Default Items can be
allocated to each Customer (using the field on the ‘Pricing’ card of the
Customer record).

To open the setting, move to the Sales Ledger using the Modules menu and
click the [Settings] button in the Master Control panel (or choose ‘Settings’
from the File menu). When the ‘Settings’ list is opened, double-click ‘Default
Items’. The ‘Default Items: Browse’ window is displayed, showing all
Default Item records previously entered. Double-click a Default Item record
in the list to edit it, or add a new record by clicking the [New] button in the
Button Bar.

Assign each Default Item record a unique Code and Name. In the grid area,
specify all the Items that are in this set of Default Items using ‘Paste Special’
if necessary. Use one row per Item. All Items listed in the grid area will be
added to Invoices automatically for all Customers using this Default Item
record.

An example use of this setting might be to set up a system of courier charges,
as shown in the example illustration above (which also include the provision
to send a free catalogue with every Invoice). Each Customer is assigned a
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Default Item record containing the appropriate courier charge. Each courier
charge is a separate record in the Item register, with a price calculated using
an Item Formula (in this example, 10% of Invoice value)—

When an Invoice is entered in the name of a Customer using the overnight
courier, this Item and the catalogue are added to the first rows of the
Invoice—
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Note that no Quantity appears for the default Items. Add the other Items to
the Invoice and then specify a Quantity for the overnight courier. A Unit
Price of 10% of the Invoice value will appear. Because the overnight courier
has a calculated price based on the value of the other Items on the Invoice, its
Quantity should not be entered until all the Items have been added.

When Invoices are raised from Orders, the Customer’s Default Items will
again appear, although they will not be shown on the Order or the Delivery.
As before, the Default Items will have no Quantity, so be certain to specify
one before printing and approving the Invoice. Particular care should be
taken to make sure Quantities for Default Items are specified in Invoices
created in batches using the ‘Group Invoicing’ Maintenance function in the
Sales Orders module before printing and approving them.
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Item Classifications
This setting, which can be found in the Stock module, allows you to define
any number of Classifications by which you can categorise your Items. This
is done using the Class. field on the ‘Pricing’ card of the Item record. This
field can contain one or more Classification Codes, separated by commas. So,
for example, an Item such as a radio/cassette player can be both a radio and a
playback device.

The Item Classification provides a different means of classifying Items
compared with Item Groups. Item Groups will usually be used to group Items
together for accounting purposes (e.g. Items with the same Sales, Stock and
Purchase Control Accounts, VAT Codes and Cost Models can belong to the
same Item Group). On the other hand, Classifications can be used to group
Items together for sales purposes, so that it will be easier for users and
Customers to find the Items that they want. Each Item can belong to several
Item Classifications, but can only belong to a single Item Group.

Item Classifications can be divided into Classification Types, allowing great
flexibility. Classification Types are defined using a setting in the CRM
module.

On double-clicking ‘Item Classifications’ in the ‘Settings’ list in the Stock
module, the ‘Item Classifications: Browse’ window opens, listing the
available Item Classifications.
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To enter a new record, click the [New] button in the Button Bar. The ‘Item
Classification: New’ window appears: enter the details as appropriate and
click [Save] to save the new record.

Code Enter a unique code to identify this particular Item
Classification. It can consist of up to five alphanumeric
characters.

Name Assign a descriptive name to the Item Classification.
This is shown in the ‘Item Classifications: Browse’
window and the ‘Paste Special’ list: it should therefore
be descriptive enough to make the selection of the
correct Item Classification easy for all users.

Type Paste Special Classification Types setting,
CRM module

If necessary, you can group Item Classifications of a
broadly similar nature together by assigning them to the
same Classification Type.

Classification Paste Special Item Classifications setting,
Stock module

Use this field to define a hierarchical structure for your
Item Classifications. This is described below in the
remaining parts of this section.
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Item Classifications and the Item ‘Paste Special’ List

Whenever you need to enter an Item in a record such as an Order, Invoice or
Goods Receipt, you can use the ‘Paste Special’ feature to help you choose the
correct Item. When you press Ctrl-Enter (Windows and Linux) or z-Enter
(Macintosh) from any Item field, the result is usually a simple list from which
you can choose the correct Item by double-clicking—

You can sort the list so that you can find the Item you want, and you can save
the sort order so that it's used by default.

If you have many Items in your database, you can use Item Classifications to
build a ‘Paste Special’ list that provides a greater level of help with Item
selection. Follow these steps—

1. Spend some time planning your Item Classifications with the aim of
helping users to choose Items quickly and easily. In the example
illustration of the ‘Item Classifications: Browse’ window above, we have
implemented the following hierarchical structure—

Main

Radios
Recorders/
Playback

Record Decks/
Accessories Speakers

Transistor
Radios

Tuners
Cassette

Decks
Minidisc
Players Turntables Cartridges

Moving
Magnet

Moving
Coil

2nd Level

1st Level

3rd Level

4th Level
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The Item Classification hierarchy is established using the Classification
field. In each record on a lower level, the Classification is the Code of
the record on the level immediately above.

In the example, the “MAIN” Classification is on the top level: the
Classification field in this record is blank—

The “MAIN” Classification has four sub-Classifications “Radios”,
“Recorders and Playback Devices”, “Record Decks and Accessories”
and “Speakers”. In these Classifications, “MAIN”, the top level
Classification, has been entered in the Classification field—

Within Classification 1 (“Radios”), there are two further sub-
Classifications, “Transistor Radios” and “Tuners”. In these
Classifications, “1”, the immediately superior Classification, has been
entered in the Classification field—

This structure is continued down through the hierarchy.
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2. Having planned your Item Classifications and entered them in the Item
Classifications setting, you should now assign them to your Items (using
the Classification field on the ‘Pricing’ card). You can assign as many
Classifications as you like to each Item, separated by commas. The
Classifications that you assign can be from any level in the hierarchy.

Every Item should have at least one Classification: Items without a
Classification will not appear in the new ‘Paste Special’ list.
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3. Decide which Classification is to be your default Classification. This is
the Classification whose Items will be listed when the Item ‘Paste
Special’ list first appears. Enter this Classification in the Paste
Classification field in the Stock Settings setting in the Stock module—
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Once you have entered something in this Paste Classification field, the
standard ‘Paste Special’ window will be replaced with the following
window when you press Ctrl-Enter/z-Enter from any Item field (in this
case, from the Item field in an Invoice)—

In this example, we have specified that our “MAIN” Classification (i.e.
the top level Classification) is the Paste Classification. As a result, the
list on the left-hand side is headed “MAIN”, and the four second-level
Classifications that belong to the “MAIN” Classification are listed there.
The list of Items on the right is empty because no Items belong directly
to the “MAIN” Classification.
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If the Item that we want is a type of Speaker, we can double-click on “4
Speakers” in the left-hand list, with the following result—

The title of the left-hand list changes to “4”, the Classification Code for
Speakers. This list is now empty, because this Classification has no sub-
Classifications. The right-hand list now shows the four Items that belong
to this Classification. This right-hand list can be sorted and searched in
the usual fashion and, as in the standard ‘Paste Special’ window, we can
create a new Item by clicking [New] or [Duplicate]. If the Item we want
is in the list, we can double-click it to add it to the Invoice.

The advantage of specifying that our “MAIN” Classification (i.e. the top
level Classification) is the Paste Classification in this example is that
when the ‘Paste Special’ list opens, the major Classifications are all
shown in the left-hand list, helping us to find the Item that we want
quickly and easily.

However, in some circumstances we might want to specify a lower level
Classification as the Paste Classification. For example, our best-selling
Item might belong to the “CASS” Classification, so we can make this the
Paste Classification. This is a Classification on the third level. In this
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situation, when the ‘Paste Special’ list opens, the title of the left-hand list
is “CASS”, the Paste Classification. This list is empty, because “CASS”
has no sub-Classifications. The right-hand list contains the four Items
that belong to this Classification—

If the Item that we want does not belong to the “CASS” Classification,
we can click the [Back] button to go up one level in the hierarchy (to
Classification “2 Recorders and Playback Devices”), or we can click the
[Top] button to go to the top level (to the “MAIN” Classification).

Item Classifications and the Web Shop

If you are using Hansa’s Web Shop, you may wish to offer different Items to
different Customers. This is done using Item Classifications and by
specifying a Classification for each Customer. Customers will see only those
Items in the relevant Classification when they log on to your Web Shop site.
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Using the example hierarchical structure described above, in this illustration
we have assigned the Classification “3” to a Customer using the Main
Classification field on the ‘Web’ card of the Customer record—

When this Customer logs in to the Web Shop, they will be shown a list of
Items that belong to Classification “3” (Record Decks and Accessories). They
will be able to access and purchase any Items belonging to this Classification
and to its sub-Classifications (Turntables, and Cartridges of both types).
However, they will not be able to move up a level to the “MAIN”
Classification, and therefore will not be able to view or purchase Radios,
Recorders or Speakers.

Item Classifications can be specified both in individual Customer records and
in Customer Category records. If a Classification is specified at the Customer
level, it will override one that has been specified at the Customer Category
level.

If no Classification is specified for a Customer or Customer Category, the
Classification with the Code “MAIN” will be used. If there is no “MAIN”
Classification, or if a non-existent Classification has been specified for the
Customer, no Items will listed when the Customer logs on.
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Controlling Price Changes

The Base Price Changes Setting

This setting, available in the Stock module, allows you to change the Base
Prices of many Items at one stroke.

To open the setting, move to the Stock module using the Modules menu and
click the [Settings] button in the Master Control panel (or choose ‘Settings’
from the File menu). When the ‘Settings’ list is opened, double-click ‘Base
Price Changes’. The ‘Base Price Changes: Browse’ window is displayed,
showing previous Base Price Change records.

Create a new record by clicking the [New] button in the Button Bar, or
highlight an existing record that is similar to the one you want to create and
click the [Duplicate] button.
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Header

No The unique identifying number of a new Base Price
Change record is provided automatically by Hansa
following on from the Number of the last record entered.

When you start using Hansa, the number sequence will
start at 1. If you want the sequence to start from another
number, change the Number of the first or any other
record before it is saved for the first time: Hansa will
then continue the sequence from there.

Person Paste Special Person register, System module

Default taken from Current User

Enter the initials of the Person responsible for this
record.

Trans. Date Paste Special Current Date

Enter the date of this price change. This will be copied to
the Base Price Change field of all Items affected by the
change.

Card 1

Use this grid to list the Items whose Base Price is to be changed.

Item Paste Special Item register

Enter the Item Number or Bar Code of the Item whose
Base Price is to be changed. The current Base Price is
shown in the Before field.

Description The Item Name is entered here automatically after you
have entered the Item Number.

Before The current Base Price of the Item is shown here after
you have entered the Item Number.

After Enter the new Base Price for the Item here. When the
OK box is checked and the record saved, this will be
copied to the Item record.

Footer

The footer contains the OK check box and various totals that are updated
automatically.

OK When the Base Price Change record is complete, check
the OK box and then click the [Save] button to save the
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record. The Base Prices of all the Items listed in the grid
will be changed as specified and you will no longer be
able to change the Base Price Change record.

Note that you can save the Base Price Change record
without checking the OK box. This allows you to enter
the record and to have it checked by all relevant
personnel before implementing the changes.

Card 2

Comment Use these fields to record the circumstances of the price
changes for future references.

Complete the Base Price Change record as described above and save it by
clicking the [Save] button in the Button Bar. You can now check that the
record is complete and accurate. When you are ready to implement the
change, check the OK box and then click the [Save] button once again. For
each Item listed in the grid, the After figure will be copied to the Base Price
field and the Transaction Date will be copied to the Base Price Change field.
You will no longer be able to change the Base Price Change record.

Two methods are available by which a Base Price Change record can be
printed—

1. While entering or inspecting a Base Price Change record, click the
Printer icon in the Button Bar or select ‘Print’ from the File menu. If you
want to print to screen, click the Preview icon.

2. Ensure you are in the Stock module and click the [Documents] button in
the Master Control panel or select ‘Documents’ from the File menu.
Double-click ‘Base Price Change’ in the ‘Documents’ list window.
Indicate the Number of the Base Price Change record (or range of
Numbers) to be printed and press [Run].

Using Access Groups to Control Price Changes

Base Prices can be changed using this setting even if the Do Not Allow Base
Price Change option in the Item Settings setting is in use. This option
prevents the changing of Base Prices using the Item screen. In multi-user
systems, using this combination means that you can control who can change
Base Prices, using the Access Groups setting in the System module.
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To do this, first move to the System module using the Modules menu and
then open a record in the Access Groups setting. If the Access Group starts
from the No Access position, you should use the grid to allow members of
that Access Group to use particular features—
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If the Access Group starts from the Full Access position, you should use the
grid to prevent members of that Access Group from using particular
features—

In both cases, if the Base Price Changes setting is not listed in the grid, access
to it will depend on the chosen Start From option. If this is No Access,
members of the Access Group will not be able to change Base Prices. If it is
Full Access, they will be able to make such changes.

The Access Groups setting is fully described in the ‘System Module’ chapter
elsewhere in this manual.

Prices in Sales Transactions

When you enter an Item in a sales transaction (e.g. Quotation, Order or
Invoice), the Unit Price according to the valid Price List for the Customer
will be brought in automatically (Price Lists are described later in this
chapter). If the Customer has no Price List specified, or the Item is not on the
Price List in question, the Base Price from the Item screen is brought in. You
are then free to change this Unit Price in the sales transaction if necessary.
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You can prevent a particular user or group of users from changing Unit Prices
in sales transactions using Access Groups. To do this, deny access to the
‘Change Unit Prices’ Action—
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A user that has been denied access to the ‘Change Unit Prices’ Action can
still change the Price List in a Quotation, Order or Invoice. If you want to
prevent this as well, deny access to the ‘Change Prices’ Action—

Changing Prices of Items in Batches

Another method for changing the Base Prices of many Items at one stroke is
the ‘Update Item Base Prices’ Maintenance function in the Pricing module.
This function allows you to change Base Prices using a formula, so it will be
useful if, for example, you want to change all Base Prices by 10%.

To use this function, move to the Pricing module using the Modules menu
and choose ‘Maintenance’ from the File menu. When the ‘Maintenance’ list
is opened, double-click ‘Update Item Base Prices’. The ‘Specify Item Prices’
window is displayed—
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Item Group Paste Special Item Group register, Sales
Ledger

Enter an Item Group here if you want to update the Base
Prices of all Items belonging to that Item Group.

Items Paste Special Item register

Range Reporting Alpha

Enter an Item Number or range of Item Numbers here if
you want to update the Base Price of a specific Item or
of a range of Items. You must enter either an Item
Number here or an Item Group in the field above,
otherwise no Base Prices will be updated. Do not leave
both fields empty in the hope of updating the Base Price
of every Item in the database.

Price Formula Paste Special Price Formula register, Pricing
module

Enter here the Price Formula record that is to be used to
recalculate the Base Prices of the selected Items. If this
field is left blank, Base Prices will not be changed. For
more information about Price Formulae, please refer to
the ‘Prices’ section later in this chapter.

When you click [Run], the Base Price of each selected Item will be
recalculated using to the specified formula.

A similar function, ‘Update Item Cost Prices’ (also in the Pricing module)
allows you to change the Cost Prices of many Items at one stroke. This
operates in an identical manner to the ‘Update Item Base Prices’ function.
Another Maintenance function, ‘Update Item Cost Price’ in the Stock
module, changes Items’ Cost Prices to the latest purchase prices (i.e. to the
prices in the latest Goods Receipts). This function, which can be applied to
Stocked Items only, is described in Volume 3 of these manuals. If necessary,
you can deny access to these functions using Access Groups as described
earlier in this section.
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Price Lists

Introduction

Hansa’s Pricing module contains a powerful set of functions to handle
different types of Price Lists in a business. These functions allow the user to
manage several alternative Price Lists listing all or some of the goods or
services offered to Customers. Price Lists can be specified in different
Currencies, with automatic recalculation to the current exchange rate at
invoicing. They can be dynamically updated based on user defined formulae,
or on the last recorded purchase prices. Different Price Lists can be connected
with specific Customer Categories and to specific Payment Terms. The latter
case might be useful for users who have different prices for Customers who
pay by different methods (for example, special prices for credit card
payments). The number of alternatives is great, but as always is the case with
great flexibility, it is necessary to know and understand the tools and
techniques to set up a specific pricing structure.

The Base Price

Each Item has a Base Price field, shown on the ‘Pricing’ card. This is the
Item’s normal selling price. In many cases, this will be the only price used. If
each Item is always sold at the same price (or with an ad hoc discount),
whoever the Customer, you will be able to rely on the Base Price and not
worry about the Price List feature.

On the ‘Costs’ card of the Item record, there is also a Cost Price. This
indicates the cost of purchasing or making the Item. Hansa uses the Cost
Price to calculate the Gross Profit of Orders and Invoices. The Cost Price and
the Base Price can both be used to calculate new prices for the Item when it is
included in different Price Lists.

Structure of Price Lists

Hansa allows you to assign different Prices to individual Items so that each
Price is associated with a particular Price List. For example, many retail
outlets have different prices for their retail and trade Customers, or different
retail and educational prices. You might then have separate retail, trade and
educational Price Lists, each of which is available to the appropriate kind of
Customer. When a Price List is specified in an Order or Invoice, the
appropriate prices will be selected automatically.
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In planning such a price structure, follow these steps—

1. Enter the Items with their Base Prices, using the Item register as
described towards the beginning of this chapter.

2. Price Formulae should be defined, using the Price Formula register in the
Pricing module. These are the mechanism by which the different prices
are calculated. In our example, the retail price might be the same as the
Base Price, the trade price might represent a discount of 20% and an
educational price might represent a discount of 30%. A Price Formula
record would be set up for each. This process is described in detail in the
next section.

3. Each Price List (retail, trade and educational) should then be defined
using the Price List register in the Pricing module. Items or Item Groups
should be attached to the Price Lists with an appropriate Price Formula.
For example, in the educational Price List, all Items that are likely to be
sold to such Customers should be attached, using the 30% discount Price
Formula. Effectively, the relationship between the Items and the Price
List is being defined here.

4. For each Price List, the Prices of the Items should be calculated. This
process is automated by the provision of the ‘Calculate Price Lists’
Maintenance function in the Pricing module. For each Item on each Price
List, this function applies the specified Price Formula and saves the
result in a record in the Price register. In our example, for each Item
three Price records will be created: one each containing the retail, trade
and education prices.

The relationship between the Items, the Price Lists and the Price records
makes it of critical importance that the ‘Calculate Price Lists’ function is
run whenever the Base Price of an Item changes or, if you have Price
Lists in various Currencies, whenever the Exchange Rate alters.
Otherwise, the Price records could soon lose their relationship to the
Base Price of their Items, resulting in you quoting out-of-date prices to
your Customers. If a Price List is specified in an Order or Invoice, Hansa
searches in the Price register for the appropriate, and unique, record
representing the particular Item for that Price List.

The ‘Calculate Price Lists’ function in fact can save records to one of
two places depending on how the Price List record has been defined: the
Price register and the Quantity Dependent Prices setting, also in the
Pricing module. The Price register contains a single price to be applied
irrespective of the quantity sold, while the Quantity Dependent Prices
setting can be used to set up quantity discounts.
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5. Each Customer, Customer Category and/or Payment Term record can
now be assigned a Price List. When Orders or Invoices are entered for
each Customer, prices will be taken from the specified Price List
automatically. If an Item not on the appropriate Price List is sold, the
Base Price will be used.

6. Once calculated, Price Lists can be printed or exported to disk for
incorporation into your company’s publicity material. Price Lists are
printed using the report of the same name, available in the Pricing and
Sales Orders modules and in the Sales Ledger. This is fully described in
the ‘Reports’ section towards the end of this chapter.

Below, steps 2-4 are described in detail. These descriptions are followed by
worked examples.

Price Formulae

When Items are assigned to a Price List, it is by means of a Price Formula.
Price Formulae are used to calculate prices for that Price List, based on the
Base or Cost Price of the Items.

To define a new Price Formula, first move into the Pricing module using the
Modules menu. Then click [Price Formulae] in the Master Control panel or
select ‘Price Formulae’ from the Registers menu. When the ‘Price Formulae:
Browse’ window appears, click [New]. Once entered, click [Save] to save the
record.

 

Code Enter a code by which the Price Formula can be
identified.

Name Specify a name for the Formula.
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% Adjustment The value entered here is used to calculate the price. The
value is entered as a percentage: enter “110” to add 10%
to the base price, “90” to deduct 10%.

Add 1 Add or deduct a fixed amount. If used in combination
with the field above, the addition or deduction will take
place after the percentage adjustment.

Round Off Specify here the number of decimal places you wish to
be used in the calculation. Enter zero to round the price
to the nearest whole monetary unit (e.g. to the nearest £
or $), 1, 2 etc (positive) to calculate to one or two
decimal points respectively, and -1, -2 etc. to round to
the nearest ten, hundred etc.

Add 2 Add another fixed amount after the rounding process.

Base Value Specify here the figure on which the calculation is to be
based. The Cost Price, Base Price, Last Purchase Price
and Weighted Average Purchase Price are all taken from
the Item record, while Default Purchase Item refers to
the Cost Price of the Default Purchase Item representing
the Item. Please refer to the ‘Purchase Orders’ chapter in
Volume 3 for full details of Purchase Items.

Price Lists

To define a new Price List, first ensure you are in the Pricing module using
the Modules menu. Then click [Lists] in the Master Control panel or select
‘Price Lists’ from the Registers menu. When the ‘Price Lists: Browse’
window appears, click [New].
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Code Enter a unique code here, by which this Price List will
be identified elsewhere in Hansa.

Description Name the Price List here.

Period Paste Special Current Date

If the Price List is valid for a certain period, enter that
period in these two fields. If this Price List is assigned to
a Customer, it will only be used during the period
entered here. At other times, the Base Price for each
Item will be used.

These fields cannot be changed once the Price List has
been saved for the first time.

The Period can be used in combination with the Replace
field (below). Please refer to the description of that field
for details.

Currency Paste Special Currency register, System
module

Indicate here the Currency in which the prices in the
price list are quoted. When using the ‘Calculate Price
Lists’ function to calculate prices, the Currency
conversion (using the most recent applicable Exchange
Rate) will take place before any Formula is applied.

Replace Paste Special Price List register, Pricing
module

This field is used in combination with the Period above.
It is used when a standard Price List has been assigned
to a Customer or Customer Category and you want to
use a temporary Price List for a certain time period.

In the standard Price List, leave the Period and Replace
fields blank. Create a new record for the temporary Price
List, enter the Period for which it is valid and specify the
Code of the standard Price List in the Replace field. Do
not change the Customer or Customer Category. When
entering Quotations, Orders or Invoices, the temporary
Price List will be used during the specified Period and
the standard Price List will be used at all other times,
both before and after this Period.

In the case of Quotations and Invoices, the relevant dates
for the Period will be the Quotation and Invoice Dates
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respectively. In the case of Orders, the Order Date,
Planned Delivery Date or the Despatch Date can be used
to determine whether the temporary Price List is valid.
This is set for each Customer, using the Price Based On
options on the ‘Pricing’ card of the Customer record.

This field cannot be changed once the Price List has
been saved for the first time.

VAT Choose the Exclusive option if the prices calculated by
the ‘Calculate Price Lists’ function are to exclude VAT,
and the Inclusive option if they are to include VAT. In
the case of ‘Inclusive’ and ‘Exclusive’ Price Lists using
the same Price Formulae, the resulting prices will
numerically be the same but in the former case the
figures will include VAT.

If an ‘Inclusive’ Price List is used in an Invoice or an
Order, the Unit Price, Sum and Total figures will all
include VAT, but if an ‘Exclusive’ Price List is used, the
Unit Price and Sum figures will exclude VAT. In both
cases, VAT will be calculated using, in order of
preference, the VAT Code specified for the Item, the
Item Group or on card 3 of the Account Usage S/L
setting.

Type The ‘Calculate Price Lists’ function can save records in
one of two places: the Price register and the Quantity
Dependent Prices setting. The Price register contains a
single price to be applied irrespective of the quantity
sold, while the Quantity Dependent Prices setting can be
used to set up quantity discounts.

Select the Discount option if the Price List is to save to
the Price register, otherwise select the Qty Dep Values
option.

The Type is also of importance in determining pricing in
Orders and Invoices. If the Price List specified in an
Order, Quotation or Invoice has had the Discount option
selected, pricing will be determined by the Price register.
Otherwise, pricing will be determined by the Quantity
Dependent Price register.
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If, for whatever reason, the Currency
of a Price List is changed, run the
‘Calculate Price Lists’ function
immediately. Otherwise, prices used
in Orders and Invoices will not be as
expected.

Use the table to determine the Items that will appear in the Price List, and at
what price. Use each row to include an Item or a whole Item Group in the
Price List. If an Item Group is specified, all Items in the Item Group will
appear in the Price List.

Item Code Paste Special Item or Item Group registers

This field can contain either an Item Code or an Item
Group Code. The contents of the ‘Paste Special’ list will
depend on the Row Type. If you wish this Price List to
apply to all Items in the Item register, leave the field
blank.

Price Formula Paste Special Price Formula register, Pricing
module

Specify here the code of a Price Formula, defined as
described in the previous section. It is used to calculate
the prices for this Price List. Note that, in a particular
Price List, different Items can have their Prices
calculated using different Formulae.

Row Type Paste Special Choices of possible entries

This field can contain one of two entries: “Item” or
“Item Group”. It indicates whether the Item Code (the
left-hand column) refers to an Item or an Item Group.
Use ‘Paste Special’ to increase input speed.

A Price Formula must be specified
for each row in the table. Otherwise,
when the Price List is built, the Item
or Item Group will be given a zero
price.

!

!
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The Price Register

It is possible to create several alternative Prices for each Item. These Prices
are recorded as records in the Price register, one record for each Price for
each Item.

In most cases, these records will be created automatically using the
‘Calculate Price Lists’ Maintenance function in the Pricing module. They will
then be updated each time the function is run.

The Quantity Dependent Prices Setting

The Quantity Dependent Prices setting in the Pricing module provides an
alternative to the Price register. It allows the use of quantity discounts for
each Item.

To create records in the Quantity Dependent Prices setting, first select the
Qty Dep Values option in the Price List(s) concerned. Then, run the
‘Calculate Price Lists’ Maintenance function in the Pricing module. The
quantity discounts should then be entered to each record manually.

In the example illustration, the price for Item 10101 will be as follows—

Quantity Sold Unit Price
1 5.00
2 4.95

3-5 4.85
over 5 4.75
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In the example, the Price column has been used to specify an absolute price
for each quantity break. The Formula column could be used instead to
calculate each price: use ‘Paste Special’ to enter the correct Price Formula.

Note that although records in the Quantity Dependent Price register are
created by the ‘Calculate Price Lists’ function, they will not subsequently be
updated by that function.

The ‘Calculate Price Lists’ function

This function can be run once the steps described above (defining Items,
Price Formulae and Price Lists) have been completed. For each Item on each
Price List it will calculate a new price using the Formula specified and save it
in a Price record. This will result in there being a single, unique, Price record
for each Item/Price List combination, making the use of Price Lists in Orders
and Invoices extremely fast. As a consequence, each time a price that is used
as a base price by a Formula is changed, the function should be run again to
update the Price records. The function should also be used regularly if you
have Price Lists in foreign Currencies with exchange rates that change
frequently.

If, in a particular Price List, the Qty Dep Values option is being used, this
function will save to the Quantity Dependent Prices setting instead of the
Price register. Again, this setting will feature a single, unique, Price record
for each Item/Price List combination. Note, however, that these records will
not be updated when the function is run on later occasions.

If there is both a Price record and a Quantity Dependent Price record for the
same Item/Price List combination, priority will depend on how the Price List
has been defined. If the Price List is of Discount Type, the Price record will
be used, while if it is of Qty Dep Value Type, the Quantity Dependent Price
will be used.

To use this function, ensure you are in the Pricing module using the Modules
menu and select ‘Maintenance’ from the File menu. Double-click ‘Calculate
Price Lists’ in the subsequent list. The following dialogue box appears—
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Leave all fields blank and click [Run] to calculate all prices. To restrict the
calculation process, use the fields as described below before clicking [Run].

Price List Paste Special Price List register, Pricing
module

Enter the code identifying the Price List you want to
update. Leave the field blank to recalculate all Price
Lists.

Item Group Paste Special Item Group register, Sales
Ledger

Limit the calculation to a single Item Group. Prices will
only be recalculated if the Item Group is explicitly
included in the grid of the Price List specified in the
field above. If no Price List is specified, prices will be
recalculated for all Price Lists in which the Item Group
is included.

Item Paste Special Item register

Limit the calculation to a single Item. The Item does not
have to be explicitly included in the grid of the specified
Price List: its Price will also be recalculated if its Item
Group is in the grid or if the first column of the grid is
blank (i.e. if the Price List includes all Items).

Supplier Paste Special Supplier register

Enter a Supplier Number to limit the recalculation to a
single Supplier. Prices will be recalculated for Items that
have a Default Purchase Item in the name of that
Supplier. Suppliers are described in the ‘Purchase
Ledger’ chapter in Volume 2a while Default Purchase
Items are covered in the ‘Purchase Orders’ chapter in
Volume 3.

Add Item Markup to Base

Select this option to apply the Markup % (specified on
the ‘Pricing’ card of the Item record) before the Price
Formula.

When you click [Run], the function may take a few minutes to run,
depending on how many prices you are updating.
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Entering Price Records Manually

It is also possible to enter Price records manually. You might want to do this
to assign a particular price to an Item, rather than one which is calculated
using a formula. Hansa will prevent you entering a Price record for an
Item/Price List combination if one already exists by displaying the error
message “Already Registered”.

To enter a new Price record, open the Price register using the [Prices] button
in the Master Control panel or the ‘Prices’ function on the Registers menu
and click [New]. Enter the Item Number of an existing Item, using ‘Paste
Special’ if necessary to select from a list of Items, and press Return. The Item
Name from the Item register is shown. Enter the required Price (in the
Currency of the Price List) and specify a Price List, again using ‘Paste
Special’. Finally, if appropriate, specify a Sales Account and Customer. If
necessary, you can use the Customer field to offer different Prices to different
Customers within the same Price List. Click [Save] to save the record.

Specifying a Price List in a Price record has the following effects—

• It will be included when the Price List is printed, using the report in the
Pricing and Sales Orders module and in the Sales Ledger.

• When an Order or Invoice is created, a Price List can be specified which
will determine the Prices and, if specified, the Sales Accounts used. The
Price List can be specified on three levels: for each individual Invoice;
for each Customer; or for Customer Categories. The second and third
alternatives involve the Customer’s Price List being offered as a default
whenever the Customer places an Order or receives an Invoice.

• If a Currency code is entered in the Price List record, the Prices in the
Price List will be in that currency. If the Price records have been created
using the ‘Calculate Price Lists’ function, they will have been converted
from the home Currency to that specified using the most recent
Exchange Rate. They may be converted again to another currency at
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invoicing, depending on the currency code of the Customer or Invoice. If
no Currency is specified for the Order or Invoice, but a Price List has
been specified which is not in the home Currency, the Prices will be re-
converted back to the home Currency.

If a Sales Account is specified for a Price record, that Account will be offered
as a default in Invoices where pricing is determined by that Price (i.e. by the
unique Price record for the Item/Price List combination). This Account will
take priority over those for the Item and Item Group and that in the Account
Usage S/L setting. Sales Accounts can also be specified for Quantity
Dependent Prices.

Deleting a Price List

1. Ensure you are in the Pricing module using the Modules menu and select
‘Price Lists’ from the Registers menu or click [Lists] in the Master
Control panel.

2. Find the Price List you want to remove, and open it by double-clicking.

3. Select ‘Delete’ from the Record menu.

The Price List is permanently removed. The window shows the
preceding Price List.

4. Close the window with the close box.

You cannot undo the deletion of a
Price List.

When a Price List is deleted in this way, the related records in the Price
register are not removed. If you want to delete these as well, run the ‘Delete
Prices’ Maintenance function in the Pricing module.

!
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Examples

Prices in Currency

The following Prices have been defined—

The Price List “DOL” has three members, Item Numbers 10101 to 10103. It
has US Dollars as its Currency. All Prices in the “DOL” Price List are
therefore in dollars. The Price List “DOL” is assigned to the Customer
Category “USS”—

Customer no 008 is a member of this Customer Category. When a Quotation,
an Order or an Invoice is issued for this Customer, Hansa will automatically
use the prices on the “DOL” Price List. If this Invoice is given the Currency
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Code “USD” (for US Dollars), the Invoice will be issued in dollars (i.e. the
prices will be taken straight from the “DOL” Price List without any further
conversion).

The Nominal Ledger Transaction generated from this Invoice will show
figures in both foreign and home Currencies (and in the second base
Currency if appropriate): the conversion rate shown on the ‘Currency’ card of
the Invoice will be used.
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If the Customer instead is to be invoiced in the home Currency, ensure the
Currency field is blank or showing the Currency Code for the home Currency
(Pounds Sterling in the example) and the prices will be converted from US
Dollars using the current conversion rate as the Items are added to the
Invoice—
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If, for some reason, the Invoice is to be issued in another Currency, e.g.
Japanese Yen, the Currency field of the Invoice should be amended
accordingly and the prices will be converted to that Currency in the Invoice,
using the latest valid conversion rate for that Currency—

Note that in each illustration, the Total GP and the Base remain the same,
because they are always expressed in the home Currency.

Creating Price Lists

This example shows you how to create a new Price List in which the Prices
for each Item are the Base Price less 7%, rounded up to the nearest 10
monetary units.

Start by creating a new Price Formula record using the Price Formula register
in the Pricing module, as shown overleaf.
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Give a name to the formula. In the % Adjustment field, enter the value “93”
(representing a 7% discount) to give the calculation formula. The field round-
off gives instructions for rounding off the calculated value. A zero means that
the price will be rounded to the nearest monetary unit (Pound, Mark, Krona,
Dollar etc.). 1 and 2 (positive) provide prices to one or two decimal places,
and -1, -2 etc. round to the nearest ten, hundred etc. unit of the currency. For
the example, “-1” is entered. Finally, select the Base Price to act as the base
value for the calculation. Save the Price Formula by clicking [Save].

Now, create a new Price List using the register in the Pricing module, with
the code “SEVEN”, and an appropriate name. Enter the Code of the Price
Formula that you have just set up in the Formula field.

If you leave the Item Code field blank, a new Price List will be created for all
Items in the Item register. Otherwise enter one or more Items or Item Groups
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in separate rows to apply different Price Formulae to different products. Save
the Price List by clicking [Save].

To create the new Price records, select ‘Maintenance’ from the File menu.
Double-click ‘Calculate Price Lists’, and specify in the following dialogue
box that Price records for the Price List “SEVEN” are to be created—

New Price records will be added to the Price register if this is the first time
you have run the function for this Price List. Otherwise, the Prices will
simply be recalculated. The creation will take some time, depending on the
number of records. When the job is finished, the new records are visible in
the Price register.

Creating a Price List in another Currency

The procedure described above can be used again here, with one amendment.
When entering the Price List, specify the appropriate Currency. When the
‘Calculate Price Lists’ function is run, the Prices of all Items will be
converted to the selected Currency. The Price records created will therefore
contain Prices in the converted Currency. If, as in the previous example, a
discount of 7% was specified, this will be deducted after the Currency
conversion.
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Dated Price Lists

For this example, you have a standard Price List with the Code ”SEVEN”
which is assigned to many of your Customers and Customer Categories—

This Price List offers a 7% discount from the Base Price of all Items. You
decide you want to offer a 14% discount for the month following the annual
trade show, and an 18% discount for the two weeks after that.

Do not change the “SEVEN” Price List or your Customers or Customer
Categories. Instead, define a new Price List with a 14% Price Formula. Enter
the period of validity (the month after the trade show) in the two Period
fields, and use the Replace field to signify that this new Price List is to take
the place of the “SEVEN” Price List during that period.
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Similarly, enter a new Price List with an 18% Price Formula for the next two
week period. Again, use the Replace field to signify that this new Price List is
to take the place of the “SEVEN” Price List during this period. Once this
Period has expired, the “SEVEN” Price List will be used once again.

Use the ‘Calculate Price Lists’ Maintenance function to create new Price
records for both new Price Lists as described in the previous example.
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When entering Invoices or Quotations, the appropriate Price List will be
used, based on the Invoice Date or the Quotation Date respectively. When
entering Orders, the Order Date, Planned Delivery Date or Despatch Date can
determine which Price List is to be used. This choice is set for each
Customer, using the Price Based On options on the ‘Pricing’ card—

If the determining date is changed, use the ‘Update Currency Price List
Items’ Operations menu function to recalculate the prices of Items previously
added to the record. If necessary, this will select another Price List and
change all prices appropriately.

Note that even when the “14” or “18” Price List is being used, the Price List
field in the Quotation, Order or Invoice will show the standard Price List
(“SEVEN” in the example).

Of course, you can also assign the “14” or “18” Price List directly to a
Customer or enter it in an Order, Invoice or Quotation. In this case, they will
only be used during their period of validity. At other times, the Items’ Base
Prices will be used.
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Quantity Discounts

It is possible to set up a complex quantity discount system in Hansa. To do
so, two registers in the Pricing module are used: Quantity Dependent
Discounts and Discount Matrices. Quantity Dependent Discounts should be
defined first, as they are used by the Discount Matrices.

When entering Quotations, Orders or Invoices, quantity discounts are applied
automatically as appropriate, after the Item’s price has been determined by
reference to any Price Lists that may apply.

In planning such a discount structure, follow these steps—

1. Enter the Items with their Base Prices, using the Item register, as
described earlier in this chapter. Assign each to an Item Group.

2. Quantity Dependent Discounts should be defined, using the register in
the Pricing module. This is where the various quantity breaks are
defined. Quantity breaks can be based on quantity, weight, volume or
Order value. If you offer quantity breaks for different Items, define as
many Quantity Dependent Discount records as necessary.

3. The discount levels can now be specified, using the Discount Matrix
register in the Pricing module. Each set of discount levels (a ‘Discount
Matrix’) will use the quantity breaks defined in step 2. A single set of
discount levels can apply to all Items, or to specified Item Groups.

4. Each Customer or Customer Category can now be assigned a Discount
Matrix. When Quotations, Orders or Invoices are entered for each
Customer, the specified discount structure will be used automatically.

5. The Quantity Dependent Price register (described in the previous
section) can be used in combination with Discount Matrices. When
entering Orders or Invoices, the Item’s price will first be affected by the
applicable Quantity Dependent Price and then by the Discount Matrix. In
essence, the main difference between the two discount methods is that
the quantity discounts in the Quantity Dependent Price register are
absolute values, while those in the Discount Matrices are percentages. If
your business is one where prices are fairly volatile, the latter method
will require less maintenance. Also, Discount Matrices can apply
quantity discounts based on weight, volume or value sold, in addition to
quantity sold.

Below, steps 2 and 3 are described in detail.
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Quantity Dependent Discounts

This register in the Pricing module is used to define the quantity breaks
which will be used by the Discount Matrix register. You can establish as
many sets of quantity breaks as necessary. They can be based on sales
quantity, sales value, weight or volume. Each set of quantity breaks can be
used by any number of Discount Matrices, allowing you to define different
discount structures based on the same quantity breaks.

Code The code for the definition, by which it will be identified
from the Discount Matrix screen.

Description A text describing the definition.

1-9 These fields are used to define the quantities which are
to function as the threshold for each discount level (i.e.
the quantity breaks). These quantities can be values,
quantities, weights or volumes, specified using the
Model options to the right.

In the example illustrated, the discount structure is based
on the Order or Invoice quantity. There are three
discount levels: fewer than four items, between four and
seven items, and seven items or more. To implement
this, “0” has been entered in the first row, “4” in the
second and “7” in the third. The percentage discounts for
each discount level are defined in the corresponding
Column fields on the Discount Matrix screen.

Model Select one of the alternatives to indicate how the
calculation will be made.
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Sum The discount level will be based on the total value
of the Invoice or Order row.

Qty The discount level will be based on the Order
Quantity of the Invoice or Order row.

Weight, Volume Weight or volume will be used as the base.

Discount Matrices

This register in the Pricing module allows you to specify the discount
percentages that are to be applied to the quantity breaks already defined. Each
set of discount percentages (a ‘Discount Matrix’) can then be applied to
Customers or Customer Categories. Once defined, you will be able to sell a
quantity of a particular Item, applying varying discounts according to the
Customer or Customer Category.

Code This code identifies the matrix, and is used to call it from
other parts of Hansa.

Comment Enter a name for this matrix.
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Card 1 appears below the header. It is used to define overall discount
structures that will apply whatever the Item sold. To define Item-dependent
quantity discounts, use card 2.

Code Paste Special Quantity Dependent Discount
register, Pricing module

Use ‘Paste Special’ to specify a code of a Quantity
Dependent Discount record, as described in the previous
section. This will identify the quantity breaks: the fields
below will be used to specify the discount rates for those
breaks.

Col. 0-9 Specify here the percentage discount levels for each
quantity break: usually, the percentage discount will
increase with the size of the purchase.

In the example illustration, the discount structure will be
as follows—

Quantity Sold Discount Field
Up to 4 0% Column 1

4-7 5% Column 2
Over 7 10% Column 3

The quantity breaks have already been defined in the
specified Quantity Dependent Discount record,
illustrated in the previous section. Always fill in all the
fields, even if not all are going to be used: the remaining
column fields should contain the highest discount
percentage used (“10” in the example).

The Column 0 field can be used to specify a single
discount figure which will always be applied. This is the
easiest way to apply an overall discount to an Order or
Invoice as this discount will be applied to all Order or
Invoice rows. In this case there is no need to specify a
Quantity Dependent Discount in the Code field, and
leave the Column 1-9 fields blank. Column 0 is not used
if the Column 1-9 fields contain values and there is a
valid Quantity Dependent Discount.

In the table on card 2, you can define different discount levels for different
Items or Item Groups. Any figures entered here will take precedence over any
values entered on card 1: you can therefore set up an overall structure on card
1 and an exceptional structure, perhaps applying to only one or two Items or
Item Groups, on card 2.
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Item Type Paste Special Choices of possible entries

This field can contain one of two entries: “Item” or
“Item Group”. It indicates whether the Item Group (the
next column) refers to an Item or an Item Group. Use
‘Paste Special’ to increase input speed.

When this Discount Matrix is used in an Invoice, Order
or Quotation, if the entry is “Item”, the appropriate
discount percentage will appear as soon as the Item and
Quantity have been specified. However, if the entry is
“Item Group”, the discount percentage of an Item is
dependent on how many other Items of the same Group
have been used in the same transaction. This is because
the discount percentage is calculated using the total
quantity, value, weight or volume of all Items in the Item
Group. To calculate the discount percentage for all Items
in the Group, select ‘Recalculate Discount’ from the
Operations menu when all Items have been added to the
transaction.

If this field is set to “Item Group” and the next field is
blank, the Discount Matrix will cause the ‘Recalculate
Discount’ function to calculate an overall discount
percentage for the transaction, from the total quantity,
value, weight or volume of the Items used.

Item Group Paste Special Item Group register, Sales
Ledger or Item register

Specify here the Item or Item Group to which the
discounts in this row are to apply. The contents of the
‘Paste Special’ list will depend on the Item Type.

Qty Dep. Code Paste Special Quantity Dependent Discount
register, Pricing module

Use ‘Paste Special’ to specify a code of a Quantity
Dependent Discount record, as described in the previous
section. This will identify the quantity breaks: the fields
to the right will be used to specify the discount rates for
those breaks.

Column 0-9 These fields operate in the same manner as those with
the same name on card 1.

If you enter a percentage in Column 0, that will apply to
all sales of the Items in question to Customers who use
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this discount matrix. Any figures entered to the Column
1-9 fields will take precedence over any value entered
here.

Use Columns 1-9 to specify the percentage discount
levels for each quantity break. Usually, the percentage
discount will increase with the size of the purchase.
These percentages are linked to the quantity breaks
defined in the Quantity Dependent Discount records.
Always fill in all the fields, even if not all are going to
be used: the remaining column fields should contain the
highest discount percentage used.

Each percentage entered in a Discount Matrix record can act as a discount,
margin factor or markup. This is controlled using the General Options setting
in the System module: please refer to the ‘System Module’ chapter elsewhere
in this manual for details.
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Reports

Introduction

Item reports are usually located in the Sales Ledger and the Stock and Sales
Orders modules. Use the Modules menu to ensure you are in the correct
module and then select ‘Reports’ from the File menu or click [Reports] in the
Master Control panel. Then, double-click the appropriate item in the list. A
specification window will then appear, where you can decide what is to be
included in the report. Leave all the fields in this window blank if the report
is to cover all the Items in the database. If it is necessary to restrict the
coverage of the report, use the fields as described individually for each
report.

Where specified below, it is often possible to report on a selection range,
such as a range of Customers, or a range of Items. To do this, enter the lowest
and highest values of the range, separated by a colon. For example, to report
on Customers 001 to 010, enter “001:010” in the Customer field. Depending
on the field, the sort used might be alpha or numeric. In the case of an alpha
sort, a range of 1:2 would also include 100, 10109, etc.

Using the options at the bottom of the specification window, determine the
print destination of the report (the default is to print to screen). You can
initially print to screen and subsequently send the report to a printer using the
Printer icon.

Once you have entered the reporting criteria and have chosen a print
destination, click [Run].
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Item Group List

This report, found in the Stock module, is a simple list of Item Groups.

When printed to screen, the Item Group List has Hansa’s Drill-down feature.
Click on any Item Group Number to open the corresponding Item Group
record.

Item Group Paste Special Item Group register, Sales
Ledger

Range Reporting Alpha

If you need to print the details of a particular Item Group
or range of Item Groups, enter the Item Group Code(s)
here.

Function Use these settings to control the level of detail that you
would like to be shown in the report.

Overview This option is a simple list showing the Number
and Name of each Item Group.

Detailed For each Item Group, this option prints the Sales
and Stock Accounts, the VAT Codes for each
Zone and the Cost Model.

Item List

This report is available in both the Sales Ledger and the Sales Orders
modules. For each Item, it displays the Item Number, Name, any Group
membership, Unit, VAT Code and the Base Price.
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Leave all the fields blank if the report is to cover all the Items in the Item
register. If it is necessary to restrict the coverage of the report, use the fields
as described below.

Item No. Paste Special Item register

Range Reporting Alpha

Use this field to limit the report to a single Item, or range
of Items.

Item Group Paste Special Item Group register, Sales
Ledger

Range Reporting Alpha

To limit the report to a single Item Group, enter an Item
Group Code here.

If both a range of Items and a range of Item Groups are
specified, the report will cover only those Items in the
range which are members of the specified Item Groups.

Sorting The report can be sorted by Item Number, Item Group or
Name.

Specify Use these options to include Items of specific Item
Types in the report.
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Show Bar Code Check this box if you would like the Bar Code of each
Item to appear in the report. It will appear immediately
below the Item Number.

Include Closed Items

Check this box if you would like to include in the report
Items that have been marked as Closed.

Item Statistics

This report is available from the Sales Ledger only. It displays sales statistics
for each Item, including turnover, quantity and gross profit.

When printed to screen, the Item Statistics report has Hansa’s Drill-down
feature. Click on any Item Number to open the corresponding Item record.

Leave all the fields blank if the report is to cover all the Items in the Item
register. If it is necessary to restrict the coverage of the report, use the fields
as described below.

Item No. Paste Special Item register

Range Reporting Alpha

Use this field to limit the report to a single Item, or range
of Items.
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Customer Paste Special Customer register

To limit the report to sales to a single Customer, enter a
Customer Number here.

Categories Paste Special Customer Categories setting,
Sales Ledger

Range Reporting Alpha

Use this field to limit the report to sales to Customers of
a single Category or range of Categories.

Item Classification

Paste Special Item Classifications setting,
Stock module

Select an Item Classification. Sales of all Items with that
Classification will be included in the report. If you enter
a number of Classifications separated by commas, only
Items featuring all the Classifications listed will be
included in the report.

Classification Paste Special Customer Classifications
setting, CRM module (if
installed)

Select a Customer Classification. Sales to all Customers
with that Classification will be included in the report. If
you enter a number of Classifications separated by
commas, only sales to Customers featuring all the
Classifications listed will be included in the calculations.

Item Groups Paste Special Item Group register, Sales
Ledger

Range Reporting Alpha

To limit the report to a single Item Group, enter an Item
Group Code here.

If both a range of Items and a range of Item Groups are
specified, the report will cover only those Items in the
range which are members of the specified Item Groups.
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Department Paste Special Departments setting, Assets
module

To limit the report to Items of a single Department, enter
a Department Code here. The Department of an Item is
specified on the ‘Stock’ card of the Item screen.

Price List Paste Special Price List register, Pricing
module

This field is only used by the Detailed version of the
report, which prints the Base and Cost Prices of each
Item. If a Price List is specified here, the Price according
to that Price List is shown as well.

Period Paste Special Reporting Periods setting,
System module

Enter the start and end date of the reporting period.

Function These settings control the level of detail included in the
report.

Overview This option offers a single line per Item
displaying sales statistics, including turnover,
quantity and gross profit.

Detailed In addition to the information offered by the
previous option, this choice also shows quantities
in stock and on order, and the Base and Cost
Prices for each Item. If a Price List is specified in
the field above, the Price according to that Price
List is shown as well.

Values in If you are using the Dual-Base system, values in this
report can be shown in either Base Currency. Use these
options to choose which Currency is to be used on this
occasion.

If you are not using the Dual-Base system, use the Base
Currency 1 option to produce a report in your home
Currency.
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Item Sales Statistics

This report, available in the Sales Ledger only, is a simple list of Items,
showing the quantity sold and turnover for each one. Unlike the Item
Statistics report described above, however, it sorts the Items by sales
(turnover or quantity), allowing the most or least successful to be ascertained
easily. The statistics are compiled from approved Invoices only.

Period Paste Special Reporting Periods setting,
System module

Enter the start and end dates of the reporting period,
separated by a colon. The period should consist of a
number of whole months otherwise the report will not be
produced.

Items Paste Special Item register

Range Reporting Alpha

Use this field to limit the report to a single Item, or range
of Items.
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Item Group Paste Special Item Group register, Sales
Ledger

To limit the report to a single Item Group, enter an Item
Group Code here.

If both an Item Group and a range of Items are specified,
the report will cover only those Items in the range which
are members of the specified Item Group.

No. of Items shown

Enter here the number of Items to be shown in the
report. For example, to list the ten most or least
successful Items, enter “10” here.

Function These options control the sort order of the report.

Highest Qty Sold Choose this option to sort the report so that the
most successful Items in terms of quantity sold
are at the top.

Lowest Qty Sold Choose this option to sort the report so that the
least successful Items in terms of quantity sold
are at the top. This will not include Items with no
sales, unless the Include Items with no sales box
(below) is also checked.

Highest Turnover

Choose this option to sort the report so that the
most successful Items in terms of turnover are at
the top.

Include Items with no sales

Check this box if you want to include in the report Items
that have not been sold during the report period.
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Item Turnover History

This report is only available from the Sales Ledger. It shows monthly sales
totals (both quantities and values) for the Items in the selection in a specified
calendar year.

Leave all the fields blank if the report is to cover all the Items in the Item
register. Otherwise, use the fields as described below.

Period Paste Special Reporting Periods setting,
System module

Enter the start and end date of the reporting period.

The report is an analysis of Items sold by calendar year.
Therefore, if a period is specified that spans two years,
analysis will only be provided for those months up to
and including December of the first year.

Items Paste Special Item register

Range Reporting Alpha

Use this field to limit the report to a single Item, or range
of Items.

Item Group Paste Special Item Group register, Sales
Ledger

To limit the report to a single Item Group, enter an Item
Group Code here.

If both an Item Group and a range of Items are specified,
the report will cover only those Items in the range which
are members of the specified Item Group.
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Item/Quantity Statistics

This report in the Sales Ledger can be seen as providing a printed version of
the ‘Item Status’ window. For each Item in the selection, the report shows the
Minimum Stock Level and the quantities currently in stock, on order awaiting
delivery and on approved Purchase Orders awaiting receipt. Finally, the
quantities sold this month, this year and the previous year are also shown:
these figures are calculated from approved Invoices.

Item Paste Special Item register

Range Reporting Alpha

Use this field to limit the report to a single Item, or range
of Items.

An Item will not be included in the report if it has not
been used during the current or previous financial year.

Location Paste Special Locations setting, Stock module

Enter a Location here if you would like all figures shown
in the report to refer to that Location. If this field is
blank, the figures will relate to all Locations.

Include Structured Items

Structured Items will always be included in the report,
and their current stock levels will usually be shown to be
zero. This is because Structured Items are built at the
moment of delivery: they cannot be built in advance or
kept in stock. However, if you would like the report to
show the quantities that can be built from the current
stock of components, check this box.
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Customer/Item Statistics

The Customer/Item Statistics report found in the Sales Ledger analyses in a
Customer-by-Customer format the sales in both quantity and turnover terms
of Items to Customers. It can compare this information for two periods.

Leave all the fields blank if the report is to cover all Customers and all Items.
If it is necessary to restrict the coverage of the report, use the fields as
described below.

Customer Paste Special Customer register

Range Reporting Alpha

Use this field to limit the report to a single Customer, or
range of Customers.

Category Paste Special Customer Categories setting,
Sales Ledger

Range Reporting Alpha

To restrict the report to Customers of a single Category,
enter a Category Code here.

Classification Paste Special Customer Classifications
setting, CRM module (if
installed)

Select a Customer Classification. Sales to all Customers
with that Classification will be included in the report. If
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you enter a number of Classifications separated by
commas, only sales to Customers featuring all the
Classifications listed will be shown.

Item No. Paste Special Item register

Range Reporting Alpha

To limit the report to a single Item, enter an Item
Number here.

Item Groups Paste Special Item Group register, Sales
Ledger

Range Reporting Alpha

To limit the report to a single Item Group, enter an Item
Group Code here.

If both a range of Items and a range of Item Groups are
specified, the report will cover only those Items in the
range which are members of the specified Item Groups.

This Period Paste Special Reporting Periods setting,
System module

Enter the first and last dates of the reporting period,
separated by a colon.

Compared Period Paste Special Reporting Periods setting,
System module

Enter the first and last dates of the period with which the
reporting period is to be compared, separated by a colon.

Object from Customer

Paste Special Object register, System module

To restrict the report to Customers with a particular
Object, enter the Object’s Code here.

Country from Customer

Paste Special Countries setting, System
module

To restrict the report to Customers in a particular
Country, enter the Country Code here.
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Price List

This report, available from the Pricing and Sales Orders modules and the
Sales Ledger, prints a Price List. It is a report that perhaps might be sent to a
text file so that it can be incorporated in your publicity material. To do this,
decide upon the contents of the report using the window illustrated below in
the usual fashion. Then, choose ‘File’ from the Media options at the bottom
of the window. When you click [Run], you will be asked to name the text file
and to specify where it is to be saved.

Leave all the fields blank if the report is to cover all Price Lists. If it is
necessary to restrict the coverage of the report, use the fields as described
below.

Item Paste Special Item register

Range Reporting Alpha

To limit the report to a single Item, enter an Item
Number here.
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Item Group Paste Special Item Group register, Sales
Ledger

Range Reporting Alpha

To limit the report to a single Item Group, enter an Item
Group Code here.

If both a range of Items and a range of Item Groups is
specified, the report will cover only those Items in the
range which are members of the specified Item Groups.

Price List Paste Special Price Lists setting, Sales Ledger

Specify which Price List is to be printed here.

By default, all Items or, if you have also specified a
range of Items and/or a range of Item Groups, all Items
in the range, will be printed irrespective of whether or
not they have been included in the Price List. The Price
shown will be taken from the appropriate Price record
or, if there isn’t one, from the Base Price of the Item
record.

If you only want to print those Items which fall within
the range and which have been included in the Price
List, use the Only Items from this Price List option
(below).

Leave this field blank if you wish to print the Base Price
of each Item, as entered to the ‘Pricing’ card of the Item
screen.

Language Paste Special Languages setting, System
module

Enter a Language Code here to produce a Price List
using translated Item Names (as entered on the ‘Texts’
card of the Item screen). If there is no translation for the
selected Language, the main Description entered in the
header will be used.

Function These options control the format of the report.

External Select this option to print sales prices together
with the Item Code and Description.

Internal This option prints sales prices, cost prices, gross
profit and gross margin.
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Prices Incl. VAT Check this box to print prices including VAT in the
report. This option applies to the External Price List
only.

Prices Excl. VAT Check this box to print prices excluding VAT in the
report. By checking this box and the one above, both
inclusive and exclusive prices can be shown in the same
report. This option applies to the External Price List
only.

Only Items with Balance

Select this option if you only want Items of which you
have stock to appear in the Price List.

Only Items from this Price List

By default, the report will list all Items in the selected
range, irrespective of whether they have been included
in the Price List. The Price shown will be taken from the
appropriate Price record or, if there isn’t one, from the
Base Price of the Item record.

If you only want to show those Items which fall within
the range and which have been included in the Price
List, check this box.

Multiply with rate (Currency from Price List)

If the Price List has a Currency, but you would like to
show its Prices converted to the home Currency using
the current exchange rate, use this option.

Sorting The report can be sorted by Item Number, Item Group or
Item Name.

Discount Matrices List

This report found in the Pricing module prints a list of Customers together
with the Discount Matrix allocated to each (on the ‘Pricing’ card). The report
can take the form of a simple list or it can show full details of the discount
structure in each Matrix.
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Leave all the fields blank if the report is to cover all Customers and Discount
Matrices. If it is necessary to restrict the coverage of the report, use the fields
as described below.

Customer Paste Special Customer register

Range Reporting Alpha

Use this field to restrict the report to a particular
Customer or range of Customers. Only Customers in the
range with a Discount Matrix will be shown in the
report.

Category Paste Special Customer Categories setting,
Sales Ledger

This field can be used to report on all Customers in a
particular Category. Again, only Customers in the
Category with a Discount Matrix will be shown in the
report.

Disc Matrix Paste Special Discount Matrices setting, Sales
Ledger

Enter a Discount Matrix Code to list all Customers with
that Matrix.

Function The Overview option produces a simple list showing
Customer Code and Name, Discount Matrix Code and
Quantity Dependent Discount Code. The Detailed option
shows the full structure of each Discount Matrix.
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Varieties

Introduction

You can use the Varieties feature in Hansa if you buy and sell Items with
different sizes, colours or styles, in any combination. This feature allows you
to have a single record in the Item register for each overall Item, while
maintaining stock levels for each style. Examples might be clothes and shoes
in different sizes and colours, and furniture with different finishes.

In this section, we will illustrate the use of the Varieties using two examples:
shirts that can be sold in different sizes, colours and styles (short- and long-
sleeved); and trousers that can be sold with different waist sizes, leg lengths
and fit options.

Defining Varieties

You will use three settings to configure the Varieties feature. These are all in
the Stock module. Using the Modules menu, ensure you are in the Stock
module, and follow these steps—

1. Use the Item Variety Groups setting to define the types of Variety that
you sell. In the example, we need three Item Variety Groups for the shirt
(Colour, Size and Style) and three for the trousers (Fit, Leg Length and
Waist Size)—

2. In the Item Varieties setting, define all the possible Varieties that you
sell. For example, Small, Medium and Large will all be Item Varieties
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belonging to the “Size” Variety Group, and Short-sleeved and Long-
sleeved will be Item Varieties belonging to the “Style” Variety Group—

3. You cannot use Varieties with Items that you have already used at least
once in a sales or stock transaction. Doing so will cause your stock
records to become corrupted. So, working in the Item register, you
should now enter in the normal way the Items that you will be using with
Varieties.

Do not use Varieties with Items that
you have used before.

4. Use the Variety Masks setting to specify the Varieties that can be used
with each Item.

Steps 1, 2 and 4 are now described in detail.

!
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Item Variety Groups

Use this setting to define the types of Variety that you sell. Examples might
be Colour, Size, Style, Veneer or Finish.

Do not enter the Varieties themselves in this setting. For example, when
selling clothes, an appropriate Item Variety Group might be Size: the sizes
themselves (e.g. Small, Medium, Large, etc) should be entered in the Item
Varieties setting described below.

To define a new Item Variety Group, first move into the Stock module using
the Modules menu. Then click [Settings] in the Master Control panel or select
‘Settings’ from the File menu. Double-click ‘Item Variety Groups’ in the
resulting list and, when the ‘Item Variety Groups: Browse’ window appears,
click [New]. Once entered, click [Save] to save the record.

Code Enter a code by which the Item Variety Group can be
identified. You can use up to five alphanumeric
characters.

Code Length When you use an Item that has Varieties in a transaction
of any kind, you will use a combined Item/Variety
Number. This consists of the Item Number itself, from
the Item register, and a suffix that indicates the Variety.
This suffix is divided into sections, depending on how
many types of Variety there are.

You can separate the various constituent parts of a
combined Item/Variety Number using full stops, or you
can specify the length (number of characters) of each
part. Depending on which option you want to use for the
section of the combined Item/Variety Number that
represents this Variety Group, enter a full stop or a
number of characters here.

If you enter a number of characters, every Variety that
belongs to this Variety Group should have a Code that
consists of exactly this number of characters. In the
example Variety Group illustrated above, all Colours
will have three-character Codes.
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If you enter a full stop, the number of characters in each
Variety Code will not matter.

Please refer to the ‘Item Numbers of Items with
Varieties’ section below for more details and an
example.

Comment Specify a name for the Variety Group.

Item Varieties

Use this setting to record the different Varieties that you sell.

To define a new Item Variety, first move into the Stock module using the
Modules menu. Then click [Settings] in the Master Control panel or select
‘Settings’ from the File menu. Double-click ‘Item Varieties’ in the resulting
list and, when the ‘Item Varieties: Browse’ window appears, click [New].
Once entered, click [Save] to save the record.

Code Enter a code by which the Item Variety can be
identified.

If you specified a number of characters in the Code
Length field in the parent Variety Group, you should
enter a Code consisting of exactly that number of
characters. The example Variety shown above belongs to
the Variety Group illustrated on the previous page and
so has a three-character Code. When entering the
Variety Group in the field to the right, the required
number of characters is shown in the ‘Paste Special’ list
as a reminder.
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If you entered a full stop in the Code Length field in the
parent Variety Group, you can enter up to five characters
here (the exact number does not matter).

Group Paste Special Item Variety Groups setting,
Stock module

Specify here the Variety Group to which the Variety
belongs.

Name Specify a name for the Variety. This will be used as part
of the Item description whenever the Variety is used
(e.g. in Invoices, Orders and Goods Receipts).

The table in the lower part of the window can be used to enter various
translations of the name of the Item Variety. Specify a Language in the first
column using ‘Paste Special’ if necessary, and the appropriate translation in
the second column. When using the Variety in Orders or Invoices, the
Language of the Order or Invoice will determine which translation is used.
There is no need to enter a row for your home Language.

Variety Masks

Use the Variety Masks setting to specify which Varieties can be used with
each Item.

Once you have entered a Variety Mask for a particular Item, and have then
used the Item in at least one sales or stock transaction, you should not change
the Mask. Doing so will cause your stock records to become inaccurate. If the
Mask contains an error, or the specification of the Item changes, you should
not change or remove the Mask. Instead, you should enter a new Item and
Mask. You can change the Report Order on flip B and the Subsets on flip C.

A Variety Mask should not be
changed.!
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To edit Variety Masks, ensure you are in the Stock module, open the
‘Settings’ list and double-click ‘Variety Masks’. The following window
appears—

To edit a Variety Mask, simply click in the field to be changed and overtype
the existing entry. As mentioned above, you should only edit a Variety Mask
if you are absolutely sure you have not used it in a sales or stock transaction.
To add a new Variety Mask record, scroll down to and type in to the first
blank line. The information required for each Variety Mask record is as
follows—

Flip A

From Item, To Item

Paste Special Item register

Use these two fields to specify the range of Items that
will use the Mask.

Length When you use an Item that has Varieties in a transaction
of any kind, you will use a combined Item/Variety
Number. This consists of the Item Number itself, from
the Item register, and a suffix that indicates the Variety.
This suffix is divided into sections, depending on how
many types of Variety there are.

You can separate the various constituent parts of a
combined Item/Variety Number using full stops, or you
can specify the length (number of characters) of each
part. Depending on which option you want to use for the
section of the combined Item/Variety Number that
represents the Item Number, enter a full stop or a
number of characters here.
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If you enter a number of characters, every Item in the
range specified in the From Item and To Item fields
should have an Item Number that consists of exactly this
number of characters. In the example illustration, the
Items in the first three rows should all have five-
character Codes.

If you enter a full stop (as in the fourth row in the
illustration), the number of characters in each Item
Number will not matter.

Please refer to the ‘Item Numbers of Items with
Varieties’ section below for more details and an
example.

Mask Paste Special Item Variety Masks setting,
Stock module

Specify here the Variety Groups that should be used
with the Items in the range.

You can enter as many Variety Groups as necessary,
separated by commas. If you need to use ‘Paste Special”
to enter several Variety Groups, type the comma before
opening the ‘Paste Special’ list. This will cause Hansa to
add the next Variety Group to those already entered.
Otherwise, the previous Variety Group will be
overwritten.

In the example illustration, we have specified that the
first three Items should all be used with the Variety
Groups “COL” (Colour), “SIZ” (Size) and “STY”
(Style). This means that whenever we buy or sell these
Items, we must specify a colour, a size and a style, in
that order. So, for example, we will not be able to sell
any of these Items without knowing the size.

If you use the ‘Item Status’ window from Orders and
Invoices to view the stock levels of the Items that you
are selling, the order in which you list the Variety
Groups within the Mask is important. Referring to the
first Item in the illustration above as an example, we
would be able to use the ‘Item Status’ window to view
the stock level of Item 10126 (i.e. all Varieties) and of
Item 10126 in a particular colour (all sizes and styles).
However, as size is not the first Group in the Mask, we
could not use the ‘Item Status’ window to view the stock
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level of Item 10126 in a particular size (all colours and
styles). This is illustrated towards the end of this section.

If you need to specify a Variety Group that can be used
with an Item but want to prevent the use of a particular
Variety (e.g. a shirt is only available in black and white),
use the Subsets field on flip C.

Flip B

Report Order Paste Special Item Variety Groups setting,
Stock module

Out of the Variety Groups listed in the Mask field on flip
A, specify here which ones you would like to be
included in the Varieties in Stock report. You must make
an entry here, otherwise the report will be empty. Please
refer to the description of the Varieties in Stock report
below for details and an example.

Flip C

Subsets Paste Special Item Varieties setting, Stock
module

Considering each Variety Group in the order in which
they were entered in the Mask field on flip A, you
should list here the Varieties that can be used with the
Items in the range.

Start by listing the allowable Varieties for the first
Variety Group. Separate these Varieties with commas.
Then, enter a semi-colon (;) to mark the division
between the first and second Variety Groups. Then enter
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the allowable Varieties for the second Variety Group,
again separated by commas, and so on.

If every Variety in a particular Group can be used, enter
an asterisk (*). If every Variety in every Group can be
used, the field can be left blank.

In the example illustrated above, the first three Items
have the same Mask: “COL” (Colour), “SIZ” (Size) and
“STY” (Style). The Subset for the first Item has been left
blank, meaning it is available in all colours, sizes and
styles. The second Item has a Subset of “BLA;*;*”, so it
can only be sold in black, but in any size and style. The
Subset of the third Item is “BLA,WHI;SM,LA;*”. This
Item is available in black and white, small and large, and
in any style.

Item Numbers of Items with Varieties

When you use an Item that has Varieties in a transaction of any kind, you
should use a combined Item/Variety Number. This consists of the Item
Number itself, from the Item register, and a suffix that indicates the Variety.
This suffix is divided into sections, depending on how many types of Variety
there are.

You can separate the various constituent parts of a combined Item/Variety
Number using full stops, or you can specify the length (number of characters)
of each part. The full stop method can be easier to manage if you will be
typing combined Item/Variety Numbers in to your transactions, as you will
not need to remember how many characters are required in each part of the
Number. This method also produces Item/Variety Numbers that are easier to
read. However, the length method might be preferable if you are using certain
types of bar code reader.

If you want to use full stops, you should enter a full stop in the Length field
in the Variety Masks setting and in the Code Length field in each Item
Variety Group record.

If you want to specify the number of characters of each part of the combined
Item/Variety Number, you should enter the length of the first part (the Item
Number) in the Length field in the Variety Masks setting, and the number of
characters of each section of the suffix in the Code Length field in each Item
Variety Group record.

The example combined Item/Variety Numbers illustrated in the diagram
below use the Varieties, Variety Groups and Variety Masks illustrated in the
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preceding sections. Item 10126 is one where we have specified the length
(number of characters) of each part. The Item Number is five characters, the
first Variety is three characters, and the second and third Varieties are two
characters each. Item 10129 is one where the various constituent parts of the
combined Item/Variety Number are separated using full stops: the numbers
of characters in the Item Number and the Varieties do not matter—

10126GRESMLS

Variety = Small. Length is
two characters, from Item

Variety Group for Size

Variety = Green. Length is
three characters, from Item
Variety Group for Colour

Variety = Long-sleeved.
Length is two characters, from

Item Variety Group for Style

Item Varieties

10129.34W.REG.32L

Item Number from Item
Register. Separator is full
stop, from Variety Mask

Variety = Regular. Separator
is full stop, from Item Variety

Group for Fit

Variety = 34” Waist. Separator
is full stop, from Item Variety

Group for Waist Size

Variety = 32” Length.
Separator  from final Item
Variety Group is not used

Item Number from Item
Register. Length is five

characters, from Variety Mask

The following points are important—

• The order of the Variety Groups (Colour, Size, Style in the case of Item
10126; Waist Size, Fit, Leg Length in the case of Item 10129) is the
same as was listed on flip A of the Variety Masks setting.

• If you are specifying the length (number of characters) of each part, as in
Item 10126, the number of characters in the first part (the Item Number)
must be the same as recorded in the Variety Masks setting. This must
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therefore be the number of characters in the Item Number in the Item
register. Similarly, the number of characters in each section of the
second part must be the same as recorded in the Item Variety Groups
setting. If there is any variation, Hansa will not be able to interpret the
combined Item/Variety Number correctly.

• If you are separating each section with a full stop, the number of
characters does not matter.

• It is recommended that you do not mix the two separation methods. In
the example above, the Variety Group for Colour cannot be used with
the full stop separator, and so cannot be used with Item 10129.

• Bear in mind when entering your Varieties that the maximum number of
characters that can be used in a combined Item/Variety Number is 20.
This includes full stops if you are using that separation method.
Depending on the length of your Item Numbers, this imposes a practical
limit of three or four Variety Groups for each Item.

Using Items with Varieties in Transactions

When you use an Item with Varieties in a transaction, you should usually
enter the combined Item/Variety Number, as follows—

• You should always enter the combined Item/Variety Number in any
stock transaction (e.g. Delivery or Goods Receipt) and in an Invoice. If
you only enter an Item Number, you will not be able to save the record.

• There is no requirement to enter the combined Item/Variety Number in a
Quotation. When a Quotation is issued, the Customer might not know
precisely which Varieties they want. However, this information can be
entered in a Quotation if it is known.

• There is no requirement at first to enter the combined Item/Variety
Number in an Order. However, you must enter the combined
Item/Variety Number before you can create a Delivery.

• There is no requirement to enter the combined Item/Variety Number in a
Purchase Order. When you create a Goods Receipt from a Purchase
Order, you will not be able to approve the Goods Receipt until you enter
the combined Item/Variety Number.
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Using ‘Paste Special’ with Items with Varieties

When you need to use an Item with Varieties in a transaction, the ‘Paste
Special’ feature gains a second stage to help you choose the correct Variety.
In this example, we choose an Item and Variety in an Invoice—

1. With the cursor in the Item Number field, use Ctrl-Enter or z-Enter to
open the familiar Item ‘Paste Special’ list.

Find the correct Item, and double-click. The Item Number is copied in to
the Invoice.
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2. Leave the cursor in the Item Number field and activate the ‘Paste
Special’ feature for a second time. This time, instead of the usual ‘Paste
Special’ list, the ‘Assisted Variety Entry’ window opens.

In this example, Item 10126 requires Varieties belonging to three
different Variety Groups. As a result, the ‘Assisted Variety Entry’
window has three fields, one for each required Variety Group.
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3. Using ‘Paste Special’ in the usual way from each of these three fields in
turn, enter a Variety belonging to each Group in the appropriate field.
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4. Close the ‘Assisted Variety Entry’ window by pressing the Shift-Enter
key combination. The combined Item/Variety Number will be pasted
into the Invoice. When you press the Tab or Return key to move the
cursor in to the Quantity field, the names of each Variety will be added
to the Item Name in the Description field—

If you forget to activate the ‘Paste Special’ feature for the second time to
choose a Variety (step 2 above) and instead press the Tab or Return key
to move the cursor in to the Quantity field, Hansa will beep, and the
Description field will be left blank. This provides a reminder that you
have not chosen a Variety. The same thing will happen if you choose a
Variety that has not been allowed (in the Subsets field on flip C of the
Variety Masks setting). An example might be when a shirt is only
available in black and white and you choose “blue” in the ‘Assisted
Variety Entry’ window.

In Quotations and Orders, where it is not necessary to enter the
combined Item/Variety Number, you do not need to activate the ‘Paste
Special’ feature for the second time. Hansa will not beep, and the Item
Name will be copied to the Description field.
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Varieties and Reports

Hansa contains various reports to help you work with Varieties. Please refer
to the ‘Reports’ section earlier in this chapter for an introduction to producing
reports in Hansa.

Varieties Enquiry

Use this report (which can be found in the Stock module) to display the stock
level of a particular Variety, or the Varieties of a particular Item that you
have in stock.

To produce this report, ensure you are in the Stock module using the Modules
menu and click the [Reports] button in the Master Control panel. When the
‘Reports’ list opens, double-click ‘Varieties Enquiry’. The ‘Specify Varieties
Enquiry’ window appears—

Item No. Paste Special Item register

Range Reporting Alpha

Enter an Item Number (or range of numbers) to produce
a report for specific Item(s). Use a colon (:) to separate
the first and last number.

Group Paste Special Item Group register, Sales
Ledger

Range Reporting Alpha

Enter an Item Group Code to produce a report listing the
Items in a particular Item Group.
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Location Paste Special Locations setting Stock module

To produce a report for one stock Location, enter its
Location Code here.

If this field is left empty, the report will contain separate
stock figures for each Variety in each Location.

Varieties, Or, And Paste Special Item Varieties setting, Stock
module

If you need to know the stock level of a particular
Variety, specify that Variety here.

You can enter a number of Varieties separated by
commas. If you also use the And option on the right,
only those Items featuring all the Varieties listed will be
shown in the report. If you use the Or option on the
right, any Item featuring at least one of the Varieties
listed will be shown in the report.

For example, if you need to know the stock level of
small black shirts, enter the Item Number for the shirt in
the Item No. field above and the Varieties for small and
black in this field, and use the And option on the right. If
you need to know many shirts you have that are either
small or black, use the Or option on the right.

If this field is left empty, the report will contain separate
stock figures for each Variety of the specified Item(s).

Per Location The report is normally sorted by combined Item/Variety
Number and then by Location. So, if you have more than
one Location, stock figures for a particular Variety of an
Item in the various Locations will be shown together.
Use this option if you would like the report to be sorted
by Location and then by combined Item/Variety
Number.

Varieties in Stock

This report (to be found in the Stock module) provides similar information to
the Varieties Enquiry report described above. However, where that report is a
simple list of Varieties, this one displays the information in a table format.

Before producing this report, you must specify a Report Order for the
relevant Item(s) on flip B of the Variety Masks setting. If you have not done
this, the report will be empty.
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In this example, the Report Order for Item 10129 is “WS,FT,LL” (waist size,
fit, leg length)—

The Varieties in Stock report for this Item looks like this—

The row titles (“30 inch waist”, etc) are Varieties belonging to the “WS”
Variety Group (waist size), the first Variety Group in the Report Order field.
The column headings (“Comfort Fit”, etc) are Varieties belonging to the
second Variety Group in the Report Order field. The group headings (“30
inch inside leg”, etc) belong to the third Variety Group in the Report Order
field. The figures show the quantity in stock of each Variety (e.g. there are 78
Comfort Fit trousers with a 30” waist and 30” inside leg in stock).
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Changing the Report Order from “WS,FT,LL” to “FT,WS,LL” produces this
report—

This change causes the column headings and row titles to be swapped over.
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In this final example, there are four Variety Groups in the Report Order field:
“WS,FT,LL,FLY” (waist size, fit, leg length, fly type)—

The second set of group headings (“Zip” and “Button”) are Varieties
belonging to the “FLY” Variety Group, the fourth Variety Group in the
Report Order field. The figures show the quantity in stock of each Variety
(e.g. from the first set of group headings, there are 156 Comfort Fit trousers
with a 30” waist and 30” inside leg in stock, including trousers with both
types of fly; and from the second set of group headings, there are 128
Comfort Fit trousers with a 30” waist and button fly in stock, with all inside
leg measurements).

Unlike the Mask field on flip A of the Variety Masks setting, you can change
the Report Order field at any time, so you can produce different reports. One
option is that if, for example, there are four Variety Groups in the Mask field,
you do not need to quote all four in the Report Order field.
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To produce this report, ensure you are in the Stock module using the Modules
menu and click the [Reports] button in the Master Control panel. When the
‘Reports’ list opens, double-click ‘Varieties in Stock’. The ‘Specify Varieties
in Stock report’ window appears—

Item No. Paste Special Item register

Range Reporting Alpha

Enter an Item Number (or range of numbers) to produce
a report for specific Item(s). Use a colon (:) to separate
the first and last number.

Location Paste Special Locations setting Stock module

To produce a report for one stock Location, enter its
Location Code here.

Include all Possible Varieties

Usually the report will only show the Varieties that you
have in stock. Check this box if you would like every
Variety to be shown.
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Stock List

When an Item with Varieties is included in the Stock List report, it will
immediately be recognisable because its Item Number will be underlined.
This signifies that it has Hansa’s drill-down feature, allowing you to display
extra information. This is an example Stock List report (Overview option)
showing an Item with Varieties—

Clicking on the Item Number opens the Varieties in Stock report for the Item
in question—
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This report will be empty if you have not specified a Report Order for the
relevant Item on flip B of the Variety Masks setting.

The Varieties in Stock report also has a drill-down feature. Clicking once
again on the Item Number opens the Varieties Enquiry report for the Item—
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If the original Stock List report was produced using the Detailed option,
drilling down produces a more detailed Varieties Enquiry report showing the
inward stock transactions for each Variety—

Similar drill-down features providing information at the Variety level can be
found in other reports (e.g. Item Statistics).

The Stock List is described in full in Volume 3 of these manuals.

Varieties and the ‘Item Status’ Window

The ‘Item Status’ window provides instant feedback for each Item
concerning the quantity in stock, the quantity on order, how many can be
shipped and the current gross profit. This window can be opened from the
‘Items: Browse’ and ‘Items: Inspect’ windows, and from Sales Orders,
Purchase Orders, Invoices, Deliveries, Stock Depreciation records and Stock
Movements by choosing ‘Item Status’ from the Operations menu.

When you open the ‘Item Status’ window from the ‘Item: Inspect’ window, it
displays information about the current Item. When you open it from the
‘Items: Browse’ window, it displays information about the Item highlighted
in the list. This information will change as you click on different Items in the
list. In both cases, the figures shown in the ‘Item Status’ window will refer to
the Item as a whole (i.e. all Varieties).



Chapter 6: Items and Pricing -Varieties - Varieties and the ‘Item Status’ Window

411

When you open the ‘Item Status’ window from other windows, for example,
from an Invoice or Order, it displays information about the Item in the row
containing the cursor. In this case, it responds to Item Numbers, combined
Item/Variety Numbers and to partially entered Item/Variety Numbers. For
example, entering an Item Number in an Invoice, and then selecting ‘Item
Status’ from the Operations menu produces the following result—

This shows that there are 1260 pairs of trousers in stock, of all Varieties.
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If we enter the Item Number and the first Variety, the result is as follows—

This shows that we have in stock 465 pairs of trousers with a 32” waist. This
includes trousers of all fits and with any inside leg measurement.

In a similar manner, the ‘Item Status’ window will respond to the Item
Number and the first two Varieties, and to the complete Item/Variety
Number. However, it will not respond to the Item Number and the second
Variety only (fit in the example), so we could not use this method to establish
how many Regular fit trousers with any waist and inside leg measurement we
have. So, you should consider this feature when deciding the order that you
list your Variety Groups in your Variety Masks.

There is a [Var] button on the far right of the ‘Item Status’ window. Clicking
this button produces a Varieties in Stock report for the Item in question.
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Chapter 7: The System Module
This module contains settings and registers used collectively by the other
modules, including the Chart of Accounts and Objects. It is also where the
administration of users, including the allocation of access rights to the other
modules, is carried out.

Settings
The following settings are available in the System module—
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To edit a setting, ensure you are in the System module using the Modules
menu and click the [Settings] button in the Master Control panel or select
‘Settings’ from the File menu. The list shown above appears. Then, double-
click the relevant item in the list.

Access Groups

Access Groups are a part of Hansa’s security system. You can define a
number of Access Groups, each of which can be allowed access to one or
more parts of the program. Each member of personnel, when entered to the
Person register (described later in this chapter), can then be allocated to the
relevant Access Group.

Double-click on ‘Access Groups’ in the ‘Settings’ list to open the ‘Access
Groups: Browse’ window. A list of the defined Groups is shown—

To create a new Access Group, click [New] in the Button Bar. To edit an
existing record, double-click one of the items in the list.
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In either case, the following window appears—

Members of the Access Group “ORDER” in the above illustration will have
access to two modules - Sales Orders and Stock. The Sales Orders module is
featured in the first row of the grid, so this will be the active module when
they first log in to Hansa. They will be allowed access to all functions within
those modules, except the Number Series - Goods Receipts setting. In this
manner, you can determine in great detail to which parts of Hansa the
members of each Access Group have access.

As you create Access Groups, give each a unique identifier in the Code field,
and enter a description in the Text field.

The grid is used to determine the areas of Hansa to which members of the
Access Group will be given access, and the level of that access. You can
allow or disallow access to any module or any component of a module (such
as a particular register or setting).
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First, specify the component in the Type field, using the ‘Paste Special’
function to show a full list of the components available—

Next, use the second field in the grid to specify the individual item. For
example, if you enter “Modules” in the Type field, the ‘Paste Special’ list
from the Item field will contain a list of modules—

The list will show all Hansa’s modules, including those that you may not
have installed. Make sure you only select modules that are included in your
particular installation of Hansa.

As illustrated overleaf, if you enter “Action” in the Type field, the ‘Paste
Special’ list from the Item field will contain a list of functions to which you
can restrict access if necessary. These include the checking of the OK box in
transactions of all kinds, the Operations menu functions and some
miscellaneous features such as deleting records.
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If you enter “Reports” in the Type field, ‘Paste Special’ from the Item field
will list all reports, and so on.

Finally, use the last column to determine the access level of the Group. A
further ‘Paste Special’ list displays the available options—

‘Read’, ‘Read/New’, ‘Browse’ and ‘Browse/New’ should only be applied to
registers or settings, as follows—

Browse Allows access to the browse and ‘Paste Special’
windows only. Searches can be performed. Records
cannot be entered or modified.

Browse/New Allows access to the browse and ‘Paste Special’
windows and the creation of new records. Existing
records cannot be viewed, changed or copied.

Read Allows access to the browse window and the double-
clicking of items so that they can be viewed in an inspect
window. Records cannot be entered or modified.
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This attribute can also be applied to reports, allowing
them to be printed to screen but not to a printer or to a
text file.

Read/New Allows access to the browse window and the double-
clicking of items so that they can be viewed in an inspect
window. New records can be created. Existing records
cannot be modified, but they can be copied.

If you want to allow ‘Paste Special’ access to a register or setting to which
access is otherwise denied, you should grant Browse or Read access to that
register or setting. For example, if a user only has access to the Sales Ledger,
you should grant them Browse or Read access to the Account register if you
want them to be able to choose Sales Accounts in Invoices.

You can allocate access to the various parts of Hansa using one of two
methods, by specifying one of the two Start From alternatives. These can be
described as follows—

No Access This option excludes members of the Access Group from
all modules except those listed in the grid. You should
use the first row(s) of the grid to specify the module(s)
that members of the Access Group are to be allowed to
use, selecting ‘Full’ in the third ‘Paste Special’ list. This
will give full access to those modules (including to all
registers, settings and reports). You can then exclude
users from particular parts of those modules if necessary.
No access will be given to modules that you have not
listed.

Full Access If this option is used, members of the Access Group will
be allowed full access everywhere except those areas
listed in the grid.

Note that it is only possible to restrict access to Persons that belong to an
Access Group. Persons that do not belond to an Access Group will have full
access to your Hansa system.
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Logging In

By default, the Nominal Ledger is the first module that you will see when
you log in to Hansa. If you want another module to be active on log-in but
otherwise do not want to restrict access in any way, this can be achieved
using Access Groups. Enter an Access Group that Starts from Full Access
and with a single module listed in the grid: the module that is to be active on
log in. Assign this Access Group to the Persons as appropriate.

Members of the Access Group illustrated above will see the Stock module
when they enter Hansa.
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System Administrator

In multi-user systems, it is recommended that at least one member of staff
acts as a system administrator, able to use the Technics module on a client
machine when other users are logged in. To implement this, the Person
record for that administrator should belong to an Access Group that Starts
from Full Access and explicitly grants full access to the Technics module—
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Block Accounts

The Block A/Cs field can be used to prevent details of particular Accounts
being shown in the Nominal Ledger report when it is produced by members
of the Access Group.

You can enter a range of Accounts, a number of individual Accounts
separated by commas, or a number of ranges of Accounts, again separated by
commas. If you need to use ‘Paste Special” to enter several Accounts, type
the comma or colon before opening the ‘Paste Special’ list. This will cause
Hansa to add the next Account to those already entered. Otherwise, the
previous Account will be overwritten.

In the example above, when members of the Access Group “ACC” produce a
Nominal Ledger report, Accounts 300 and 890 and all Accounts between 950
and 999 will be omitted. These Accounts will appear in other reports such as
the Profit & Loss report and Balance Sheet, but drilling down from these
reports to the Nominal Ledger report for these Accounts will not be possible.
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Active Users

This setting lists the current users in a network (multi-user) installation of
Hansa.

Auto Actions

This setting determines the rules for automatic document printing.

The documents involved are the Order Confirmation/Acknowledgement, the
Internal Order, the Delivery Note, the Freight Label and the Invoice. The
default setting is that no documents are printed automatically.

You can choose to have Order Confirmations and Internal Orders printed
every time a new Order is saved for the first time, or after every alteration of
an Order. For Invoices, Freight Labels and Delivery Notes, the document can
be printed each time an Invoice or Delivery Note is approved and saved. In
the case of Freight Labels, if you choose the One per Item Row or One per
Item option, you can prevent their being printed for certain Items. To do this,
place these Items in an Item Group whose Do Not Print Freight Labels for
this Group option is switched on. Invoices can also be printed automatically
when they are created using the ‘Invoice’ function on the Operations menu of
the Contract screen. At the time that these are printed, the Invoices are
unapproved, so they are marked with the text “Test Printout”. Finally, Cash
Invoices can also be printed automatically from the Point of Sales module
when they are approved and saved.
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Base Currency

Please refer to the ‘Multi-Currency’ chapter in Volume 2b of these manuals
for full details of this setting.

Base Currency Rates

Please refer to the ‘Multi-Currency’ chapter in Volume 2b of these manuals
for full details of this setting.

Company Info

This setting is used to enter your company’s name and address, and other
particulars such as phone and fax numbers, and the bank and bank account
number. This will be printed as appropriate on all documents.

To open the Company Info setting, double-click on ‘Company Info’ in the
‘Settings’ list. The ‘Company Info: Inspect’ window is opened. When the
window is complete, confirm the entry by clicking [Save], or cancel it by
closing the window using the close box.
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Apart from the Company Name, Address etc, this window should be
completed as follows—

Reg Card

Bank 1, Bank 2 Your company’s main bank account number(s) should
be entered here. This information can then be printed on
any appropriate documentation.

Bank Customer ID

This is an ID number used for automatic (modem)
communication with certain credit institutions in some
countries. Please contact your local Hansa representative
for details.

Country Paste Special Countries setting, System
module

Hansa contains a feature whereby any VAT Numbers
entered for Customers and Suppliers are checked to
make sure they comply with the official format for their
Countries. For Customers and Suppliers whose Country
is unspecified, this validation check will use the Country
entered here. Please refer to the section below describing
the VAT Number Masks setting for full details of this
feature.

Commercial Reg. No.

The Intrastat system is used to collect statistics on the
physical trade in goods (i.e. the actual movement of
goods) between the various member countries of the
European Union (EU). If your business is situated in an
EU country and its trade with companies in other EU
countries is greater than the threshold value, it will be
necessary to send an Intrastat report periodically to the
relevant authorities. You can do this by printing a
document or exporting a text file. In both cases, the
report should include your company name and address
(from the ‘Address’ card above), your VAT Number
(above) and a company or branch identifier (entered in
this field). You should have a separate identifier for each
branch if you will be submitting Intrastat returns from
different branches using the same VAT Number.

ANA Code Record the unique number assigned by the Article
Numbering Association to your company here. This is
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required if you will be using the EDI (Electronic Data
Interchange) module. Please refer to your local
representative for details.

Fonts Card

Character Set This field is used to control sorting in Hansa. In the UK,
it should be set to zero. In countries where the alphabet
differs to that of the UK/US, sorting by ASCII codes
produces a list that is not in the correct alphabetical
order: this field is used to overcome this problem.

VAT Law This field is used to ensure the behaviour of Hansa
conforms to certain local conventions of the country in
which it is being used. The following values can be
used—

Byelorussia 46
Denmark 7
Estonia 27
Finland 13
France 1
Germany 2
Hungary 26
Iceland 15
Ireland (Republic of) 35
Italy 3
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Latvia 28
Lithuania 24
Netherlands 4
Norway 9
Poland 25
Portugal 8
Russia 32
Spain 6
Sweden 5
Ukraine 45
United Kingdom 0 (zero)

DB Encoding If you are using Hansa to send and receive email, this
field should be set to “mac” (all lower case) if the server
uses a PowerPC processor (e.g. AS/400, AIX,
Macintosh, Z-series). If the server is Intel-based, the
field should be left blank. In Russia, enter “acyr” for
PowerPC servers and “cp1251” for Intel servers.

Def. Mail Encoding

All emails are encoded to protect special characters in
the text. This allows the recipient to read these
characters as they were written. If you are using Hansa
to send and receive email, the ISO-8859-1 (Western
European) encoding standard will be used if you leave
this field empty. If you need to use a different encoding
standard, specify that here. For example, users in Russia
should enter “koi8-r” to this field. Please refer to your
local Hansa representative for further information.

Edit Font, Report Font, Report Font Size

These allow you to select different fonts for use on
screen and in reports respectively. If nothing is entered
in these fields, Hansa’s default fonts will be used. These
fonts are selected for maximum readability, and should
only be changed if you have good reasons to do so. In
non-English versions of Hansa, these fields are used to
select fonts with special character sets.

Language Paste Special Languages setting, System
module

When printing amounts in words (rather than figures) in
documents, these can be printed in different Languages
using rules defined in the Values in Text setting. In most
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cases, the Language used will be determined by the
Language of the Customer or Supplier in question. For
Customers and Suppliers whose Language is
unspecified, the Language entered here will be used.
Please refer to the section below describing the Values
in Text setting for full details of this feature.

Conversions - Master, Conversions - Accounts

These settings allow you to move all postings to one or more Accounts to
another Account. Assume that you have been using Account 100 for sales of
a particular product, and that for some reason you want to use Account 102
instead. These settings allow you to change Account 100 wherever it appears
in the Transaction register to Account 102 and to recalculate all previous
entries to the old Account, so that they will appear under the new Account in
all reports. To do this recoding you must follow the steps below—

1. Make a back-up of your entire database and quit Hansa.

2. Remove the Hansa database file (named “Hansa.HDB”) from the folder
or directory containing your Hansa application. Ensure, however, that the
“DBDef.txt” and “Default.txt” files are present.

3. Launch Hansa again. Because there is now no “Hansa.HDB” file, a new
database is created. Enter new Company information to the dialogue (a
Code and Name is sufficient): click [Save] and double-click the new
Company in the subsequent list.

4. When the ‘Import files available’ window appears, close it by clicking
the close box. Do not import anything yet.

5. Select ‘System Module’ from the Modules menu, and ‘Settings’ from the
File menu. Double-click ‘Conversions - Accounts’. Enter the old and
new Account numbers one by one in the window as shown in the
illustration. Finish by saving the setting by clicking [Save].
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6. From the ‘Settings’ list, select ‘Conversions - Master’ and enter a check
mark in the Convert Accounts  check box. Save the setting by clicking
[Save].

  

7. Select ‘Imports’ from the File menu and import the back-up using the
‘Automatic’ or ‘Automatic, manual file search’ import routines. Quit
Hansa and restart if so prompted.

8. The routine will renumber the Account records in the Account register as
required. In the example, Account 100 will be given the new number of
102. If Account 102 already existed, the old Account (100) would be
deleted. Check the Account register to make sure that this has happened.

9. Produce a Nominal Ledger report for one of the new Accounts and check
that all the Transactions have been converted as you expected.

10. You must now inspect and change all report definitions in the Nominal
Ledger where the old Account number has been used.
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11. Return to the Conversions - Master setting in the System module and
turn off the option to Convert Accounts.

12. Return to the Conversions - Accounts setting and delete everything line
by line.

During the import of the back-up, all references to the old Account numbers
will be replaced in all transactions (including Sales and Purchase Ledger
transactions and Sales Order records) and in all settings (including Account
Usage S/L and Payment Modes).

Note that if you have more than one Company in your database, the
conversion will apply to all Companies in that database. If you want the
conversion to take place in one Company only, follow the procedure
described above with the following differences—

i. Before step 1, and working in the Company where the conversion is to
take place, enter the old and new Account numbers one by one in the
Conversions - Accounts setting. Check that the setting is empty in all
other Companies, or, if you want a different conversion to take place in
another Company, enter old and new Account numbers in that Company
as necessary.

ii. Omit step 5.

So, if the Conversions - Accounts setting in all Companies is empty when the
original database is exported in step 1, any conversion on import will be
determined by what you enter to the setting in step 5. If the Conversions -
Accounts setting in a particular Company is not empty when the original
database is exported, its contents in that Company only will override what
you enter to the setting in step 5. Therefore, it's important to empty the
Conversions - Accounts setting after conversion in all Companies in step 12:
this is not done automatically. If you do not do this, the conversion may have
unexpected results the next time you carry it out.

The next five options in the Conversions - Master setting are described in the
following sections, while the last two options are described in the ‘Multi-
Currency’ chapter in Volume 2b of these manuals.

Conversions - Master, Conversions - Activity Types

These settings allow you to change the Activity Type in all Activities. For
example, assume that you have been using Activity Type “S”, and that for
some reason you want to use Activity Type “ST” instead. These settings
allow you to change Activity Type “S” in every past Activity in which it has
been used to Activity Type “ST”. The Activities will appear under the new
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Activity Type in all reports. To do this recoding you must follow the steps
below—

1. Make a back-up of your entire database and quit Hansa.

2. Remove the Hansa database file (named “Hansa.HDB”) from the folder
or directory containing your Hansa application. Ensure, however, that the
“DBDef.txt” and “Default.txt” files are present.

3. Launch Hansa again. Because there is now no “Hansa.HDB” file, a new
database is created. Enter new Company information to the dialogue (a
Code and Name is sufficient): click [Save] and double-click the new
Company in the subsequent list.

4. When the ‘Import files available’ window appears, close it by clicking
the close box. Do not import anything yet.

5. Select ‘System Module’ from the Modules menu, and ‘Settings’ from the
File menu. Double-click ‘Conversions - Activity Types’. Enter the old
and new Activity Types numbers one by one in the window as shown in
the illustration. Finish by saving the setting by clicking [Save].

6. From the ‘Settings’ list, select ‘Conversions - Master’ and enter a check
mark in the Convert Activity Types check box. Save the setting by
clicking [Save].
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7. Select ‘Imports’ from the File menu and import the back-up using the
‘Automatic’ or ‘Automatic, manual file search’ import routines. Quit
Hansa and restart if so prompted.

8. The routine will apply the new Activity Type to all Activities with the
old Type. In the example, Activities which were of Type “S” will be
given the new Type of “ST”. Any use of the old Activity Type elsewhere
(e.g. in the Target Time setting) will also be changed.

If the Activity Type “ST” existed as a record in the Activity Types
setting in the old database, the old Activity Type (“S”) will be deleted. If
the Activity Type “ST” did not exist in the old database, the old Activity
Type will have its Code changed from “S” to “ST”.

9. Return to the Conversions - Master setting in the System module and
turn off the option to Convert Accounts.

10. Return to the Conversions - Activity Types setting and delete everything
line by line.

Note that if you have more than one Company in your database, the
conversion will apply to all Companies in that database. If you want the
conversion to take place in one Company only, follow the procedure
described above with the following differences—

i. Before step 1, and working in the Company where the conversion is to
take place, enter the old and new Activity Types one by one in the
Conversions - Activity Types setting. Check that the setting is empty in
all other Companies, or, if you want a different conversion to take place
in another Company, enter old and new Activity Types in that Company
as necessary.

ii. Omit step 5.
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So, if the Conversions - Activity Types setting in all Companies is empty
when the original database is exported in step 1, any conversion on import
will be determined by what you enter to the setting in step 5. If the
Conversions - Activity Types setting in a particular Company is not empty
when the original database is exported, its contents in that Company only will
override what you enter to the setting in step 5. Therefore, it's important to
empty the Conversions - Activity Types setting after conversion in all
Companies in step 10: this is not done automatically. If you do not do this,
the conversion may have unexpected results the next time you carry it out.

Conversions - Master, Conversions - Currency Codes

The Conversions - Master and Conversions - Currency Codes settings can be
used to change the Currency Code of a Currency record. All transactions such
as Quotations, Orders, Invoices and Transactions will be changed as well.

To do this, follow the numbered steps described in the ‘Conversions - Master,
Conversions - Activity Types’ section above, using the Conversions -
Currency Codes setting in place of the Conversions - Activity Types setting,
and checking the Convert Currency Codes box in step 6.

Conversions - Master, Conversions - Customers

The Conversions - Master and Conversions - Customers settings can be used
in much the same manner as described in the ‘Conversions - Master,
Conversions - Activity Types’ section above to change the Customer Number
of a Customer record. For example, Customer Number “001” can be changed
to “002”, and all transactions such as Quotations, Orders, Invoices and
Activities will be changed as well.

To do this, follow the numbered steps described in the previous section, using
the Conversions - Customers setting in place of the Conversions - Activity
Types setting and with the following differences—

i In step 5, the Conversions - Customers setting can be used to carry out a
simple change of Customer Number as already described. It can also be
used to add a prefix or suffix to existing Customer Numbers, as
follows—

Old New Result

+ A “A” will be placed in front of all Customer Numbers
- A “A” will be placed at the end of all Customer Numbers

The prefix or suffix will be added to all Customer Numbers in the
database.
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ii In step 6, check the Convert Customers box instead of the Convert
Activities box.

iii. The routine will convert all occurrences of the old Customer Number to
the new one (in the Customer register and in the transaction registers).

If the new Customer Number (002 in the example) existed as a record in
the Customer register in the old database, the record with the old
Customer Number (001) will be deleted. In this circumstance, the
Customer Number in transaction registers such as Orders and Invoices
will be changed from 001 to 002, but the Customer Name in those
records will not be changed to that of the new Customer. If the new
Customer did not exist in the old database, the old Customer will have its
Number changed from the old one (001) to the new one (002).

Conversions - Master, Conversions - Customer Classifications

The Conversions - Master and Conversions - Customer Classifications
settings can be used to change the Customer Classification in Customers,
Contact Persons and Customer Letters. The Customer Classifications setting
will be updated as well.

To do this, follow the numbered steps described in the ‘Conversions - Master,
Conversions - Activity Types’ section above, using the Conversions -
Customer Classifications setting in place of the Conversions - Activity Types
setting, and checking the Convert Customer Classifications box in step 6.

Conversions - Master, Conversions - Items

The Conversions - Master and Conversions - Items settings can be used to
change the Item Number of a Item record. For example, Item Number
“10101” can be changed to “10102”, and all transactions such as Quotations,
Orders, Invoices, Deliveries and Goods Receipts will be changed as well.

To do this, follow the numbered steps described in the ‘Conversions - Master,
Conversions - Activity Types’ section above, using the Conversions - Items
setting in place of the Conversions - Activity Types setting, and checking the
Convert Items box in step 6.
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Countries

This setting is used to define the correct spelling of the name of each country,
in different Languages. This country name can be used to produce correct
business documents in several different Languages.

Double-click on ‘Countries’ in the ‘Settings’ list to view a list of Countries
already entered. Then double-click on one of the rows, e.g. FIN to bring up
the record for Finland.

Use ‘Paste Special’ to enter the Language Code in each row, together with
the appropriate translation.

The Duty Code is used by the Customs module: please refer to your local
Hansa representative for details.

Currency Round Off

Please refer to the ‘Multi-Currency’ chapter in Volume 2b of these manuals
for full details of this setting.
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Date and Numeric Format

Use this setting to ensure your Hansa installation uses your preferred date and
number formats.

Internally, Hansa features full Year 2000 compatibility: all dates are stored
with four-digit years (e.g. “2000”). If the Century check box is switched on,
Hansa will display the century digits in all dates. However, you do not have
to type the extra two century digits, they will be added automatically by
Hansa. If you enter “100400” in a date field, Hansa will change it to “10-04-
2000”.

In the current version of Hansa, the Century check box must be checked for
the long dates to appear in back-up and in Hansa’s different Export files. If
the box is not checked, all dates in the exported files will be written as short
dates, without the century digits. This will create a problem if you later
import a back-up or an export file containing dates from both centuries.

Our recommendation is always to check the Century box. This will make
certain that your Hansa program will behave correctly, both internally and
when you communicate with other applications.

Whenever a change is made to this setting, its effect will be immediate and
universal, with one exception. A change to any of the separators will not
affect the Autotransactions setting in the Nominal Ledger. All records in this
setting will have to be changed manually.

In multi-user systems, the Date and Numeric Format setting is unusual in that
any changes made to it from a client machine will not be saved in the
database on the server. Therefore these changes will not affect the other
clients. If you want to change the Date and Numeric Format setting on the
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server, you must either work on the server itself or log on from a client in
“Admin Client” mode. Details about “Admin Client” mode can be found in
the section describing the Company register later in this chapter.

Although it is possible to have date and numeric formats on a client that are
different to those on the server, this is not usually recommended. If the date
formats differ, dates may not be displayed in a consistent manner. If the
separators differ, Autotransactions whose formulae contain decimals may
produce unexpected results.

Dates and Export Files

Be careful when opening a Hansa Export file with Microsoft Excel with the
intention of editing it before importing it to a new database. Under certain
circumstances, Excel will, when opening a text file, convert some variables
that it interprets as dates into its own internal date format. Where you are
expecting a date to appear in the spreadsheet you may see a number such as
“35475”. When the spreadsheet is saved again as a text file these variables
will not be converted back to date format. So, if you import this text file to
Hansa, the dates will all be wrong. To avoid this problem, make sure you use
the third step of Excel’s Import Wizard to set all imported columns to ‘text’
format (highlight all the columns in the Data Preview area using the Shift key
and select ‘Text’ as the Column Data Format).

Files created using the ‘Database Text Backup’, ‘Company Text Backup’ and
‘Client Text Backup’ functions cannot be opened in Excel as they are not text
files.
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Display Groups

This setting allows you to divide the employees of your company into groups.
These groups might represent different types of work or the various
departments in your company. Dividing employees into Display Groups will
help with resource planning and with classifying Activities in the CRM
module. Many reports in the CRM module can list the Activities recorded,
scheduled or carried out by the Persons belonging to a particular Display
Group. The Employee Time Statistics report can compare the work carried
out by the various Display Groups.

Double-clicking ‘Display Groups’ in the ‘Settings’ list in the System module
opens the ‘Display Groups: Inspect’ window listing the Display Groups that
have already been entered. To add a new record, simply enter its details on
the first blank line and click [Save] to save and close. Click the close box to
close without saving changes.

Code Specify a unique identification Code for each Display
Group. You can use up to five alphanumeric characters.

Def Paste Special Person register, System module

Enter the initials of each Person that belongs to the
Display Group, separated by commas.

If you need to use ‘Paste Special” to enter several sets of
initials, type the comma before opening the ‘Paste
Special’ list. This will cause Hansa to add the next set of
initials to those already entered. Otherwise, the previous
initials will be overwritten.

A particular Person can belong to more than one Display
Group, as shown in the illustration.
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The Activities, Period report in the CRM module shows how Display Groups
can be used. The report uses a timetable format to display what each member
of a particular Display Group is doing for each day of the report period. The
information is taken from Calendar Activities. The example report illustrated
below shows the Calendar Activities of the members of the “SALES”
Display Group for the second week in November. The format of the report
means that it is easy to see which members of a particular department are
available to carry out a sales task, and when they could carry it out.

Enabler

Please refer to the section entitled ‘The Database Key’ in the first chapter of
this manual for full details of this setting.
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Fiscal Years

Hansa has a multi-year database. In this setting you can define several
financial years. Each year must have a Code, and can be between 6 and 18
months in duration. The Code will be used as a prefix for Transactions
entered directly to the Transaction register in the Nominal Ledger.

Note that Fiscal Years should always be listed in chronological order as
shown in the illustration. You cannot insert new Fiscal Years at the top of the
list, or remove old Fiscal Years. You should not make any changes to a Fiscal
Year once a transaction has been posted.

Hansa will issue a warning whenever an attempt is made to post a transaction
whose date does not fall in a Fiscal Year as defined in this setting.

General Options

Use this setting to specify how discounts are to be calculated in Hansa (in
Contracts, Invoices, Quotations, Sales Orders, Work Sheets and Project
Budgets).

To open the General Options setting, double-click on ‘General Options’ in
the ‘Settings’ list in the System module. The ‘General Options: Inspect’
window is opened—
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When a Discount of 10% is applied to a Unit Price of 200.00, the various
calculation options produce the following results—

Discount 200 - (200 x 10%) = 180

Margin Factor 200 x 10% = 20

Markup % 200 + (200 x 10%) = 220

Confirm the entry by clicking [Save], or cancel it by closing the window
using the close box.

Note that this setting does not affect Purchase Orders, which always use the
‘Discount’ method.

Languages

This setting allows you to define foreign Languages: Language Codes can
then be assigned to Customers or Suppliers. These can be used to ensure the
correct Forms are used: e.g. French invoice forms to French customers,
Finnish documents for Finnish customers etc. In addition, Language Codes
can be used to show the correct translations of Item Names, Payment Terms,
Delivery Terms, etc. on printed documentation.

To enter a new Language, simply enter a Language Code and Name on the
first blank line and click [Save] to save and close. Click the close box to close
without saving changes.
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Local Machine

If you are using the Restaurant module on several terminals, you may wish to
restrict the Items that are sold on each machine. For example, you may want
to be able to sell drinks on one machine and food on another. To do this, you
should assign a unique code to each machine using this setting. Then, using
the Item Group register in the Restaurant module, define the Items that can be
sold by each machine. Please refer to your local Hansa representative for full
details of the Restaurant module.

This setting is also used in the Point of Sales module, again to identify each
terminal. When a Cash Invoice is saved for the first time, the Local Machine
Code of the machine being used is copied to the field on the ‘Date’ card.

Locking

This setting allows you to close an accounting period to prevent the further
entry of new or corrected transactions. This is done by specifying a cut-off
date. Once this has been done, no transactions whose Transaction Date is on
or before the cut-off date will be permitted. Because Locking is carried out
by specifying a single date, months or periods must be locked
chronologically.

Hansa does not force you to close months or periods, but this setting allows
the use of such a feature if necessary.

Lock TR If a date has been entered in this field, the entry of
Transactions whose Transaction Date is on or before this
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date will not be permitted. This applies only to
Transactions entered directly to the Transaction register
in the Nominal Ledger.

If it is discovered that a Transaction which falls within a
closed month contains an error, it can only be corrected
using the ‘Correction Mark’ function. Please refer to the
‘Correcting Transactions’ section of the ‘Nominal
Ledger’ chapter in Volume 2b for full details.

If an attempt is made to enter a Transaction whose
Transaction Date is on or before the Lock TR date, the
following warning is shown—

Warn TR If a date has been entered in this field, a warning will be
displayed on the entry of Transactions whose
Transaction Date is on or before this date. This applies
only to Transactions entered directly to the Transaction
register in the Nominal Ledger.

If an attempt is made to enter a Transaction whose
Transaction Date is on or before the Warn TR date, the
following warning is shown—

Not Prel TR If Preliminary Transactions are allowed (this is
controlled in the Transaction Settings setting in the
Nominal Ledger) and a date has been entered to this
field, only those Transactions whose Transaction Date is
after this date will be treated as Preliminary (i.e.
modifiable). All Transactions whose Transaction Date is
on or before this date will not be modifiable.

If the Not Prel TR date is later than the Lock TR date, it
will be possible to enter Transactions with a Transaction
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Date that falls between them. Such Transactions will be
treated as actual Transactions as soon as they have been
saved (i.e. they will never be modifiable).

Lock Others If a date has been entered in this field, the creation of
records in any of Hansa’s transaction registers whose
Transaction Date is on or before this date will not be
permitted. This covers all transaction registers except
Invoices or Purchase Invoices, which have separate
controls (below).

Warn Others If a date has been entered in this field, a warning will be
displayed on the creation of records in any of Hansa’s
transaction registers whose Transaction Date is on or
before this date. Again, all transaction registers except
Invoices and Purchase Invoices are affected.

Lock S/L Inv If a date has been entered in this field, the creation of
Invoices whose Transaction Date is on or before this
date will not be permitted.

Warn S/L Inv If a date has been entered in this field, a warning will be
displayed on the creation of Invoices whose Transaction
Date is on or before this date.

Lock P/L Inv If a date has been entered in this field, the creation of
Purchase Invoices whose Transaction Date is on or
before this date will not be permitted.

Warn P/L Inv If a date has been entered in this field, a warning will be
displayed on the creation of Purchase Invoices whose
Transaction Date is on or before this date.

After locking the accounts at a
certain date, you may not enter
Transactions with earlier dates, and
you may not alter earlier
Transactions.

Delete Before Date

Under normal circumstances, it is not possible to delete
Nominal Ledger Transactions or approved records in the
transaction registers. However, it can be necessary to
delete such records in certain situations, perhaps because
disk space is at a premium and the previous year‘s
accounts have been committed to an archive file.

!
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To allow the deletion of such transactions, a Delete
Before Date must be entered in this field. It will only be
possible to delete Nominal Ledger Transactions and
records in Hansa‘s transaction registers whose
Transaction Date is on or before this Delete Before Date.

Deletions can be carried out for individual records using
the ‘Delete’ function on the record menu and for groups
of records using ‘Delete Old Transactions’ Maintenance
function in the System module. This latter function will
only delete records whose Transaction Date is on or
before the Delete Before Date specified here.

Use great care when attempting to
delete records, and make sure you
have a backup before you remove any
data.

Warn when creating new records with older dates than existing records

Use this option if you would like to be warned when
entering a date to an accounting transaction if a record
with a later date already exists in the same register. The
existing record can be approved or unapproved. The
warning appears as follows—

As it is a warning, you will still be able to save and
approve the new record.

Once you have entered a date in any of the fields in this setting, you will
usually only be able to change that date to a later one. You will not be able to
change it to an earlier date. When a period or month is locked, you should
print and file all management reports (e.g. Balance Sheet, Profit & Loss
report, etc), and so it will not be appropriate to re-open the period to post new
transactions. However, in some exceptional circumstances, it may be
appropriate to change a locking date to an earlier one. If you want to do this,
you must belong to an Access Group where Full access has been granted to
the ‘Allow to Change Locking’ Action (illustrated overleaf).

!
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Access Groups are described at the beginning of this chapter.

Number Series Defaults

Hansa allows the definition of several Number Series (number sequences) for
use in generating Order Numbers, Invoice Numbers, Transaction Numbers
and so on. By default, Hansa will select the next available number from the
first Number Series defined for the current period whenever a new record is
created.

If you have several number sequences in each Number Series setting, you can
specify here which one is to be used as the default when creating new records
in each register. This default will be overridden if the current user has a
Number Series specified on the ‘Ser Nos’ card of their record in the Person
register.

Take care to specify a number in each field that falls in a recognised Number
Series. If a number is specified that is not in a Number Series, new records in
the affected register will not be given serial numbers when they are created.
The implications of this are quite far reaching: for example, Invoices will not
be created by any of the remote Invoice creation functions (e.g. from Sales
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Orders). This situation will be most common in cases where Number Series
are tied to a period such as a calendar year and that period ends.

If you are not using Number Series, Hansa will normally start numbering
transaction records from 1.

Click [Save] to save any changes and close, or the close box to close without
saving changes.

Password Security

This setting allows you to set rules for passwords. These rules will apply to
the passwords assigned to each Person record (allowing users to log in to
your Hansa system) and to each Customer record (allowing Customers to log
in to your Web Shop).

To open the Password Security setting, double-click on ‘Password Security’
in the ‘Settings’ list in the System module. The ‘Password Security: Inspect’
window is opened—

Enter your password requirements as necessary and confirm the entry by
clicking [Save], or cancel it by closing the window using the close box. When
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a password is changed, the Check Old Password option will make sure the
new password is different to the old one. The Letter option requires that
every password contains at least one uppercase alpha character.

Printers

This setting is associated with the use of printers other than the primary
printer selected in the Windows Control Panel or the Macintosh Chooser. The
Printers setting lets you redirect the printer output to a different printer.

This is practical if for instance you want to print reports to a laser printer and
documents, e.g. invoices, to a dot matrix printer using pre-printed continuous
stationery.

The printers defined here are used when printing documents. Reports are
always printed to the printer specified in the first row of this setting. If this
setting is configured as recommended below, this will be the printer selected
in the Control Panel (Windows) or the Chooser (Macintosh). Windows users
can direct reports to specific printers by opening a list of reports, highlighting
one in the list, selecting ‘Page Setup’ from the File menu and selecting a
printer there.

Double-clicking ‘Printers’ in the ‘Settings’ list in the System module opens
the ‘Printers: Inspect’ window listing the Printers that have already been
entered. To add a new Printer, simply enter its details on the first blank line
and click [Save] to save and close. Click the close box to close without
saving changes.

If no Printers are listed, Hansa will always use the Printer selected in the
Control Panel (Windows) or Chooser (Macintosh), for both reports and
documents. It is likely that this will be the case in single-user installations of
Hansa.
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The Printer described in the first row should be the one that you wish to be
used as a default printer: it will be used if no Printer has been specified for
use with a particular document. It is recommended that this row be left blank
(apart from the Code) as in the illustration, signifying that the Printer selected
in the Control Panel (Windows) or Chooser (Macintosh) will be the default
Printer.

For each available printer, the fields should be completed as outlined
below—

Code Enter here an arbitrary name for the printer. When
defining documents, this Code will be used to determine
which printer will be used to print them out (see example
below).

Print Server IP & Port

Enter here the full network IP address of the computer to
which the printer is attached. If the printer is attached to
a printer server, that server must be switched on and
Hansa must be running.

In the example illustrated, the Printer known to Hansa as
“PSERVER” is attached to a print server whose IP
address is 192.20.20.20, while the “ACCT” Printer is
attached to a computer with the IP address of
192.20.20.22. The “DEFAULT” printer has a blank IP
address, signifying that the printer is attached to your
own computer: the first row of the Printers setting
should always have a blank IP address.

The IP address of a particular computer can be obtained
from the appropriate communications Control Panel.

The Hansa print server facility and the third column of
the grid are described below.

Hardw. Port Enter here the port of the computer named in the
previous field to which the printer is attached. The
following values can be used—

Blank or P Leaving the Port blank (or entering “P”) will
cause the default printer of the specified computer
to be used (i.e. that which has been selected in the
Control Panel or Chooser). In this case, the built-
in printer drivers will be used.

LPT1 - LPT5 To print directly to a parallel port of the Windows
machine whose IP address appears in the Print
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Server field, enter the port number here (between
LPT1 and LPT5). The built in Windows printer
driver will be bypassed.

COM1 - COM5 To print directly to a serial port of the Windows
machine whose IP address appears in the Print
Server IP field, enter the port number here
(between COM1 and COM5). The built in
Windows printer driver will be bypassed.

In some Windows NT4 installations, the serial
port entry can be case sensitive. An entry of
“com1” can sometimes be successful where
“COM1” fails.

LP0 - LP3 To print directly to a parallel port of the Linux
machine whose IP address appears in the Print
Server field, enter the port number here (between
LP0 and LP3).

1 or 5 To print directly to the printer port of the
Macintosh whose IP address appears in the Print
Server IP field, enter “1” or “5” here. Use “1” if
the printer communicates at 9.6kbps (standard) or
“5” if it communicates at 57kbps. The built in
Macintosh printer driver will be bypassed.

F This signifies that the machine whose IP address
appears in the Print Server IP field is a Fax
Server. In the third column of the grid, enter the
port number of the Hansa Fax Server. This should
be the port specified in the Print Server Port field
in the Program Mode register on the Hansa Fax
Server.

In all cases when a Port is indicated, Hansa will only
send variable data for a document through the port. All
text items and formatting information will be lost, but
the physical positioning on the page is preserved. It is
thus assumed that pre-printed stationery is being used.

Note that if you have a printer installed (using a driver in
the Control Panel or Chooser) but are printing directly to
the serial/parallel port, the driver can interfere with the
direct printing from Hansa. If you have problems try to
deinstall the printer drivers.



Chapter 7: System Module - Settings - Printers

451

Defining when Printers are to be used

Hansa’s documents are user-definable, a process which can include
specifying which printer is to be used for a specific document. For example,
you may wish to print a document to a specific printer that you know will
always contain the correct stationery. The following example will use the
Invoice Definition window to illustrate the process, but the procedure can be
followed for any of Hansa’s user-definable documents.

Having entered all available printers in the Printers setting as described
above, move to the Sales Ledger and click the [Documents] button in the
Master Control panel or select ‘Documents’ from the File menu. Highlight
‘Invoices’ in the ‘Documents’ list window and select ‘Define Document’
from the Operations menu.

The following window opens—

In this example, which refers to the Printer setting illustrated on the previous
page, Swedish language Customers will have their Invoices printed using a
Swedish language invoice Form “FAKTURA”. The printout is sent to the
printer attached to the LPT1 port of the Windows computer with IP address
192.20.20.24. English language Customers will have their Invoices printed on
the printer attached to the Macintosh with IP address 192.20.20.22, and they
will use the English language Form “INVOICE”. The ‘Paste Special’
function can be used from the Printer field to obtain a list of printers.

The “FAKTURA” and “INVOICE” Forms are designed using the Form
register described later in this chapter.

If the Printer field is blank in any row in the ‘Define Document’ window, the
first record in the Printers setting will be used.
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Setting up a Print Server

In some larger installations it can be useful to set up a print server to look
after the printing of documents. Hansa can be configured to act as a print
server. It periodically interrogates the data server for print jobs. When a user
prints a document, it is held on the data server until the next interrogation by
the print server. It is then taken from the data server by the print server. The
data server is therefore made available for the next data processing task more
quickly while the print server looks after communications with the printer.

The copy of Hansa that acts as the print server should be on its own dedicated
machine (i.e. not on the same machine as the data server or any of the
clients). Up to six printers can be attached to this machine. Because the print
server is on a separate machine, it must be backed up separately.

To configure the Hansa print server, follow these steps—

1. Create a new database on the machine that is to act as your dedicated
print server following the instructions in the section entitled ‘Creating a
New Database’ in the first chapter of this manual. Only one Company is
necessary: specify a suitable name such as “Hansa Print Server”.

2. Using the Modules menu, change to the System module and open the
System Usage setting. Ensure that the Server box on card 1 is checked.
This may result in you needing to apply for a new database key for the
print server database.

3. Select ‘Technics’ from the Modules menu and click the [Prog Mode]
button in the bottom left-hand corner of the screen (or select ‘Program
Mode’ from the Registers menu).
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4. Complete the ‘Server’ and ‘Print Server’ cards of this setting as
follows—

Server Card

Server Port Enter an arbitrary four-digit code to identify the
database. Even though the sole purpose of this database
is to act as a print server and so no cl ients will be
logging on, a Server Port number is still required to
activate TCP/IP. The Port specified here must be unique
(i.e. it must be different to the Server Port specified in
the data server).

Print Server Card

Print Server Port Enter the Server Port specified in the Program Mode
register on the data server. This is used to enable the
print server to locate the correct copy of Hansa on the
server. If you are using the Hansa parallel server facility,
enter the Server Port from the distributor.

A consequence of this field is that if you have more than
one data server machine (with different databases), you
will need a separate print server for each one.

Auto Connect Serv IP

Specify here the IP address of the data server machine.
This can be obtained from the TCP/IP control software
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on the server and is used to enable the print server to
locate the correct data server on the network. If you are
using the Hansa parallel server facility, enter the IP
address of the distributor.

Auto Connect Time (secs)

The print server periodically interrogates the data server
for print jobs. Specify here in seconds how often it
should do this (10 is the recommended figure).

Fax Interval (secs) This field is used for fax servers only. Please refer to the
section below entitled ‘Setting up a Fax Server’ for
details.

Port This field should be the same as the Print Server Port
above.

Auto Connect as Print Server

This box must be checked on the print server to ensure it
checks the data server for print jobs every so often.

5. Once the ‘Server’ and ‘Print Server’ cards of this register are complete,
click the [Save] button in the Button Bar to save.  If you have entered any
Port numbers for the first time (or changed the ones that were already
there), quit Hansa and restart to allow the changes to take effect.

6. If you have used the Timed Operations setting in the Technics module on
the main data server to ensure it creates a daily back-up file or to specify
that it starts up and shuts down automatically, you should use the same
setting on the print server to shut it down during this time. The print
server interrogates the data server periodically: it will not get a response
when the data server is backing itself up or is shut down.

If you have used the Timed Operations setting on the main data server to
create a daily back-up file (i.e. you have entered an Operation Time,
checked the backup box and specified a Backup Path), the Database
Closing Time on the print server should be set to three minutes before
the Operation Time on the data server. The Database Opening Time on
the print server should be a few minutes after the back-up process on the
data server has finished.

If you have used the Timed Operations setting on the main data server to
shut it down during the night, perhaps to allow third-party back-up
software to operate (i.e. you have entered Database Opening and Closing
Times), the Database Closing Time on the print server should be set to
three minutes before the Database Closing Time on the data server. The
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Database Opening Time on the print server should be a few minutes after
the Database Opening Time on the data server.

In both cases, the Database Opening Time on the print server should be
before the time when users begin logging in to the data server.

7. The final task is to select ‘Server’ or ‘External Gateway’ from the
Modules menu. The ‘Server Status’ screen appears. The print server can
now be left alone.  ‘External Gateway’ is recommended as you can
change from there to the Technics module to check settings etc when
necessary. If you do this, return to the External Gateway module when
you've finished, to prevent messages appearing that will stop the
program running. In the Server and External Gateway, these messages
will be written to the log file and will not appear on screen.

8. Changing to the data server (or to one of the clients with access to the
System module), the Printers setting should now be configured to make
the print server available. If you choose to do this work on the server and
it is running, ensure no other user is logged in, select ‘Quit, remove
autoserver’ from the File menu and restart Hansa. You will then be able
to change the Printers setting. If your server does not have a graphical
interface, you will need to change the Printers setting from a client
machine.

The first row of this setting should be blank (apart from the Code) as in
the illustration, signifying that the Printer selected in the Control Panel
(Windows) or Chooser (Macintosh) will be the default Printer.

In the illustration, the print server has been entered on the second row.
The IP address of the print server machine has been entered in the Print
Server IP field and the Port field shows the same number that was
entered to the Print Server Port field in the Program Mode register on the
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print server (step 4 above). Use the Hardware Port to instruct the print
server which printer is to be used. If several printers have been attached
to the print server, you should enter separate rows in this setting with
appropriate Hardware Ports to allow documents to be printed on the
correct printer.

When the Printers setting is complete, save it by clicking the [Save]
button in the Button Bar.

9. Finally, following the instructions in the ‘Defining when Printers are to
be used’ section above, go to the ‘Define Document’ window for each
document that is to be printed through the print server and specify the
print server in the Printer field.

Setting up a Fax Server

In some larger installations it can be useful to set up a fax server to fax
documents to their recipients. Hansa can be configured to act as a fax server.
In the same manner as the print server described above, it periodically
interrogates the data server for fax jobs. When a user prints a document that
is to be sent by fax, it is held on the data server until the next interrogation by
the fax server. It is then taken from the data server by the fax server. The data
server is therefore made available for the next data processing task more
quickly while the fax server looks after communications with the recipient’s
fax machine.

The copy of Hansa that acts as the fax server should be on its own dedicated
machine (i.e. not on the same machine as the data server or any of the clients)
although it can be the copy of Hansa that is being used as the print server. If
so, remember that there may be a delay in printing if a document is being
faxed. The machine must be a Macintosh containing or connected to a fax
modem and with a fixed IP address. The operating system should be OS 9.
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Because it is on a separate machine, the fax server must be backed up
separately.

To configure the Hansa fax server, follow these steps—

1. Create a new database on the machine that is to act as your dedicated fax
server following the instructions in the section entitled ‘Creating a New
Database’ in the first chapter of this manual. Only one Company is
necessary: specify a suitable name such as “Hansa Fax Server”.

2. Using the Modules menu, change to the System module and open the
System Usage setting. Ensure that the Server box on card 1 and the Fax
box on card 5 are both checked. This may result in you needing to apply
for a new database key for the fax server database.

3. Select ‘Technics’ from the Modules menu and click the [Prog Mode]
button in the bottom left-hand corner of the screen (or select ‘Program
Mode’ from the Registers menu).

4. Complete the ‘Server’ and ‘Print Server’ cards of this setting in the same
manner as described for the print server above. The Fax Interval is the
time in seconds that the fax server should wait between faxes. The fax
server is fully occupied when it is sending a fax and can’t be used, so
there needs to be an interval time to allow you to check the fax queue
between faxes if necessary. If you leave the Fax Interval field blank, the
interval will be 30 seconds.

Click the [Save] button in the Button Bar to save. If you have entered
any Port numbers for the first time (or changed the ones that were
already there), quit Hansa and restart to allow the changes to take effect.

If you have already set up your print server and want it to be the fax
server as well, there is no need to do this step.
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5. Staying in the Technics module, open the Fax Settings setting—

Fax Modem Type Paste Special Choices of possible entries

Specify here the type of fax modem that is connected to
your fax server machine. If your fax modem is not listed
in the ‘Paste Special’ list, please contact your local
Hansa representatives, although “US Robotics 56K”can
be used for the majority of modems.

Fax Baud Rate Paste Special Choices of possible entries

Enter the speed of your fax modem in bps here.

Port Paste Special Choices of possible entries

Specify here the hardware port used for communication
between the fax server computer and the modem.

Dial Prefix If the modem needs to dial a number (e.g. to get an
outside line) before the fax number itself, enter that
number here.

Speaker Click an option to choose when you want to hear sound
from the modem.

Resolution Click an option to choose the resolution of faxed
documents.

When the setting is complete, save it by clicking the [Save] button in the
Button Bar.

6. If you have used the Timed Operations setting in the Technics module on
the main data server to ensure it creates a daily back-up file or to specify
that it starts up and shuts down automatically, you should use the same
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setting on the fax server to shut it down during this time. The fax server
interrogates the data server periodically: it will not get a response when
the data server is backing itself up or is shut down.

If you have used the Timed Operations setting on the main data server to
create a daily back-up file (i.e. you have entered an Operation Time,
checked the backup box and specified a Backup Path), the Database
Closing Time on the fax server should be set to three minutes before the
Operation Time on the data server. The Database Opening Time on the
fax server should be a few minutes after the back-up process on the data
server has finished.

If you have used the Timed Operations setting on the main data server to
shut it down during the night, perhaps to allow third-party back-up
software to operate (i.e. you have entered Database Opening and Closing
Times), the Database Closing Time on the fax server should be set to
three minutes before the Database Closing Time on the data server. The
Database Opening Time on the fax server should be a few minutes after
the Database Opening Time on the data server.

In both cases, the Database Opening Time on the fax server should be
before the time when users begin logging in to the data server.

7. The final task is to select ‘Server’ from the Modules menu. The ‘Server
Status’ screen appears. The fax server can now be left alone. ‘External
Gateway’ is recommended as you can change from there to the Technics
module to check the fax queue when necessary. If you do this, return to
the External Gateway module when you've finished, to prevent messages
appearing that will stop the program running. In the Server and External
Gateway, these messages will be written to the log file and will not
appear on screen.

8. Changing to the data server (or to one of the clients with access to the
System module), open the System Usage setting in the System module
and ensure that the Fax box on card 5 is checked. This may result in you
needing to apply for a new database key for the main database. If you
choose to do this work on the server and it is running, ensure no other
user is logged in, select ‘Quit, remove autoserver’ from the File menu
and restart Hansa. You will then be able to change the System Usage
setting. If your server does not have a graphical interface, you will need
to change the System Usage and Printers (step 9 below) settings from a
client machine.
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9. The Printers setting should now be configured to make the fax server
available.

The first row of this setting should be blank (apart from the Code) as in
the illustration, signifying that the Printer selected in the Control Panel
(Windows) or Chooser (Macintosh) will be the default Printer.

In the illustration, the fax server has been entered on the bottom row.
The IP address of the fax server machine has been entered in the Print
Server IP field and the Port field shows the same number that was
entered to the Print Server Port field in the Program Mode register on the
fax server (step 4 above). The Hardware Port has been set to “F”, to
instruct the fax server that the fax modem is to be used. Separate
machines are being used as the fax and print servers.

When the Printers setting is complete, save it by clicking the [Save]
button in the Button Bar.

10. Finally, following the instructions in the ‘Defining when Printers are to
be used’ section above, go to the ‘Define Document’ window for each
document that is to be printed through the fax server and specify the fax
server in the Printer field.
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In the example illustration, it has been determined that Purchase Orders
will first be printed on the print server (providing a hard copy for
checking and filing) and then on the fax server. The fax number will be
taken from the appropriate Supplier record. Note that because the same
document is being printed twice, the Seq. field has been used to specify
the order of printing.

Note that any pictures included in the Form (i.e. PICT and EPS files on
Macintosh, BMP in Windows) will not be faxed.

Note too that fax numbers should not contain spaces, dashes or other
non-numeric characters if you will be sending faxes through the fax
server. These characters can be removed using the ‘Update Fax
Numbers’ Maintenance function, described later in this chapter.

Managing the Fax Server

When a user prints a document that is to be sent by fax, it is held on the data
server until the next interrogation by the fax server. It is then taken from the
data server by the fax server, where it is placed in a queue. You can view this
queue on the fax server machine by opening the Fax Queue register in the
Technics module.

The Fax Queue register has the following features—

• Invoices and Quotations are placed in the Queue with a higher priority
than Customer Letters.

• Successful faxes will be deleted from the Queue automatically.

• If a fax is not sent the first time, two more attempts will be made to send
it. If it is still unsuccessful, it will not be deleted from the Queue, from
where you can delete it or try sending it again. The Failed column in the
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‘Fax Queue: Browse’ window will show how many attempts have been
made to send a particular fax.

• To try sending an unsuccessful fax again, open it from the ‘Fax Queue:
Browse’ window and choose ‘Retry Fax’ from the Operations menu.
You can change the Fax Number before selecting this function. If you
want three more attempts to be made to send the fax, set the number of
Tries back to zero and save. To try sending all unsuccessful faxes again,
choose ‘Retry All’ from the Operations menu of the ‘Fax Queue:
Browse’ window.

• To pause all fax activity, select ‘Add Pause Fax Job’ from the Operations
menu of the ‘Fax Queue: Browse’ window. A dummy record is added to
the head of the Fax Queue. No faxes will be sent until you delete this
record. The fax server is fully occupied when it is sending faxes and
can’t be used, so you should use this feature if you need to work on the
fax server machine (e.g. you need to check the contents of the Fax
Queue).

• To remove a fax from the Queue, open it from the ‘Fax Queue: Browse’
window and choose ‘Remove Fax Job’ from the Operations menu. To
remove all faxes from the Queue, choose ‘Remove All Fax Jobs’ from
the Operations menu of the ‘Fax Queue: Browse’ window.
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Reporting Periods

This setting allows you to name and define certain time periods. These should
be the periods that you will commonly use when producing reports: using
‘Paste Special’ from the Period field of a report specification window will
bring up a list of the Report Periods entered using this setting. For example, if
you want to produce monthly reports you should define each month in the
setting.

Once memorised, the Code can be used as a fast way of choosing a Report
Period. For example, using the Report Periods illustrated above, type
“Q1CY” in the Period field of a report specification window when you want
the report to cover the period “1/1/2003:31/3/2003”.

To enter a new Reporting Period, simply click in the first blank line and enter
details as appropriate. Click [Save] to save and close, or the close box to
close without saving changes.

Note that the Reporting Period in the first row of this setting will be offered
as a default wherever a Reporting Period is required. You might therefore
like to change the first row from time to time so that a useful option is always
offered as a default. To delete the old first row once it is no longer useful,
click on the row number and press the Backspace key. To insert a new record
on the first row, click on the row number and press the Return key.

Round Off

In this setting you control the way calculations are rounded off. The setting is
used by Quotations, Sales and Purchase Orders and Sales and Purchase
Invoices. Any amounts lost or gained from the rounding off process are
posted to the Round Off Account specified in the Account Usage S/L setting.
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This Account is used in Transactions generated both from the Sales Ledger
and from the Purchase Ledger.

Total This set of options is used to set the rule for rounding off
Total figures (i.e. including VAT) in Invoices, Orders,
Purchase Orders and Quotations whose Currency field is
blank and for those whose Currency is not entered in the
Currency Round Off setting.

VAT This set of options allows you to use a different rounding
off rule for taxes. This rule applies to Quotations,
Orders, Invoices, Purchase Orders and Purchase Invoices
whose Currency field is blank and for those whose
Currency is not entered in the Currency Round Off
setting.

FIFO This set of options allows you to determine the rounding
options used when calculating FIFO values in the Stock
List report.

Discount Calculation

This set of options allows you to determine how
discounts are calculated throughout Hansa (i.e. in
Quotations, Sales and Purchase Orders, Invoices,
Contracts, Work Sheets and Project Budgets). In certain
circumstances (where there is a very small unit price and
a large quantity), the two alternatives can produce
different results due to rounding. If the Value Discount
option is chosen, the discount will be calculated after the
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multiplication of the unit price and the quantity. If the
Price Discount option is chosen, the discount will be
applied to the unit price before it is multiplied by the
quantity.

For example, you receive an Order for 20,000 items
priced at 0.05 with a 25% discount. With the Value
Discount option selected, the calculated discount is
250—

20000 x 0.05 = 1000. 25% of 1000 = 250

With the Price Discount option selected, the calculated
discount is 200—

25% of 0.05 rounded to two decimal places is
0.01. 0.01 x 20000 is 200

VAT Calculation Specify here how VAT is to be rounded off.

Per VAT Code A VAT subtotal is calculated for each VAT Code
used in the transaction. These subtotals are then
rounded as determined in the Currency Round
Off setting or using the option chosen above
(whichever is appropriate). The subtotals are then
added together to produce the overall VAT total.

Per Row The VAT amount for each individual transaction
row is rounded as determined in the Currency
Round Off setting or using the option chosen
above (whichever is appropriate). These amounts
are then added together to produce the overall
VAT total.

Note that the transaction row sum is rounded as
determined in the Currency Round Off setting or to two
decimal places (whichever is appropriate) before the
VAT calculation is carried out.

Click [Save] to save any changes and close, or the close box to close without
saving changes.

Sales Groups

Sales Groups are used to divide the employees of your company into groups.
These groups will be used by the Limited Access module.
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The ‘Sales Groups: Browse’ window lists the available Sales Groups: to enter
a new record, click the [New] button in the Button Bar. The ‘Sales Group:
New’ window appears: enter the details as appropriate and click [Save] to
save the new record.

Once you have defined your Sales Groups, you should assign one Group to
each Person record, using the Sales Group field on the ‘Access’ card—
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Many registers (e.g. Customers, Invoices) have a Sales Group field. When a
Person is assigned to a record in one of these registers, their Sales Group will
be brought in automatically—

Where a register has a Sales Group field, the Button Bar of the browse
window will contain three extra buttons—
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You can use these buttons if the Limited Access module is present, as
follows—

Lists all records in the register.

Lists records belonging to members of the same Sales
Group as the current user (i.e. records whose Sales
Group is the same as that of the current user).

Lists records belonging to the current user (i.e. records
whose Person field contains the initials of the current
user).

For example, in the illustration below, user FF has clicked the  button in
the ‘Customers: Browse’ window so that it only lists the Customers whose
Sales Group is I (i.e. the Sales Group in her Person record)—

Referring back to the illustration of the Person record earlier in this section,
you can also prevent a user from seeing all records in a register by restricting
their view to their own records or to those of their Sales Group. This applies
to registers whose browse windows have the three buttons shown above, and
is done by choosing a Limited Access option for each Person. The options
are—

No Limitation The Person will be able to see all the records in the
register. They will be able to reduce the list so that it
only shows records belonging to members of their Sales
Group or their own records, using the buttons described
above.

Group Only The Person will only be able to see those records
belonging to members of their Sales Group. They will be
able to reduce the list to show their own records only.
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User Only The Person will only be able to see their own records.

If you want to use these features, check the Limited Access box on card 4 of
the System Usage setting in the System module. Remember that any changes
made in this setting will require you to apply for a new Enabler key.

Styles

In this setting, you can define the different font Styles to be used in the Fields
and Text objects in your Forms, ensuring a consistency of appearance.

Double-click ‘Styles’ in the ‘Settings’ list in the System module to open the
‘Styles: Browse’ window and see a list of the defined Styles.
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Double-click on a line to open the edit window.

Code The code for the Style.

Comment Any description.

Mac/Windows/Linux Font

Paste Special Fonts available on your
computer

The name of the font file, as it appears in the Windows
directory or the System folder.

Mac/Windows/Linux Size

The font size in points.

Styles Select one of the available style types.

Character Spacing

This is used when printing bank giro forms, where a
fixed character spacing is required. Specify here the
spacing in pixels from the start of one character to the
start of the next. Usually this will be six pixels or less.
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Styles with a Character Spacing can only be used in
Fields and Text objects with a left or right justification.
The Character Spacing will have no effect in Fields and
Text objects with a centre justification.

This feature is Macintosh only.

Do not use ANSI character set

Use this option if the Style is to use a non-standard
character set (for example, that used in barcodes).

If you are using Hansa on a mixed network with Linux, Windows and
Macintosh clients in any combination, you should specify Fonts and Sizes for
each platform in each Style record.

Sub-ledger Control Accounts

In this setting you specify the Accounts that are to be part of the sub-ledger
Control Accounts feature. This is activated for the Sales and Purchase
Ledgers using the Sub-ledger Checking check boxes on card 1 of the Account
Usage S/L and Account Usage P/L settings respectively.

The feature prevents the user posting to the specified Control Accounts
manually from the Transaction register in the Nominal Ledger. Instead, it will
only be possible to post to these Accounts (such as, on the Sales Ledger side,
Debtor Accounts) from the sub-ledger (i.e. from Invoices or Receipts in the
Sales Ledger). If you try to post to a controlled Account directly from the
Nominal Ledger (using the Transaction register) you will get an alert
message.

If this feature is in use, you will still be able to enter Receipts and Payments
by journal in the Nominal Ledger. However, it will prevent you from using
the Debtor and Creditor Accounts accidentally and incorrectly in other
Nominal Ledger Transactions, thus rendering them inaccurate. For details of
this process, please refer to the description of flip E of the Transaction screen
in the ‘Nominal Ledger’ chapter in Volume 2b of these manuals.

The Debtor and Creditor Control Accounts specified on card 1 of the
Account Usage S/L and P/L settings are automatically protected when this
feature is activated. All other Accounts that you want to be part of the sub-
ledger control feature (i.e. the Accounts which are not to be used in the
Transaction register) must be entered in this setting. To do this, double-click
‘Sub-ledger Control Accounts’ in the ‘Settings’ list. The ‘Sub-ledger Control
Accounts: Inspect’ window is shown.



Hansa Financials and HansaWorld

472

For each row, use the Code field to enter an Account Category. Two Account
Categories are valid: 1 for accounts receivable (debtors), and 2 for accounts
payable (creditors). In the Account field, enter the Account Number of the
Control Account of which use in the Nominal Ledger is to be prohibited. Use
‘Paste Special’ if necessary. The text in the Type field is entered by the
program, depending on the Account Category chosen.

Click [Save] to save the changes and close, or the close box to close without
saving changes.

An attempt to enter or change a Transaction posting to a protected Account
will give the following error message—

If you are using the Sub-ledger Checking feature and need to specify separate
Debtor Accounts for each Customer Category, those Accounts must first be
listed in this setting. Similarly, all Accounts that are entered as Creditor
Accounts in Suppliers and Supplier Categories must also be listed here.

System Usage

This setting is used to register which modules have been purchased, how
many Companies there are in your Hansa database and how many users will
have access to the system. Once this has been done, Hansa will generate a
Control Code, which should be quoted when it is necessary to obtain an
Enabler Key. The setting is fully described in the sections entitled ‘Modules,
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Users and Companies’ and ‘The Database Key’ in the first chapter of this
manual.

Values in Text

Many documents can be printed showing amounts in words, rather than
figures. This will most commonly be required when printing cheques. Hansa
needs to be informed of the words and rules to be used, because this can be
done in different Languages. This work is done in the Values in Text setting,
which can store a separate record for each Language.

Double-click ‘Values in Text’ in the ‘Settings’ list in the System module to
open the ‘Values in Text: Browse’ window. This contains a list of the records
already entered to this setting, one for each Language. Double-click on a line
to open the edit window, or click the [New] button to create a new record.

When the record is complete, click the [Save] button in the Button Bar to
save it, or use the close box to close it without saving changes.

Card 1

Enter a Language Code: Hansa will prevent you from entering more than one
record for a particular Language. Use ‘Paste Special’ if necessary. Complete
the remaining fields as shown in the illustration. Note how Hundreds are
treated differently in that there is a separate field for each one and in each
case you should type in the word for the number of Hundreds as well as the
word “Hundred” itself. The Hund .1 (Single) field is used for one hundred
when it's not followed by any tens or units (e.g. 100.00, 2100.00, 100.10),
while the Hundreds 1 field is used at other times (e.g. 110.00, 101.00 and
2110.00).
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Card 2

Text up to a Hundred

Use this grid to enter words for each number between
one and 99.

In Languages that do not have genders, use the left-hand
column only, as shown in the illustration. In Languages
where each number has separate masculine and feminine
forms to agree with Currency names of different
genders, enter the masculine form in the left-hand
column and the feminine form in the right-hand column.

Hundreds and Tens Conjunction

Enter here the word that is to appear between the
hundreds and the tens in any amount. In English, the
word “and” is used (for example, one hundred and
twenty).
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Decimals Conjunction

Enter here the word that is to appear between the Major
and Minor Currency amounts. In English, it is not
necessary to have such a word, so the field can be left
blank (for example five pounds forty pence, or five
pounds and forty pence to illustrate where the word
would appear, if one were specified).

Trailing Text Enter here any text that is to appear after the amount. For
example, some users might require the word “only” to
appear after the amount on their cheques.

Zero Enter here the word to be used for zero.

Print Currency Use these options to specify whether the word for the
Currency appears before the amount or after it. In the
latter case, it will appear before the Minor Currency
amount. For example, £5.40 can be written as pounds
five forty pence or as five pounds forty pence. The word
for the Currency itself (“pounds’ in the example) is
entered in the Currency register, also in the System
module.

The Minor Currency In

The Minor Currency is the one hundredth part of the
Currency (for example, pence, cents or öre). Use this
option to specify whether the amount is to appear in
words or figures. Note that the word for the Minor
Currency is not entered here but in the Currencies
setting, also in the System module.

Cut Decimals Check this box if you do not want Minor Currency
amounts to be printed. For example, if this box is
checked, an amount of £5.40 will be printed as five
pounds. Unlike the other fields and check boxes
described above, this option affects amounts both in
words and in figures. It should only be used with
Currencies where there are no Minor Currency values
e.g. in Byelorussia.
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Including Amounts in Words in Documents

When it is necessary to include amounts in words as defined in this setting in
a document, follow these steps—

1. In the System module, open the Form register by clicking the [Forms]
button in the Master Control panel or by selecting ‘Forms’ from the
Registers menu.

2. A list of Forms is opened. Find the one that is to feature the amount in
words and double-click, or click [New] in the Button Bar to create a new
one.

3. Amounts in words can be included in Forms of most types. To check,
change or set the type of a Form, select ‘Properties’ from the Operations
menu. The following window appears—

With the cursor in the Document Type field, use ‘Paste Special’ to bring
up a list of Document Types. It is a good idea to give each Form a
Document Type because when the time comes to include fields in the
Form, the ‘Paste Special’ list of fields will only show those fields that
can be used in Forms of that type. Click [OK] to save the Form’s
Properties.

4. To include a field in your Form that will show an amount in words, click
the [Field] button and then draw a box where the amount in words is to
appear. In the dialogue box which opens when you release the mouse
button, place the cursor in the Fieldname field and use ‘Paste Special’ to
bring up a list of fields.
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Depending on the Document Type, the name of the field containing the
amount in words will be “Amount in Text” (as in the illustration) or “To
Pay in Text”. Double-click one of these as appropriate. Design the rest of
the Form (full details are to be found in the section entitled ‘The Form
Register’ later in this chapter) and save it. An example (intended for
printing on pre-printed stationery) is shown below—
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When printed, it will look like this—

Depending on the document being printed, the Values in Text record used
will be determined by the Language of the Customer or Supplier or that
specified in the Company Info setting. In cases where the Customer or
Supplier Language is blank, the Language in the Company Info setting will
be used.

If a record in the Values in Text setting exists and nothing is printed where an
amount in words is expected, the probable cause is that the Customer or
Supplier Language is blank, and the Language on the ‘Fonts’ card of the
Company Info setting is blank as well.

VAT Number Masks

VAT Numbers are formatted differently according to their country of issue.
For example, Belgian VAT Numbers start with “BE” and contain six digits
followed by a dash, then two more digits, two alpha characters and finally a
"9". This setting is used to ensure all VAT Numbers entered to Hansa are
formatted correctly.

For each Country with which your business trades, use a separate row to
enter the appropriate format (VAT Mask). Where a Country has more than
one possible format, these should each be entered on a separate row, with a
appropriate identifying Comment. ‘Paste Special’ can be used from the
Country field to bring up a list of Countries, to ensure the correct code is
entered.

The format of the VAT Number is defined in the Mask field. For example,
the Belgian format will be entered as “BE######-##??9”, where # means any
number and ? means any character, number or alpha. # is obtained by
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pressing Option-3 on the Macintosh. Note that the validation check is case
sensitive, so be sure to enter upper- or lower-case letters as appropriate.

When entering the VAT Number of a Customer or Supplier (‘Company’
card), Hansa will check the VAT Number Masks setting that the appropriate
format has been used, determined by the Country of that Customer or
Supplier (also on the ‘Company’ card). If the Country is blank, the Country
from the Company Info setting will be used. If that is blank, no validation
check will be made. The validation check is also carried out if a VAT
Number is entered directly to an Invoice.
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Weeks

This setting is used to define the Week Numbers that are shown in the six-
monthly and monthly Calendar views. Week Numbers can vary from country
to country and depending on when the year started. The six-monthly and
monthly Calendar views are described in Volume 6 of these manuals.

Click the [Settings] button in the Master Control panel or select ‘Settings’
from the File menu to open the ‘Settings’ list. Double-click ‘Weeks’ in the
list. The ‘Weeks: Browse’ window lists the records that have already been
entered: double-click one to modify it or click [New] to create a new record.

Complete the grid for each year of use as shown in the illustration (there is no
need to have the years in order, but you should only enter each year once).
Click [Save] in the Button Bar to save, and then click the close box to save
the record.
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The Company Register
If your business is one where there are separate departments or subsidiary
companies that keep separate accounts, these can be set up as separate
accounting entities in Hansa using the Company register in the System
module. Each department or subsidiary is termed a ‘Company’. If you set up
more than one Company in Hansa, each will be completely separate: there
will be no common information, although it is possible to copy from one to
another using the export and import functions. Separate account balances will
be maintained, and each Company within a database can be backed up
separately or together.

Note that you should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.

On launching Hansa for the first time, your first task will normally be to
create a Company. Please refer to the first chapter of the manual for full
details.

You must enter at least one Company
as your first task in using Hansa.

The number of Companies that you can create is restricted by the System
Usage setting (in the System module). In a new database, this number will
always be one. If you need more than one Company, it is advisable to change
this limit and then to enter as many Companies as you need straight away, so
that you only need apply for an Enabler key once. The Enabler key is
dependent upon the number of Companies entered, so you will need to apply
for a new one if you add a new Company later. Remember that each
Company will maintain completely separate accounts, so there is no need to
create separate Companies for departments that are part of the same
accounting whole.

Entering Companies

This is the first task to be completed when creating a Hansa database. The
process is fully described in the first chapter of this manual.

If you have been working with a Hansa database for some time and need to
change or add to the information in the Company register, ensure you are in

!
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the System module and click the [Companies] button in the Master Control
panel or select ‘Companies’ from the Registers menu. The ‘Companies:
Inspect’ window appears: this is the same as that used to enter Companies
when starting to use Hansa. Please refer to the first chapter of this manual for
details.

You can add new Companies at any time, but remember that doing so will
mean that you will need to apply to your Hansa representative for a new
Enabler key.

For security reasons, Hansa will shut down after any changes or additions
have been made in the Company register. Restart the program to continue
working.

If you need to change or add to the information in the Company register in a
multi-user system, you must do so either working on the server itself or
having logged on from a client in “Admin Client” mode. “Admin Client”
mode is described at the end of this section.

The “Default.txt” file must be present
when entering Companies.

Working with Companies

If you have set up more than one Company, you will need to inform Hansa
which one you would like to work with each time you start work. Whenever
you launch Hansa, the ‘Select Company’ list window will appear
automatically—

Highlight the Company you wish to work with and press the Enter key (or
double-click on the Company in the list).

!
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If you need to change Companies in the middle of a work session, there is no
need to quit Hansa and restart. Instead, go to the File menu and select
‘Company’. The ‘Select Company’ list will appear, where you can choose a
new Company to work with.

In a multi-user installation, choose any Company when starting the server.
Users will then be able to log on to and work with any of the Companies
stored within that database.

The Admin Client

In multi-user systems, almost all work done on a client machine will be saved
in the database on the server, and will therefore be available to the other
clients immediately. For example, a change made from a client machine to
the Printers setting will immediately affect printing from all other clients.

In a very small number of cases, the work will be saved in the database on the
client machine and will therefore only affect the operation of that client.
These special cases are the E-Mail Aliases, E-Mail POP3 Servers and
Gateways settings in the Technics module, and the Date and Numeric Format
and Page Setup settings and Company register in the System module.

To change these settings and registers in the server database you must either
work on the server itself, or you must log on from a client as the system
administrator, and then change to “Admin Client” mode. You must use the
second method if your server does not have a graphical interface, or if it is
otherwise inconvenient to work on the server (e.g. it is in another building).
To do this, choose ‘Company’ from the File menu, ‘Open Company Register’
from the Operations menu and then ‘Admin Client’, again from the
Operations menu. If you need to change the Company register on the server,
close the ‘Companies: Inspect’ window and re-open it. It will now show the
Companies on the server. Once you have completed the setup work, leave
“Admin Client” mode by following the same sequence and choosing ‘Normal
Client’ from the Operations menu as the final step.

Ensure you leave “Admin Client”
mode as soon as possible.

Before changing to “Admin Client” mode, you should check that no other
users are logged in. If you change the Company register on the server, the
server will shut down, so you will need to close the client as well.

!
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The Person Register
This register holds information about Persons, i.e. users, employees, sales
persons etc. It can be used as part of your Hansa security system: each Person
can be given their own password. Once a single record has been entered to
the register, starting Hansa will require the entry of a Person’s initials and, if
appropriate, a password. However, if the Person register contains a blank
record, the password and logging on window will not appear.

In the System module, select ‘Persons’ from the Registers menu, or click the
[Persons] button in the Master Control panel.

The ‘Persons: Browse’ window is opened, showing Persons that have already
been entered.

To enter a new record, click [New] in the Button Bar or use the Ctrl-N
(Windows and Linux) or z-N (Macintosh) keyboard shortcut. Alternatively,
highlight a Person similar to the one you want to enter and click [Duplicate]
on the Button Bar.

The ‘Person: New’ window is opened, empty if you clicked [New] or
containing a duplicate of the highlighted Person.

Since the amount of information stored about each Person will not fit on a
single screen, the Person window has been divided into five cards. At the top
of each is the header. This contains the Person’s Initials and Name. There are
five named buttons (‘tabs’) in the header.
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By clicking the tabs you can navigate between the cards, and always go
directly to a certain card. The header is always visible, so you can always see
which Person you are working with.

Header

Signature Enter the Person’s initials to be used when logging on,
or to identify the Person from elsewhere in Hansa.

If there is more than one Company in the database,
records in the Person register (as with all registers) are
specific to the Company in which they are entered.
However, if you are using Hansa’s Mail facilities, each
Person’s Mailbox will be open to all Companies in the
database. This allows mail to be sent between Persons in
different Companies. One implication of this is that all
Persons across all Companies should have different
initials. If there are two or more Persons in different
Companies with the same initials, they will not be able
to have separate Mailboxes.

Name The name of the Person.
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Closed Check this box if the Person is no longer to be used.
Closed Persons will appear in the ‘Persons: Browse’
window but not in the Persons ‘Paste Special’ list. You
will not be able to enter Orders or Invoices for closed
Customers. A closed Customer can be re-opened at any
time.

Allow FTP Access If you are using the Hansa FTP facility and wish to
allow this Person access to your FTP server, check this
box. They will use their initials as a Login ID, and you
can allocate them a password using the ‘Change
Password’ function on the Operations menu of the
‘Persons: Browse’ window.

Access Card

Access Group Paste Special Access Groups setting, System
module

Enter an Access Group, perhaps representing the
department in which the Person works. By allocating an
Access Group, you can restrict the Person’s access to
certain modules or parts of modules. Please refer to the
section covering Access Groups earlier in this chapter
for full details.

Sales Group, Limited Access

Paste Special Sales Groups setting, System
module

Enter a Sales Group, perhaps representing the
department in which the Person works. By allocating a
Sales Group to a user, they will be able to see a reduced
selection of records in certain browse windows and
‘Paste Special’ lists if the Limited Access module is
present. This can be useful where a register contains
many records, making it easier to find the correct one.

The browse windows and ‘Paste Special’ lists with this
feature have three buttons in the bottom right-hand
corner. These buttons can be used as follows—

Lists all records in the register.

Lists records belonging to members of the same
Sales Group as the current user (i.e. records
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whose Sales Group field is the same as that of the
current user).

Lists records belonging to the current user (i.e.
records whose Person field contains the initials of
the current user).

It is also possible to prevent a user from seeing all
records in a register by restricting their view to their own
records or to those of their Sales Group. This applies to
registers whose browse windows have the three buttons
shown above, and is done by choosing a Limited Access
option for each Person. The options are—

No Limitation The Person will be able to see all the records in
the register. They will be able to reduce the list so
that it only shows records belonging to members
of their Sales Group or their own records, using
the buttons described above.

Group Only The Person will only be able to see those records
belonging to members of their Sales Group. They
will be able to reduce the list to show their own
records only.

User Only The Person will only be able to see their own
records.

The Limited Access module must be active if you want
to choose the Group Only or User Only option for any
Person, or if you want to use the browse window
buttons. To make this module active, check the Limited
Access box on card 4 of the System Usage setting in the
System module. Remember that any changes made in
this setting will require you to apply for a new Enabler
key.

Language This field is only used in multi-language versions of
Hansa. Enter the language used by this Person: all
screens, menu items, field names and reports will appear
in the correct language when this Person signs in to
Hansa.

The language entered here must be one contained within
the Hansa program, one that it can match to the
appropriate set of translations. There is no ‘Paste
Special’ link to the Languages setting in the System
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module because the records entered in that setting are
user-defined and may not match those in the program.

The following codes and languages may be used—

ENG English
ESP Spanish
EST Estonian
FIN Finnish
FRA French
ICE Icelandic
LAT Latvian
LIT Lithuanian
POL Polish
POR Portuguese
NOR Norwegian
RUS Russian
SWE Swedish, Finnish-Swedish

Multi-language versions of Hansa are produced
according to need and will not necessarily contain all of
these languages. Standard versions of Hansa contain
only one language, and this field can be left empty.

Job Card

This window is used when the Job Costing module is installed. Please refer to
the ‘Job Costing’ chapter in Volume 5 of these manuals for a detailed
description.

Ser Nos Card

Hansa allows the definition of several Number Series (number sequences) for
use in generating Order Numbers, Invoice Numbers, Transaction Numbers
and so on.

If you have several number sequences in each Number Series setting, you can
specify here which one is to be used when this Person creates new records in
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each register. Select a valid Number Series, as defined using the settings in
each module. If a Number Series is chosen that is not valid, all new records in
the affected register will not be given serial numbers when they are created
by this Person. The implications of this are quite far reaching: for example,
Invoices will not be created by any of the remote Invoice creation functions
(e.g. from Sales Orders). This situation will be most common in cases where
Number Series are tied to a period such as a calendar year and that period
ends.

It is not necessary to assign a Number Series to every field on this screen. A
Person may have his own number range for Invoices, for example, but be
using default numbers for all other events. This default will be taken from the
Number Series Defaults setting in the System module or, if nothing is
specified there, from the first Number Series defined for the current period.

Using the Our Ref field, you can assign a short (up to 20 characters)
reference text for the individual. This text will appear in the Reference fields
of all transactions entered by this Person.

In countries where personal identity cards are carried, the Person’s ID
number from their card can be entered in the ID field. This can be made to
appear on any printed documentation associated with the employee.

Any changes that you make to the ‘Ser Nos’ card will not take effect until
you quit Hansa and restart.

Bonus Card

As with the ‘Ser Nos’ card above, you should quit Hansa and restart for any
changes made to the ‘Bonus’ card to take effect.

Bonus A bonus percentage can be entered for each individual.
The figure can be used by the Bonus, Salesman report in
the Sales Ledger. This report has options allowing
bonuses to be calculated using percentages entered here,
in the Item register (‘Pricing’ card), or in the Bonus
setting in the Sales Ledger. The Bonus, Salesman report
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and the Bonus setting are described in the ‘Sales Ledger’
chapter in Volume 2a of these manuals.

Location Paste Special Locations setting, Stock module

If a Location is specified in this field, it will be used
whenever this Person enters an Order, Purchase Order,
Goods Receipt, Quotation or Invoice.

Account Paste Special Account register, Nominal
Ledger/System module

This Account, used from the Expenses module, can be
viewed as an Advances and Settlements Account. It will
be credited whenever an Expense record in the name of
the Person in question is approved and debited when
Personnel Payment records are approved.

It is recommended that a separate Account be used for
each Person (or, if this is not possible, a separate
Account/Object combination). If this rule is not
followed, the Periodic Personnel Statement report in the
Expenses module may be misleading.

Object Paste Special Object register, Nominal
Ledger/System module

Used in the Expenses module to assign an Object to the
credit side of any Nominal Ledger Transactions created
from expense claims by this Person. Only one Object
can be entered per Person.

Bank Name Paste Special Banks setting, Purchase Ledger

The name of the employee’s Bank.

Bank A/C The employee’s bank account number.

Email Address The employee’s email address. This is used as a return
address if the employee uses Hansa to send email.

Specification, Comment

These fields can be used to record any comments about
the Person.

As soon as a single Person has been
entered in the Person register, the
password dialogue will appear each
time you start Hansa.

!
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Operations Menu

The Operations menu for Persons is shown above. It is available for the
‘Persons: Browse’ window: highlight a Person in the list before selecting the
function.

Open Mailbox

This command opens the Mailbox belonging to the Person highlighted in the
‘Persons: Browse’ window. If the Person does not have a Mailbox, the
command has no effect. Mailboxes are described in Volume 6 of these
manuals.

Change Password

Once a user or employee has been entered to the Person register, they will be
able to log in to and use your Hansa database. For security reasons, therefore,
it is recommended that all Persons have their own passwords and that these
are changed from time to time.

To set a password for a Person, highlight their name in the ‘Persons: Browse’
window and select ‘Change Password’ from the Operations menu. The
following window is opened—

Enter the old password if there is one and then type in the new one twice to
ensure that it is correct. Press the Shift-Enter key combination to close the
window and save: use the close box if you do not want to save changes. The
password is case-sensitive.

Each Person can also change their own password, even if they do not have
access to the System module. Open the Master Control panel (or bring it to



Hansa Financials and HansaWorld

492

the front) and select ‘Change Password’ from the Operations menu. Then,
follow the instructions above.

If you want to set rules for passwords (e.g. to impose a minimum number of
characters, or to require at least one alpha or numeric character), use the
Password Security setting, described earlier in this chapter.

To Do List

This command produces a To Do List report for the Person highlighted in the
‘Persons: Browse’ window. This is a report listing To Do Activities for the
Person, sorted by Start Date and Time. By default, Activities marked as Done
are not shown in the report, so in effect it is a list of Activities that have not
yet been completed (i.e. a check list of tasks to be undertaken). Activities are
described in Volume 6 of these manuals.

Calendar

This command opens the Calendar for the Person highlighted in the ‘Persons:
Browse’ window. The Calendar is described in Volume 6 of these manuals.

Create Mailbox

To create a Mailbox for a Person, first click on the Person in the ‘Persons:
Browse’ window and then select ‘Create Mailbox’ from the Operations
menu. Only one Mailbox can be entered for a particular Person: if a Mailbox
already exists, the function will have no effect.

The Mailbox is opened in a new window entitled ‘Conference/Mailbox:
New’. This means that it has not yet been saved. After amendment if
necessary, save the Mailbox by clicking the [Save] button in the Button Bar.
Alternatively, if you no longer require the Mailbox, click [Cancel].

The Person’s initials and Name will be copied from the Person record to the
new Mailbox, and the Class will be set to “Mailbox”. This leaves only the
Conference Access Groups to be specified.

To close the screen and return to the ‘Persons: Browse’ window, click the
close box. You will be asked if you would like to save any changes that you
may have made.

For more details about Mailboxes, please refer to the ‘Mail’ chapter in
Volume 6 of these manuals.
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The Account Register
This is where you define the Chart of Accounts. Each Account has a number
and a name, and belongs to a class of Accounts.

Hansa has no pre-assigned Accounts. Each user must define a Chart of
Accounts, or import an existing one. The simplest method is to use the
standard Chart of Accounts supplied with Hansa. See the section entitled
‘Setting up a Basic Accounts System’ in the first chapter of this manual for
details of how to do this.

If you use your own Chart of
Accounts, or modify that supplied
with Hansa, it is important that all
the Account numbers used in the
settings and report definitions for
each module are made to agree with
your own numbers.

In Hansa you always have access to the Chart of Accounts through the ‘Paste
Special’ feature, for example when you enter Transactions and cannot
remember an Account Number.

In the Account register you can—

• Show all Accounts on screen

• Search for a certain Account

• Inspect or change a certain Account

• Create new Accounts

• Remove Accounts you don’t need

• Print the Chart of Accounts.

!
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Showing all Accounts on screen

In the System module, select ‘Accounts’ from the Registers menu, or click
the [Accounts] button in the Master Control panel. The ‘Accounts: Browse’
window is opened, showing Accounts that have already been entered.

The list contains two columns: Account Number and Account Name. The list
is sorted by the column whose heading is underlined. Click on the column
heading if you want to change the sort order, and double-click on the column
heading to reverse the sort order.

Searching for an Account

In the ‘Accounts: Browse’ window shown above, you can scroll up and down
through the list of Accounts as usual. You can also search for a particular
Account by entering the first few characters of its Number or Name in the
Search field in the top right-hand corner of the window. Enter a Name if the
list is sorted by Name, a Number otherwise. Hansa will find the first record
that matches the text you have entered.
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Inspecting or Changing an Account

If you want to look at the details of an Account, double-click its name in the
‘Accounts: Browse’ window to open the Account record.

The ‘Account: Inspect’ window contains the following information—

Header

Account The unique number of the Account. Up to ten characters
can be used, with a minimum of two.

Name The name or description of the Account.

Misc Card

Auto. Trans. Paste Special Autotransactions sett ing,
Nominal Ledger

You can link an Autotransaction with a particular
Account by entering the code of the Autotransaction in
this field. When the Account number is entered in a
Transaction record, the Autotransaction will be entered
on the following rows automatically.

VAT Code Paste Special VAT Codes setting, Nominal
Ledger

A VAT Code can be assigned to each Account. It will be
entered automatically every time the Account is used in
a Purchase Invoice or Nominal Ledger Transaction.
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Currency Paste Special Currency register, System
module

An Account can be assigned a foreign Currency. It will
be used automatically every time the Account is used in
a Transaction. Only postings in that Currency will be
permitted. If no Currency is assigned to the Account,
postings in all Currencies will be permitted.

Account Type An Account can belong to one of five types: Assets,
Liabilities, Equity, Revenues or Expenses. This
information is used to control how the balance of this
Account will be stored, as a negative or a positive figure.
Assets and costs are treated as positive values, while
accounts for liabilities, equity, and incomes are treated
as negative. If it is necessary to change the sign of
negative (credit) values for reporting purposes, use the
Presentation of Balances setting in the Nominal Ledger.

SRU Code This field is required in Sweden where the SIE Export
function in the Nominal Ledger is used to export
accounting information in a standard format to other
systems. The SRU Code is a form of classification used
by this export to group Accounts of a particular type
together. For more details, please contact your local
Hansa representative.

Consolidation Acc Please refer to the ‘Consolidation’ chapter in Volume 4
of these manuals for details of this field.

Accrual Paste Special N/L Accruals setting, Nominal
Ledger

You can link an Account with a particular record in the
N/L Accruals setting by entering the Code of the N/L
Accrual in this field. When the Account number is
entered in an Invoice or Purchase Invoice, this reference
to the N/L Accrual record will be brought in
automatically. N/L Accruals are described in the
‘Nominal Ledger’ chapter in Volume 2b of these
manuals.

Normal Amount Click one or both of the check boxes to indicate what
type of posting is the usual for the Account. If you use
this option, and try to debit an Account usually used for
credit, Hansa will alert you to the possible error.
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Closed Check this box if you want to close the Account for
further Transactions. You will no longer be able to use
it, and it will not appear in the ‘Paste Special’ selection
window. If you want to open the Account again later,
you simply click in the box again to remove the check
mark.

Group Account This check box is designed for use in Portugal, where
hierarchical Charts of Accounts including report
headings and subtotals are commonly used.

The Accounts in an example section of such a Chart of
Accounts might be defined as follows—

A/C Group Name Comment
Acc. box

70 On Banks Shows total amount in all
banks

701 On Current Accounts Shows total amount in
c u r r e n t  a c c o u n t s
(7011+7012)

7011 On Bank 1 Shows total amount in
current accounts in bank 1
(70111+70112)

70111 Off Curr. Account 1 Receipts and Payments
post to this Account

70112 Off Curr. Account 2 Receipts and Payments
post to this Account

7012 On Bank 2 Shows total amount in
current accounts in bank 2
(70121+70122)

70121 Off Curr Account 3 Receipts and Payments
post to this Account

70122 Off Curr. Account 4 Receipts and Payments
post to this Account

702 On Deposit Accounts Shows total amount in
deposit accounts

The report headings are entered to the Account register
in the form of separate records. The Group Account box
is switched on for these records, Accounts 70, 701,
7011, 7012 and 702 in the example. Because the Group
Account box is on, you will not be able to post to these
Accounts, and they will not appear in the ‘Paste Special’
selection window. Their purpose is solely to appear as
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report headings (together with subtotals) in the
Analytical Balance report in the Nominal Ledger, when
the ‘With Group Accounts’ Presentation option is used.
They will not appear in other reports, even when the
option to show unused Accounts is chosen.

The report heading hierarchy is established using the
initial digits of the Account Number. So, in the example
Account 70 shows the total amount in all banks,
establishing that all Accounts and Group Accounts
concerned with banks should begin with “70”. Account
701 shows the total amount in current accounts, so all
Accounts and Group Accounts concerned with current
accounts should begin with “701” and so on. The
Accounts with five digits (70111, 70112, 70121 and
70122) are the only ones which can be used in
transactions, the others show subtotals of the balances of
these Accounts in various combinations.

Reduce Minorities Please refer to the ‘Consolidation’ chapter in Volume 4
of these manuals for full details of this check box.

Texts Card

The table on the ‘Texts’ card can be used to enter various translations of the
Account Name. Specify a Language in the first column using ‘Paste Special’
if necessary, and the appropriate translation in the second column. There is
no need to enter a row for your home Language.

The translations entered here will be used by the Balance Sheet, Nominal
Ledger, Profit & Loss and Transaction Journal reports, which can be printed
in different Languages. To define translations of the report headings and sub-
headings (applicable to the Balance Sheet and Profit & Loss report only), use
the report definition feature (fully described in the section describing the
‘Balance Sheet’ report in the ‘Nominal Ledger’ chapter in Volume 2b of
these manuals).

Entering an Account

There are two ways to add new Accounts to the Chart of Accounts: creating a
new Account or copying and then editing an existing one.

In the ‘Accounts: Browse’ window, click [New] in the Button Bar, or
highlight the Account to be copied and click [Duplicate] in the Button Bar.
The ‘Account: New’ window appears. This is as described in the previous
section.
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Enter the new information or change the copied record as appropriate. Click
[Save] to save the new record or [Cancel] to close without saving the record.

Deleting Accounts

You can delete an Account from the Chart of Accounts, as long as it has not
been used in any Transactions.

In the ‘Accounts: Browse’ window, double-click the Account you want to
delete. This opens the ‘Account: Inspect’ window.

Select ‘Delete’ from the Record menu. The Account is deleted and the
previous Account in the list is shown.

You cannot undo the deletion of an
Account. Used Accounts cannot be
deleted.

Printing the Chart of Accounts

The Chart of Accounts can be printed using the ‘System Documentation’
report in the System module. To print the Chart of Accounts with
Consolidation Accounts and percentages, use the ‘Consolidation Chart of
Accounts’ report. These reports are fully described in the ‘Reports’ section of
this chapter.

!
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The Object Register
Hansa supports the use of Objects, to allow your accounts to be classified and
reported in several different categories or dimensions.

You can assign default Objects to Customers, Items, Suppliers, individual
Invoices and Nominal Ledger entries. When an Object is assigned to a
Customer, for example, Hansa will assign that Object automatically to all
Invoices raised in the name of that Customer and to all Transactions
generated by those Invoices. This gives you excellent possibilities to report
for example sales per Object. In general, Objects are tools to improve the
internal cost accounting capabilities in your business.

Objects may be used as selection criteria in many reports. If, for example,
you have several profit centres in your business, and use Objects to separate
income and expenditure for each of these, you may produce separate profit
and loss statements for each profit centre.

Object Types are a means of grouping similar Objects together. They are
defined using the Object Types setting in the Nominal Ledger, but since they
are so closely connected with Objects, they will be dealt with together.

Let us look at an example. We will look at the simplest form of a
“Contribution”: sales income less cost of sales.

In our example we have created a “PRODS” Object Type using the Object
Types setting in the Nominal Ledger—
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The following Objects belong to the “PRODS” Object Type—

The following illustration shows the definition of one of these Objects,
“MACH”—

Each Item can then be allocated the appropriate Object. If you sell different
groups of products or services, it is easy to set up various groups of Objects
in this manner. It is then simple to separate the transactions belonging to
different Object or Object Types when producing reports such as profit and
loss, key ratios, etc.

You control the definition and use of
Object and Object Types entirely.
They are your own tools for your cost
accounting.

All Objects in Hansa can span several years. This is a consequence of
Hansa’s continuous database, where the end of year is simply a user-defined
reporting interval. Object balances are thus automatically transferred from
one financial year to the next. This gives you the ability to keep track of the
budget and results of an Object (e.g. a building project) for several years.

An Object can also be closed, to prevent further use. With the Object on
screen in a record window, check the Closed check box to close it. If you

!
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want to open the Object again later, you simply click in the box again to
remove the check.)

Do try out the Objects, Object Types and the different reports. This is an
interesting way to get an insight into the status of the company - and there
may be money to gain!

Defining, Inspecting, Changing and Deleting Objects

When you select ‘Objects’ from the Registers menu in the System module or
click the [Objects] button in the Master Control panel, the ‘Objects: Browse’
window is opened with a list of the currently defined Objects.

This operates in the same manner as all browse windows in Hansa: you can
sort the list by clicking on one of the headings, or search using the search box
in the top right-hand corner.

Open an Object record by double-clicking one of the items in the list, or
create a new Object using the [New] or [Duplicate] buttons in the Button Bar.

Delete an Object by opening it and then selecting ‘Delete’ from the Record
menu. Remember that, as elsewhere in Hansa, deletions are permanent and
cannot be reversed by the ‘Undo’ facility. You will not be able to delete
Objects that have been used in Transactions.
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Using Objects - an example

All invoiced sales are recorded with an Object of the “LAND” Object Type
(representing their country of origin). The following reports are produced
based on the data entered. First, we produce a Profit and Loss report for the
“LAND” Object Type—

Similarly, ordering a report for an individual Account (the Nominal Ledger
Report) and for one Object will list only Transactions for that Object.

Multiple Objects

Hansa allows you to assign more than one Object to a transaction. An
example is when you have assigned a certain group of Objects to Customers,
and another group of Objects to Items. Both groups of Objects will be used in
Nominal Ledger transactions generated by Invoices for those Items made out
to those Customers. With some careful organisation, you may then produce a
very detailed and precise analysis of your business for the different
combinations. To set up the right combination of Objects is usually quite a
difficult analytical exercise, and it is quite easy to create nonsense results.

When entering transactions of any type, up to 30 Objects separated by
commas can be assigned separately to the transaction and to each row: each
Object field can contain up to 60 characters. However, it is recommended
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that Object Codes with at least two characters are used, imposing a more
usual limit of 20 Objects.

The Currency Register
Please refer to the ‘Multi-Currency’ chapter in Volume 2b of this manual for
full details of this register.

The Exchange Rate Register
Please refer to the ‘Multi-Currency’ chapter in Volume 2b of this manual for
full details of this register.
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The Form Register
Hansa has a built-in forms editor, which allows the design of all documents
used in the program. In the System module, select ‘Forms’ from the Registers
menu or click [Forms] in the Master Control panel to show a list of all
available Forms.

Double-click on a document to open the editing window, or click [New] or
[Duplicate] to create a new Form. When you have designed the Form, click
[Save] in the Button Bar to save it in the normal way.

The ‘Form: Inspect’ window shows the selected Form or document. At the
top of the window there are five buttons: [Text], [Line], [Frame], [Field] and
[Picture]. In the editing area, each printing object in the Form is shown either
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as a framed box, or as text. You can select an object by clicking on it with the
mouse and then drag it to another place, re-size it etc. as in most drawing
programs.

Editing Objects

To edit an object, double-click on it with the mouse. This will open a
dialogue box, where you can perform certain editing functions. These are
described for each object type below. For all object types the fields Left, Top,
Right and Bottom indicate the location in pixels of the four sides of the
object. The Justification options allow you to justify the text as you wish.
Style refers to a Style setting, where you can set font, font size and font style.

Text Objects

To add a new text element to the Form, click the [Text] button and then draw
the object where you want the text to appear.

When you release the mouse button, the following dialogue box will
appear—

Text The text that is to be printed on the Form. This can be up
to 80 characters long, but it is limited to one line. To
create a text area with more than one line, use the
appropriate number of separate one-line text objects.

Left, Top, Right, Bottom

Use these fields to specify the size and position of the
text box that is to contain the text. When creating a new
text box, the measurements of the box that you have just
drawn will appear here.
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Style Paste Special Styles setting, System module

Use this field to assign a font and font style to the text.
Styles are defined using a separate setting which is fully
described earlier in this chapter. If no Style is entered
here, the first record in the Styles setting will be used.

Escape Sequence The Escape Sequence is used when printing cash
receipts: please refer to your local Hansa representative
for details of this feature.

Justification Use these options to specify where the text will appear
inside the text box.

Exclude from page

Please refer to the ‘Single- and Multi-Page Forms’
section below for details about these options.

Click [OK] to close. The text field is visible on the screen, and you can move
it around the Form with the mouse.

To edit a text object once it has been created, double-click it to open the
‘Text’ dialogue box.

Lines and Frames

Use these tool buttons to draw lines and frames on the Form. Click either
button and then draw the object. When you release the mouse button, a
dialogue box will appear where you can indicate the width in pixels of the
line or frame, and the pages on which it is to be printed.

Fields

A field is an area on the Form where information from Hansa’s database is to
be printed. The following example from an Invoice Form explains how—

Fields appear as framed boxes containing the field name, e.g. “Del Date”.
The box frames are for identification only: they will not be printed. The
[Frame] button can be used to add a printing frame if necessary. Above each
field is a text object which identifies the information shown in the field.
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These would not be necessary if the Form is to be printed on pre-printed
stationery.

To add a field, click the [Field] button, and mark the position of the field. A
dialogue box opens—

Enter the Field Name (use ‘Paste Special’ to see all available Field Names for
the Document Type), and paste a style in the Style field. Some fields consist
of more than one line (e.g. the text in Letters and Mails, and the fields listing
the Items in Quotations, Orders and Invoices). You can modify the spacing
between lines (in pixels) with the Vertical Spacing field. Usually the number
of pixels that you specify here should be the same as the font size. If you
leave this field empty, the lines of text may be printed on top of each other.
Click [OK] to save.

Document Types are described in the section covering the ‘Properties’
Operations menu function below.

Notes and Comments

Usually each field that you place in a Form corresponds to a field in the
original record. For example, the Customer No field in the illustration above
will print the contents of the Customer Number field in each Invoice. An
exception is the “Note” field. If you include the “Note” field in your Form
design, this will print the first note or comment that you attach to the original
record using the Attachments feature.

Pictures

Use the [Picture] button to include a picture in your design. As with other
tools, click the button and draw a frame for the picture on the Form. A
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dialogue box then appears. In the Picture Name field, enter the file name of
the picture as it is on your hard disk. Use ‘Paste Special’ to ensure that the
file name is spelt correctly. The picture must be stored in the same directory
or folder as the Hansa database and application. In multi-user systems, the
picture should be on both the server and the clients. In the Windows
environment, files of BMP format are supported. For Macintosh users, EPS
and PICT formats are supported. If the Form is one that will be faxed through
a fax server, bear in mind that any pictures will be omitted.

Operations Menu

Properties

This menu command opens the ‘Form Properties’ dialogue box. Here you can
record the basic specification for the Form currently being edited.

Code A unique code for the Form. If you have created a new
Form by copying a template, you must enter a new Code
here before you can save it.

Comment A description of the Form, e.g. Invoice.

Matrix Rows On Please refer to the ‘Single- and Multi-Page Forms’
section below for details about these options.
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Document Type Using ‘Paste Special’, enter one of the available
Document Types into this field. When the time comes to
add fields to the Form, only the fields available for that
Document Type will be available in the ‘Paste Special’
list in the ‘Field’ dialogue box.

Printer Dialog Check this box to force a printer dialogue to be shown
each time the Form is printed.

PC Printer

If a dot matrix printer is used, use this dialogue box to define the page size.

A dot matrix printer needs certain settings for printing on continuous
stationery. If you are printing a document to pre-printed forms, you may need
to define the number of rows in the page, the number of visible rows and the
left margin for the forms used.

Copies

Use this function to define the number of copies to be printed each time the
Form is used, their respective headings and the printer tray from which each
copy is to be printed. If you want the headings to be printed, be sure to
include the Copy Type field in your Form design.

Send to Back

If you wish certain objects on the Form to appear behind other objects, select
them and select this function.

View All, First Only, Middle Only, Last Only, Single Page Only

These functions are described in the next section, ‘Single- and Multi-Page
Forms’.
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Single- and Multi-Page Forms

When designing Forms, you should consider what is to happen when the
printing of a document requires more than one page. Two options are
available—

1. The “simple” option, where the same page design is used for each page.

2. The “multi-page” option allows the use of up to four page designs, as
follows—

First The first page of a multi-page document.

Middle In a multi-page document, the pages between the
first and last pages.

Last The last page of a multi-page document.

Single The sole page of a single-page document.

Usually, the First and Single page designs will be the same.

When an object of any kind (i.e. text, line, frame or field) is added to the
Form design, the Exclude From Page check boxes can be used to specify the
pages on which the object is to be printed. If none of these boxes is checked,
the object will be printed on every page. This will be the case when using the
“simple” option. If you want the object to be printed on certain pages only,
check one or more of the boxes. For example, if the object is to be printed on
all pages except the first, check the First box. If it is only to be printed on the
first page, check all boxes except the First box (i.e. it will be excluded from
all pages except the first). The Text object in the illustration below will be
printed on the first page only—
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To help with the design process, you can choose to display the objects from a
particular page. To do this, select ‘First Only’, ‘Middle Only’, ‘Last Only’ or
‘Single Page Only’ as appropriate from the Operations menu. For example,
select ‘First Only’ to view the objects that are to be printed on the first page
(i.e. those whose First box has not been checked). Select ‘View All’ to see all
objects, irrespective of the page on which they are to be printed.

The number of pages printed will vary from record to record, depending on
the number of rows that the record has. An Invoice with one Item will be
printed on a single page (i.e. using those objects whose Single box is not
checked). An Invoice with 100 Items (i.e. 100 rows) will be printed over
several pages. You should specify the maximum number of rows that can be
printed on each page by selecting ‘Properties’ from the Operations menu.
This opens the ‘Form Properties’ window, which has four fields under the
overall heading of Matrix Rows On—

In the case of the “simple” option, the same number should be entered to each
of these four fields. Otherwise, enter different numbers as appropriate. For
example, in an Invoice Form, First and Single are set to 5, Middle to 6 and
Last to 7. Invoices will be printed as follows, depending on the number of
rows—

Invoice rows Pages Type of Page

Up to 5 1 Single
5-12 2 First and Last
13-19 3 First, Middle and Last
19-25 4 First, 2 x Middle, Last
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Printing Forms

Once a Form has been designed, you should inform Hansa when it is to be
printed. This is done by attaching the Form to an item in the ‘Documents’ list
in the appropriate module. This is only necessary if you have given your
Form a new Form Code using the ‘Properties’ Operations menu function.

For example, when printing an Invoice, Hansa, by default, will use a Form
with the Form Code of “INVOICE”. A template Form with this Code is
supplied with Hansa. If you have used this template as a basis for designing
your own invoice form and haven’t changed the Form Code, the new design
will be used automatically. However, if you have changed the Form Code to,
for example, “INVOICE1”, you should inform Hansa that this is now the
Form to be used for printing Invoices.

To do this, follow these steps—

1. Select the Sales Ledger module using the Modules menu.

2. Select [Documents] in the Master Control panel. The ‘Documents’ list
window is opened showing a list of available documents. Highlight
‘Invoices’.

3. Select ‘Define Document’ from the Operations menu.

4. In the first row, “INVOICE” will be shown in the Form field. Change
this to the Form Code of your new invoice Form (“INVOICE1” in the
example). Use the ‘Paste Special’ feature to see the available forms in
your Forms register and to ensure the spelling is correct.

5. Click [Save] to save the Invoice definition. From now on, whenever
Invoices are printed, the “INVOICE1” Form will be used.

‘Define Document’ (steps 3 and 4 above) can also be used to specify that
different invoice Forms are used depending on the Language of the
Customer, the Access Group of the user or the number sequence in which the
Invoice Number falls. It is also possible to specify that more than one Form is
to be printed (for example, you might require that a Delivery Note is printed
with each Invoice).

The ‘Define Document’ function is available for many of the documents
printed by Hansa, allowing a high level of flexibility in the production of
printed output from Hansa. Further details are given in the chapters of this
manual covering the individual modules.
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Related Items

The Printers setting in the System module is used to inform Hansa of the
different printers available in your network. Once this has been done, the
‘Define Document’ function can be used to specify which printer is to be
used when printing a particular Form.

The Styles setting, also in the System module, is used to define the various
type styles, fonts, etc available for use when designing Forms.

The Activity Register
Please refer to Volume 6 of these manuals for full details of this register.
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Maintenance

Introduction

Maintenance functions tend to be used to carry out certain updating tasks,
usually involving batch processing and encompassing all or many of the
records in the affected register. There are four such functions available in the
System module. To use them, select ‘Maintenance’ from the File menu. The
following window appears—

Double-click the chosen option. A specification window will then appear,
where you can decide how the function is to operate. Click [Run] to operate
the function.

Create N/L Transactions

The integration between Hansa's different modules means that Nominal
Ledger Transactions can be generated automatically from other ledgers and
modules (‘Sub Systems’). For example, approving an Invoice in the Sales
Ledger can cause the automatic generation of a Nominal Ledger Transaction
debiting a Debtor Account and crediting a Sales Account and, if appropriate,
a VAT Account. This feature is controlled using the Sub Systems setting in
the Nominal Ledger.

If you are not using this feature, this function allows you to create appropriate
Nominal Ledger Transactions in batches from different Sub Systems.
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Select a Sub System from which Nominal Ledger Transactions are to be
created by clicking one of the radio button options. You should first
temporarily turn on the equivalent option in the Sub Systems setting. If you
wish to create Transactions for a particular range of Sub System records,
specify this in the Ser No field. In the illustration, Nominal Ledger
Transactions will be created for Goods Receipts numbers 6020 to 6030.

If a Sub System transaction contains an error, an error message will be shown
and the routine will be stopped.

Nominal Ledger Transactions will not be created for unapproved Sub System
transactions.

Delete Old Transactions

This option allows you to remove old transactions from the database, for
example when they are no longer needed for accounting or statistical
purposes.
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Select one or more registers from which records are to be deleted. Only
transactions which fall within the specified time period and/or number range
will be removed. No records later than the Delete Before Date specified in
the Locking setting in the System module will be deleted.

In some cases, a record will not be deleted even if its date is earlier than the
Delete Before Date. For example, Invoices and Purchase Invoices will not be
deleted if they have not been paid or if the payment was received or issued
after the Delete Before Date.

Use this feature with great care, and
make sure you have a backup before
you remove any data.

Send and Receive E-Mail

This function is a duplicate of the ‘Send and Receive E-Mail’ function on the
Operations menu of the Master Control panel. You should use it to send a
receive email in a single-user system. Depending on how your computer has
been configured, you may have to establish a connection to the internet first.
All Mail in the Queue will then be sent, and any incoming mail will be
downloaded from your POP3 account as well. Please refer to Volume 6 of
these manuals for full details.

Update Fax Numbers

This function can be used to remove spaces and dashes from all fax numbers.
This will be necessary if you will be sending faxes through the fax server, in
which case fax numbers should not contain non-numeric characters. The fax
numbers affected are those in the Customer, Contact Person and Supplier
registers.

!
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Remove from Fax No.

Enter here a character or string of characters that you
want to be removed from the start of all Fax Numbers.
Blanks and dashes will be removed irrespective of
whether you have made an entry to this field.

Documents
A single document can be printed from the System module: please refer to
the description of Hansa’s Mail facilities in Volume 6 of these manuals for
full details.
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Reports

Introduction

As with all modules, to print a report in the System module, select ‘Reports’
from the File menu or click [Reports] in the Master Control panel. The
keyboard shortcut Ctrl-R or z-R can also be used. Then, double-click the
appropriate item in the list.

The following reports are available in the System module—

A specification window will then appear, where you can decide what is to be
included in the report.

Using the options at the bottom of the specification window, determine the
print destination of the report (the default is to print to screen). You can
initially print to screen and subsequently send the report to a printer by
clicking the Printer icon.

Once you have entered the reporting criteria and have chosen a print
destination, click [Run].

With a report in the active window, the ‘Recalculate’ command on the
Operations menu can be used to update the report after making alterations to
background data. The ‘Reopen Report Specification’ command on the same
menu can be used to update the report using different reporting criteria.
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Activities, Persons

This report can also be found in the CRM module. Please refer to the ‘CRM’
chapter in Volume 6 of these manuals for full details.

Company Info

This report is effectively a print-out of the Company Info setting. It also
shows licensing information such as the Control String and Control Code. It
is sometimes necessary to print this report when applying to your local Hansa
representative for an Enabler key.

Exchange Rates

Please refer to the ‘Multi-Currency’ chapter in Volume 2b for full details of
this report.

Person List

This report lists the records in the Person register. As well as each Person’s
initials and name, the Sales Group, Job Group, Job Description, Cost and
Price per Hour, Bank Account details and Email Address are shown.

User Paste Special Person register, System module

Range Reporting Alpha

Enter a Person’s initials (or a range or initials) to report
on that member of personnel only.

Record Checking

This report is used for system maintenance.
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System Documentation

System Documentation produces a number of lists showing the records that
have been entered to certain settings. it can thus be used to describe the
contents and set-up of your system. It may be a good idea to check the
contents of your system from time to time. This report is also useful for
auditing purposes since it contains important system information to be
included in a professional audit, such as lists of Objects and Object Types
and the Chart of Accounts.

Select ‘System Documentation’ in the ‘Reports’ list in the System module.
The ‘Specify System Documentation’ window is opened.

Click the check boxes for each option that you would like to be included in
the report and click the [Run] button in the Button Bar.

Transaction Checking

This report provides a list of unapproved Sub System transactions (i.e. those
for which Nominal Ledger Transactions have not been generated).

User Activities

Please refer to the ‘CRM’ chapter in Volume 6 of these manuals for a
description of this report.
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Imports
The ‘Imports’ function provides for the importing of data from tab-delimited
text files exported by other Hansa databases or Companies, or from other
applications such as spreadsheets. It also imports the encrypted back-up files
created by the ‘Company Text Backup’ and ‘Database Text Backup’ Export
functions. The function is selected using the ‘Imports’ item on the File menu.

On selecting the ‘Imports’ function from the File menu, an ‘Imports’ list
window appears. There are two import options in the System module:
double-click one to start the import process. An ‘Open File’ dialogue box will
appear, asking you to locate the file to be imported. Click [Open] and the
import will begin.

Automatic

The ‘Automatic’ import can be used to import from text and encrypted files
created by any of Hansa’s export functions. It determines from information
contained in the first line of such files what the file contains and thus in
which register the information is to be saved.

The function will therefore be used in the event that it is necessary to restore
from a back-up. This process is described in the next section of this chapter.
It will also be used to import information to a Company holding the
consolidated accounts of several subsidiaries.

A further use will be to import set-up information such as a Chart of
Accounts and base register data such as Customers and Suppliers, thus
ensuring that the task of accurately entering this information need only be
undertaken once.

Finally, the function can also be used to import data exported from other
systems, after appropriate formatting. For further details, please contact your
local Hansa representative.
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Automatic, manual file search

This import is similar to the ‘Automatic’ import described above in that it can
be used to import from files created by any of Hansa’s export functions. The
only differences are—

• It allows you to import files from anywhere on your hard disk or on your
network, while files imported by the ‘Automatic’ function have to be
located in the “Backup” or “Setup” folders in the same folder as the
Hansa application.

• It allows you to import files with any filename. The ‘Automatic’ function
is restricted to files named using the DOS naming convention (i.e. a
maximum of eight characters followed by a three character extension).

• Comments inserted in the back-up files are not visible when using the
‘Automatic, manual file search’ function, so be certain that you are
selecting the correct file to be imported. These comments can be seen
when using the ‘Automatic’ import.

To use the function to restore from a back-up, follow the procedure below.
To import data exported from other systems, after appropriate formatting or
from other Companies in your Hansa database, follow the procedure as
described below, but omit steps 1 and 2. If you have more than one
Company, ensure you are in the correct one before importing.

1. Move the old database (named “Hansa.HDB”) to another
folder/directory, to avoid mixing things up. Rename it so that you know
what it contains.

2. Delete the database file “Hansa.HDB” from the folder or directory with
your Hansa application, but make sure that the “DBDef.txt” and
“Default.txt” files are present in that folder. Double-clicking the Hansa
application now will force it to create a new database.

It is important to restore to a new,
empty database, to avoid mixing the
restored data with the old, damaged
database.

3. In the System module, choose ‘Imports’ from the File menu.

4. Select ‘Automatic, manual file search’ and press the Enter key (or
double-click on ‘Automatic, manual file search’).

!
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In most operating systems, Hansa opens a standard dialogue box with a
list of the files in the current folder of the current volume. To find the
back-up file, scroll through the list or select another folder or volume in
the normal way.

In some operating systems (e.g. Macintosh OS X), Hansa uses its own
file dialogue window—

When the file dialogue window is first opened, the main part of the
window shows the contents of the folder containing your Hansa
application. Folder names are shown in angled brackets <>. Double-click
a folder name to see its contents. Double-click the first item in the list (..)
to go up one level. Click the [Desktop] button to go to your desktop, and
the [Backup] button to enter the Backup folder that is inside the folder
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containing your Hansa application. This has been done in the illustration
above.

5. Once you have found the file you want to import (the back-up to which
you wish to revert), highlight it and click [Open] or [Select] (depending
on the operating system), or double-click on the name of the file.

6. A message window informs you about the progress of the import.

7. When the import has finished, Hansa will shut down for reasons of
security if the imported file contains any Person register records. Restart
the program and you will then be ready to continue working. If you
imported the file to a brand new database (i.e. you were restoring from a
back-up file), you will need to re-enter your database key to the Enabler
setting.

Copy the old database to another
folder/directory or remove it, to avoid
mixing things up.!
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Exports

Introduction

You can export several different types of data from Hansa. The exported data
can be used by external programs such as spreadsheets, word processors etc.
Apart from those created by the Back-up functions, all exports are output in
simple text format, with fields separated by tabs.

To produce an export file, select the ‘Exports’ item on the File menu or click
the [Exports] button in the Master Control panel. The window illustrated
below appears. This lists the Exports which can be produced from the System
module. Double-click the appropriate item in the list. A specification window
will then appear, where you can decide the contents of the exported file.
Click [Run] and a ‘Save File’ dialogue box will appear, where you can name
the file and determine where it is to be saved.
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Company Text Backup, Database Text Backup

These functions provide an effective way to back up your data. They copy all
data from the program to a separate file. It is also possible to copy or
duplicate the database file as it appears on your hard disk, but Hansa’s
method has two advantages—

• The back-up file takes up very little space.

• The back-up file is independent of the program version. IT CAN
ALWAYS BE USED, whereas a new version of the Hansa program (for
reasons of internal updates in the program) may have difficulties in
reading old database files.

Use Hansa’s built-in back-up feature
to guarantee a successful restoration.

This is how you back up your data—

1. In the System module, select ‘Exports’ from the File menu or click the
[Exports] button in the Master Control panel. The ‘Exports’ list opens.

2. Select ‘Company Text Back-up’ (if you wish to back up the data in the
database relating to the single Company currently selected) or ‘Database
Text Back-up’ (if you wish to back up the whole database) from the
‘Exports’ window and press the Enter key.

Usually the ‘Database Text Back-up’ option should be used, as this is the
only choice that backs up the entire database. You must use it regularly
for your safety and peace of mind. Some registers and settings (e.g. the
System Usage setting, Mailboxes and Conferences) are stored at
database level, not Company level. These will not be exported by the
‘Company Text Back-up’ option, even if your database only contains a
single Company. The ‘Company Text Back-up’ option is intended for
use in the situation where you need to move all the information relating
to a specific Company from one database to another.

In a multi-user system, the ‘Database Text Back-up’ option cannot be
used on a client machine. It can only be used on the server machine,
when no other user is logged in. On the server, select ‘Quit, Remove
Autoserver’ from the File menu and restart Hansa. Then, choose the
System module using the Modules menu. If it is not convenient to work
from the server, use the ‘Run Timed Backup’ option described below.
This will be the case if your server does not have a graphical interface, or
if it is in another room or building.

!
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3. The “Specify Text Backup” window appears where you can describe the
back-up file using up to 40 characters. This description will be shown in
the list of importable files shown by the ‘Imports’ function. Click [Run]
to proceed.

4. In most operating systems, Hansa opens a standard dialogue box where
you can name and place the export file. Enter the name of the file in the
filename area and locate it in the appropriate directory in the usual way.

The name of the back-up should include the date the back-up was made
(e.g. TC0711 for Training Company and date), but remember that you
can use a maximum of eight characters if you are using Windows NT
version 3 and/or if you are intending to restore from the back-up file
using the ‘Automatic’ function (the ‘Automatic, manual file search’
function can import files with names of any length). Then, click [Save].

It is recommended that the back-up file be stored in a folder or directory
named “Backup” which should be in the same folder or directory as the
Hansa application. All back-up files in this folder will be shown in a list
of importable files if it becomes necessary to restore from a back-up.
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In some operating systems (e.g. Macintosh OS X), Hansa uses its own
file dialogue window—

When the file dialogue window is first opened, the main part of the
window shows the contents of the folder containing your Hansa
application. Folder names are shown in angled brackets <>. Double-click
a folder name to see its contents. Double-click the first item in the list (..)
to go up one level. Click the [Desktop] button to go to your desktop, and
the [Backup] button to enter the Backup folder that is inside the folder
containing your Hansa application. This has been done in the illustration
above.

5. A message window informs you about the progress of the export.

6. When the export is finished, you are brought back to the ‘Exports’ list.
Close it using the close box.

Make a rule to take a safety back-up
EVERY DAY! Your database can be
damaged, through hardware failures,
power cuts and other reasons. A
back-up file is a safety guarantee
against loss of data and loss of work,
should anything go wrong.

Note that, for reasons of security and unlike the other export files produced
by Hansa’s Export functions, the files created by the ‘Company Text Backup’
and ‘Database Text Backup’ functions are encrypted files, not text files.

!
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Restoring from a Back-up

To restore from a back-up, you must first create a new database. Then import
the back-up file using the ‘Imports’ function on the File menu in the System
module.

Restoration from a safety back-up is a non-destructive process, i.e. the back-
up file is not affected by the reading process. This means that you can use the
same back-up file more than once.

Restoring from a back-up is done in the following way—

1. Move the old database (named “Hansa.HDB”) to another
folder/directory, to avoid mixing things up. Rename it so that you know
what it contains.

2. Delete the database file “Hansa.HDB” from the folder or directory with
your Hansa application, but make sure that the “DBDef.txt” and
“Default.txt” files are present in that folder. Double-clicking the Hansa
application now will force it to create a new database.

It is important to restore to a new,
empty database, to avoid mixing the
restored data with the old, damaged
database.

3. In the System module, choose ‘Imports’ from the File menu. The
‘Imports’ window is shown.

4. Select ‘Automatic’ and press the Enter key (or double-click on
‘Automatic’).

Hansa opens a list of back-up files. To be included in this list, a back-up
file can be stored in the “Backup” or “Setup” folder or directory, which
should be in the same folder or directory as the Hansa application.

In the list, the filename of each back-up file is shown together with the
date it was saved and any comment added when it was created (see step
3 in the previous section).

!
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5. Highlight the file you want to import (the back-up to which you wish to
revert) and press the Enter key (or double-click on the name of the file).

6. A message window informs you about the progress of the import.

7. When the import has finished, Hansa will shut down for reasons of
security if the imported file contains any Person register records. Restart
the program and you will then be ready to continue working. If you
imported the file to a brand new database (i.e. you were restoring from a
back-up file), you will need to re-enter your database key to the Enabler
setting.

Copy the old database to another
folder/directory or remove it, to avoid
mixing things up.!
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If the Restoration Appears to Fail

There are certain circumstances in which Hansa will show files in the list of
available back-up files, but not be able to import them successfully. This will
occur on both Macintosh and Windows machines if the filename does not
comply with the DOS naming convention (i.e. a maximum of eight characters
followed by a three character extension). If the name of your back-up file
does not comply with this convention (or it is not shown in the list of
available files because it is not stored in the “Backup” or “Setup” folder or
directory), continue with these steps—

1. If it is still open, close the list of available import files using the close
box.

2. In the System module, choose ‘Imports’ from the File menu. The
‘Imports’ window is shown—

3. Select ‘Automatic, manual file search’ and press the Enter key (or
double-click on ‘Automatic, manual file search’).

In most operating systems, Hansa opens a standard dialogue box with a
list of the files in the current folder of the current volume. To find the
back-up file, scroll through the list or select another folder or volume in
the normal way.
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In some operating systems (e.g. Macintosh OS X), Hansa uses its own
file dialogue window—

When the file dialogue window is first opened, the main part of the
window shows the contents of the folder containing your Hansa
application. Folder names are shown in angled brackets <>. Double-click
a folder name to see its contents. Double-click the first item in the list (..)
to go up one level. Click the [Desktop] button to go to your desktop, and
the [Backup] button to enter the Backup folder that is inside the folder
containing your Hansa application. This has been done in the illustration
above.

4. Once you have found the file you want to import (the back-up to which
you wish to revert) and click [Open] or [Select] (depending on the
operating system), or double-click  the name of the file.
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A message window informs you about the progress of the import.

5. When the import has finished, Hansa will then close for reasons of
security if the back-up file contains at least one record in the Person
register. Restart the program and type your database key in to the
Enabler setting: you will then be ready to continue working.

Client Text Backup

This function is used on client machines for backing up information that is
stored locally. This information will not be included in the normal daily back-
up file made from the server. As very little is stored locally, the resulting
back-up file will usually be very small. For example, window settings saved
by each user using the ‘Save Normal Position’ (Windows)/‘Save’
(Macintosh) functions on the Window menu (i.e. window positions, sizes and
sort orders) are stored on the client machines. Company information is also
stored on client machines, so if there are several Companies in a client (i.e. it
is capable of logging on to several servers), then it is advisable to create a
Client Text Backup periodically.

If the local machine has not been backed up before, a second Company must
be created, to be used for backing up only. Follow these steps—

1. Select ‘Company’ from the File menu. The ‘Select Company’ window
appears. Select ‘Open Company Register’ from the Operations menu.

2. The ‘Companies: Inspect’ window appears. On the second row, enter a
new Company. This should be a local Company, so leave the TCP/IP and
Port fields blank.

3. Save the new Company by clicking the [Save] button in the Button Bar.
For security reasons, Hansa quits automatically. Restart Hansa, and
choose to use the new, second, Company. You might wish to enter a
single record in the Person register with a password, again for security
reasons.

If the local machine has been backed up before and the second Company
already exists, you must log off from the server and change to the second
Company before backing up. Follow these steps—

1. If you are on the logged on to the server, quit Hansa.

2. Restart Hansa and choose to use the second Company. You cannot
change Companies using the ‘Company’ function on the File menu
because the two Companies are on different machines.
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In both cases, you can now back up the local machine. Change to the System
module using the Modules menu, select ‘Exports’ from the File menu and
double-click the ‘Client Text Backup’ option. From here, this option operates
in a similar fashion to the ‘Company’ and ‘Database Text Backup’ functions
described in the previous section, and, like them, creates an encrypted file,
not a text file.

Restoring from a Client Text Back-up

Whenever you upgrade to a new version of Hansa, the new version should be
installed on the server and all clients, as described in the first chapter of this
manual. If there are several Companies in the client (i.e. it is capable of
logging on to several servers), it will probably be easier for you to recreate
them by importing the Client Text Backup file into the new client database
rather than by typing them in to the Company register manually. Also, if
special window settings have been saved on a local machine, you may want
to ensure these are still used after the upgrade. To do this, you should import
the Client Text Backup file that you created from the old version following
the instructions above. If you do not have any special window settings and if
the Company register is easy to recreate manually, there is no need to import
a Client Text Backup file, because no other important information is stored
locally.

Importing a Client Text Backup is done on the client machine in the usual
way. Install the new version of Hansa on the client, ensure there is no
Hansa.HDB file in the folder containing the program and start the program. If
the ‘Import files available’ window appears, import the Client Text Backup
from there. Otherwise, change to the System module using the Modules
menu, and select ‘Imports’ from the File menu.

System Data

This function can be used to export basic information from a database. This is
a practical tool when you want to create a new Company which will use the
same basic accounts structure as your existing ones.

You can save much work by simply copying repeated data such as the Chart
of Accounts and afterwards changing whatever is different between the two
Companies.

The System Data export is saved as an ordinary text file and is imported to
the new Company using the ‘Automatic’ or ‘Automatic, manual file search’
Import functions in the System module (described earlier in this chapter).
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Select ‘Exports’ from the File menu in the System module and double-click
‘System Data’ in the ‘Exports’ list. The ‘Specify System Data Export’
window is opened—

Check the boxes to determine the data to be exported. Use the Backup
Comment to describe the back-up file (up to 40 characters are permitted).
This description will be shown in the list of importable files shown by the
‘Imports’ function. Click [Run] to proceed. Hansa will open a dialogue box
where you can name the export file and specify where it is to be saved.

Enter a name for the file and click [Save] or press the Enter key.

A message window informs you about the progress of the export. The process
can be interrupted at any time by pressing Esc (Windows) or z-Period
(Macintosh).

When the export has finished, you may close the ‘Exports’ window with the
close box.

Base Registers

In a similar manner to the ‘System Data’ export described above, this
function allows you to export the records from any base register except those
related to Items. To export these, use the ‘Item Base Registers’ export
described below.

Some of the registers in the ‘Specify Base Registers Export’ window may not
be used in your version of Hansa. An attempt to export information from
registers not present will result in an empty file.
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Select one or more options and use the Backup Comment to describe the
back-up file (up to 40 characters are permitted). This description will be
shown in the list of importable files shown by the ‘Imports’ function. Click
[Run] to proceed. If you have selected a single register, you may export a
selection of records in that register by specifying a code range in the Code
field. Then, give a name and destination to the file and click [Save].

Files created by this export can be imported to other Hansa Companies or
databases using the ‘Automatic’ or ‘Automatic, manual file search’ import
functions in the System module.
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Item Base Registers

In a similar manner to the ‘System Data’ export described above, this
function allows you to export the records from any base register related to
Items.

Some of the registers in the ‘Specify Base Registers Export’ window may not
be used in your version of Hansa. An attempt to export information from
registers not present will result in an empty file.

Select one or more options and use the Backup Comment to describe the
back-up file (up to 40 characters are permitted). This description will be
shown in the list of importable files shown by the ‘Imports’ function. Click
[Run] to proceed. If you have selected a single register, you may export a
selection of records in that register by specifying a code range in the Code
field. Then, give a name and destination to the file and click [Save].

Files created by this export can be imported to other Hansa Companies or
databases using the ‘Automatic’ or ‘Automatic, manual file search’ import
functions in the System module.
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Transaction Registers

In a similar manner to the ‘System Data’ and ‘Base Registers’ functions
described above, records in Hansa’s transaction registers can be exported.
Just as is the case with the Base Registers, if your installation does not use
some of the registers,  an attempt to export data from a register that is not
present will result in an empty file.

Select one of the options, enter a Backup Comment to describe the back-up
file (up to 40 characters are permitted) and click [Run]. You may export a
selection of records in a particular register by specifying a code range in the
Ser No field. Then, give a name and destination to the file and click [Save].

Files created by this export can be imported to other Hansa Companies or
databases using the ‘Automatic’ and ‘Automatic, manual file search’ import
functions in the System module.

Transaction Registers (Period)

This export allows you to export all records within selected transaction
registers for a certain time period. Hansa has a multi-year database, where all
transactions are saved in full. After a few years, as the database grows, the
time required to create a back-up increases. With this feature, you can reduce
the time needed to carry out the daily back-up by only backing up those
transactions that fall within a specified period, for example the current year
only. If using this function, you should ensure you create a full back-up at the
end of the previous financial year. To restore the database, you should import
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two files: the “historical” archive back-up, and the most recent back-up file
from the current year. In both cases, use the ‘Automatic’ or ‘Automatic,
manual file search’ import functions in the System module.

To use this feature, check the registers you need to back up, set the time
period and use the Backup Comment to describe the back-up file (up to 40
characters are permitted). This description will be shown in the list of
importable files shown by the ‘Imports’ function. Click [Run] to proceed.

Then, give a file name and destination to the file and click [Save].

Raw Data

This export is used for system maintenance, and requires a Hansa system
expert to be used correctly.

If the database has somehow become damaged, you will be prompted to
create a Raw Data export. You should do so, and you should then attempt to
create a Database Text Backup as well. The Raw Data option exports data in
byte order, while the Database Text Backup exports data in record order, on a
register-by-register basis.

A Raw Data export can be imported in the usual way, using the ‘Automatic’
or ‘Automatic, manual file search’ options. However, because of the way the
Raw Data export file is structured, no indexes will be created. Therefore, as
soon as the Raw Data file has been imported, you must immediately create a
Database Text Backup and import that file to a new database. This will
ensure the data is properly indexed.
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Run Timed Backup

Hansa contains a timed back-up feature whereby a database back-up file can
be created automatically every day. To specify when the back-up files are to
be created, and where they are to be stored, use the Timed Operations setting
in the Technics module. For full details, please refer to the first chapter in this
manual.

This function can be used to create a database back-up immediately, naming
and saving the file according to the specifications entered in the Timed
Operations setting. It will not create a back-up file if you have not specified a
Backup Path in the Timed Operations setting.

In multi-user systems, this function can be used from a client machine: it is
the only way to create a ‘Database Text Backup’ from a client. It is
recommended that it is run when no other client is logged on to the server.

Settings

This function exports the contents of many settings, including Base Currency,
Languages, Reporting Periods, Round Off, Payment Modes, Credit Limit.
Freight, Account Usage S/L, Sub-ledger Control Accounts and VAT Codes.
These are all settings containing sets of preferences or where separate records
are entered in grids. To export information from other settings (those
containing discrete records, such as Payment Terms), use the System Data,
Base Registers or Item Base Registers Export functions described above.

Enter a Backup Comment if necessary and specify the Company Code of the
Company whose settings are to be exported. This does not have to be the
Company you are currently in, but you must specify a Company otherwise
the export file will be empty. Then, click [Run] to proceed.
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Index

%
% Adjustment

Price Formulae, 347

A
A/C. See Accounts or specific Accounts
Access Group

Persons, 486
Access Groups

and System Administrator, 421
Block Accounts, 422
System Module setting, 112, 415
Using to control who can change prices, 338

Access Rights. See Access Groups
Account

Persons, 167, 490
Account Customers, 159, 161, 230, 247
Account Operator

Customers, 244
Account String, 183
Account Suppliers, 165, 166
Account Usage P/L

Cash Account, 165
Creditor Account, 165, 471
Exporting, 535
On Account A/C, 165, 166
Preliminary Creditor Account, 165
Rate Gain Account, 167
Rate Loss Account, 167
Rate Round Off Account, 167
Sub-ledger Checking check box, 471
VAT Cash Discount Account, 167
VAT Code, 164

Account Usage S/L
Bad Debtor Account, 230
Cash Account, 159, 230
Customs Cost Account, 170
Debtor Account, 159, 230, 471
Exporting, 535, 541
Freight Cost Account, 170
On Account A/C, 159, 161, 230, 231, 248

Purchase Control Account, 282
Rate Gain Account, 162
Rate Loss Account, 162
Rate Round Off Account, 162
Round Off Account, 160, 463
Sales Account, 158, 253, 279
Stock Account, 160, 169, 281
Stock Cost Account, 160, 280, 306
Sub-ledger Checking check box, 471
Use Credit Sales Accounts check box, 280,

305, 306
VAT Cash Discount Account, 162
VAT Code, 159, 253, 280
Write Offs Account, 162

Accounting Periods. See Fiscal Years and
Locking

Accounting Systems
Changing, 209

Accounts
Browse Window, 494
Changing to reflect Language of reports, 498
Excluding from Nominal Ledger report, 422
Exporting, 535
Importing a Basic Template, 51
Introduction to, 154
Modifying, 495
Moving Balances to other Accounts, 428
Preventing Direct Use of in N/L, 471
Printing, 521
Setting up a Basic System, 52
System Module register, 493
VAT Code, 164

Active Users
System Module setting, 423

Active Window, 84
Activities

Changing Activity Types, 430
Creating from Customers, 259
Deleting, 516
Exporting, 539
System Module register. See Volume 6

Activities, Persons
System Module report. See Volume 6
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Add 1
Price Formulae, 347

Add 2
Price Formulae, 347

Address
Customers

Naming individual address lines, 236
Address Labels

Printing for Customers, 263
Admin Client, 55, 483
Alcohol %

Items, 296
Allow FTP Access check box

Customers, 61, 248
Persons, 61, 486

Allow Login check box
Customers, 248

Alternative Code
Items, 304

Amounts in Words
Defining, 473

ANA Code
Company Info, 425
Customers, 246

Analytical Balance
Defining Group Accounts, 497

Archives, 140, 148
Creating, 140, 148
Naming, 142
Removing, 142, 151
Renaming, 150

Area
Selling Items by, 298

Assembly. See Structured Item
Asset Status

Exporting, 539
Assets

Exporting, 536
Attach File

Operations menu command, Attachments, 136
Attachments, 135

Changing Names, 138
Copying, 140
Files, 136
Notes and Comments, 137
Organising, 140
Reading, 136, 137, 147
Record menu command, 121

Records, 138
Removing, 139

Attachments button, 135
Auto Actions

System Module setting, 423
Auto Connect Server IP

Program Mode, 453
Auto Connect Time

Program Mode, 454
Automatic

System Module Import function, 522
Automatic, manual file search

System Module Import function, 74, 523, 532
Autotransactions

Exporting, 535
Printing, 521
Unexpected results, 437

B
B/FW Balances. See Brought Forward Balances
Backing Up, 66, 527

Automatic, 68
Using Specialist Software, 70

Back-up
Restoring from, 72, 523, 530

Bad Debtor Account
Account Usage S/L, 230

Bad Debtors Account
Customer Categories, 230

Balance Sheet, 195
Bank 1, Bank 2

Company Info, 425
Bank Account

Customers, 244
Persons, 490
Setting Default, 161, 167

Bank Customer ID
Company Info, 43, 425

Bank Name
Persons, 490

Banks. See also Account Operator
Exporting, 536
Purchase Ledger setting, 244

Bar Code
Ensuring Unique Value for Each Item, 304,

313
Items, 304



Hansa Financials and HansaWorld

546

Setting Length, 304, 313
Bar Code Length

Item Settings, 304, 313
Bar Tabs

Exporting, 539
Base Currency

Exporting, 536, 541
System Module setting. See Volume 2b

Base Currency Rates
Exporting, 536
System Module setting. See Volume 2b

Base Price
Changing in batches, 336
Changing using Formulae, 342
Controlling Changes, 338
Date of Last Change, 290
Items, 284, 290, 344, 346
Preventing Changes, 290, 314

Base Price Change
Items, 290

Base Price Changes
Stock Module setting, 336

Base Registers
System Module Export function, 536

Base Value
Price Formulae, 347

Batch Level
Serial Number Tracking, 295

Batch Status
Showing in Serial Number ‘Paste Special’

Lists, 314
Best Before Dates

Showing in Serial Number ‘Paste Special’
Lists, 314

Block Accounts
Access Groups, 422

Bonus
Calculating for Salesmen from Items, 291
Persons, 489

Bonus %
Items, 291

Bonus, Salesman
Sales Ledger report, 291, 489

Branch Identifier
Intrastat, 425

Brought Forward Balances. See also Opening
Balances
Nominal Ledger register, 211

Browse Window, 84
Accounts, 494
Button Bar, 85
Buttons, 486
Customers, 238
Items, 287
Persons, 484
Scrolling, 85
Searching, 86
Sorting Data, 85

Budget Keys
Exporting, 535
Printing, 521

Budgets
Exporting, 535
Printing, 521

Building Societies. See Account Operator
Button Bar

in Browse Windows, 85
in Record Windows, 89

Buttons
Attachments, 135
Calendar, 80
Cancel, 91
Chat, 81
Conferences, 81
Documents, 82
Duplicate, 86, 91
Exports, 82
Hansaworld.com, 75, 83
in Browse Windows, 486
Login, 80
Mailbox, 80
New, 85, 91
Next Record, 89
Preview, 91
Previous Record, 89
Reports, 81
Resources, 81
Save, 91
Select Module, 81
Settings, 82
Tasks, 80
The Printer, 90
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C
Calculate Price Lists

Pricing module function, 345, 348, 351, 354
Calendar

Defining Week Numbers, 480
Opening from Person register, 492
Operations menu command, Persons, 492

Calendar button, 80
Cancel

Record menu command, 118
Cancel button, 91
Carriage. See Freight Charges
Cash Account

Account Usage P/L, 165
Account Usage S/L, 159, 230
Setting Default, 161, 167

Cash Customers, 159
Cash In

Exporting, 539
Cash Out

Exporting, 539
Cash Transactions

Common Number Series, 245
Century, 436
Change History. See History
Change Password

Operations menu command, Customers, 257
Operations menu command, Master Control

Panel, 83
Operations menu command, Persons, 491

Changing Accounting Systems, 209
Character Set

Company Info, 426
Chart of Accounts, 179, 181

Exporting, 535
Printing, 499, 521

Chat button, 81
Cheques

Defining Amounts in Words, 473
Class. See Classification.
Classification

Customers, 242
Items, 292, 326, 330

Client
Logging on, 58

Client machines
Creating a Database Text Backup, 541

Client Text Backup
System Module Export function, 534

Closed check box
Customers, 247
Items, 289
Objects, 184
Persons, 486

Closing
Months and Periods, 442

Closing Hansa, 62
Code

Company, 40
Comment

Customers, 252
Invoices, 243
Persons, 490
Sales Orders, 243

Comments
Attaching to Records, 137
Attaching to the Personal Desktop, 147
Printing, 137
Reading, 137, 147
Removing, 139

Commercial Reg No
Company Info, 425

Commodity/EAN Code
Items, 305

Common Number Series, 245
Companies

Adding, 46
Changing, 482
Creating, 39
Number of, 45
Reporting on, 520
Sharing information between, 133
System Module register, 39, 46, 53, 58, 104,

130, 481
Transferring Information by Dragging and

Dropping, 94
Working with, 130

Company, 35
Code, 40
Encryption Key, 53, 58
File menu command, 53, 104
Name, 40
Opening, 36
Opening Automatically on Start Up, 57
Port, 58
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Selecting, 41, 53, 58, 104
Short, 40
TCP/IP, 58

Company Info
ANA Code, 425
Bank 1, Bank 2, 425
Bank Customer ID, 43, 425
Character Set, 426
Commercial Reg No, 425
Country, 425, 479
DB Encoding, 427
Default Mail Encoding, 427
Edit Font, 43, 427
Exporting, 535
Language, 427, 478
Report Font, 43, 427
Report Font Size, 427
System Module report, 520
System Module setting, 42, 424
VAT Law, 426
VAT Law Code, 44

Company Name
Changing, 42

Company Registration Number. See Registration
Number

Company Text Backup
System Module Export function, 527

Components
Displaying on Orders/Invoices, 302

Conferences button, 81
Contact Persons

CRM register, 242
Exporting, 536
Removing blanks and dashes from Fax

Numbers, 517
Contacts

Creating from Customers, 258
Contents of Hansa Directory/Folder, 32
Continuous Stationery, 510
Contract Item

Items, 303
Contract Quotations

Exporting, 539
Contracts

Creating from Invoices, 303
Discount, 440
Exporting, 539

Control String
System Usage, 48

Conversion 1 and 2
Items, 297

Conversions - Accounts
System Module setting, 428

Conversions - Activity Types
System Module setting, 430

Conversions - Currency Codes
System Module setting, 433

Conversions - Customer Classifications
System Module setting, 434

Conversions - Customers
System Module setting, 433

Conversions - Items
System Module setting, 434

Conversions - Master
System Module setting, 428, 430, 433, 434

Copies
Operations menu command, Forms, 510
Printing Several, 113

Copy
Edit menu command, 116

Copying Records. See Duplicate
Cost Account. See also Purchase Account

Item Groups, 160, 280
Items, 160, 306
Setting Default, 159
Suppliers, 163
Updating after Invoicing, 159

Cost Accounting, 180
Switching on, 159
Use Item Groups for Cost Accounts check

box, 160, 281, 282, 306
Cost Bearer, 181
Cost Centre, 181
Cost Model

Item Groups, 283
Sales Ledger setting, 283
Setting Default for Items, 289

Cost Price
Changing using Formulae, 343
Date of Last Change, 300
Items, 284, 300, 344
Most Recent, for Items, 300, 301
Setting Default for updating method for new

Items, 302, 315
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Updating For Items from Goods Receipts, 178,
301

Cost Price Change
Items, 300

Countries
Formatting VAT Numbers, 254, 478
System Module setting, 252, 435

Country
Company Info, 425, 479
Customers, 252

Create Activity
Operations menu command, Customers, 259

Create Contract
Operations menu command, Invoices, 303

Create Interest Invoices
Sales Ledger function, 247

Create Mailbox
Operations menu command, Persons, 492

Create Nominal Ledger Transactions
System Module function, 515

Create Purchase Item
Operations menu command, Items, 312

Create Purchase Orders
Sales Orders function, 293

Create Random Password Mail
Operations menu command, Customers, 260

Creating Records, 85, 128
Creation Date

Customers, 241
Credit Account. See also Stock Account

Setting Default for Items, 289
Credit Limit

Customers, 246
Exporting, 541
Sales Ledger setting, 246

Credit Notes
Using different Sales Accounts, 280, 305
Using different VAT Codes, 280, 306

Creditor Account
Account Usage P/L, 165, 471
Setting Default, 165, 166
Setting Default for Suppliers, 472
Supplier Categories, 165, 472
Suppliers, 165, 472

Creditor Control Account. See Creditor Account
Credits, 167
Currencies

Changing Currency Code, 433

Exporting, 536
In Payments, 167
In Receipts, 162
System Module register, 348. See Volume 2b

Currency
Customers, 251
Most recently used, for purchasing Items, 301
Price Lists, 348

Currency Round Off
System Module setting. See Volume 2b

Current Record, 128
Customer Categories

Bad Debtors Account, 230
Debtor Account, 159, 472
Debtors Account, 230
Discount Matrix, 229, 365
Down Payment Percentage, 231
Exporting, 536
Main Classification, 334
Main Display Group, 232
On Account A/C, 230
Price List, 229, 346
Sales Ledger setting, 228, 239
Web Order Class, 231

Customer Category
Customers, 239

Customer Classifications
CRM setting, 242

Customer Labels
Designing, 265
Not Properly Aligned, 266
Printing Static Text, 266
Sales Ledger document, 263

Customer List
Sales Ledger report, 267

Customer Name
Customers, 240

Customer Number
Customers, 239

Customer Sales Statistics
Sales Ledger report, 274

Customer Statistics
Sales Ledger report, 272

Customer Status
Operations menu command, Customers, 257
Sales Ledger report, 257, 275

Customer Status Report
CRM module setting, 257
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Customer’s Item Number
Converting to your own when importing EDI

Orders, 304
Customer/Item Statistics

Sales Ledger report, 381
Customers

Account, 159, 161
Account Operator, 244
Adding extra fields, 233
Adding Items to Invoices automatically, 249,

323
Allow FTP Access check box, 61, 248
Allow Login check box, 248
ANA Code, 246
Bank Account, 244
Browse Window, 238
Cash, 159
Changing Classification, 434
Changing Customer Number, 433
Classification, 242
Closed check box, 247
Comment, 252
Country, 252
Creation Date, 241
Credit Limit, 246
Currency, 251
Customer Category, 239
Customer Name, 240
Customer Number, 239
Default Items, 249
Deleting, 256
Delivery Address, 243

Naming individual address lines, 236
Delivery Date Based On options, 244
Delivery Mode, 244
Delivery Terms, 244
Department, 240
Discount Matrix, 250, 365
Display On The Web, 255
EDI Customer check box, 248
Editing, 255
EGO Customer check box, 248
Email, 242
Entering, 206, 238
Exporting, 536
Fax Number, 241
Freight Code, 255
Freight Number, 243

Generating Activities from, 259
Generating Contacts from, 258
Interest check box, 247
Interest Rate, 246
Invoice Address, 240

Naming individual address lines, 236
Invoice To, 246
Language, 253
Last Changed, 241
Limited Access, 250
Listing those with most/least sales, 274
Listing with Discount Matrices, 385
Mailing options, 248
Main Classification, 254, 334
Mobile, 241
Objects, 241
On Account check box, 230, 247
On Hold check box, 247
Order Comment, 243
Password, 257, 260
Payment Terms, 245
Price Based On options, 251
Price List, 249, 346
Primary Contact, 242
Registration Number, 252
Reminders check box, 247
Removing blanks and dashes from Fax

Numbers, 517
Sales Group, 250
Sales Orders/Sales Ledger register, 206, 238
Salesman, 250
Short Code, 239
Sort Key, 240
Telephone Number, 241
Their Supplier Code, 246
Using Web Shop. See Web Shop Customers
VAT Code, 158, 253, 280
VAT Registration Number, 254
Warning, 252
Web Site, 242
Zone, 253, 279, 305

Cut
Edit menu command, 115

D
Data

Entering, 202
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Exporting, 82, 104
Importing, 105

Database, 35
Creating, 37
Creating (Multi-user), 52
Creation does not follow steps in manual, 49
Opening, 36
Structure, 155

Database Backup Path
Timed Operations, 70

Database Backup Time
Timed Operations, 70

Database Closing Time
Timed Operations, 71

Database key, 48
Database Opening Time

Timed Operations, 71
Database Text Backup

on Client machines, 541
System Module Export function, 527

Date and Numeric Format
System Module setting, 436

Date Formats
Year 2000, 436

Date Last Modified. See Last Changed
Date of Last Base Price Change

Items, 290
Date of Last Cost Price Change

Items, 300
Dated Price Lists, 348, 362

Selection of, 251
Dates

and Export Text Files, 437
Warning when entering accounting

transactions out of date sequence, 445
DB Encoding

Company Info, 427
DBDef.txt, 37
Debtor Account

Account Usage S/L, 159, 230, 471
Customer Categories, 159, 472
Setting Default, 159, 161
Setting Default for Customers, 230, 239, 472

Debtors Account
Customer Categories, 230

Decimal Places. See Round Off and Rounding
Rules

Decrease Available on Deliveries
Stock Settings, 310, 311

Default Company
Program Mode, 57

Default Item Group
Item Settings, 289, 313

Default Item Type
Item Settings, 294, 315

Default Items
Customers, 249
Sales Ledger setting, 323

Default Mail Encoding
Company Info, 427

Default Source
Items, 296

Defaults
Bank Account, 161, 167
Cash Account, 161, 167
Cost Account, 159
Cost Model for Items, 289
Credit Account for Items, 289
Creditor Account, 165, 166
Creditor Account for Suppliers, 472
Customs Cost Account, 170
Debtor Account, 159, 161
Debtor Account for Customers, 230, 239, 472
Delivery Date from Orders, 244
Discount Matrix for Customers, 229, 239
Freight Cost Account, 170
Item Classification for Customers, 232
Item Group, 289, 313
Item Type, 294, 315
Locations for different Persons, 490
Number Series, 199, 446, 488
Objects, 183, 186
On Account A/C for Customers, 230
Price List, 354
Price List for Customers, 229, 239
Purchase Account, 163
Purchase Account for Items, 289
Reporting Period, 463
Sales Account, 157, 220, 305
Sales Account for Items, 289
Sales Account in Credit Notes, 285
Sales Account in Invoices, 279
Stock Account, 159, 169
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Updating Cost Price, 302, 315
VAT Account, 158, 164
VAT Account in Invoices, 280
VAT Code for Credit Notes, 285
VAT Code for Items, 280, 289, 306
VAT Code for Sales, 253
VAT Code on Invoices, 220

Deficiency List
Purchase Orders/Stock module report, 294

Define Document
Operations menu command, Documents, 110

Definition of Reports
Exporting, 535

Delete Not Used Items
Sales Ledger function, 309

Delete Old Transactions
System Module function, 516

Delete Prices
Pricing module function, 355

Deleting Records, 129
Deliveries

Deleting, 516
Determining when Items are removed from

stock, 310, 311
Exporting, 539
Generating Nominal Ledger Transactions

from, 515
Delivery Address

Customers, 243
Naming individual address lines, 236

Delivery Charges. See Freight Charges
Delivery Date

Setting Default for Customers, 244
Delivery Date Based On options

Customers, 244
Delivery Mode

Customers, 244
Delivery Modes

Sales Orders setting, 244
Using to Determine layout of documents, 112,

244
Delivery Notes

Printing Automatically, 423
Printing hazardous information on, 296

Delivery Terms
Customers, 244
Sales Orders setting, 244

DemoData2003.Txt
Example Database, 33

Density
Items, 299

Department
Customers, 240

Department (of your company). See Companies
Departments

Exporting, 536
Depreciation Models

Exporting, 536
Depth

Items, 298
Description

Items, 289
Price Lists, 348

Destination
Specifying when Printing Reports, 107

Dimensions
Using to Calculate Quantity, 314

Discount
Contracts, 440
Invoices, 440, 464
Price Lists, 349
Project Budgets, 440
Purchase Orders, 464
Quotations, 440, 464
Recalculating in Invoices, 369
Sales Orders, 440, 464
Work Sheets, 440, 464

Discount Bands, 366
Discount Calculation Method, 440, 464
Discount Matrices

Exporting, 535
Pricing module register, 229, 250, 365, 367,

369
Discount Matrices List

Pricing module report, 385
Discount Matrix

Customer Categories, 229, 365
Customers, 250, 365
Setting Default for Customers, 229, 239

Disk Space, 127
Display Groups

System Module setting, 438
Display On The Web

Customers, 255
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Disposals
Exporting, 539

Do Not Allow Base Price Change check box
Item Settings, 290, 314, 338

Do Not Print Freight Labels for this Group check
box
Item Groups, 282, 423

Documents, 110, 154
Adjusting Page Setup/Magnification, 113
Attaching to the Personal Desktop, 146
Changing to reflect Delivery Mode of

transaction, 112, 244
Changing to reflect Language of Customer,

253
Changing to reflect Language of transaction,

111
Customer Labels, 263
Defining, 110
Placing in a Print Queue, 114
Printing Automatically, 423
Printing more than one Copy, 113
Printing to Specific Printers, 451
Reminder, 247
Superimposed Text, 508
System module, 518

Documents button, 82
Down Payment Percentage

Customer Categories, 231
Down Payments

Percentage, 231
Sales Orders setting, 231

Download File
Operations menu command, Attachments, 136

Drag and Drop
Using to Copy Data between Companies, 94
Using to Insert Data into Fields, 94

Drill-down in Reports, 98
Drill-down reports

Customer List, 267
Customer Status, 257, 276
Item Group List, 372
Item Statistics, 374
Stock List, 408

Duplicate button, 86, 91
Duplicating Records, 86, 128

E
EDI Customer check box

Customers, 248
EDI module, 248, 304
EDI Orders

Converting Customer’s Item Numbers to your
own, 304

Edit Font
Company Info, 43, 427

Edit Link Comment
Operations menu command, Attachments, 138
Operations menu command, Master Control

Panel, 148
Edit Menu, 115

Copy, 116
Cut, 115

EGO Customer check box
Customers, 248

Electronic Data Interchange. See EDI module
Email

Customers, 242
Email Address

Persons, 490
Employees. See also Persons

Expenses, 167
Enable Quantity Calculation check box

Item Settings, 314
Enabler

System Module setting, 48, 439
Encryption Key

Company, 53, 58
Entering Records, 85, 128
Entry Date. See Creation Date
Error Messages

A Transaction of this type already exists with a
later date, 445

Account is protected by sub-ledger control,
472

Already Registered, 354
Code not registered, 159, 164
Creditor Account missing, 165
Debtor Account missing, 159
Month checked, 443
Month locked, 443
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Preliminary Account not found, 165
Sales Account missing, 158
Transaction could not be generated, 160, 162,

167
User Limit on Server reached, 59

Escape Sequence, 507
EU VAT Sales

Sales Ledger report, 242
Example Database, 33
Exchange Rates

Exporting, 536
System Module register. See Volume 2b
System Module report. See Volume 2b

Exclude from page options
Forms, 511

Expenses
Deleting, 516
Exporting, 539

Expenses module, 167
Explode when Pasted. See Show Components on

Documents check box
Export Files

Opening in Excel, 437
Exporting Data, 82, 104
Exporting Reports to Disk, 108
Exports

Attaching to the Personal Desktop, 146
Base Registers, 536
Client Text Backup, 534
Company Text Backup, 527
Database Text Backup, 527
Item Base Registers, 538
Raw Data, 540
Run Timed Backup, 541
Settings, 541
System Data, 535
System module, 526
Transaction Registers, 539
Transaction Registers (Period), 539

Exports button, 82
Extra Cost

Items, 300

F
Fax Interval

Program Mode, 457

Fax Number
Customers, 241

Fax Numbers
Removing blanks and dashes, 517

Fax Queue
Technics Module register, 461

Fax Server
Setting Up, 456

Fax Settings
Technics Module setting, 458

Fields
in Forms, 507
Moving between, 88

FIFO, 168
Calculating Prices, 176
Using to Calculate Gross Profit, 177

File Dialogue Window, 101
File Menu, 103

Company, 53, 104
Documents, 110
Imports, 105
Page Setup, 113
Print, 90, 114
Print Queue, 114
Reports, 106
Settings, 42, 112

File Transfer Protocol. See FTP
Files.

Attaching to Records, 136
Making Available to FTP Clients, 61
Reading, 136
Removing, 139

Financial Years. See Fiscal Years
First Only

Operations menu command, Forms, 512
Fiscal Years

Ending, 193
System Module setting, 198, 440

Flips, 89
Fonts

Setting for Reports, 43
Using in Forms, 469

Forms. See also Documents
Defining Type Styles, 469
Exclude from page options, 511
Exporting, 536
Fields, 507
Frames, 507
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Lines, 507
Naming, 509
Pictures, 508
Printing, 513
Printing a specific number of copies

automatically, 510
Printing on Continuous Stationery, 510
Single- and Multi-page, 511
Superimposed Text, 508
System Module register, 110, 112, 505
Text Objects, 506

Forms Editor, 505
Frames

in Forms, 507
Freight

Exporting, 541
Freight Charges

on Web Orders, 255
Freight Code

Customers, 255
Freight Labels

Preventing Printing for certain Items, 282, 423
Printing Automatically, 423

Freight Number
Customers, 243

FTP Customers
Allowing to Log In, 61, 248

FTP Port
Program Mode, 60

FTP Server
Setting Up, 59

FTP Shared Directory
Program Mode, 61

FTP Users
Allowing to Log In, 61, 486

G
General Options

System Module setting, 440
Goods

Printing a total for, on Invoices, 285
Goods Receipts

Deleting, 516
Exporting, 539
Generating Nominal Ledger Transactions

from, 515
Stock Module register, 223

GP. See Gross Profit
GP, Orders

Sales Orders report, 177
Gross Margin

Reporting, 272
Gross Profit

Calculating from FIFO Values, 177
Including Carriage, etc, 300
Reporting, 272, 274

H
Hansa

Changing To, 209
Closing Down, 62
Importing process appears to fail, 73, 532
Installation, 26
Keyboard Commands, 103, 152
Starting, 35
Structure, 155
Structure of Registers, 19
Upgrading from Previous Versions, 75
Version Number, 127
Website, 75, 83
Work Area, 78

Hansa Directory
Contents, 32

Hansa Folder
Contents, 32

Hansa.HDB, 35
Hansaworld.com, 75
HansaWorld.com button, 83
Hazard Level

Items, 296
HDB File, 35
Height

Items, 298
Hier. Objects. See Hierarchical Objects
Hierarchical Objects, 188

Objects, 188
History

Record menu command, 121

I
ID

Persons, 489
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Importing Files
Process Appears to Fail, 73, 532

Imports
Attaching to the Personal Desktop, 146
Automatic, 522
Automatic, manual file search, 74, 523, 532
File menu command, 105
System module, 522

Initials. See Signature
Installation, 26

LinuxSingle-user, 28
Macintosh Single-user, 28
Windows Single-user, 28

Integration, 155
Workflow, 20

Interest
Charging on Late Payment, 246, 247
Exporting, 536
Sales Ledger setting, 246

Interest check box
Customers, 247

Interest Rate
Customers, 246

Internal Orders
Exporting, 539
Printing Automatically, 423

Intrastat
Branch Identifier, 425
Commodity Code, 305

Invalidate
Record menu command, 119

Invoice Address
Customers, 240

Naming individual address lines, 236
Invoice History

Viewing for each Customer, 257
Invoice Recipe

Items, 303
Invoice To

Customers, 246
Invoices, 156

Adding Items automatically, 249, 323
Cannot be Created, 446, 489
Comment, 243
Creating Contracts from, 303
Creating for Rental, 303
Deleting, 516
Discount, 440, 464

Entering, 214
Exporting, 539
Generating Nominal Ledger Transactions

from, 156, 515
Including Subtotals for Goods, Transport and

Packaging, 285
Interest for Late Payment, 246, 247
Listing Components, 302
Printing Automatically, 423
Recalculating Discount, 369
Rounding to Nearest Monetary Unit, 160
Sales Account, 157
Sales Ledger register, 219
Setting Rounding Rules for Total, 464
Setting Rounding Rules for VAT, 464
Unit Price

Preventing Changes to, 340
Updating Stock and Cost Accounts after, 159
VAT Account, 158

Item Base Registers
System Module Export function, 538

Item Classification
Setting Default for Customers, 232

Item Classifications
and Item ‘Paste Special’ list, 328
and Web Shop, 334
Stock Module setting, 232, 254, 292, 326, 334

Item Code
Price Lists, 350

Item Formula
Items, 291

Item Formula check box
Item Settings, 320

Item Formulae
Pricing module register, 316
Sales Ledger setting, 291
Using to change Base Prices, 342
Using to change Cost Prices, 343

Item Group
Items, 289
Setting Default for new Items, 289, 313

Item Group List
Stock Module report, 372

Item Groups
Adding comments to Invoices, 286
Cost Account, 160, 280
Cost Model, 283
Deleting, 286
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Do Not Print Freight Labels for this Group
check box, 282, 423

Entering, 278
Exporting, 538
Printing a List of, 372
Purchase Control Account, 282
Sales Account, 158, 279
Sales Ledger register, 278, 289, 350
Sales Ledger setting, 369
Stock Account, 160, 281
Type, 285
VAT Code, 159, 280

Item History
Operations menu command, Items, 312
Stock report, 176

Item List
Sales Ledger report, 372
Sales Orders report, 372

Item Number
Converting Customer’s Item Numbers to,

when importing EDI Orders, 304
Items, 289

Item Sales Statistics
Sales Ledger report, 377

Item Settings
Bar Code Length, 304, 313
Default Item Group, 289, 313
Default Item Type, 294, 315
Do Not Allow Base Price Change check box,

290, 314, 338
Enable Quantity Calculation check box, 314
Item Formula check box, 320
Sales Ledger setting, 313
Show Batch Status check box, 314
Show Best Before Dates check box, 314
Show Item Status check box, 311, 314
Unique Bar Code check box, 304, 313

Item Statistics
Sales Ledger report, 374

Item Status
Operations menu command, Items, 310

Item Status Report
Operations menu command, Items, 309

Item Status Window, 310
and Varieties, 410
Opening Automatically, 311, 314
Var Button, 412

Item Turnover History
Sales Ledger report, 379

Item Type
Items, 293
Setting Default for new Items, 294, 315

Item Types
Plain, 293
Service, 294
Stocked, 293
Structured, 293

Item Varieties
Changing to reflect Language of Customer,

391
Stock module setting, 390

Item Variety Groups
Stock module setting, 389

Item/Customer Statistics
Sales Ledger report, 381

Item/Quantity Statistics
Sales Ledger report, 380

Items
Adding comments to Quotations, Orders and

Invoices, 307
Adding to Invoices automatically, 249, 323
Alcohol %, 296
Alternative Code, 304
Bar Code, 304
Base Price, 284, 290, 344, 346
Base Price Change, 290
Bonus %, 291
Browse Window, 287
Calculating Bonus for Salesmen, 291
Changing Base Prices in batches, 336
Changing Base Prices using Formulae, 342
Changing Cost Prices using Formulae, 343
Changing Item Number, 434
Changing to reflect Language of Customer,

307
Charging to Projects, 291
Classification, 292, 326, 330
Closed check box, 289
Commodity/EAN Code, 305
Contract Item, 303
Conversion 1 and 2, 297
Converting into Purchase Items, 312
Cost Account, 160, 306
Cost Price, 284, 300, 344
Cost Price Change, 300
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Default Source, 296
Deleting, 309
Deleting Not Used, 309
Density, 299
Depth, 298
Description, 289
Displaying Prices and Stock Levels in Web

Shop, 255
Entering, 209, 287
Exporting, 538
Extra Cost, 300
Hazard Level, 296
Height, 298
Invoice Recipe, 303
Item Formula, 291
Item Group, 289
Item Number, 289
Item Type, 293
Last Purchase Cost, 300
Last Purchase Currency, 301
Last Purchase Price, 301
Listing those with most/least sales, 377
Markup %, 291, 353
Maximum Stock Level, 295
Minimum Stock Level, 294
Objects, 292
Offering to Web Customers, 232, 254, 292,

334
Plain option, 293
Price Factor, 291
Printing hazardous information on Delivery

Notes, 296
Recipe, 302
Rental Invoicing, 303
Sales Account, 158, 305
Sales Orders/Sales Ledger register, 209, 287
Selling by Area and Volume, 298
Serial Number Tracking, 295
Service option, 294
Setting Default for method for updating Cost

Price, 302
Setting Default for updating method, 315
Shelf Code, 296
Show Components on Documents check box,

302
Stocked option, 293
Structured Item option, 293

Treat Item as Material on Project check box.
See Volume 5

Unit, 289
Unit 2, 296
Unit Coefficient, 296
Updating Cost Price from Goods Receipts,

178, 301
Varieties, 387
VAT Code, 158, 306
Viewing Stock Status, 310
Volume, 299
Warning, 304
Warranty Months, 304
Weight, 299
Weighted Average, 284, 300
Width, 298
with calculated prices, 316

K
Key, 48
Key Financial Ratios

Exporting Definitions, 535
Printing Definitions, 521

Keyboard Shortcuts, 103, 152

L
Labels

Designing, 265
Not Properly Aligned, 266
Printing for Customers, 263
Printing Static Text, 266

Language
Company Info, 427, 478
Customers, 253
Persons, 487

Languages
Defining Amounts in Words for Printing on

Cheques, 473
Exporting, 541
System Module setting, 112, 253, 441
Using to Determine layout of documents, 111
Using to Determine text for Accounts, 498
Using to Determine text for Item Varieties,

391
Using to Determine text for Items, 307
Using to Determine text on Documents, 253



Index

559

Using to Determine text on Price Lists, 384
Last Changed

Customers, 241
Last Only

Operations menu command, Forms, 512
Last Purchase Cost

Items, 300
Last Purchase Currency

Items, 301
Last Purchase Price

Items, 301
Late Payment

Charging Interest, 246, 247
Launching Hansa, 35

Importing process appears to fail, 73, 532
Leasing Companies, 246
Limited Access

Customers, 250
Persons, 486

Limited Access module, 87, 468, 486
Lines

in Forms, 507
Linux

Multi-user Installation, 29
Single-user Installation, 28
System Requirements, 28

List Window, 100
Loading Hansa, 35

Importing process appears to fail, 73, 532
Loans, 167
Local Machine

System Module setting, 442
Location

Persons, 490
Setting Defaults for different Persons, 490

Locations
Exporting, 538
Stock Account, 160, 169, 281

Locking
Months and Periods, 442
System Module setting, 442

Logging Control
Technics Module setting, 121

Logging on to a Server, 58
Login button, 80
Lookup Table

Using to Insert Data into Fields, 91

Loss
Posting, 197

M
Macintosh

Multi-user Installation, 29
Single-user Installation, 28
System Requirements, 27

Mailbox button, 80
Mailboxes

Creating from Person register, 492
Entering, 202
Opening from Person register, 491, 492

Mailing options
Customers, 248

Main Classification
Customer Categories, 232, 334
Customers, 254, 334

Maintenance
System module, 515

Maintenance functions
Attaching to the Personal Desktop, 146
Calculate Price Lists, 345, 348, 351, 354
Create Interest Invoices, 247
Create Nominal Ledger Transactions, 515
Create Purchase Orders, 293
Delete Not Used Items, 309
Delete Old Transactions, 516
Delete Prices, 355
Send and Receive E-Mail, 517
System Message, 63
Transfer to Bad Debtors, 230
Update Fax Numbers, 517
Update Item Base Prices, 342
Update Item Cost Price, 178
Update Item Cost Prices, 343

Maintenance Window, 105
Markup %

Items, 291, 353
Master Control

File menu command, 104
Master Control Panel, 79

Calendar button, 80
Chat button, 81
Conferences button, 81
Documents button, 82
Exports button, 82
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Hansaworld.com Button, 75, 83
Login button, 80
Mailbox button, 80
Opening, 104
Personal Desktop, 143
Reports button, 81
Resources button, 81
Select Module button, 81
Settings button, 82
Tasks button, 80

Max FTP Users
Program Mode, 61

Max Level. See Maximum Stock Level
Maximum Stock Level

Items, 295
Menus

Edit, 115
File, 103
Modules, 125
Operations, 90, 125
Record, 117
Window, 126

Messages
Sending to all users, 63

Middle Only
Operations menu command, Forms, 512

Min Level. See Minimum Stock Level
Minimum Stock Level

Items, 294
Minor Currency, 475
Mobile

Customers, 241
Modified Date. See Last Changed
Modifying Records, 86
Modules

Active Module on Start Up, 420
EDI, 248, 304
Expenses, 167
Granting Access to, 45
Limited Access, 87, 468, 486
Pricing, 344
Server, 54
Stock, 167
System, 42, 414

Modules Menu, 125
Months

Locking/Closing, 442

Multi-company Capability, 35
Multi-page Forms, 511

N
N/L Accruals

Exporting, 536
Name

Company, 40
Name of Company

Changing, 42
Names of Attachments

Changing, 138
Network

Logging on, 58
New Archive

Operations menu command, Attachments, 140
Operations menu command, Master Control

Panel, 148
New button, 85, 91
New Contact

Operations menu command, Customers, 258
New Mail

Operations menu command, Attachments, 139
New Note

Operations menu command, Attachments, 137
Operations menu command, Master Control

Panel, 147
Next Record button, 89
Nominal Ledger

Entering Opening Balances, 210
Preventing Direct Use of Accounts in, 471

Nominal Ledger Report, 194
Excluding Accounts from, 422

Nominal Ledger Transactions. See Transactions
Notes

Attaching to Records, 137
Attaching to the Personal Desktop, 147
Printing, 137
Reading, 137, 147
Removing, 139

Number Format
System Module setting, 436

Number of Users, 45
Number Series

Common to transactions of all types, 245
Setting Default for each Person, 488
Setting Overall Default, 446
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Setting Overall Defaults, 199
Number Series Defaults

System Module setting, 199, 446

O
Object

Persons, 490
Object Types, 186

Exporting, 536
Nominal Ledger setting, 186
Printing, 521
Using in Profit & Loss Report, 187

Objects, 180
Closed check box, 184
Closing, 184
Customers, 241
End of Year Implications, 184
Exporting, 536
Hierarchical, 188
Hierarchical Objects, 188
Items, 292
Printing, 521
Separating, 183
Setting Default, 183, 186
System Module register, 241, 292, 500
Transactions, 183
Using in Profit & Loss Report, 184

On Account A/C
Account Usage P/L, 165, 166
Account Usage S/L, 159, 161, 230, 231, 248
Customer Categories, 230
Setting Default for Customers, 230

On Account check box
Customers, 230, 247

On Account Payments, 165, 166
On Account Receipts, 159, 161
On Hold check box

Customers, 247
Open Mailbox

Operations menu command, Persons, 491
Open Record

Operations menu command, Attachments, 139
Operations menu command, Master Control

Panel, 145, 146
Opening Balances

Entering, 209
Importing, 224

Nominal Ledger, 210
Purchase Ledger, 223
Sales Ledger, 214
Stock Control, 223

Operations Menu, 90, 125
Operations Menu (Attachments)

Attach File, 136
Download File, 136
Edit Link Comment, 138
New Archive, 140
New Mail, 139
New Note, 137
Open Record, 139
Show To Links, 138

Operations Menu (Customers), 256
Change Password, 257
Create Activity, 259
Create Random Password Mail, 260
Customer Status, 257
New Contact, 258

Operations Menu (Documents)
Define Document, 110

Operations Menu (Forms), 509
Copies, 510
First Only, 512
Last Only, 512
Middle Only, 512
PC Printer, 510
Properties, 509
Send to Back, 510
Single Page Only, 512
View All, 512

Operations Menu (Invoices)
Create Contract, 303
Recalculate Discount, 369

Operations Menu (Items), 309
Create Purchase Item, 312
Item History, 312
Item Status, 310
Item Status Report, 309

Operations Menu (Master Control Panel)
Change Password, 83
Edit Link Comment, 148
New Archive, 148
New Note, 147
Open Record, 145, 146

Operations Menu (Persons), 491
Calendar, 492
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Change Password, 491
Create Mailbox, 492
Open Mailbox, 491
To Do List, 492

Operations Menu (Reports)
Recalculate, 97
Reopen Report Specification, 97

Order Acknowledgements
Printing Automatically, 423

Order Class
Given to Web Orders, 231

Order Classes
Sales Orders setting, 231

Order Comment
Customers, 243

Orders
Listing Components, 302

Orders placed over the Web. See Web Shop
Orders

Our Ref
Persons, 489

P
Packaging

Printing a total for, on Invoices, 285
Page Setup

for Reports, 107
Paper Clip. See Attachments
Pareto Report

Customer Sales, 274
Item Sales, 377

Password
Customers, 257, 260
Persons, 83, 491

Password Security
System Module setting, 447

Passwords
Minimum Number of Characters, 447
Requiring Alpha and/or Numeric Characters,

447
Paste Classification

Stock Settings, 331
Paste Special, 91

and Access Rights, 419
Payment Methods. See Payment Modes
Payment Modes

Exporting, 535, 541

Sales/Purchase Ledger setting, 161, 167, 218
Payment Terms

Customers, 245
Exporting, 535
Sales/Purchase Ledger setting, 245

Payments, 166
Deleting, 516
Exporting, 539
In Currency, 167
On Account, 165, 166
Purchase Ledger register, 223

PC Printer
Operations menu command, Forms, 510

Percentage
Down Payments, 231

Period
Price Lists, 348

Period Locking. See Locking
Periods. See Reporting Periods
Person List

System Module report, 520
Personal Desktop, 143

Archives, 148
Creating, 148
Removing, 151
Renaming, 150

Attaching Notes and Comments, 147
Changing Names of Items, 148
Organising, 148
Reading Notes and Comments, 147
Removing Items from, 148
Working with Records, 145
Working with Registers, 146
Working with Settings, Reports, Documents

and Maintenance functions, 146
Personnel Payments

Deleting, 516
Exporting, 539

Persons
Access Group, 486
Account, 167, 490
Allow FTP Access check box, 61, 486
Bank Account, 490
Bank Name, 490
Bonus, 489
Browse Window, 484
Closed check box, 486
Comment, 490
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Creating Mailboxes from, 492
Email Address, 490
Entering, 202
Exporting, 536
ID, 489
Language, 487
Limited Access, 486
Location, 490
Object, 490
Opening Mailbox, 491, 492
Our Ref, 489
Password, 83, 491
Printing a List, 520
Sales Group, 486
Signature, 485
Specification, 490
System Module register, 59, 250, 484

Pictures
in Forms, 508

Plain option
Items, 293

Point of Sales Module
Identifying each terminal, 442

Port
Company, 58
Program Mode, 454

Preferences. See Settings
Prel Book. See Preliminary Booking
Preliminary Booking check box

Purchase Invoices, 165
Preliminary Creditor Account

Account Usage P/L, 165
Preview Icon, 91
Previous Record button, 89
Price Based On options

Customers, 251
Price Factor

Items, 291
Price Formula

Price Lists, 350
Pricing module register, 350

Price Formula Code
Price Formulae, 346

Price Formula Name
Price Formulae, 346

Price Formulae
% Adjustment, 347
Add 1, 347

Add 2, 347
Base Value, 347
Exporting, 538
Price Formula Code, 346
Price Formula Name, 346
Pricing module register, 345, 346
Round Off, 347
Setting Up, 346

Price List
Customer Categories, 229, 346
Customers, 249, 346
Exporting as a Text File, 383
Printing, 383
Sales Ledger report, 354, 383
Setting Default, 354
Setting Default for Customers, 229, 239

Price List Code
Price Lists, 348

Price Lists, 344
Calculating, 345, 348, 351, 354
Calculating Prices for, 350
Changing to reflect Language of Customer,

384
Currency, 348
Deleting, 355
Description, 348
Exporting, 538
Inclusive or Exclusive of VAT, 349
Item Code, 350
Period, 348
Price Formula, 350
Price List Code, 348
Pricing module register, 229, 345, 347
Printing, 354
Replace, 348
Row Type, 350
Selection of, Depending on Date, 251, 348,

362
Setting Up, 347
Structure, 344
Type, 349
Updating, 352

Prices
Calculating for Price Lists, 350
Calculating using Formulae, 291
Displaying in Web Shop, 255
Exporting, 538
Pricing module register, 344, 351
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Sales Account, 158, 355
Setting up Multiple Price Lists, 344

Pricing module, 344
Pricing of Invoices

Selecting Discount, 369, 440, 464
Pricing of Orders

Selecting Discount, 440, 464
Pricing of Sales Orders

Selecting Price List, 251
Primary Contact

Customers, 242
Print

File menu command, 90
Print Destination

Specifying for Reports, 107
Print Queue, 114
Print Server

Setting Up, 452
Print Server Port

Program Mode, 453
Print Spool. See Print Queue
Printer Dialogue

Appearing before Printing Reports, 107
Printer Icon, 90
Printers

System Module setting, 112
Printing

Forms, 513
Printing Reports, 97
Productions

Exporting, 539
Products. See Items
Profit

Posting, 197
Profit & Loss Report, 194

Producing for Different Cost Centres, 184
Producing for Different Object Types, 187

Program Mode
Auto Connect Server IP, 453
Auto Connect Time, 454
Default Company, 57
Fax Interval, 457
FTP Port, 60
FTP Shared Directory, 61
Max FTP Users, 61
Port, 454
Print Server Port, 453
Program Name, 56

Server at Startup check box, 57
Server Port, 56, 58, 453
Technics Module register, 56

Program Name
Program Mode, 56

Project Budgets
Discount, 440

Projects
Determining Markup on Items, 291
Exporting, 536

Properties
Operations menu command, Forms, 509

Purchase Account
Setting Default, 163
Setting Default for Items, 289

Purchase Control Account
Account Usage S/L, 282
Item Groups, 282

Purchase Invoice Settings
Purchase Order Item Transfer Control options,

282
Purchase Invoices, 162

Appearance of when created from Purchase
Orders, 282

Deleting, 516
Entering, 223
Exporting, 539
Generating Nominal Ledger Transactions

from, 515
Preliminary Booking check box, 165
Purchase Account, 163
Purchase Ledger register, 223
Setting Rounding Rules for VAT, 464
VAT Account, 164

Purchase Items
Entering from Item register, 312
Exporting, 538

Purchase Ledger
Entering Opening Balances, 223

Purchase Ledger Control Account
Suppliers, 165

Purchase Order Item Transfer Control options
Purchase Invoice Settings, 282

Purchase Order Quotations
Exporting, 539

Purchase Orders
Appearance of Purchase Invoices created

from, 282
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Deleting, 516
Discount, 464
Exporting, 539
Setting Rounding Rules for Total, 464
Setting Rounding Rules for VAT, 464

Purchasing Suggestion
Purchase Orders report, 294

Q
Quantity

Calculating, based on Dimensions, 314
Quantity Breaks, 366
Quantity Dependent Discounts

Pricing module register, 299, 365, 366, 368,
369

Quantity Dependent Prices
Exporting, 538
Pricing Module setting, 351

Quantity Dependent Values
Price Lists, 349

Quantity Discounts, 351, 365. See also Quantity
Dependent Discounts

Quitting Hansa, 62
Quotations

Discount, 440, 464
Exporting, 539
Setting Rounding Rules for Total, 464
Setting Rounding Rules for VAT, 464
Unit Price

Preventing Changes to, 340

R
Rate Gain Account

Account Usage P/L, 167
Account Usage S/L, 162

Rate Loss Account
Account Usage P/L, 167
Account Usage S/L, 162

Rate Round Off Account
Account Usage P/L, 167
Account Usage S/L, 162

Raw Data
System Module Export function, 540

Recalculate
Operations menu command, Reports, 97

Recalculate Discount
Operations menu command, Invoices, 369

Receipts, 160
Deleting, 516
Entering, 221
Exporting, 539
Generating Nominal Ledger Transactions

from, 515
In Currency, 162
On Account, 159, 161, 230, 247
Sales Ledger register, 221

Recipe
Items, 302

Recipes
Displaying on Orders/Invoices, 302
Exporting, 538
Stock Module register, 302

Record Checking
System Module report, 520

Record Menu, 117
Attachments, 121
Cancel, 118
History, 121
Invalidate, 119
Send to Desktop, 121, 145

Record Window, 88
Button Bar, 89
Moving from field to field, 88

Records
Attaching Files, 136
Attaching Notes and Comments, 137
Attaching other Records, 138
Attaching to the Personal Desktop, 145
Copying, 118
Creating, 85, 118, 128
Current, 128
Deleting, 119, 129, 516
Duplicating, 86, 128
Modifying, 86
Opening Attached Records, 139
Printing Notes and Comments, 137
Reading Attached Files, 136
Reading Notes and Comments, 137
Removing Attachments, 139
Viewing History, 121

Registers
Accounts, 493
Activities. See Volume 6
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Attaching to the Personal Desktop, 146
Brought Forward Balances, 211
Companies, 39, 46, 53, 58, 104, 130, 481
Contact Persons, 242
Currencies, 348. See Volume 2b
Customers, 206, 238
Discount Matrices, 229, 250, 365, 367, 369
Exchange Rates. See Volume 2b
Fax Queue, 461
Forms, 110, 112, 505
Goods Receipts, 223
Invoices, 219
Item Formulae, 316
Item Groups, 278, 289, 350
Items, 209, 287
Objects, 241, 292, 500
Payments, 223
Persons, 59, 250, 484
Price Formulae, 345, 346, 350
Price Lists, 229, 345, 347
Prices, 344, 351
Program Mode, 56
Purchase Invoices, 223
Quantity Dependent Discounts, 299, 365, 366,

368, 369
Receipts, 221
Recipes, 302
Sharing information between Companies, 133
Structure of, 19
Suppliers, 208
System module, 481
Transactions, 213

Registers Menu, 124
Registration Defaults

Sales Ledger setting, 252
Registration Number

Customers, 252
Reminder

Sales Ledger document, 247
Reminders check box

Customers, 247
Removing Attachments, 139
Rental Invoicing

Items, 303
Reopen Report Specification

Operations menu command, Reports, 97
Replace

Price Lists, 348

Report Font
Company Info, 43, 427

Report Font Size
Company Info, 427

Report Window, 95
Reporting Period

Setting Default, 463
Reporting Periods

Exporting, 541
System Module setting, 463

Reports, 154
Activities, Persons. See Volume 6
Adjusting Page Setup/Magnification, 113
Analytical Balance, 497
Attaching to the Personal Desktop, 146
Bonus, Salesman, 291, 489
Changing Report Criteria, 108
Company Info, 520
Customer List, 267
Customer Sales Statistics, 274
Customer Statistics, 272
Customer Status, 257, 275
Customer/Item Statistics, 381
Deficiency List, 294
Defining, 108
Discount Matrices List, 385
Drill-down, 98
EU VAT Sales, 242
Exchange Rates. See Volume 2b
Exporting, 108
GP, Orders, 177
Item Group List, 372
Item History, 176
Item List, 372
Item Sales Statistics, 377
Item Statistics, 374
Item Turnover History, 379
Item/Quantity Statistics, 380
Page Setup, 107
Person List, 520
Placing in a Print Queue, 114
Price List, 354, 383
Printing, 97, 224
Printing more than one Copy, 113
Printing to Specific Printers, 448
Purchasing Suggestion, 294
Recalculating, 97, 108
Record Checking, 520
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Saving to Disk, 108
Searching in, 97
Selecting Print Destination, 107
Setting Fonts, 43
Specifying Printer Dialogue, 107
Stocktaking List, 296
System Documentation, 521
System module, 519
Transaction Checking, 521
Trial Balance, 210, 224
Underlined Text, 99
User Activities. See Volume 6
Varieties Enquiry, 402
Varieties in Stock, 403

Opening from Item Status Window, 412
Opening from Stock List, 408

Reports button, 81
Resources button, 81
Restaurant Module

Identifying each terminal, 442
Restoring from a Back-up, 72, 523, 530

Appears to Fail, 73
Process Appears to Fail, 532

Returned Goods
Exporting, 539

Revaluations
Exporting, 539

Revised Budgets
Printing, 521

Round Off
Exporting, 541
Price Formulae, 347
System Module setting, 160, 463

Round Off Account
Account Usage S/L, 160, 463

Rounding Rules
Setting for Invoice/Order Total, 464
Setting for VAT, 464

Row Type
Price Lists, 350

Run Timed Backup
System Module Export function, 541

S
Safety Back-up, 66

Automatic, 68
Restoring from, 72

Sales Account
Account Usage S/L, 158, 253, 279
Item Groups, 158, 279
Items, 158, 305
Prices, 158, 355
Setting Default, 157, 220, 305
Setting Default for Credit Notes, 285
Setting Default for Invoices, 279
Setting Default for Items, 289

Sales Group
Customers, 250
Persons, 486

Sales Groups
System Module setting, 465

Sales Invoices. See Invoices
Sales Ledger

Entering Opening Balances, 214
Sales Orders

Comment, 243
Deleting, 516
Discount, 440, 464
Exporting, 539
Salesman, 250
Setting Rounding Rules for Total, 464
Setting Rounding Rules for VAT, 464
Unit Price

Preventing Changes to, 340
Salesman

Customers, 250
Sales Orders, 250

Salesmen
Calculating Bonus on the sale of Items, 291

Save button, 91
Scrolling

in a Browse Window, 85
Searching

in a Browse Window, 86
using a Wildcard, 86

Select Company Window
Bypassing, 57

Select Module button, 81
Selection List

Using to Insert Data into Fields, 91
Send and Receive E-Mail

System Module function, 517
Send to Back

Operations menu command, Forms, 510
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Send to Desktop
Record menu command, 121, 145

Serial Number Defaults. See Number Series
Defaults

Serial Number Tracking
Batch Level, 295
Items, 295
Unit Level, 295

Server
Logging on to, 58
Starting up, 483

Server at Startup check box
Program Mode, 57

Server module
Granting Access to, 54
Selecting by Default, 57
Setting up, 54

Server Port
Program Mode, 56, 58, 453

Service option
Items, 294

Service Orders
Exporting, 539

Service Stock Transactions
Exporting, 539

Settings, 41, 82, 112
Access Groups, 112, 415
Active Users, 423
Attaching to the Personal Desktop, 146
Auto Actions, 423
Banks, 244
Base Currency. See Volume 2b
Base Currency Rates. See Volume 2b
Base Price Changes, 336
Company Info, 42, 424
Conversion - Accounts, 428
Conversion - Activity Types, 430
Conversion - Currency Codes, 433
Conversion - Customer Classifications, 434
Conversion - Customers, 433
Conversion - Items, 434
Conversions - Master, 428, 430, 433, 434
Cost Model, 283
Countries, 252, 435
Credit Limit, 246
Currency Round Off. See Volume 2b
Customer Categories, 228, 239
Customer Classifications, 242

Customer Status Report, 257
Date and Numeric Format, 436
Default Items, 323
Delivery Modes, 244
Delivery Terms, 244
Display Groups, 438
Down Payments, 231
Enabler, 48, 439
Exporting Contents, 535, 541
Fax Settings, 458
File menu command, 42, 112
Fiscal Years, 198, 440
General Options, 440
Interest, 246
Item Classifications, 232, 254, 292, 326, 334
Item Formulae, 291
Item Groups, 369
Item Settings, 313
Item Varieties, 390
Item Variety Groups, 389
Languages, 112, 253, 441
Local Machine, 442
Locking, 442
Logging Control, 121
Number Series Defaults, 199, 446
Object Types, 186
Order Classes, 231
Password Security, 447
Payment Modes, 161, 167, 218
Payment Terms, 245
Printers, 112
Quantity Dependent Prices, 351
Registration Defaults, 252
Reporting Periods, 463
Round Off, 160, 463
Sales Groups, 465
Shared Registers, 133
Sources, 296
Styles, 469
Sub Systems, 216
Sub-ledger Control Accounts, 471
System module, 41, 414
System Usage, 45, 54, 472
Timed Operations, 69, 71
Units, 289, 296
User Defined Fields, 232
Values in Text, 473
Variety Masks, 391
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VAT Codes, 158, 164, 253, 280
VAT Number Masks, 254, 478
Viewing Contents, 521
Weeks, 480

Settings button, 82
Settlement Discounts

On Sales, 245
Shared Registers

Technics module setting, 133
Shelf Code

Items, 296
Short

Company, 40
Short Code

Customers, 239
Show Batch Status check box

Item Settings, 314
Show Best Before Dates check box

Item Settings, 314
Show Components on Documents check box

Items, 302
Show Item Status check box

Item Settings, 311, 314
Show To Links

Operations menu command, Attachments, 138
Shutting Hansa Down, 62
Signature

Persons, 485
Simulations

Deleting, 516
Exporting, 539

Single Page Only
Operations menu command, Forms, 512

Single-page Forms, 511
Sort Key

Customers, 240
Sorting

in a Browse Window, 85
Sources

Stock Module setting, 296
Specification

Persons, 490
Specification Window, 100
Spooling. See Print Queue
Standard Texts

Exporting, 536

Starting Hansa, 35
Static Text

Showing on Labels, 266
Stock

Calculating FIFO Price, 176
FIFO Principle, 168
Shipping Goods, 171
Value Compared with Stock Account, 173

Stock Account. See also Credit Account
Account Usage S/L, 160, 169, 281
Compared with Stock Value, 173
Item Groups, 160, 281
Locations, 160, 169, 281
Setting Default, 159, 169
Updating after Invoicing, 159

Stock Control
Entering Opening Balances, 223

Stock Cost Account
Account Usage S/L, 160, 280, 306

Stock Depreciations
Deleting, 516
Exporting, 539

Stock History
Specifying for each Item that one is to be

maintained, 293
Stock Levels

Displaying in Web Shop, 255
Viewing for each Item, 310

Stock List
Using Different Units of Measurement, 296

Stock module, 167
Stock Movements

Deleting, 516
Exporting, 539
Generating Nominal Ledger Transactions

from, 515
Stock Settings

Decrease Available on Deliveries, 310, 311
Paste Classification, 331
Unit 2 Conversion Calculation options, 297

Stock Transactions, 167
Stocked option

Items, 293
Stocktaking

Exporting, 539
Stocktaking List

Stock module report, 296
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Structure of Hansa, 155
Structured Item option

Items, 293
Styles

Exporting, 536
System Module setting, 469

Sub Systems
Nominal Ledger setting, 216

Sub-ledger Checking check box
Account Usage P/L, 471
Account Usage S/L, 471

Sub-ledger Control Accounts
Exporting, 541
System Module setting, 471

Subsidiary Companies. See Companies
Superimposed Text

Printed in Documents, 508
Supplier Categories

Creditor Account, 165, 472
Suppliers

Account, 165, 166
Cost Account, 163
Creditor Account, 165, 472
Entering, 208
Exporting, 536
Purchase Ledger Control Account, 165
Purchase Orders/Purchase Ledger register, 208
Removing blanks and dashes from Fax

Numbers, 517
VAT Code, 164

System Administrator
Granting Access to Technics Module, 421

System Data
System Module Export function, 535

System Documentation, 195
System Module report, 521

System Message
Technics Module function, 63

System module, 42, 414
Documents, 518
Exports, 526
Imports, 522
Maintenance, 515
Registers, 481
Reports, 519
Settings, 41, 414

System Requirements
Linux, 28

Macintosh, 27
Windows, 27

System Usage
Control String, 48
Number of Companies, 45
Number of Users, 45
System Module setting, 45, 54, 472

T
Tabs, 89
Tasks button, 80
TCP/IP

Company, 58
Technics Module

and System Administrator, 421
Telephone Number

Customers, 241
Terminals. See Local Machine
Text Back-up

Creating, 66, 527
Creating Automatically, 68
Restoring from, 72, 523, 530

Text Files
Opening in Excel, 437

Text Objects
in Forms, 506

Their Supplier Code
Customers, 246

Time Sheets
Exporting, 539

Timed Operations
Database Backup Path, 70
Database Backup Time, 70
Database Closing Time, 71
Database Opening Time, 71
Technics Module setting, 69, 71

To Do List
Operations menu command, Persons, 492

Total
Setting Rounding Rules, 464

Trader’s Branch Identifier
Intrastat, 425

Transaction Checking
System Module report, 521

Transaction Date
Warning when entering out of date sequence,

445
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Transaction Journal, 194
Transaction Records. See Transactions
Transaction Registers

System Module Export function, 539
Transaction Registers (Period)

System Module Export function, 539
Transactions, 155

Credits and Loans, 167
Deleting, 516
Entering, 210
Expenses, 167
Exporting, 539
Generating from Invoices, 156
Generating from other Ledgers and Modules,

515
Nominal Ledger register, 213
Objects, 183
Payments, 166
Purchase Invoices, 162
Receipts, 160
Sales Invoices, 156
Stock, 167

Transfer to Bad Debtors
Sales Ledger function, 230

Translations
Accounts, 498
Item Varieties, 391
Items, 307
Price Lists, 384

Transport
Printing a total for, on Invoices, 285

Treat Item as Material on Project check box
Items. See Volume 5

Trial Balance
Nominal Ledger report, 210, 224

Turnover
Reporting, 272, 274

Type
Item Groups, 285

Type Styles. See Styles

U
UKAccs1.Txt

Accounts Template File, 33, 51
UKForms.Txt

Accounts Template File, 33

UKStd.Txt
Accounts Template File, 33

Underlined Text in Reports, 99
Unique Bar Code check box

Item Settings, 304, 313
Unit

Items, 289
Unit 2

Items, 296
Unit 2 Conversion Calculation options, 297
Unit Coefficient

Items, 296
Unit Level

Serial Number Tracking, 295
Unit Price

Use in Pricing Invoices
Preventing Changes to, 340

Use in Pricing Quotations
Preventing Changes to, 340

Use in Pricing Sales Orders
Preventing Changes to, 340

Units
Exporting, 535
Sales Ledger setting, 289, 296

Update Cost Price at Purchase
Item Settings, 302, 315
Items, 301

Update Fax Numbers
System Module function, 517

Update Item Base Prices
Pricing module function, 342

Update Item Cost Price
Stock Module function, 178

Update Item Cost Prices
Pricing module function, 343

Upgrades
Obtaining, 75

Upgrading from Previous Versions, 75
Use Credit Sales Accounts check box

Account Usage S/L, 280, 305, 306
Use Item Groups for Cost Accounts check box

Cost Accounting, 160, 281, 282, 306
User Activities

System Module report. See Volume 6
User Company. See Company Info
User Defined Fields

CRM module setting, 232
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Users. See also Persons
Listing, 423
Number of, 45

V
Values in Text

Exporting, 536
System Module setting \b, 473

Var Button
Item Status Window, 412

Varieties, 387
and the Item Status Window, 410

Varieties Enquiry
Stock Module report, 402

Varieties in Stock
Stock Module report, 403

Opening from Item Status Window, 412
Opening from Stock List, 408

Variety Masks
Stock module setting, 391

VAT
Setting Rounding Rules, 464
Using with Price Lists, 349

VAT Account
Setting Default, 158, 164
Setting Default for Invoices, 280

VAT Cash Discount
Account Usage P/L, 167
Account Usage S/L, 162

VAT Code
Account Usage P/L, 164
Account Usage S/L, 159, 253, 280
Accounts, 164
Customers, 158, 253, 280
Item Groups, 159, 280
Items, 158, 306
Setting Default for Credit Notes, 285
Setting Default for Invoices, 220
Setting Default for Items, 280, 289, 306
Setting Default for Sales, 253
Suppliers, 164

VAT Codes
Exporting, 535, 541
Nominal Ledger setting, 158, 164, 253, 280

VAT Law
Company Info, 426

VAT Law Code
Company Info, 44

VAT Number Masks
System Module setting, 254, 478

VAT Numbers
Formatting for Different Countries, 254, 478

VAT Registration Number
Customers, 254

V-Cd. See VAT Code
Version Number, 127
View All

Operations menu command, Forms, 512
Virus

Removing, 66
Volume

Items, 299
Selling Items by, 298

W
Warning

Customers, 252
Items, 304

Warranty Months
Items, 304

Web Order Class
Customer Categories, 231

Web Shop
Allocating Passwords to Customers, 257, 260
Allowing Login, 248
Calculating Freight Charges, 255
Role of Item Classifications, 334

Web Shop Customers
Allowing to Log In, 248
Calculating Freight Charges, 255
Offering specific Items to, 232, 254, 292, 334
Setting Password, 257, 260
Showing Stock Levels to, 255

Web Shop Orders
Allocating Order Class, 231
Calculating Freight Charges, 255

Web Site
Customers, 242

Website (Hansa), 75
Website (HansaWorld.com), 83
Week Numbers

Defining for the Calendar, 480
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Weeks
System Module setting, 480

Weight
Items, 299

Weighted Average
Items, 284, 300

Width
Items, 298

Wildcard. See also Paste Special
Used in Searches, 86

Window Menu, 126
Window Title, 40
Windows

Active Window, 84
Closing and Saving Changes, 118
Closing without Saving Changes, 118
Management of, 84
Moving, 84

Windows (Microsoft)
Multi-user Installation, 29
Single-user Installation, 28
System Requirements, 27

Work Area, 78
Work Orders

Exporting, 539
Work Sheets

Deleting, 516
Discount, 440, 464
Exporting, 539

Workflow, 20
Working with Hansa, 202
Write Offs Account

Account Usage S/L, 162
WWW Address. See Web Site

Y
Y2K, 436
Year 2000, 436

Z
Zone

Customers, 253, 279, 305


